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Preface 
 

The xStack DGS/DXS-3300 Series Manual is divided into sections that describe the system installation and operating 
instructions with examples.  

Section 1, Introduction - Describes the Switch and its features. 

Section 2, Installation- Helps getting started with the basic installation of the Switch and also describes the front panel, 
rear panel, side panels, and LED indicators of the Switch. 

Section 3, Connecting the Switch - Tells how to connect the Switch to the Ethernet network. 

Section 4, Introduction to Switch Management - Introduces basic Switch management features, including password 
protection, SNMP settings, IP address assignment and connecting devices to the Switch. 

Section 5, Introduction to Web-based Switch Management - Talks about connecting to and using the Web-based switch 
management feature on the Switch. 

Section 6, Configuring the Switch - A detailed discussion about configuring some of the basic functions of the Switch, 
including accessing the Switch information, using the Switch's utilities and setting up network configurations, such as 
Quality of Service, the Access Profile Table, port mirroring and configuring the Spanning Tree. 

Section 7, Management - A discussion of the security features of the Switch, including Security IP, User Accounts, and 
Access Authentication Control. 

Section 8, SNMP Manager – A detailed discussion regarding the Simple Network Monitoring Protocol including 
description of features and a brief introduction to SNMP. 

Section 9, Monitoring - Features graphs and screens used in monitoring features and packets on the Switch. 

Section 10, Maintenance - Features information on Switch utility functions, including TFTP Services, Switch History, 
Ping Test Save Changes and Rebooting Services. 

Section 11, Single IP Management - Discussion on the Single IP Management function of the Switch, including functions 
and features of the Java based user interface and the utilities of the SIM function. 

Appendix A, Technical Specifications  - The technical specifications of switches in the xStack DGS/DXS-3300 Series. 

Appendix B, Cables and Connectors  - Describes the RJ-45 receptacle/connector, straight-through and crossover cables 
and standard pin assignments. 

Appendix C, Cable Lengths  - Information on cable types and maximum distances. 

Glossary - Lists definitions for terms and acronyms used in this document. 
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Intended Readers 
The xStack DGS/DXS-3300 Series Manual contains information for setup and management of the Switch. This manual is 
intended for network managers familiar with network management concepts and terminology.  

Typographical Conventions 
Convention                        Description 

[ ] In a command line, square brackets indicate an optional entry. For example: [copy 
filename] means that optionally you can type copy followed by the name of the file. 
Do not type the brackets. 

Bold font Indicates a button, a toolbar icon, menu, or menu item. For example: Open the File 
menu and choose Cancel. Used for emphasis. May also indicate system messages 
or prompts appearing on screen. For example: You have mail. Bold font is also 
used to represent filenames, program names and commands. For example: use the 
copy command. 

Boldface 
Typewriter Font 

Indicates commands and responses to prompts that must be typed exactly as printed 
in the manual. 

Initial capital letter Indicates a window name. Names of keys on the keyboard have initial capitals. For 
example: Click Enter. 

Italics Indicates a window name or a field. Also can indicate a variables or parameter that is 
replaced with an appropriate word or string. For example: type filename means that 
the actual filename should be typed instead of the word shown in italic. 

Menu Name > Menu 
Option 

Menu Name > Menu Option Indicates the menu structure. Device > Port > Port 
Properties means the Port Properties menu option under the Port menu option that 
is located under the Device menu. 

Notes, Notices, and Cautions 
 

 

A NOTE indicates important information that helps make better use of the 
device. 

 

 

A NOTICE indicates either potential damage to hardware or loss of data 
and tells how to avoid the problem. 

 

   

A CAUTION indicates a potential for property damage, personal injury, or 
death. 
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Safety Instructions 
Use the following safety guidelines to ensure your own personal safety and to help protect your system from potential 

damage. Throughout this safety section, the caution icon (  ) is used to indicate cautions and precautions that need to be 
reviewed and followed. 

 

Safety Cautions 

To reduce the risk of bodily injury, electrical shock, fire, and damage to the equipment, observe the following precautions. 

• Observe and follow service markings.  

• Do not service any product except as explained in the system documentation.  

• Opening or removing covers that are marked with the triangular symbol with a lightning bolt may expose the 
user to electrical shock. 

• Only a trained service technician should service components inside these compartments. 

• If any of the following conditions occur, unplug the product from the electrical outlet and replace the part or contact 
your trained service provider: 

• Damage to the power cable, extension cable, or plug. 

• An object has fallen into the product. 

• The product has been exposed to water. 

• The product has been dropped or damaged. 

• The product does not operate correctly when the operating instructions are correctly followed. 

• Keep your system away from radiators and heat sources. Also, do not block cooling vents. 

• Do not spill food or liquids on system components, and never operate the product in a wet environment. If the system 
gets wet, see the appropriate section in the troubleshooting guide or contact your trained service provider. 

• Do not push any objects into the openings of the system. Doing so can cause fire or electric shock by shorting out 
interior components. 

• Use the product only with approved equipment. 

• Allow the product to cool before removing covers or touching internal components. 

• Operate the product only from the type of external power source indicated on the electrical ratings label. If unsure of 
the type of power source required, consult your service provider or local power company. 

• To help avoid damaging the system, be sure the voltage selection switch (if provided) on the power supply is set to 
match the power available at the Switch’s location: 

• 115 volts (V)/60 hertz (Hz) in most of North and South America and some Far Eastern countries such as South 
Korea and Taiwan 

• 100 V/50 Hz in eastern Japan and 100 V/60 Hz in western Japan 

• 230 V/50 Hz in most of Europe, the Middle East, and the Far East 

• Also, be sure that attached devices are electrically rated to operate with the power available in your location. 

• Use only approved power cable(s). If you have not been provided with a power cable for your system or for any AC-
powered option intended for your system, purchase a power cable that is approved for use in your country. The power 
cable must be rated for the product and for the voltage and current marked on the product's electrical ratings label. 
The voltage and current rating of the cable should be greater than the ratings marked on the product. 
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• To help prevent electric shock, plug the system and peripheral power cables into properly grounded electrical outlets. 
These cables are equipped with three-prong plugs to help ensure proper grounding. Do not use adapter plugs or 
remove the grounding prong from a cable. If using an extension cable is necessary, use a 3-wire cable with properly 
grounded plugs. 

• Observe extension cable and power strip ratings. Make sure that the total ampere rating of all products plugged into 
the extension cable or power strip does not exceed 80 percent of the ampere ratings limit for the extension cable or 
power strip. 

• To help protect the system from sudden, transient increases and decreases in electrical power, use a surge suppressor, 
line conditioner, or uninterruptible power supply (UPS). 

• Position system cables and power cables carefully; route cables so that they cannot be stepped on or tripped over. Be 
sure that nothing rests on any cables. 

• Do not modify power cables or plugs. Consult a licensed electrician or your power company for site modifications. 
Always follow your local/national wiring rules. 

• When connecting or disconnecting power to hot-pluggable power supplies, if offered with your system, observe the 
following guidelines: 

• Install the power supply before connecting the power cable to the power supply. 

• Unplug the power cable before removing the power supply. 

• If the system has multiple sources of power, disconnect power from the system by unplugging all power cables 
from the power supplies. 

• Move products with care; ensure that all casters and/or stabilizers are firmly connected to the system. Avoid sudden 
stops and uneven surfaces. 

   

General Precautions for Rack-Mountable Products 

Observe the following precautions for rack stability and safety. Also, refer to the rack installation documentation 
accompanying the system and the rack for specific caution statements and procedures. 

• Systems are considered to be components in a rack. Thus, "component" refers to any system as well as to various 
peripherals or supporting hardware. 

   

CAUTION: Installing systems in a rack without the front and side stabilizers installed could 
cause the rack to tip over, potentially resulting in bodily injury under certain circumstances. 
Therefore, always install the stabilizers before installing components in the rack. After 
installing system/components in a rack, never pull more than one component out of the 
rack on its slide assemblies at one time. The weight of more than one extended 
component could cause the rack to tip over and may result in serious injury. 

• Before working on the rack, make sure that the stabilizers are secured to the rack, extended to the floor, and that the 
full weight of the rack rests on the floor. Install front and side stabilizers on a single rack or front stabilizers for joined 
multiple racks before working on the rack. 

• Always load the rack from the bottom up, and load the heaviest item in the rack first. 

• Make sure that the rack is level and stable before extending a component from the rack. 

• Use caution when pressing the component rail release latches and sliding a component into or out of a rack; the slide 
rails can pinch your fingers. 

• After a component is inserted into the rack, carefully extend the rail into a locking position, and then slide the 
component into the rack. 
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• Do not overload the AC supply branch circuit that provides power to the rack. The total rack load should not exceed 
80 percent of the branch circuit rating. 

• Ensure that proper airflow is provided to components in the rack. 

• Do not step on or stand on any component when servicing other components in a rack. 

 

NOTE: A qualified electrician must perform all connections to DC power and to safety 
grounds. All electrical wiring must comply with applicable local or national codes and 
practices. 

 

   

CAUTION: Never defeat the ground conductor or operate the equipment in the absence 
of a suitably installed ground conductor. Contact the appropriate electrical inspection 
authority or an electrician if uncertain that suitable grounding is available. 

 

   

CAUTION: The system chassis must be positively grounded to the rack cabinet frame. 
Do not attempt to connect power to the system until grounding cables are connected. 
Completed power and safety ground wiring must be inspected by a qualified electrical 
inspector. An energy hazard will exist if the safety ground cable is omitted or 
disconnected. 

Protecting Against Electrostatic Discharge 
Static electricity can harm delicate components inside the system. To prevent static damage, discharge static electricity 
from your body before touching any of the electronic components, such as the microprocessor. This can be done by 
periodically touching an unpainted metal surface on the chassis. 

The following steps can also be taken prevent damage from electrostatic discharge (ESD): 

1. When unpacking a static-sensitive component from its shipping carton, do not remove the component from the 
antistatic packing material until ready to install the component in the system. Just before unwrapping the antistatic 
packaging, be sure to discharge static electricity from your body. 

2. When transporting a sensitive component, first place it in an antistatic container or packaging. 

3. Handle all sensitive components in a static-safe area. If possible, use antistatic floor pads, workbench pads and an 
antistatic grounding strap.
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Section 1      
Introduction 

Ethernet Technology 

Switch Description  

Features 

Ports 

Front-Panel Components 

Side Panel Description 

Rear Panel Description 

Gigabit Combo Ports 

Ethernet Technology 

Fast Ethernet Technology 

 
The DGS/DXS-3300 Layer 3 stackable Gigabit Ethernet switches are members of the D-Link xStack family. Ranging from 
10/100Mbps edge switches to core gigabit switches, the xStack switch family has been future-proof designed to provide a 
stacking architecture with fault tolerance, flexibility, port density, robust security and maximum throughput with a user-
friendly management interface for the networking professional. 

The following manual describes the installation, maintenance and configurations concerning members of the xStack 
DGS/DXS-3300 Switch Series. These four switches, the DGS-3324SRi, DGS-3324SR, DXS-3326GSR and the DXS-
3350SR are all very similar in configurations and basic hardware and consequentially, most of the information in this 
manual will be universal to the whole xStack DGS/DXS-3300 Switch Series. Corresponding screen pictures of the web 
manager may be taken from any one of these switches but the configuration will be identical, except for varying port 
counts.  

Ethernet Technology 
Fast Ethernet 
The growing importance of LANs and the increasing complexity of desktop computing applications are fueling the need 
for high performance networks. A number of high-speed LAN technologies are proposed to provide greater bandwidth and 
improve client/server response times. Among them, Fast Ethernet, or 100BASE-T, provides a non-disruptive, smooth 
evolution from 10BASE-T technology.  

100Mbps Fast Ethernet is a standard specified by the IEEE 802.3 LAN committee. It is an extension of the 10Mbps 
Ethernet standard with the ability to transmit and receive data at 100Mbps, while maintaining the Carrier Sense Multiple 
Access with Collision Detection (CSMA/CD) Ethernet protocol.  

Gigabit Ethernet Technology 
Gigabit Ethernet is an extension of IEEE 802.3 Ethernet utilizing the same packet structure, format, and support for 
CSMA/CD protocol, full duplex, flow control, and management objects, but with a tenfold increase in theoretical 
throughput over 100Mbps Fast Ethernet and a one hundred-fold increase over 10Mbps Ethernet. Since it is compatible with 
all 10Mbps and 100Mbps Ethernet environments, Gigabit Ethernet provides a straightforward upgrade without wasting a 
company's existing investment in hardware, software, and trained personnel. 

The increased speed and extra bandwidth offered by Gigabit Ethernet are essential to coping with the network bottlenecks 
that frequently develop as computers and their busses get faster and more users use applications that generate more traffic. 
Upgrading key components, such as the backbone and servers to Gigabit Ethernet can greatly improve network response 
times as well as significantly speed up the traffic between sub networks.  
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Gigabit Ethernet enables fast optical-fiber connections to support video conferencing, complex imaging, and similar data-
intensive applications. Likewise, since data transfers occur 10 times faster than Fast Ethernet, servers outfitted with Gigabit 
Ethernet NIC's are able to perform 10 times the number of operations in the same amount of time. 

In addition, the phenomenal bandwidth delivered by Gigabit Ethernet is the most cost-effective method to take advantage 
of today’s and tomorrow's rapidly improving switching and routing internetworking technologies.  

Switching Technology 
Another key development pushing the limits of Ethernet technology is in the field of switching technology. A switch 
bridges Ethernet packets at the MAC address level of the Ethernet protocol transmitting among connected Ethernet or Fast 
Ethernet LAN segments. 

Switching is a cost-effective way of increasing the total network capacity available to users on a local area network. A 
switch increases capacity and decreases network loading by making it possible to divide a local area network into different 
segments, which are not competing with each other for network transmission capacity, and therefore decreasing the load on 
each segment. 

The Switch acts as a high-speed selective bridge between the individual segments. The Switch will automatically forward 
network traffic intended to travel from one segment (Port) to another, without interfering with any other segments (ports). 
This allows the total network capacity to be multiplied, while still maintaining the same network cabling and adapter cards. 

For Fast Ethernet or Gigabit Ethernet networks, a switch is an effective way of eliminating problems of chaining hubs 
beyond the "two-repeater limit." A switch can be used to split parts of the network into different collision domains, for 
example, making it possible to expand the Fast Ethernet network beyond the 205-meter network diameter limit for 
100BASE-TX networks. Switches supporting both traditional 10Mbps Ethernet and 100Mbps Fast Ethernet are also ideal 
for bridging between existing 10Mbps networks and new 100Mbps networks. 

Switching LAN technology is a marked improvement over the previous generation of network bridges, which were 
characterized by higher latencies.  Routers have also been used to segment local area networks, but the cost of a router and 
the setup and maintenance required make routers relatively impractical. Today's switches are an ideal solution to most 
kinds of local area network congestion problems. 

Switch Description 
D-Link's next-generation xStack DGS/DXS-3300 Series switches are high port-density Layer 3 stackable switches that 
combine the ultimate performance with fault tolerance, security, management functions with flexibility and ease-of-use. 
All these features, typically found in the more expensive chassis-based solutions, are available from the xStack DGS/DXS-
3300 Switch Series at the price of a stackable switch! 

All xStack DGS/DXS-3300 Series switches have some combination of 1000BASE-T ports, XFP ports and 10-Gigabit 
stacking ports that may be used in uplinking various network devices to the Switch, including PCs, hubs and other switches 
to provide a gigabit Ethernet uplink in full-duplex mode. The SFP (Small Form Factor Portable) combo ports are to be used 
with fiber-optical transceiver cabling in order to uplink various other networking devices for a gigabit link that may span 
great distances. These SFP ports support full-duplex transmissions, have auto-negotiation and can be used with DEM-
310GT (1000BASE-LX), DEM-311GT (1000BASE-SX), DEM-314GT (1000BASE-LH) and DEM-315GT (1000BASE-
ZX) transceivers. These ports are referred to as “combo” ports which means that both the SFP ports and the 1000BASE-T 
ports are numbered the same and cannot be used simultaneously. Attempting to use the ports simultaneously will cause a 
link down status for the 1000BASE-T ports. SFP ports will always have priority over these 1000BASE-T ports. 

Also included at the rear of the xStack DGS/DXS-3300 Series switches are 10-gigabit stacking ports used to stack other 
xStack DGS/DXS-3300 Series switches. The DGS-3324SRi may be used as the master unit of a switch stack when 
utilizing these ports and can be configured in a Star topology, and in total, may provide a stacking solution of up to 312 
gigabit ports. Other switches of the xStack DGS/DXS-3300 Series may utilize these ports for stacking in a ring topology or 
in combination with the DGS-3324SRi master switch in a star topology. More information will be provided later in this 
manual concerning stacking the xStack DGS/DXS-3300 Series switches. 

 

NOTE: The SFP combo ports on the Switch cannot be used simultaneously with the 
corresponding 1000BASE-T ports. If both ports are in use at the same time (ex. port 
21 of the SFP and port 21 of the 1000BASE-T), the SFP ports will take priority over 
the combo ports and render the 1000BASE-T ports inoperable. 
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Features 
• IEEE 802.3z compliant 

• IEEE 802.3x Flow Control in full-duplex compliant 

• IEEE 802.3u compliant 

• IEEE 802.3ab compliant 

• IEEE 802.3ae compliant (for optional XFP module) 

• IEEE 802.1p Priority Queues 

• IEEE 802.3ad Link Aggregation Control Protocol support. 

• IEEE 802.1x Port-based and MAC-based Access Control 

• IEEE 802.1Q VLAN 

• IEEE 802.1D Spanning Tree, IEEE 802.1W Rapid Spanning Tree and IEEE 802.1s Multiple Spanning Tree 
support 

• Stacking support in either Ring or Star topology 

• Access Control List (ACL) support 

• IP Multinetting support 

• Protocol VLAN support 

• Single IP Management support 

• Access Authentication Control utilizing TACACS, XTACACS, TACACS+ and RADIUS protocols 

• Dual Image Firmware 

• Simple Network Time Protocol support 

• MAC Notification support 

• System and Port Utilization support 

• System Log Support 

• High performance switching engine performs forwarding and filtering at full wire speed up to 128Gbps. 

• Full- and half-duplex for all gigabit ports. Full duplex allows the switch port to simultaneously transmit and 
receive data. It only works with connections to full-duplex-capable end stations and switches. Connections to a 
hub must take place at half-duplex. 

• Support broadcast storm filtering 

• Non-blocking store and forward switching scheme capability to support rate adaptation and protocol conversion 

• Supports by-port Egress/Ingress rate control 

• Efficient self-learning and address recognition mechanism enables forwarding rate at wire speed 

• Support port-based enable and disable  

• Address table: Supports up to 8K MAC addresses per device 

• Supports a packet buffer of up to 3 Mbits 

• Supports Port-based VLAN Groups  

• Port Trunking with flexible load distribution and fail-over function 

• IGMP Snooping support 

• IGMP version 3 

• Layer 3 support including DVMRP, OSPF and RIP 

• SNMP support 
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• Secure Sockets Layer (SSL) and Secure Shell (SSH) support 

• System Severity control 

• Port Mirroring support 

• MIB support for: 

• RFC1213 MIB II 

• RFC1493 Bridge 

• RFC1757 RMON 

• RFC1643 Ether-like MIB 

• RFC2233 Interface MIB 

• IF MIB 

• Private MIB 

• RFC2674 for 802.1p 

• IEEE 802.1x MIB 

• RS-232 DCE console port for Switch management 

• Provides parallel LED display for port status such as link/act, speed, etc. 

Ports 

DGS-3324SRi 
 

Twenty-four 
10/100/1000BASE-T 

Gigabit ports 

 

Eight Combo SFP 
Ports 

 

Six 10-Gigabit 
stacking ports 

 

One console port  

 

One CompactFlash 
slot 

DGS-3324SR 
 

Twenty-four 
10/100/1000BASE-T 

Gigabit ports 

 

Four Combo SFP 
Ports 

 

Two 10-Gigabit 
stacking ports 

 

One console port 

DXS-3326GSR 
 

Four Combo 
10/100/1000BASE-T 

Gigabit ports 

 

Twenty-four SFP 
Ports 

 

Two 10-Gigabit 
stacking ports 

 

One console port 

 

One open slot to add 
a 2-port 10-gigabit 

Uplink Module 

DXS-3350SR 
 

Forty-eight 
10/100/1000BASE-T 

Gigabit ports 

 

Four Combo SFP 
Ports 

 

Two 10-Gigabit 
stacking ports 

 

One console port 

 

One open slot to add 
a 2-port 10-gigabit 

Uplink Module 

 

 

NOTE: For customers interested in D-View, D-Link Corporation's 
proprietary SNMP management software, go to the D-Link Website 
(www.dlink.com.cn) and download the software and manual. 
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Installing the SFP ports 
The xStack DGS/DXS-3300 Series switches are equipped with SFP (Small Form Factor Portable) ports, which are to be 
used with fiber-optical transceiver cabling in order to uplink various other networking devices for a gigabit link that may 
span great distances. These SFP ports support full-duplex transmissions, have auto-negotiation and can be used with DEM-
310GT (1000BASE-LX), DEM-311GT (1000BASE-SX), DEM-314GT (1000BASE-LH) and DEM-315GT (1000BASE-
ZX) transceivers. See the figure below for installing the SFP ports in the Switch. 

 
Figure 1- 1. Inserting the fiber-optic transceivers into the DGS-3324SRi 

Front-Panel Components 
The front panel of the Switch consists of LED indicators for Power, Master, Console, RPS, SIO (stacking) and for 
Link/Act for each port on the Switch. The front panel may also include a seven-segment LED (not supported for the DGS-
3324SRi) indicating the Stack ID number, as well as gigabit Ethernet ports and SFP ports. Comprehensive LED indicators 
display the status of the Switch and the network. 

DGS-3324SRi 

 
Figure 1- 2. Front Panel View of the DGS-3324SRi as shipped 

DGS-3324SR 

 
Figure 1- 3. Front Panel View of the DGS-3324SR as shipped 

DXS-3326GSR 

 
Figure 1- 4. Front Panel View of the DXS-3326GSR as shipped 

DXS-3350SR 

 
Figure 1- 5. Front Panel View of the DXS-3350SR as shipped 
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LED Indicators 
The Switch supports LED indicators for Power, Master, Console, RPS, SIO (stacking indicators) and Port LEDs. The 
following shows the LED indicators for the Switch along with an explanation of each indicator. 

  
Figure 1- 6. LED Indicators 

LED                                        Description 

Power This LED will light green after powering the Switch on to indicate the ready state 
of the device. The indicator is dark when the Switch is powered off. 

Master This LED will light solid green when the Switch is configured to be a master 
switch of a switch stack in a ring topology or when it is in use as a stand-alone 
switch. This LED will remain dark if the Switch is not configured to be a master 
switch of a switch stack or as a standalone switch. 

Console This LED should blink during the Power-On Self Test (POST). When the POST is 
finished successfully, the LED goes dark. This indicator will light solid green when 
the Switch is being logged into via out-of-band/local console management 
through the RS-232 console port in the front of the Switch using a straight-
through serial cable.  

This LED will light solid amber if the Power-On-Self-Test has failed. 

RPS This LED will light when the internal power has failed and the RPS has taken over 
the power supply to the Switch. Otherwise, it will remain dark. 

Port LEDs One row of LEDs for each port is located above the ports on the front panel. The 
first LED is for the top port and the second one is for the bottom ports. A solid 
light denotes a valid link on the port while a blinking light indicates activity on the 
port. These LEDs will remain dark if there is no link/activity on the port. 

Stacking Ports (SIO) There are six LEDs in the front of the DGS-3324SRi marked SIO 1-6, and they 
relate to the six 10-gigabit stacking ports at the rear of the Switch. For the DGS-
3324SR, DXS-3326GSR and the DXS-3350SR, there are only two stacking ports 
and therefore only two SIO LEDs, marked 1 and 2. These LEDs will light solid 
green to denote a valid link on the port. 

Stack ID These two seven segment LEDs display the current switch stack order of the 
Switch while in use. Possible numbers to be displayed range from 1-12. 
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Rear Panel Description 
DGS-3324SRi 
The rear panel of the DGS-3324SRi contains an AC power connector, six 10-gigabit stacking ports, a redundant power 
supply connector and an available slot to insert the CompactFlash card (storage media accessory).  

 
Figure 1- 7.  Rear panel view of DGS-3324SRi 

DGS-3324SR 
The rear panel of the DGS-3324SR contains an AC power connector, two 10-gigabit stacking ports, a redundant power 
supply connector and a system fan.  

 
Figure 1- 8.  Rear panel view of DGS-3324SR 

DXS-3326GSR 
The rear panel of the DXS-3326GSR contains an AC power connector, an optional module slot for uplinking a 2-port 
module, two 10-gigabit stacking ports, a redundant power supply connector and a system fan.  

 
Figure 1- 9.  Rear panel view of DXS-3326GSR  

DXS-3350SR 
The rear panel of the DXS-3350SR contains an AC power connector, an optional module slot for uplinking a 2-port 
module, two 10-gigabit stacking ports, a redundant power supply connector, a RS-232 DCE console port for Switch 
management and a system fan.  

 
Figure 1- 10.  Rear panel view of DXS-3350SR  

The AC power connector is a standard three-pronged connector that supports the power cord. Plug-in the female connector 
of the provided power cord into this socket, and the male side of the cord into a power outlet. The Switch automatically 
adjusts its power setting to any supply voltage in the range from 100 ~ 240 VAC at 50 ~ 60 Hz.  

The rear panel also includes an outlet for an optional external power supply. When a power failure occurs, the optional 
external RPS will immediately and automatically assume the power supply for the Switch. 
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Side Panel Description 
DGS-3324SRi & DGS-3324SR 

The right-hand side panel of the Switch contains two system fans, while the left hand panel includes a heat vent. 

The system fans are used to dissipate heat. The sides of the system also provide heat vents to serve the same purpose. Do 
not block these openings, and leave at least 6 inches of space at the rear and sides of the Switch for proper ventilation. Be 
reminded that without proper heat dissipation and air circulation, system components might overheat, which could lead to 
system failure. 

 
Figure 1- 11. Side Panels 

 
DXS-3326GSR & DXS-3350SR 

The right-hand side panel of the Switch contains three system fans, while the left hand panel includes two heat vents. 

The system fans are used to dissipate heat. The sides of the system also provide heat vents to serve the same purpose. Do 
not block these openings, and leave at least six inches of space at the rear and sides of the Switch for proper ventilation. Be 
reminded that without proper heat dissipation and air circulation, system components might overheat, which could lead to 
system failure. 

 

 
Figure 1- 12. Side Panels 
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SECTION 2 
Installation 

Package Contents 

Before Connecting to the Network 

Installing the Switch without the Rack 

Rack Installation 

Power On 

The Optional Module 

Redundant Power System 

Package Contents 
Open the shipping carton of the Switch and carefully unpack its contents. The carton should contain the following items: 

• One xStack Stackable Switch 

• One AC power cord  

• This H/W Installation & Getting Started Guide  

• Mounting kit (two brackets and screws) 

• Four rubber feet with adhesive backing 

• RS-232 console cable 

• One Infiniband Stacking Cable 4x50CM 

• One CD Kit for User’s Guide/CLI/D-View module 

• One CD Kit for D-View 5.1 Trial version. 

• One Generic QIG 

• Registration card & China Warranty Card (for China only) 

If any item is found missing or damaged, please contact your local D-Link reseller for replacement. 

Before Connecting to the Network 
The site where the Switch is installed may greatly affect its performance. Please follow these guidelines for setting up the 
Switch. 

• Install the Switch on a sturdy, level surface that can support at least 6.6 lb. (3 kg) of weight. Do not place heavy 
objects on the Switch. 

• The power outlet should be within 1.82 meters (6 feet) of the Switch. 

• Visually inspect the power cord and see that it is fully secured to the AC power port. 

• Make sure that there is proper heat dissipation from and adequate ventilation around the Switch. Leave at least 
10 cm (4 inches) of space at the front and rear of the Switch for ventilation. 

• Install the Switch in a fairly cool and dry place for the acceptable temperature and humidity operating ranges. 

• Install the Switch in a site free from strong electromagnetic field generators (such as motors), vibration, dust, 
and direct exposure to sunlight. 

• When installing the Switch on a level surface, attach the rubber feet to the bottom of the device. The rubber feet 
cushion the Switch, protect the casing from scratches and prevent it from scratching other surfaces. 
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Installing the Switch without the Rack 
First, attach the rubber feet included with the Switch if installing on a desktop or shelf. Attach these cushioning feet on the 
bottom at each corner of the device. Allow enough ventilation space between the Switch and any other objects in the 
vicinity. 

 
Figure 2- 1. Prepare Switch for installation on a desktop or shelf 

 

Installing the Switch in a Rack 
The Switch can be mounted in a standard 19" rack. Use the following diagrams as a guide. 

 

 
 Figure 2- 2. Fasten mounting brackets to Switch 

Fasten the mounting brackets to the Switch using the screws provided. With the brackets attached securely, the Switch can 
be mounted in a standard rack as shown in Figure 2-3 on the following page. 
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Mounting the Switch in a Standard 19" Rack 

 
Figure 2- 3. Installing Switch in a rack 

Power On 
Plug one end of the AC power cord into the power connector of the Switch and the other end into the local power source 
outlet.  

After powering on the Switch, the LED indicators will momentarily blink. This blinking of the LED indicators represents a 
reset of the system. 

Power Failure 
As a precaution, in the event of a power failure, unplug the Switch. When power is resumed, plug the Switch back in. 

The Optional Module 
At the rear of the DXS-3326GSR and the DXS-3350SR resides an optional module slot. This slot may be equipped with 
the DEM-420X 2-port 10GE XFP uplink module, or a DEM-420CX 2-port 10GBASE-CX4 uplink module, both sold 
separately.  

Adding the DEM-420X optional module will allow the administrator to add a 2-port fiber-optic uplink module which will 
transmit information at a rate of ten gigabits a second. These two ports are compliant with standard IEEE 802.3ae, support 
full-duplex transmissions only and are to be used with XFP MSA compliant transceivers.  

The DEM-420CX will too transfer information at a rate of ten gigabits a second but the medium is copper, not fiber and 
thus is only useful for short connections of up to 15 meters. Compliant with the IEEE802.3ak standard, this module will 
use a 4-laned copper connector to transfer information in full-duplex mode, quickly and accurately. User beware, the cable 
and connector port used for this module is nearly identical to the stacking ports and cables used for stacking in the xStack 
Series, but can in no way be interchangeable. 

To install these modules in the DXS-3326GSR and the DXS-3350SR, follow the simple steps listed below. 
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CAUTION: Before adding the optional module, make sure to disconnect all 
power sources connected to the Switch. Failure to do so may result in an 
electrical shock, which may cause damage, not only to the individual but to 
the Switch as well. 

At the back of the Switch to the left is the slot for the optional module, as shown in Figure 2-4 and Figure 2-5. This slot 
should be covered with a faceplate that can be easily removed by loosening the screws and pulling off the plate. 
 

 
Figure 2- 4. Optional Module slot at the rear of the DXS-3350SR 

 
Figure 2- 5. Optional Module slot at the rear of the DXS-3326GSR 

After removing the faceplate, remove the DEM-420X or DEM-420CX4 optional module from its box. The front panel 
should resemble the drawing represented here.  

 
Figure 2- 6. Front Panel of the DEM-420X 

 
Figure 2- 7. Front Panel of the DEM-420CX 

Take the module and gently slide it in to the available slot at the rear of the Switch until it reaches the back, as shown in the 
following figure. At the back of the slot are two sets of plugs that must be connected to the module. Gently, but firmly push 
in on the module to secure it to the Switch. The module should fit snugly into the corresponding receptors.  

 
Figure 2- 8. Inserting the optional module into the Switch. 

Optional Module Slot 

Optional Module Slot 
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Now tighten the two screws at adjacent ends of the module into the available screw holes on the Switch. The upgraded 
DXS-3350SR/DXS-3326GSR is now ready for use. 

 
 

Figure 2- 9. DXS-3350SR with optional module installed. 
 

The Media Accessory 
At the rear of the DGS-3324SRi is an open slot for a CompactFlash card. This 32MB PCMCIA flash card provides high 
capacity solid-state flash memory for storing information for and from the Switch, such as firmware, configuration files 
and even save log information kept on the Switch. It also supports True IDE Mode that is electrically compatible with an 
IDE disk drive. It is recommended that the user store a backup of the startup configuration file on the CompactFlash card 
of the control module and on a central server. When saving the startup configuration file, the Switch stores it in two places: 
in the CompactFlash and the PC card of the primary control module. When the Switch boots, it will try to use the primary 
configuration file on the PC card and, if for some reason the Switch cannot use the file, it automatically uses the secondary 
configuration file on the CompactFlash. If the startup file becomes corrupted in both places, the DGS-3324SRi will use its 
default configuration. 

To install the CompactFlash card, insert it into the available slot on the back of the Switch, as shown below, and ensure 
that the card “clicks” into place. When correctly inserted, the CF Card Button should protrude. To eject the card from the 
slot, press the CF Card button in and the CompactFlash card should pop out. 

 
Figure 2- 10. CF Card Installation 
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External Redundant Power System 
The Switch supports an external redundant power system. 

 
Figure 2- 11. The DGS-3324SRi with the DPS-500 Redundant External Power Supply 

 

 

Figure 2- 12. The DGS-3324SRi with the DPS-900 chassis RPS 

 

NOTE: See the DPS-500 documentation for more information. 

   

CAUTION: Do not use the Switch with any redundant power system other 
than the DPS-500. 
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Section 3  

Connecting the Switch 
Switch To End Node 

Switch to Hub or Switch 

Connecting To Network Backbone or Server 

Stacking and the xStack DGS/DXS-3300 Series  

 

 

NOTE: All high-performance N-Way Ethernet ports can support both MDI-
II and MDI-X connections. 

Switch to End Node 
End nodes include PCs outfitted with a 10, 100 or 1000 Mbps RJ 45 Ethernet Network Interface Card (NIC) and most 
routers. 

An end node can be connected to the Switch via a twisted-pair UTP/STP cable. The end node should be connected to any 
of the 1000BASE-T ports of the Switch.   

 
Figure 3- 1. Switch connected to an end node 

The Link/Act LEDs for each UTP port will light green or amber when the link is valid. A blinking LED indicates packet 
activity on that port. 
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Switch to Hub or Switch 
These connections can be accomplished in a number of ways using a normal cable. 

• A 10BASE-T hub or switch can be connected to the Switch via a twisted-pair Category 3, 4 or 5 UTP/STP cable. 

• A 100BASE-TX hub or switch can be connected to the Switch via a twisted-pair Category 5 UTP/STP cable.  

• A 1000BASE-T switch can be connected to the Switch via a twisted pair Category 5e UTP/STP cable. 

• A switch supporting a fiber-optic uplink can be connected to the Switch’s SFP ports via fiber-optic cabling. 

 

 
 Figure 3- 2. Switch connected to a port on a hub or switch using a straight or crossover cable 

 

 
Figure 3- 3. Switch connected to switch using fiber-optic cabling 
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Connecting To Network Backbone or Server 
The combo SFP ports and the 1000BASE-T ports are ideal for uplinking to a network backbone, server or server farm. The 
copper ports operate at a speed of 1000, 100 or 10Mbps in full or half duplex mode. The fiber-optic ports can operate at 
1000Mbps in full duplex mode only. 

Connections to the Gigabit Ethernet ports are made using a fiber-optic cable or Category 5e copper cable, depending on the 
type of port. A valid connection is indicated when the Link LED is lit. 

 
Figure 3- 4. Uplink Connection to a server, PC or switch stack. 
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Stacking and the xStack DGS/DXS-3300 Series 
The DGS-3324SR, DXS-3326GSR and the DXS-3350SR are equipped with two 10-gigabit stacking ports at the rear of the 
device, as seen below. The DGS-3324SRi has six 10-gigabit stacking ports at the rear of the Switch, also shown below. 
These stacking ports may be used to stack to a master switch to be used in a switch stack.  

 
Figure 3- 5. SIO 1 and SIO 2 Stacking ports at the rear of the DGS-3324SR 

 
Figure 3- 6. SIO 1-6 Stacking ports at the rear of the DGS-3324SRi 

These stacking ports, named SIO (Stacking IN/OUT), can be used with other stacking switches for a scalable stacking 
solution of up to 384 ports in a star or ring topology. Each stacking port has corresponding LEDs at the front of the Switch, 
labeled SIO and will light solid green whenever the port is in use. The seven-segment LED Stack ID to the left of the SIO 
LEDs (not supported for the DGS-3324SRi) on the front of the Switch will display the Stack ID number of the Switch in a 
switch stack.  

 
Figure 3- 7. Stacking LEDs at the front of the DGS-3324SR 

The xStack DGS/DXS-3300 Switch Series can be stacked in a star or ring topology, as previously mentioned. For a star 
architecture, only one of the two Gigabit stacking ports of the slave switch will be in use. This port will be connected to the 
master switch of the switch stack (DGS-3324SRi) and will act as a slave switch of the stack. The administrator may use 
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either of the two available stacking ports to achieve this architecture. See the following diagram for an example of stacking 
in a star architecture. 

  
Figure 3- 8. Stacking in a Star Architecture 

For stacking in a ring architecture, all SIO ports will be in use, as shown in the following diagram. Up to 12 xStack 
DGS/DXS-3300 Series may be stacked together in the ring architecture switch stack, though there are limitations on 
stacking, which will be discussed in the following section. 

   
Figure 3- 9. Stacking in a Ring Architecture 

 

NOTICE: Do not connect the stacked Switch group to the network until all 
Switches have been properly configured for stacking. An improperly 
configured Switch stack can cause a broadcast storm. 
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Stacking Limitations Utilizing a Ring or Star Topology 
The switches listed in the table below can all be stacked, but there is a limitation as to the number of Switches that can be 
included in a given stack. This limitation arises from a concept called a Token Cost. This Token Cost is used for 
communication between switches in a switch stack. Some of the switches have 2 as their token cost, while others are 4, and 
the 10G uplink ports have a Token Cost of 2. The maximum accumulated Token Cost in a given stack must be less than or 
equal to 32.  

There is an additional limitation in that a maximum of 12 Switch boxes can be included in a given switch stack, using a 
ring topology. The DGS-3324SRi cannot be used in a ring topology. For the Star topology, the maximum number of 
switches in the stack is seven {6 slaves  + 1 master (DGS-3324SRi)} 

In order to make the task of determining if a given set of Switches (from the table below) can be successfully stacked, use 
the following formula: 

Token Cost * Number of Switches ≤ 32 

Model Name Token Cost 

DGS-3324SRi 2 

DGS-3324SR 2 

4  DXS-3350SR 

6 (with 10G uplink) 

2  DXS-3326GSR 

4 (with 10G uplink) 

Table 3- 1. Switches and their corresponding token cost 

Stacking In a Ring Topology 
For example: 

All of the stacked switches are identical. 

To stack as many DGS-3324SR switches as possible.  

To calculate the maximum number of DGS-3324SR switches in the ring stack, use the following formula: 

 

Token Cost * Number of Switches ≤ 32 

 

2 * Number of Switches ≤ 32 

 

Number of Switches ≤ 32/2 

 

Number of Switches ≤ 16 

 

For this example, a maximum of sixteen DGS-3324SR switches can be ring stacked according to the previous calculations, 
but we must remember that there is a maximum limitation of twelve switches, so the actual maximum number of DGS-
3324SR switches that can be stacked together in the ring topology is twelve. 
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Adding a different switch type to an existing stack 

In this example, there are three different switch types, each with different token costs. There is one DGS-3324SR (Token 
Cost = 2), two DXS-3350SR (Token Cost = 4), and three DXS-3326GSR (Token Cost = 2). In this case the total Token 
Cost would be: 

(1 * 2) + (2 * 4) + (3 * 2) = 16 
 

If the user then wanted to add the maximum number of DGS-3324SR Switches  (Token Cost = 2) to this stack: 

 

(2 + 2 * 4 + 3 * 2) + Number of Switches * 2 ≤ 32 

 

16 + Number of Switches * 2 ≤ 32 
 

Number of Switches * 2 ≤ 32 – 16 = 16 

 

Number of Switches ≤ 16/2 = 8 

 

Therefore, in this case the user could add extra eight DGS-3324SR switches to this ring stack. The entire stack would then 
consist of nine DGS-3324SRs (Token Cost = 2), two DXS-3350SRs (Token Cost = 4) and three DXS-3326GSRs (Token 
Cost = 2). This gives a total Token Cost for the stack of: 

 

9 * 2 + 2 * 4 + 3 * 2 ≤ 32 
 

Although the Token Cost is less than 32, the number of switch boxes is 14, which exceeds the maximum number of 12. 
Thus, only extra six DGS-3324SRs can be added to the ring stack. 

For further examples, we can: 

• Make a ring stack consisting of four DXS-3350SRs (one with module), three DGS-3324SRs and three DXS-
3326GSRs (no modules). Our switch count would equal ten and our token cost would equal thirty (18 + 6 + 6 = 
30 ≤ 32). Success! 

 

• Make a ring stack consisting of four DGS-3324SRs, five DXS-3326GSRs (no modules), three DXS-3350SRs 
(no modules). Our switch count would equal twelve and our token cost would equal thirty (8 + 10 + 12 = 30 ≤ 
32). Success! 

 

• Add four 10G modules to an existing ring stack (2 + 2 + 2 + 2 = 8), using a stack consisting of six DGS-
3324SRs and six DXS-3326GSRs (12 + 20 = 32). This is the maximum number of switch boxes allowed in a 
ring stack. Our switch count stays at twelve and our token cost becomes thirty-two (2 + 2 + 2 + 2 + 24 = 32 ≤ 
32). Success! 
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Stacking In a Star Topology 

In this case, the DGS-3324SRi is the Master Switch in a star topology and up to six slave switches can be stacked with 
Master Stackable Switch. Check the following examples as a reference guide. 

For examples, we can: 

• Make a star stack consisting of one DGS-3324SRi (Master), six DXS-3350SRs (no modules). Our switch count 
would equal 6 + 1 and our token cost would equal twenty-six (2 + 24 = 26 ≤ 32). Success! 

• Make a star stack consisting of one DGS-3324SRi (Master), one DGS-3324SR, two DXS-3326GSRs (no 
modules), three DXS-3350SRs (one with module).  Our switch count would equal 6 + 1 and our token cost 
would equal twenty-two (2 + 2 + 4 + 14 = 22 ≤ 32). Success! 

 

From these examples, we can see that there is a myriad of combinations possible for adding switches and modules to a 
given stack. Yet, keep in mind three very important points in configuring the stack: 

1. The total Token Cost of switches stacked must not exceed 32. 

2. The total switch count of switches stacked in a ring topology cannot exceed 12. 

3. The total switch count of switches stacked in a star topology cannot exceed 6 + 1. 

 

 

NOTE: The total token cost of switches in a switch stack cannot exceed 
32. Surpassing this token cost limitation will result in failure of the Switch 
stack and render the switches in it inoperable. 
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    Section 4 
Introduction to Switch Management 

Management Options 

Web-based Management Interface 

SNMP-Based Management 

Managing User Accounts 

Command Line Console Interface through the Serial Port 

Connecting the Console Port (RS-232 DCE) 

First Time Connecting to the Switch 

Password Protection 

SNMP Settings 

IP Address Assignment 

Connecting Devices to the Switch 

Management Options 
This system may be managed out-of-band through the console port on the front panel or in-band using Telnet. The user 
may also choose the web-based management, accessible through a web browser. 

Web-based Management Interface 
After successfully installing the Switch, the user can configure the Switch, monitor the LED panel, and display statistics 
graphically using a web browser, such as Netscape Navigator (version 6.2 and higher) or Microsoft® Internet Explorer 
(version 5.0). 

SNMP-Based Management 
The Switch can be managed with an SNMP-compatible console program. The Switch supports SNMP version 1.0, version 
2.0 and version 3.0. The SNMP agent decodes the incoming SNMP messages and responds to requests with MIB objects 
stored in the database. The SNMP agent updates the MIB objects to generate statistics and counters. 

Command Line Console Interface through the Serial Port 
The user can also connect a computer or terminal to the serial console port to access the Switch. The command-line-driven 
interface provides complete access to all Switch management features.  

Connecting the Console Port (RS-232 DCE) 
The Switch provides an RS-232 serial port that enables a connection to a computer or terminal for monitoring and 
configuring the Switch. This port is a female DB-9 connector, implemented as a data terminal equipment (DTE) 
connection. 

To use the console port, the following equipment is needed: 

• A terminal or a computer with both a serial port and the ability to emulate a terminal. 
• A null modem or crossover RS-232 cable with a female DB-9 connector for the console port on the Switch. 

To connect a terminal to the console port: 

1. Connect the female connector of the RS-232 cable directly to the console port on the Switch, and tighten the 
captive retaining screws. 
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2. Connect the other end of the cable to a terminal or to the serial connector of a computer running terminal 
emulation software. Set the terminal emulation software as follows: 

3. Select the appropriate serial port (COM port 1 or COM port 2). 
4. Set the data rate to 115200 baud. 
5. Set the data format to 8 data bits, 1 stop bit, and no parity. 
6. Set flow control to none. 
7. Under Properties, select VT100 for Emulation mode. 
8. Select Terminal keys for Function, Arrow, and Ctrl keys. Ensure that the Terminal keys are selected (not 

Windows keys). 

9. After you have correctly set up the terminal, plug the power cable into the power receptacle on the back of the 
Switch. The boot sequence appears in the terminal. 

10. After the boot sequence completes, the console login screen displays. 
11. If the user has not logged into the command line interface (CLI) program, press the Enter key at the User name 

and password prompts. There is no default user name and password for the Switch. The administrator must first 
create user names and passwords. If user accounts have been previously set up, log in and continue to configure 
the Switch. 

12. Enter the commands to complete desired tasks. Many commands require administrator-level access privileges. 
Read the next section for more information on setting up user accounts. See the xStack DGS/DXS-3300 Series 
CLI Manual on the documentation CD for a list of all commands and additional information on using the CLI. 

13. When the commands have been completed, exit the session with the logout command or close the emulator 
program. 

Make sure the terminal or PC used to make this connection is configured to match these settings. 

If problems occur in making this connection on a PC, make sure the emulation is set to VT-100. The emulation settings can 
be configured by clicking on the File menu in the HyperTerminal window by clicking on Properties in the drop-down 
menu, and then clicking the Settings tab. This is where you will find the Emulation options. If you still do not see 
anything, try rebooting the Switch by disconnecting its power supply. 

Once connected to the console, the screen below will appear on the console screen. This is where the user will enter 
commands to perform all the available management functions. The Switch will prompt the user to enter a user name and a 
password. Upon the initial connection, there is no user name or password and therefore just press enter twice to access the 
command line interface.  

 
Figure 4- 1. Initial screen after first connection. 

 

NOTE: When using HyperTerminal with the Microsoft® Windows® 2000 operating system, 
ensure that Windows 2000 Service Pack 2 or later is installed. Windows 2000 Service Pack 2 
allows arrow keys to be used in HyperTerminal's VT100 emulation. See www.microsoft.com 
for information on Windows 2000 service packs. 
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First Time Connecting to the Switch  
The Switch supports user-based security that can allow prevention of unauthorized users from accessing the Switch or 
changing its settings. This section tells how to log onto the Switch. 

 

NOTE: The passwords used to access the Switch are case-sensitive; 
therefore, "S" is not the same as "s." 

Upon initial connection to the Switch, the login screen will be presented, as shown below.  

 

NOTE: Press Ctrl+R to refresh the screen. This command can be used at 
any time to force the console program in the Switch to refresh the console 
screen. 

 

 
Figure 4- 2. Initial screen, first time connecting to the Switch 

Press Enter in both the Username and Password fields. Then access will be given to enter commands after the command 
prompt DGS-3324SRi:4#, DGS-3324SR:4#, DXS-3326GSR:4# or DXS-3350SR:4# as shown below: 

There is no initial username or password. Leave the Username and Password fields blank. 
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Figure 4- 3. Command Prompt 

  

NOTE: The first user automatically gets Administrator level privileges. It is 
recommended to create at least one Admin-level user account for the 
Switch. 
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Password Protection 
The xStack DGS/DXS-3300 Series switches do not have a default user name and password. One of the first tasks when set-
tings up the Switch is to create user accounts. Logging in using a predefined administrator-level user name will give the 
user privileged access to the Switch's management software. 

After the initial login, define new passwords for both default user names to prevent unauthorized access to the Switch, and 
record the passwords for future reference. 

To create an administrator-level account for the Switch, do the following: 

• At the CLI login prompt, enter create account admin followed by the <user name> and press the Enter key. 

• The Switch will then prompt the user to provide a password. Type the <password> used for the administrator 
account being created and press the Enter key.  

• Once entered, the Switch will again ask the user to enter the same password again to verify it. Type the same 
password and press the Enter key.   

• A “Success” response by the Switch will verify the creation of the new administrator. 

 

NOTE: Passwords are case sensitive. User names and passwords can be 
up to 15 characters in length. 

The sample below illustrates a successful creation of a new administrator-level account with the user name "newmanager".  

DGS-3324SRi:4#create account admin newmanager 

Command: create account admin newmanager 

 

Enter a case-sensitive new password:******** 

Enter the new password again for confirmation:********  

 

Success. 

 

DGS-3324SRi:4# 

 

   

NOTICE: CLI configuration commands only modify the running 
configuration file and are not saved when the Switch is rebooted. To save 
all configuration changes in nonvolatile storage, it is necessary use the 
save command to copy the running configuration file to the startup 
configuration. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

28 

     

SNMP Settings 
Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed specifically for managing 
and monitoring network devices. SNMP enables network management stations to read and modify the settings of gateways, 
routers, switches, and other network devices. Use SNMP to configure system features for proper operation, monitor 
performance and detect potential problems in the Switch, switch group or network. 

Managed devices that support SNMP include software (referred to as an agent), which runs locally on the device. A 
defined set of variables (managed objects) is maintained by the SNMP agent and used to manage the device. These objects 
are defined in a Management Information Base (MIB), which provides a standard presentation of the information 
controlled by the on-board SNMP agent. SNMP defines both the format of the MIB specifications and the protocol used to 
access this information over the network. 

The xStack DGS/DXS-3300 Series switches support SNMP versions 1, 2c, and 3. The administrator may specify which 
version of SNMP to use to monitor and control the Switch. The three versions of SNMP vary in the level of security 
provided between the management station and the network device.   

In SNMP v.1 and v.2, user authentication is accomplished using 'community strings', which function like passwords.  The 
remote user SNMP application and the Switch SNMP must use the same community string. SNMP packets from any 
station that has not been authenticated are ignored (dropped). 

The default community strings for the Switch used for SNMP v.1 and v.2 management access are: 

• public - Allows authorized management stations to retrieve MIB objects. 

• private - Allows authorized management stations to retrieve and modify MIB objects. 

SNMP v.3 uses a more sophisticated authentication process that is separated into two parts. The first part is to maintain a 
list of users and their attributes that are allowed to act as SNMP managers. The second part describes what each user on 
that list can do as an SNMP manager.  

The Switch allows groups of users to be listed and configured with a shared set of privileges. The SNMP version may also 
be set for a listed group of SNMP managers. Thus, a group of SNMP managers can be created to view read-only 
information or receive traps using SNMP v.1 while assigning a higher level of security to another group, granting 
read/write privileges using SNMP v.3. 

Using SNMP v.3 individual users or groups of SNMP managers can be allowed to perform or be restricted from 
performing specific SNMP management functions. The functions allowed or restricted are defined using the Object 
Identifier (OID) associated with a specific MIB. An additional layer of security is available for SNMP v.3 in that SNMP 
messages may be encrypted. To read more about how to configure SNMP v.3 settings for the Switch read the section 
entitled Management. 

Traps 
Traps are messages that alert network personnel of events that occur on the Switch. The events can be as serious as a 
reboot (someone accidentally turned OFF the Switch), or less serious like a port status change. The Switch generates traps 
and sends them to the trap recipient (or network manager). Typical traps include trap messages for Authentication Failure, 
Topology Change and Broadcast\Multicast Storm. 

MIBs 
The Switch in the Management Information Base (MIB) stores management and counter information. The Switch uses the 
standard MIB-II Management Information Base module. Consequently, values for MIB objects can be retrieved from any 
SNMP-based network management software. In addition to the standard MIB-II, the Switch also supports its own 
proprietary enterprise MIB as an extended Management Information Base. The proprietary MIB may also be retrieved by 
specifying the MIB Object Identifier. MIB values can be either read-only or read-write. 
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IP Address Assignment 
An IP Address must be assigned to each switch, which is used for communication with an SNMP network manager or 
other TCP/IP application (for example BOOTP, TFTP). The Switch's default IP address is 10.90.90.90. The user may 
change the default Switch IP address to meet the specification of your networking address scheme. 

The Switch is also assigned a unique MAC address by the factory. This MAC address cannot be changed, and can be found 
by entering the command "show switch" into the command line interface, as shown below.  

 
Figure 4- 4.  “show switch” command 

The Switch's MAC address can also be found from the Web management program on the Switch Information (Basic 
Settings) window on the Configuration menu. 

The IP address for the Switch must be set before it can be managed with the Web-based manager. The Switch IP address 
can be automatically set using BOOTP or DHCP protocols, in which case the actual address assigned to the Switch must be 
known. 

The IP address may be set using the Command Line Interface (CLI) over the console serial port as follows: 

Starting at the command line prompt, enter the commands config ipif System ipaddress 
xxx.xxx.xxx.xxx/yyy.yyy.yyy.yyy. Where the x's represent the IP address to be assigned to the IP interface named System 
and the y's represent the corresponding subnet mask. 

Alternatively, the user can enter config ipif System ipaddress xxx.xxx.xxx.xxx/z. Where the x's represent the IP address 
to be assigned to the IP interface named System and the z represents the corresponding number of subnets in CIDR 
notation. 

The IP interface named System on the Switch can be assigned an IP address and subnet mask, which can then be used to 
connect a management station to the Switch's Telnet or Web-based management agent. 
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Figure 4- 5.  Assigning the Switch an IP Address 

In the above example, the Switch was assigned an IP address of 10.53.13.144 with a subnet mask of 255.0.0.0. The system 
message Success indicates that the command was executed successfully. The Switch can now be configured and managed 
via Telnet and the CLI or via the Web-based management. 

Connecting Devices to the Switch 
After assigning an IP addresses to the Switch, devices can be connected to the Switch. 

To connect a device to an SFP transceiver port: 

• Use the cabling requirements to select an appropriate SFP transceiver type. 

• Insert the SFP transceiver (sold separately) into the SFP transceiver slot. 

• Use the appropriate network cabling to connect a device to the connectors on the SFP transceiver. 

 

   

NOTICE: When the SFP transceiver acquires a link, the associated 
integrated 10/100/1000BASE-T port is disabled. 
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Section 5                       

Introduction to Web-based Switch 
Configuration 

Introduction 

Logging on to the Web Manager 

Web-Based User Interface 

Basic Setup 

Reboot 

Basic Switch Setup 

Network Management 

Switch Utilities 

Network Monitoring 

IGMP Snooping Status 

Introduction 
All software functions of the xStack DGS/DXS-3300 Switch Series can be managed, configured and monitored via the 
embedded web-based (HTML) interface. The Switch can be managed from remote stations anywhere on the network 
through a standard browser such as Netscape Navigator/Communicator, Mozilla or Microsoft Internet Explorer. The 
browser acts as a universal access tool and can communicate directly with the Switch using the HTTP protocol. 

The Web-based management module and the Console program (and Telnet) are different ways to access the same internal 
switching software and configure it. Thus, all settings encountered in web-based management are the same as those found 
in the console program. 

Logging on to the Web Manager 
To begin managing the Switch, simply run the browser installed on your computer and point it to the IP address you have 
defined for the device. The URL in the address bar should read something like: http://123.123.123.123, where the numbers 
123 represent the IP address of the Switch. 

 

NOTE: The Factory default IP address for the Switch is 10.90.90.90.  

 In the page that opens, click on the Login button: 

 
Figure 5- 1. Login Button 

This opens the management module's user authentication window, as seen below. 
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Figure 5- 2. Enter Network Password window 

Leave both the User Name field and the Password field blank and click OK. This will open the Web-based user interface. 
The Switch management features available in the web-based manager are explained below. 
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Web-based User Interface 
The user interface provides access to various Switch configuration and management screens, allows the user to view 
performance statistics, and permits graphical monitoring of the system status. 

Areas of the User Interface 
The figure below shows the user interface. Three distinct areas divide the user interface, as described in the table. 

 
Figure 5- 3. Main Web-Manager Screen 

Area 1 

Area 2

Area 3 
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  Area                               Function 

Area 1 Select the menu or window to be displayed. The folder icons can be opened to 
display the hyperlinked menu buttons and subfolders contained within them. Click 
the D-Link logo to go to the D-Link website. 

Area 2 Presents a graphical near real-time image of the front panel of the Switch. This area 
displays the Switch's ports and expansion modules, showing port activity, duplex 
mode, or flow control, depending on the specified mode. 

Various areas of the graphic can be selected for performing management functions, 
including port configuration. 

Area 3 Presents switch information based on user selection and the entry of configuration 
data. 

 

  

 

NOTICE: Any changes made to the Switch configuration during the current 
session must be saved in the Save Changes web menu (explained below) 
or by using the command line interface (CLI) command save. 

Web Pages 
When connecting to the management mode of the Switch with a web browser, a login screen is displayed. Enter a user 
name and password to access the Switch's management mode. 

Below is a list and description of the main folders available in the web interface: 

Configuration – Contains screens concerning configurations for IP Address, Switch Information, Box Information, 
Advanced Settings, Port Configuration, Port Description, Port Mirroring, Link Aggregation, LACP Port Settings, MAC 
Notification, IGMP Snooping, Spanning Tree, Forwarding Filtering, VLANs, Traffic Control, Port Security, Port Lock 
Entries, QoS, System Log Host, SNTP Settings, Access Profile Table, CPU Access Profile Table, System Severity Settings, 
Port Access Entity, and Layer 3 IP Networking. 

Security Management – Contains screens concerning configurations for Security IP, User Accounts, Access 
Authentication Control (TACACS), Secure Sockets Layer (SSL), and Secure Shell (SSH).  

SNMP Manager – Contains screens and windows concerning the implementation and upkeep of the SNMP Manager of 
the Switch. 

Monitoring – Contains screens concerning monitoring the Switch, pertaining to Port Utilization, CPU Utilization, Packets, 
Errors, Size, Stacking Information, Module Information, Device Status, MAC Address, Switch History Log, IGMP 
Snooping Group, IGMP Snooping Forwarding, Browse Router Port, Port Access Control and Layer 3 Feature. 

Maintenance – Contains screens concerning configurations and information about Switch maintenance, including TFTP 
Services, Multiple Image Services, CF Services, Ping Test, Save Changes, Reset, Reboot System and Logout. 

Single IP Management – Contains screens concerning information on Single IP Management, including SIM Settings, 
Topology and Firmware Upgrade, Configuration Backup/Restore and Upload Log File. 

 

 

NOTE: Be sure to configure the user name and password in the User 
Accounts menu before connecting the Switch to the greater network. 
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Section 6 
Configuring the Switch 

Switch Information 
IP Address 
Box Information 
Advanced Settings 
Port Configuration 
Port Description 
Port Mirroring  
Link Aggregation  
LACP Port Settings 
MAC Notification 
IGMP Snooping 
Spanning Tree 
Forwarding & Filtering 
VLANs  
Traffic Control 
Port Security 
Port Lock Entries 
QoS 
System Log Host 
SNTP Settings 
Access Profile Table 
CPU Access Profile Table 
System Severity Settings 
Port Access Entity 
Layer 3 IP Networking 
 L3 Global Advanced Settings 
 IP Interface Table 
 MD5 Key Settings 
 Route Redistribution Settings 
 Static Default Route Settings 
 Route Preference Settings  
 Static ARP Settings 
 RIP 
 OSPF 
 DHCP/BOOTP Relay 
 DNS Relay 
 VRRP 
 IP Multicast Routing Protocol 
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Switch Information 

 
                                                                           Figure 6- 1. Switch Information - Basic Settings 

The subsections below describe how to
change some of the basic settings for the
Switch such as changing IP settings and
assigning user names and passwords for
management access privileges, as well as
how to save the changes and restart the
Switch. 

Click the Switch Information link in the
Configuration menu. 

The Switch Information window shows
the Switch's MAC Address (assigned by
the factory and unchangeable), the Boot
PROM, Firmware Version, and
Hardware Version. This information is
helpful to keep track of PROM and
firmware updates and to obtain the
Switch's MAC address for entry into
another network device's address table, if
necessary. The user may also enter a
System Name, System Location and
System Contact to aid in defining the
Switch, to the user's preference. In
addition, this screen displays the status of
functions on the Switch to quickly assess
their current global status. This serves as a
great quick reference for network
administrators to promptly assess problems
concerning Switch functions. 
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IP Address 
The IP Address may initially be set using the console interface prior to connecting to it through the Ethernet. If the Switch 
IP address has not yet been changed, read the introduction of the xStack DGS/DXS-3300 Series CLI Manual or return to 
Section 4 of this manual for more information. 

To change IP settings using the web manager, the user must access the IP Address menu located in the Configuration 
folder. 

To configure the Switch's IP address: 

Open the Configuration folder and click the IP Address menu link. The web manager will display the Switch's current IP 
settings in the IP configuration menu, as seen below. 

 
Figure 6- 2. IP Address Settings window 

To manually assign the Switch's IP address, subnet mask, and default gateway address: 

1. Select Manual from the Get IP From drop-down menu. 
2. Enter the appropriate IP Address and Subnet Mask. 
3. If accessing the Switch from a different subnet from the one it is installed on, enter the IP address of the Default 

Gateway. If managing the Switch from the subnet on which it is installed, the user may leave the default address 
(0.0.0.0) in this field. 

4. If the Switch has no previously configured VLANs, the user can use the default VLAN Name. The default VLAN 
contains all of the Switch ports as members. If the Switch has previously configured VLANs, the user will need to 
enter the VLAN ID of the VLAN that contains the port connected to the management station that will access the 
Switch. The Switch will allow management access from stations with the same VID listed here. 

 

NOTE: The Switch's factory default IP address is 10.90.90.90 with a 
subnet mask of 255.0.0.0 and a default gateway of 0.0.0.0. 

To use the BOOTP or DHCP protocols to assign the Switch an IP address, subnet mask, and default gateway address: 

Use the Get IP From: <Manual> pull-down menu to choose from BOOTP or DHCP. This selects the method the Switch 
assigns an IP address on the next reboot. 

The IP Address Settings options are: 

Parameter             Description 

BOOTP The Switch will send out a BOOTP broadcast request when powered on. The BOOTP 
protocol allows IP addresses, network masks, and default gateways to be assigned by a 
central BOOTP server. If this option is set, the Switch will first look for a BOOTP server to 
provide it with this information before using the default or previously entered settings. 

DHCP The Switch will send out a DHCP broadcast request when powered on. The DHCP protocol 
assigns IP addresses, network masks, and default gateways utilizing a DHCP server. If this 
option is set, the Switch will first look for a DHCP server to provide it with this information 
before using the default or previously entered settings. 
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Manual Allows the entry of an IP address, Subnet Mask, and a Default Gateway for the Switch. 
These fields should be of the form xxx.xxx.xxx.xxx, where each xxx is a number 
(represented in decimal form) between 0 and 255. This address should be a unique address 
on the network assigned for use by the network administrator.  

Subnet Mask A Bitmask that determines the extent of the subnet that the Switch is on. This Subnet Mask 
should be of the form xxx.xxx.xxx.xxx, where each xxx is a number (represented in decimal) 
between 0 and 255. The value should be 255.0.0.0 for a Class A network, 255.255.0.0 for a 
Class B network, and 255.255.255.0 for a Class C network, but custom subnet masks are 
allowed. 

Default 
Gateway 

IP address that determines where packets with a destination address outside the current 
subnet should be sent. This is usually the address of a router or a host acting as an IP gate-
way. If your network is not part of an intranet, or you do not want the Switch to be accessible 
outside your local network, leave this field unchanged. 

VLAN Name This allows the entry of a VLAN Name from which a management station will be allowed to 
manage the Switch using TCP/IP (in-band via web manager or Telnet). Management 
stations that are on VLANs other than the one entered here will not be able to manage the 
Switch in-band unless their IP addresses are entered in the Security IP Management menu.  
If VLANs have not yet been configured for the Switch, the default VLAN contains all of the 
Switch's ports. There are no entries in the Security IP Management table, by default, so 
any management station that can connect to the Switch can access the Switch until a 
management VLAN is specified or Management Station IP Addresses are assigned. 

Auto Config 
State 

When enabled, Auto Config instructs the Switch to get a configuration file via TFTP, and it 
becomes a DHCP client automatically. The configuration file will be loaded upon boot up. To 
use Auto Config, the DHCP server must be set up to deliver the TFTP server IP address 
and configuration file name information in the DHCP reply packet. The TFTP server must be 
running and have the requested configuration file stored in its base directory when the 
request is received from the Switch. Consult the DHCP server and/or TFTP server software 
instructions for information on loading a configuration file for use by a client. (Also, see the 
section titled “Maintenance” for instructions on uploading a configuration to a TFTP server.)

If the Switch is unable to complete the auto configuration process, the previously saved 
configuration file present in Switch memory will be loaded. 

Click Apply to implement changes made. 
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Advanced Settings 
The Advanced Settings window contains the main settings for all major functions for the Switch. To view the Advanced 
Settings window, click its link in the Configuration folder. This will enable the following window to be viewed and 
configured. 

 
Figure 6- 3. Switch Information (Advanced Settings) 

Parameter                   Description 

Serial Port Auto 
Logout Time 

Select the logout time used for the console interface. This automatically logs the user 
out after an idle period of time, as defined. Choose from the following options: 2 
Minutes, 5 Minutes, 10 Minutes, 15 Minutes or Never. The default setting is 10 minutes. 

Serial Port Baud 
Rate 

This field specifies the baud rate for the serial port on the Switch. This fields menu is set 
at 115200 and cannot be changed. 

MAC Address 
Aging Time (10-
1000000) 

This field specifies the length of time a learned MAC Address will remain in the 
forwarding table without being accessed (that is, how long a learned MAC Address is 
allowed to remain idle). The default age-out time for the Switch is 300 seconds. To 
change this, type in a different value representing the MAC address age-out time in 
seconds. The MAC Address Aging Time can be set to any value between 10 and 
1,000,000 seconds.  

IGMP Snooping To enable system-wide IGMP Snooping capability select Enabled. IGMP snooping is 
Disabled by default. Enabling IGMP snooping allows the user to specify use of a 
multicast router only (see below). To configure IGMP Snooping for individual VLANs, 
use the IGMP Snooping page under the IGMP folder. 
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Multicast router 
Only 

This field specifies that the Switch should only forward all multicast traffic to a multicast-
enabled router, if enabled. Otherwise, the Switch will forward all multicast traffic to any 
IP router. The default is Disabled. 

GVRP Status Use this pull-down menu to enable or disable GVRP on the Switch. 

Telnet Status Telnet configuration is Enabled by default. If the user does not want to allow 
configuration of the system through Telnet, choose Disabled. 

Telnet TCP Port 
Number (1-65535) 

The TCP port number. TCP ports are numbered between 1 and 65535. The "well-
known" TCP port for the Telnet protocol is 23. 

Web Status Web-based management is Enabled by default. If choosing to disable this function by 
selecting Disabled, the ability to configure the system through the web interface as soon 
as these settings are applied will be lost. 

RMON Status Remote monitoring (RMON) of the Switch is Enabled or Disabled here. 

Link Aggregation 
Algorithm 

The algorithm that the Switch uses to balance the load across the ports that make up 
the port trunk group is defined by this definition. Choose MAC Source, MAC Destination, 
MAC Src & Dest, IP Source, IP Destination or IP Src & Dest (See the Link Aggregation 
section of this manual for more information). 

Switch 802.1x  The Switch’s 802.1x function may be enabled by port or by MAC Address; the default is 
Disabled. This field must be enabled to view and configure certain windows for 802.1x. 
More information regarding 802.1x, its functions and implementation can be found later 
in this section, under the Port Access Entity folder. 

Port-Based 802.1x specifies that ports configured for 802.1x are initialized based on the 
port number only and are subject to any authorization parameters configured. 

MAC-based Authorization specifies that ports configured for 802.1x are initialized based 
on the port number and the MAC address of the computer being authorized and are 
then subject to any authorization parameters configured. 

Auth Protocol The user may use the pull-down menu to choose between radius eap and radius pap for 
the 802.1x authentication protocol on the Switch. The default setting is radius eap. 

HOL Prevention This field will enable or disable Head of Line Prevention on the Switch. The default is 
Enabled.  

Jumbo Frame This field will enable or disable the Jumbo Frame function on the Switch. The default is 
Disabled. 

Syslog State Enables or disables the Syslog State. The default setting is Disabled. 

CPU Interface 
Filtering State 

The user may globally enable or disable the CPU Interface Filtering mechanism by 
using the pull-down menu to change the running state. For more information on CPU 
filtering, see the “CPU Access Profile Table” entry later in this section. 

Click Apply to implement changes made.  
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Box Information 
The Box Information Configuration screen is found in the Configuration folder under the heading Box Information. 
This window is used to configure stacking parameters associated with all switches in the xStack Series. The user may 
configure parameters such as box ID, box priority and pre-assigning model names to switches to be entered into the switch 
stack. 

 
Figure 6- 4. Box Information Configuration window 

Parameter      Description 

Current Box ID The Box ID of the switch in the stack to be configured.   

New Box ID The new box ID of the selected switch in the stack that was selected in the Current 
Box ID field. The user may choose any number between 1 and 12 to identify the 
switch in the switch stack. Auto will automatically assign a box number to the switch 
in the switch stack.  

Box Type The user may pre-assign the model name of the switch in a stack by using the pull-
down menu. The choices are DGS-3324SR, DXS-3350SR, DXS-3326GSR and 
BOX_NOTEXIST for the DGS-3324SRi master switch. This menu may very between 
switches. 

Priority Displays the priority ID of the Switch. The lower the number, the higher the priority. 
The box (switch) with the lowest priority number in the stack is the Master switch. The 
Master switch will be used to configure applications of the switch stack. 

Information configured in this screen is found in the Monitoring folder under Stack Information. 

 

 

NOTE: Configured box priority settings will not be implemented until the 
next power cycle of the stack. 

 

 

NOTE: In a star topology, the DGS-3324SRi will be the master switch of 
the stack, regardless of priority settings implemented. 
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Port Configuration 
This section contains information for configuring various attributes and properties for individual physical ports, including 
port speed and address learning. Clicking on Port Configuration in the Configuration menu will display the following 
window for the user: 

 
Figure 6- 5. Port Configuration and The Port Information Table window 

To configure switch ports: 

1. Choose the port or sequential range of ports using the From…To… port pull-down menus, and the Unit ID of the 
Switch to be configured. 

2. Use the remaining pull-down menus to configure the parameters described below: 

Parameter                             Description 

State <Enabled> Toggle the State <Enabled> field to either enable or disable a given port or group 
of ports. 
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Speed/Duplex <Auto> Toggle the Speed/Duplex field to either select the speed and duplex/half-duplex 
state of the port. Auto denotes auto-negotiation between 10 and 100 Mbps 
devices, in full- or half-duplex. The Auto setting allows the port to automatically 
determine the fastest settings the device the port is connected to can handle, and 
then to use those settings. The other options are Auto, 10M/Half, 10M/Full, 
100M/Half and 100M/Full, 1000M/Full_M and 1000M/Full_S. There is no 
automatic adjustment of port settings with any option other than Auto. 

The Switch allows the user to configure two types of gigabit connections; 
1000M/Full_M and 1000M/Full_S. Gigabit connections only support full duplex 
connections and take on certain characteristics that are different from the other 
choices listed.  

The 1000M/Full_M (master) and 1000M/Full_S (slave) parameters refer to 
connections running a 1000BASE-T cable for connection between the Switch port 
and other device capable of a gigabit connection. The master setting 
(1000M/Full_M) will allow the port to advertise capabilities related to duplex, 
speed and physical layer type. The master setting will also determine the master 
and slave relationship between the two connected physical layers. This 
relationship is necessary for establishing the timing control between the two 
physical layers. The timing control is set on a master physical layer by a local 
source. The slave setting (1000M/Full_S) uses loop timing, where the timing 
comes form a data stream received from the master. If one connection is set for 
1000M/Full_M, the other side of the connection must be set for 1000M/Full_S. 
Any other configuration will result in a link down status for both ports. 

Flow Control Displays the flow control scheme used for the various port configurations. Ports 
configured for full-duplex use 802.3x flow control, half-duplex ports use 
backpressure flow control, and Auto ports use an automatic selection of the two.  
The default is Disabled. 

Learning Enable or disable MAC address learning for the selected ports. When Enabled, 
destination and source MAC addresses are automatically listed in the forwarding 
table. When learning is Disabled, MAC addresses must be manually entered into 
the forwarding table, if to enhance security or efficiency. See the section on 
Forwarding/Filtering for information on entering MAC addresses into the 
forwarding table. The default setting is Disabled. 

Click Apply to implement the new settings on the Switch. 
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Port Description 
The xStack DGS/DXS-3300 Series switches support a port description feature where the user may name various ports on 
the Switch. To assign names to various ports, click the Port Description on the Configuration menu: 

 
Figure 6- 6. Port Description Setting and Port Description Table 

Use the From and To pull-down menu to choose a port or range of ports to describe and Unit to choose the Switch in the 
switch stack, and then enter a description of the port(s). Click Apply to set the descriptions in the Port Description Table. 
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Port Mirroring 
The Switch allows frames to be copied transmitted and received on a port and redirect the copies to another port. A 
monitoring device may be attached to the mirrored port, such as a sniffer or an RMON probe, to view details about the 
packets passing through the first port. This is useful for network monitoring and troubleshooting purposes. To view the 
Port Mirroring window, click Port Mirroring in the Configuration folder. 

 
Figure 6- 7. Port Mirroring window 

To configure a mirror port: 

• Select the Source Port from where to copy frames and the Target Port, which receives the copies from the 
source port. 

• Select the Source Direction, Ingress, Egress, or Both and change the Status drop-down menu to Enabled. 

• Click Apply to let the changes take effect. 

 

 

NOTE: A fast port cannot be mirrored onto a slower port. For example, if 
the user tries to mirror the traffic from a 100 Mbps port onto a 10 Mbps 
port, this can cause throughput problems. The port copying frames should 
always support an equal or lower speed than the port to which the copies 
are being sent. In addition, the target port for the mirroring cannot be a 
member of a trunk group. Please note a target port and a source port 
cannot be the same port. 
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Link Aggregation 
Understanding Port Trunk Groups 
Port trunk groups are used to combine a number of ports together to make a single high-bandwidth data pipeline. 

The xStack DGS/DXS-3300 Series switches support up to 32 port trunk groups with 2 to 8 ports in each group. A potential 
bit rate of 8000 Mbps can be achieved. 

 
Figure 6- 8. Example of Port Trunk Group 
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The Switch treats all ports in a trunk group as a single port. Data transmitted to a specific host (destination address) will 
always be transmitted over the same port in a trunk group. This allows packets in a data stream to arrive in the same order 
they were sent.  

 

NOTE: If any ports within the trunk group become disconnected, packets 
intended for the disconnected port will be load shared among the other 
uplinked ports of the link aggregation group. 

Link aggregation allows several ports to be grouped together and to act as a single link. This gives a bandwidth that is a 
multiple of a single link's bandwidth. 

Link aggregation is most commonly used to link a bandwidth intensive network device or devices, such as a server, to the 
backbone of a network. 

The Switch allows the creation of up to 32 link aggregation groups, each group consisting of 2 to 8 links (ports). All of the 
ports in the group must be members of the same VLAN, and their STP status, static multicast, traffic control, traffic 
segmentation and 802.1p default priority configurations must be identical. Port locking, port mirroring and 802.1X must 
not be enabled on the trunk group. Further, the aggregated links must all be of the same speed and should be configured as 
full-duplex. 

The Master Port of the group is to be configured by the user, and all configuration options, including the VLAN 
configuration that can be applied to the Master Port, are applied to the entire link aggregation group. 

Load balancing is automatically applied to the ports in the aggregated group, and a link failure within the group causes the 
network traffic to be directed to the remaining links in the group. 

The Spanning Tree Protocol will treat a link aggregation group as a single link, on the switch level. On the port level, the 
STP will use the port parameters of the Master Port in the calculation of port cost and in determining the state of the link 
aggregation group. If two redundant link aggregation groups are configured on the Switch, STP will block one entire group, 
in the same way STP will block a single port that has a redundant link. 

To configure port trunking, click on the Link Aggregation hyperlink in the Configuration folder to bring up the Link 
Aggregation Group Entries table: 

 
Figure 6- 9. Port Link Aggregation Group Entries window 

To configure port trunk groups, click the Add button to add a new trunk group and use the Link Aggregation Settings 
menu (see example below) to set up trunk groups. To modify a port trunk group, click the hyperlinked group number 

corresponding to the entry to alter. To delete a port trunk group, click the corresponding  under the Delete heading in 
the Current Link Aggregation Group Entries table. 
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Figure 6- 10. Link Aggregation Group Configuration window – Add 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

50 

     

 
Figure 6- 11. Link Aggregation Group Configuration window - Modify 

The user-changeable parameters are as follows: 

Parameter                         Description 

Group ID Select an ID number for the group, between 1 and 32. 

Type This pull-down menu allows the selection of Static and LACP (Link Aggregation 
Control Protocol). LACP allows for the automatic detection of links in a Port 
Trunking Group. 

State Trunk groups can be toggled between Enabled and Disabled. This is used to turn a 
port trunking group on or off. This is useful for diagnostics, to quickly isolate a 
bandwidth intensive network device or to have an absolute backup aggregation 
group that is not under automatic control. 

Master Port Choose the Master Port for the trunk group using the pull-down menu. 

Unit Choose the unit of the switch in the stack to be configured. 

Member Ports Choose the members of a trunked group. 2 to 8 ports can be assigned to an 
individual group. 

Active Port Shows the port that is currently forwarding packets. 

Flooding Port A trunking group must designate one port to allow transmission of broadcasts and 
unknown unicasts.  

After setting the previous parameters, click Apply to allow implementation of changes made. Successfully created trunk 
groups will be show in the Current Link Aggregation Group Entries. 
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LACP Port Setting 

 
Figure 6- 12. LACP Port Setting and LACP Port Information window 

The user may set the following parameters: 

Parameter                          Description 

Unit  Choose the switch in the switch stack to be configured by using the pull-down 
menu. 

From/To A consecutive group of ports may be configured starting with the selected port. 

Mode Active - Active LACP ports are capable of processing and sending LACP control 
frames. This allows LACP compliant devices to negotiate the aggregated link so the 
group may be changed dynamically as needs require. In order to utilize the ability to 
change an aggregated port group, that is, to add or subtract ports from the group, at 
least one of the participating devices must designate LACP ports as active. Both 
devices must support LACP. 

Passive - LACP ports that are designated as passive cannot initially send LACP 
control frames. In order to allow the linked port group to negotiate adjustments and 
make changes dynamically, one end of the connection must have "active" LACP 
ports (see above). 

After setting the previous parameters, click Apply to allow changes to be implemented. The LACP Port Table shows 
which ports are active and/or passive. 

The LACP Port Settings window is used in conjunction
with the Link Aggregation window to create port
trunking groups on the Switch. Using the following
window, the user may set which ports will be active and
passive in processing and sending LACP control frames.
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MAC Notification 
MAC Notification is used to monitor MAC addresses learned and entered into the forwarding database. 

MAC Notification Global Settings 
To globally set MAC notification on the Switch, open the following screen by opening the MAC Notification folder and 
clicking the MAC Notification Global Settings link: 

 
Figure 6- 13. Current and New MAC Notification Global Settings window. 

The following parameters may be modified: 

Parameter                      Description  

State Enable or disable MAC notification globally on the Switch. The default setting is 
Disabled. 

Interval (sec) The user may set the time, between 1 and 2,147,483,647 seconds, between MAC 
notifications. The default setting is 1 second. 

History size The maximum number of entries listed in the history log used for notification. Up to 
500 entries can be specified. The default setting is 1. 

Current MAC notification configurations can be viewed in the Current MAC Notification Global Settings window, as 
seen above. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

53 

     

MAC Notification Port Settings 
To change MAC notification settings for a port or group of ports on the Switch, click Port Settings in the MAC 
Notification folder, which will display the following screen: 

 
Figure 6- 14. MAC Notification Port Settings and Port State Table 

The following parameters may be set: 

Parameter                    Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From…To Select a port or group of ports to enable for MAC notification using the pull-down 
menus. 

State Enable MAC Notification for the ports selected using the pull-down menu. 

Click Apply to implement changes made. 
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IGMP Snooping 
Internet Group Management Protocol (IGMP) snooping allows the Switch to recognize IGMP queries and reports sent 
between network stations or devices and an IGMP host. When enabled for IGMP snooping, the Switch can open or close a 
port to a specific device based on IGMP messages passing through the Switch. 

In order to use IGMP Snooping, it must first be enabled for the entire Switch (see Advanced Settings). Settings may then 
be fine-tuned for each VLAN using the IGMP Snooping link in the Configuration folder. When enabled for IGMP 
snooping, the Switch can open or close a port to a specific Multicast group member based on IGMP messages sent from 
the device to the IGMP host or vice versa. The Switch monitors IGMP messages and discontinues forwarding multicast 
packets when there are no longer hosts requesting that they continue. Use the IGMP Snooping Group Entry Table to 
view IGMP Snooping status. To modify settings, click the Modify button for the VLAN Name entry to change. 

Use the IGMP Snooping Settings window to view IGMP Snooping settings. To modify the settings, click the Modify 
button of the VLAN ID to change. 

 
Figure 6- 15. Current IGMP Snooping Group Entries 

Clicking the Modify button will open the IGMP Snooping Settings menu, shown below: 

 
Figure 6- 16. IGMP Snooping Settings-Edit window 

The following parameters may be viewed or modified: 
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Parameter                       Description 

VLAN ID This is the VLAN ID that, along with the VLAN Name, identifies the VLAN for which to 
modify the IGMP Snooping Settings. 

VLAN Name This is the VLAN Name that, along with the VLAN ID, identifies the VLAN for which to 
modify the IGMP Snooping Settings. 

Query Interval The Query Interval field is used to set the time (in seconds) between transmitting 
IGMP queries. Entries between 1 and 65535 seconds are allowed. Default = 125. 

Max Response Time This determines the maximum amount of time in seconds allowed before sending an 
IGMP response report. The Max Response Time field allows an entry between 1 and 
25 (seconds).  Default = 10. 

Robustness Value Adjust this variable according to expected packet loss. If packet loss on the VLAN is 
expected to be high, the Robustness Variable should be increased to accommodate 
increased packet loss. This entry field allows an entry of 1 to 255. Default = 2. 

Last Member Query 
Interval 

This field specifies the maximum amount of time between group-specific query 
messages, including those sent in response to leave group messages. Default = 1. 

Host Timeout This is the maximum amount of time in seconds allowed for a host to continue 
membership in a multicast group without the Switch receiving a host membership 
report. Default = 260. 

Router Timeout This is the maximum amount of time in seconds a route is kept in the forwarding table 
without receiving a membership report. Default = 260. 

Leave Timer This specifies the maximum amount of time in seconds between the Switch receiving 
a leave group message from a host, and the Switch issuing a group membership 
query. If no response to the membership query is received before the Leave Timer 
expires, the (multicast) forwarding entry for that host is deleted. 

Querier State Choose Enabled to enable transmitting IGMP Query packets or Disabled to disable. 
The default is Disabled. 

Querier Router 
Behavior 

This read-only field describes the behavior of the router for sending query packets. 
Querier will denote that the router is sending out IGMP query packets. Non-Querier 
will denote that the router is not sending out IGMP query packets. This field will only 
read Querier when the Querier State and the State fields have been Enabled. 

State Select Enabled to implement IGMP Snooping. This field is Disabled by default. 

Fast Leave This parameter allows the user to enable the Fast Leave function. Enabled, this 
function will allow members of a multicast group to leave the group immediately 
(without the implementation of the Last Member Query Timer) when an IGMP Leave 
Report Packet is received by the Switch. The default is Disabled. 

Click Apply to implement the new settings. Click the Show All IGMP Snooping Entries link to return to the Current 
IGMP Snooping Group Entries window. 

 

NOTE: The Fast Leave function is intended for IGMPv2 users wishing to 
leave a multicast group and is best implemented on VLANs that have only 
one host connected to each port. When one host of a group of hosts uses 
the Fast Leave function, it may cause the inadvertent fast leave of other 
hosts of the group. 
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Static Router Ports 
A static router port is a port that has a multicast router attached to it. Generally, this router would have a connection to a 
WAN or to the Internet. Establishing a router port will allow multicast packets coming from the router to be propagated 
through the network, as well as allowing multicast messages (IGMP) coming from the network to be propagated to the 
router. 

A router port has the following behavior: 

• All IGMP Report packets will be forwarded to the router port. 

• IGMP queries (from the router port) will be flooded to all ports. 

• All UDP multicast packets will be forwarded to the router port. Because routers do not send IGMP reports or 
implement IGMP snooping, a multicast router connected to the router port of a Layer 3 switch would not be able 
to receive UDP data streams unless the UDP multicast packets were all forwarded to the router port. 

A router port will be dynamically configured when IGMP query packets, RIPv2 multicast, DVMRP multicast or PIM-DM 
multicast packets are detected flowing into a port.   

Open the IGMP Snooping folder and the click on the Static Router Ports Settings link to open the Current Static 
Router Ports Entries page, as shown below. 

 
Figure 6- 17. Static Router Ports Settings window 

The Static Router Ports Settings page (shown above) displays all of the current entries to the Switch's static router port 
table. To modify an entry, click the Modify button. This will open the Static Router Ports Settings - Edit page, as shown 
below. 

 
Figure 6- 18. Static Router Ports Settings - Edit window 

The following parameters can be set: 

Parameter                       Description 

VID (VLAN ID) This is the VLAN ID that, along with the VLAN Name, identifies the VLAN where the 
multicast router is attached. 

VLAN Name This is the name of the VLAN where the multicast router is attached. 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

Member Ports These are the ports on the Switch that will have a multicast router attached to them. 

Click Apply to implement the new settings, Click the Show All Static Router Port Entries link to return to the Current 
Static Router Port Entries window. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

57 

     

Spanning Tree 
This Switch supports three versions of the Spanning Tree Protocol; 802.1d STP, 802.1w Rapid STP and 802.1s MSTP.  
802.1d STP will be familiar to most networking professionals. However, since 802.1w RSTP and 802.1s MSTP has been 
recently introduced to D-Link managed Ethernet switches, a brief introduction to the technology is provided below 
followed by a description of how to set up 802.1d STP, 802.1w RSTP and 802.1s MSTP. 

802.1s MSTP 
Multiple Spanning Tree Protocol, or MSTP, is a standard defined by the IEEE community that allows multiple VLANs to 
be mapped to a single spanning tree instance, which will provide multiple pathways across the network. Therefore, these 
MSTP configurations will balance the traffic load, preventing wide scale disruptions when a single spanning tree instance 
fails. This will allow for faster convergences of new topologies for the failed instance. Frames designated for these VLANs 
will be processed quickly and completely throughout interconnected bridges utilizing either of the three spanning tree 
protocols (STP, RSTP or MSTP).  

This protocol will also tag BDPU packets so receiving devices can distinguish spanning tree instances, spanning tree 
regions and the VLANs associated with them. These instances will be classified by an MSTI ID. MSTP will connect 
multiple spanning trees with a Common and Internal Spanning Tree (CIST). The CIST will automatically determine each 
MSTP region, its maximum possible extent and will appear as one virtual bridge that runs a single spanning tree. 
Consequentially, frames assigned to different VLANs will follow different data routes within administratively established 
regions on the network, continuing to allow simple and full processing of frames, regardless of administrative errors in 
defining VLANs and their respective spanning trees. 

Each switch utilizing the MSTP on a network will have a single MSTP configuration that will have the following three 
attributes: 

1. A configuration name defined by an alphanumeric string of up to 32 characters (defined in the STP Bridge 
Global Settings window in the Configuration Name field). 

2. A configuration revision number (named here as a Revision Level and found in the STP Bridge Global Settings 
window) and; 

3. A 4096 element table (defined here as a VID List in the MST Configuration Table window) which will 
associate each of the possible 4096 VLANs supported by the Switch for a given instance. 

 To utilize the MSTP function on the Switch, three steps need to be taken: 

1. The Switch must be set to the MSTP setting (found in the STP Bridge Global Settings window in the STP 
Version field) 

2. The correct spanning tree priority for the MSTP instance must be entered (defined here as a Priority in the MST 
Configuration Table window when configuring an MSTI ID settings). 

3. VLANs that will be shared must be added to the MSTP Instance ID (defined here as a VID List in the MST 
Configuration Table window when configuring an MSTI ID settings). 

802.1w Rapid Spanning Tree 
The Switch implements three versions of the Spanning Tree Protocol, the Multiple Spanning Tree Protocol (MSTP) as 
defined by the IEEE 802.1s, the Rapid Spanning Tree Protocol (RSTP) as defined by the IEEE 802.1w specification and a 
version compatible with the IEEE 802.1d STP. RSTP can operate with legacy equipment implementing IEEE 802.1d, 
however the advantages of using RSTP will be lost.   

The IEEE 802.1w Rapid Spanning Tree Protocol (RSTP) evolved from the 802.1d STP standard. RSTP was developed in 
order to overcome some limitations of STP that impede the function of some recent switching innovations, in particular, 
certain Layer 3 functions that are increasingly handled by Ethernet switches. The basic function and much of the 
terminology is the same as STP. Most of the settings configured for STP are also used for RSTP. This section introduces 
some new Spanning Tree concepts and illustrates the main differences between the two protocols.  

Port Transition States 
An essential difference between the three protocols is in the way ports transition to a forwarding state and in the way this 
transition relates to the role of the port (forwarding or not forwarding) in the topology. MSTP and RSTP combine the 
transition states disabled, blocking and listening used in 802.1d and creates a single state Discarding. In either case, ports 
do not forward packets. In the STP port transition states disabled, blocking or listening or in the RSTP/MSTP port state 
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discarding, there is no functional difference, the port is not active in the network topology. Table 6-1 below compares how 
the three protocols differ regarding the port state transition. 

All three protocols calculate a stable topology in the same way. Every segment will have a single path to the root bridge. 
All bridges listen for BPDU packets. However, BPDU packets are sent more frequently - with every Hello packet. BPDU 
packets are sent even if a BPDU packet was not received. Therefore, each link between bridges is sensitive to the status of 
the link. Ultimately this difference results in faster detection of failed links, and thus faster topology adjustment. A draw-
back of 802.1d is this absence of immediate feedback from adjacent bridges. 

802.1d MSTP 802.1w RSTP 802.1d STP Forwarding Learning 

Discarding Discarding Disabled No No 

Discarding Discarding Blocking No No 

Discarding Discarding Listening No No 

Learning Learning Learning No Yes 

Forwarding Forwarding Forwarding Yes Yes 

Table 6- 1. Comparing Port States 
RSTP is capable of a more rapid transition to a forwarding state - it no longer relies on timer configurations - RSTP 
compliant bridges are sensitive to feedback from other RSTP compliant bridge links. Ports do not need to wait for the 
topology to stabilize before transitioning to a forwarding state. In order to allow this rapid transition, the protocol 
introduces two new variables: the edge port and the point-to-point (P2P) port. 

Edge Port 
The edge port is a configurable designation used for a port that is directly connected to a segment where a loop cannot be 
created. An example would be a port connected directly to a single workstation. Ports that are designated as edge ports 
transition to a forwarding state immediately without going through the listening and learning states. An edge port loses its 
status if it receives a BPDU packet, immediately becoming a normal spanning tree port. 

P2P Port 
A P2P port is also capable of rapid transition. P2P ports may be used to connect to other bridges. Under RSTP/MSTP, all 
ports operating in full-duplex mode are considered to be P2P ports, unless manually overridden through configuration. 

802.1d / 802.1w / 802.1s Compatibility 
MSTP or RSTP can interoperate with legacy equipment and is capable of automatically adjusting BPDU packets to 802.1d 
format when necessary. However, any segment using 802.1d STP will not benefit from the rapid transition and rapid 
topology change detection of MSTP or RSTP. The protocol also provides for a variable used for migration in the event that 
legacy equipment on a segment is updated to use RSTP or MSTP. 

The Spanning Tree Protocol (STP) operates on two levels:  

1. On the switch level, the settings are globally implemented. 

2. On the port level, the settings are implemented on a per user-defined group of ports basis. 
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STP Bridge Global Settings 
To open the following window, open the Spanning Tree folder in the Configuration menu and click the STP Bridge 
Global Settings link. 

 
Figure 6- 19. STP Bridge Global Settings – STP compatible 

 
Figure 6- 20. STP Bridge Global Settings - RSTP (default) 

 
Figure 6- 21.  STP Bridge Global Settings - MSTP 
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The following parameters can be set: 

Parameter                             Description 

STP Status Use the pull-down menu to enable or disable STP globally on the Switch. The 
default is Disabled. 

STP Version Use the pull-down menu to choose the desired version of STP to be implemented 
on the Switch. There are three choices: 

STP - Select this parameter to set the Spanning Tree Protocol (STP) globally on 
the switch. 

RSTP - Select this parameter to set the Rapid Spanning Tree Protocol (RSTP) 
globally on the Switch. 

MSTP - Select this parameter to set the Multiple Spanning Tree Protocol (MSTP) 
globally on the Switch. 

Hello Time: (1 - 10 sec)  The Hello Time can be set from 1 to 10 seconds. This is the interval between two 
transmissions of BPDU packets sent by the Root Bridge to tell all other switches 
that it is indeed the Root Bridge. This field will only appear here when STP or 
RSTP is selected for the STP Version. For MSTP, the Hello Time must be set on 
a port per port basis. See the STP Port Settings section for further details. 

Max Age: (6 - 40 sec)  The Max Age may be set to ensure that old information does not endlessly 
circulate through redundant paths in the network, preventing the effective 
propagation of the new information. Set by the Root Bridge, this value will aid in 
determining that the Switch has spanning tree configuration values consistent with 
other devices on the bridged LAN. If the value ages out and a BPDU has still not 
been received from the Root Bridge, the Switch will start sending its own BPDU to 
all other switches for permission to become the Root Bridge. If it turns out that 
your switch has the lowest Bridge Identifier, it will become the Root Bridge. The 
user may choose a time between 6 and 40 seconds. The default value is 20. 

Forward Delay: (4 - 30 
sec)  

The Forward Delay can be from 4 to 30 seconds. Any port on the Switch spends 
this time in the listening state while moving from the blocking state to the for-
warding state. 

Max Hops (1-20) Used to set the number of hops between devices in a spanning tree region before 
the BPDU (bridge protocol data unit) packet sent by the Switch will be discarded. 
Each switch on the hop count will reduce the hop count by one until the value 
reaches zero. The Switch will then discard the BDPU packet and the information 
held for the port will age out. The user may set a hop count from 1 to 20. The 
default is 20. 

TX Hold Count (1-10)  Used to set the maximum number of Hello packets transmitted per interval. The 
count can be specified from 1 to 10. The default is 3. 

Forwarding BPDU  This field can be Enabled or Disabled. When Enabled, it allows the forwarding of 
STP BPDU packets from other network devices. The default is Enabled. 

Click Apply to implement changes made. 

 

NOTE: The Hello Time cannot be longer than the Max. Age. Otherwise, a 
configuration error will occur. Observe the following formulas when setting 
the above parameters: 

Max. Age ≤ 2 x (Forward Delay - 1 second)  

Max. Age ≥ 2 x (Hello Time + 1 second) 
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MST Configuration Table 
The following screens in the MST Configuration Table window allow the user to configure a MSTI instance on the 
Switch. These settings will uniquely identify a multiple spanning tree instance set on the Switch. The Switch initially 
possesses one CIST or Common Internal Spanning Tree of which the user may modify the parameters for but cannot 
change the MSTI ID for, and cannot be deleted. To view the MST Configuration Identification window, click Con-
figuration > Spanning Tree > MST Configuration Identification: 

 
Figure 6- 22. MST Configuration Identification window 

The window above contains the following information: 

Parameter                       Description 

Configuration Name A previously configured name set on the Switch to uniquely identify the MSTI (Multiple 
Spanning Tree Instance). If a configuration name is not set, this field will show the 
MAC address to the device running MSTP.  

Revision Level This value, along with the Configuration Name will identify the MSTP region con-
figured on the Switch.  

MSTI ID This field shows the MSTI IDs currently set on the Switch. This field will always have 
the CIST MSTI, which may be configured but not deleted. Clicking the hyperlinked 
name will open a new window for configuring parameters associated with that 
particular MSTI. 

VID List This field displays the VLAN IDs associated with the specific MSTI. 

To delete a previously set MSTI Instance ID, click the corresponding  under the Delete heading in the MST 
Configuration Identification window. Clicking the Add button will reveal the following window to configure: 
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Figure 6- 23. Instance ID Settings window- Add 

The user may configure the following parameters to create a MSTI in the Switch. 

Parameter                       Description 

MSTI ID Enter a number between 1 and 15 to set a new MSTI on the Switch. 

Type Create is selected to create a new MSTI. No other choices are available for this field 
when creating a new MSTI. 

VID List (1-4094) This field is used to specify the VID range from configured VLANs set on the Switch. 
Supported VIDs on the Switch range from ID number 1 to 4094. 

Click Apply to implement changes made. 

To configure the settings for the CIST, click on its hyperlinked MSTI ID number in the MST Configuration 
Identification window, which will reveal the following window to configure: 

 
Figure 6- 24. Instance ID Settings window - CIST modify  

The user may configure the following parameters to configure the CIST on the Switch. 

Parameter                          Description 

MSTI ID The MSTI ID of the CIST is 0 and cannot be altered. 

Type This field allows the user to choose a desired method for altering the MSTI settings. 
The user has 2 choices.  

• Add VID - Select this parameter to add VIDs to the MSTI ID, in 
conjunction with the VID List parameter.  

• Remove VID - Select this parameter to remove VIDs from the MSTI ID, in 
conjunction with the VID List parameter. 

VID List (1-4094) This field is used to specify the VID range from configured VLANs set on the Switch. 
Supported VIDs on the Switch range from ID number 1 to 4094.  
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Click Apply to implement changes made. 

To configure the parameters for a previously set MSTI, click on its hyperlinked MSTI ID number, which will reveal the 
following screen for configuration.  

 
Figure 6- 25. Instance ID Settings window - Modify 

The user may configure the following parameters for a MSTI on the Switch. 

Parameter                       Description 

MSTI ID Displays the MSTI ID previously set by the user. 

Type This field allows the user to choose a desired method for altering the MSTI settings. 
The user has 2 choices.  

• Add VID - Select this parameter to add VIDs to the MSTI ID, in conjunction 
with the VID List parameter.  

• Remove VID - Select this parameter to remove VIDs from the MSTI ID, in 
conjunction with the VID List parameter. 

VID List (1-4094) This field is used to specify the VID range from configured VLANs set on the Switch to 
add to this MSTI ID. Supported VIDs on the Switch range from ID number 1 to 4094. 
This parameter can only be utilized if the Type chosen is Add or Remove. 

Click Apply to implement changes made. 
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MSTP Port Information 
This window displays the current MSTI configuration settings and can be used to update the port configuration for an 
MSTI ID. If a loop occurs, the MSTP function will use the port priority to select an interface to put into the forwarding 
state. Set a higher priority value for interfaces to be selected for forwarding first. In instances where the priority value is 
identical, the MSTP function will implement the lowest port number into the forwarding state and other interfaces will be 
blocked. Remember that lower priority values mean higher priorities for forwarding packets. 

To view the following window, click Configuration > Spanning Tree > MSTI Port Information: 

 
Figure 6- 26. MSTP Port Information window 

To view the MSTI settings for a particular port, select the Port number, located in the top left hand corner of the screen 
and click Apply. To modify the settings for a particular MSTI Instance, click on its hyperlinked MSTI ID, which will 
reveal the following window.  

 
Figure 6- 27. MSTI Settings window 

Parameter                    Description 

Instance ID  Displays the MSTI ID of the instance being configured. An entry of 0 in this field denotes 
the CIST (default MSTI). 

Internal cost  This parameter is set to represent the relative cost of forwarding packets to specified 
ports when an interface is selected within a STP instance. The default setting is 0 
(auto). There are two options: 

• 0 (auto) - Selecting this parameter for the internalCost will set quickest route 
automatically and optimally for an interface. The default value is derived from 
the media speed of the interface. 

• value 1-2000000 - Selecting this parameter with a value in the range of 1-
2000000 will set the quickest route when a loop occurs. A lower Internal cost 
represents a quicker transmission. 

Priority  Enter a value between 0 and 240 to set the priority for the port interface. A higher 
priority will designate the interface to forward packets first. A lower number denotes a 
higher priority. This entry must be divisible by 16. The default priority setting is 128. 

Click Apply to implement changes made. 
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STP Instance Settings 
The following window displays MSTIs currently set on the Switch. To view the following table, click Configuration > 
Spanning Tree > STP Instance Settings:  

 
Figure 6- 28. STP Instance Settings 

The following information is displayed:  

Parameter                       Description 

Instance Type Displays the instance type(s) currently configured on the Switch. Each instance type 
is classified by a MSTI ID. CIST refers to the default MSTI configuration set on the 
Switch. 

Instance Status Displays the current status of the corresponding MSTI ID 

Instance Priority Displays the priority of the corresponding MSTI Instance Type. The lowest priority will 
be the root bridge. 

Priority Click the Modify button to change the priority of the MSTI. This will open the Instance 
ID Settings window to configure. The Type field in this window will be permanently set 
to Set Priority Only. Enter the new priority in the Priority field and click Apply to 
implement the new priority setting. 

Click Apply to implement changes made. 

Clicking the hyperlinked name will allow the user to view the current parameters set for the MSTI Instance. 

 
Figure 6- 29. STP Instance Operational Status – CIST 
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Figure 6- 30. STP Instance Operational Status – Previously Configured MSTI 

The following parameters may be viewed in the STP Instance Operational Status windows: 

Parameter                          Description 
Designated Root 
Bridge 

This field will show the priority and MAC address of the Root Bridge. 

External Root Cost This defines a metric that indicates the relative cost of forwarding packets to the 
specified port list. Port cost can be set automatically or as a metric value. The default 
value is 0 (auto). 

• 0 (auto) - Setting 0 for the external cost will automatically set the speed for 
forwarding packets to the specified port(s) in the list for optimal efficiency. 
Default port cost: 100Mbps port = 200000. Gigabit port  = 20000. 

• value 1-200000000 - Define a value between 1 and 200000000 to determine 
the external cost. The lower the number, the greater the probability the port 
will be chosen to forward packets. 

Regional Root Bridge This field will show the priority and MAC address of the Regional (Internal) Root 
Bridge. This MAC address should be the MAC address of the Switch. 

Internal Root Cost This parameter is set to represent the relative cost of forwarding packets to specified 
ports when an interface is selected within a STP instance. The default setting is 0 
(auto). There are two options: 

• 0 (auto) - Selecting this parameter for the internalCost will set quickest route 
automatically and optimally for an interface. The default value is derived 
from the media speed of the interface. 

• value 1-2000000 - Selecting this parameter with a value in the range of 1-
2000000 will set the quickest route when a loop occurs. A lower Internal 
cost represents a quicker transmission. 

Designated Bridge This field will show the priority and MAC address of the Designated Bridge. The 
information shown in this table comes from a BPDU packet originating from this 
bridge. 

Root Port This is the port on the Switch that is physically connected to the Root Bridge. 

Max Age The Max Age may be set to ensure that old information does not endlessly circulate 
through redundant paths in the network, preventing the effective propagation of the 
new information. Set by the Root Bridge, this value will aid in determining that the 
Switch has spanning tree configuration values consistent with other devices on the 
bridged LAN. If the value ages out and a BPDU has still not been received from the 
Root Bridge, the Switch will start sending its own BPDU to all other switches for 
permission to become the Root Bridge. If it turns out that your switch has the lowest 
Bridge Identifier, it will become the Root Bridge. The user may choose a time between 
6 and 40 seconds. The default value is 20. 
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Forward Delay The Forward Delay can be from 4 to 30 seconds. Any port on the Switch spends this 
time in the listening state while moving from the blocking state to the forwarding state.

Last Topology 
Change 

This field shows the time, in seconds, since the last spanning tree topology change. 

Topology Changes 
Count 

This field displays the number of times that the spanning tree topology has changed 
since the original initial boot up of the Switch. 
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STP Port Settings 
STP can be set up on a port per port basis. To view the following window click Configuration > Spanning Tree > STP 
Port Settings: 

 
Figure 6- 31.  STP Port Settings and Table window 

In addition to setting Spanning Tree parameters for use on the switch level, the Switch allows for the configuration of 
groups of ports, each port-group of which will have its own spanning tree, and will require some of its own configuration 
settings. An STP Group will use the switch-level parameters entered above, with the addition of Port Priority and Port 
Cost. 

An STP Group spanning tree works in the same way as the switch-level spanning tree, but the root bridge concept is 
replaced with a root port concept. A root port is a port of the group that is elected based on port priority and port cost, to be 
the connection to the network for the group. Redundant links will be blocked, just as redundant links are blocked on the 
switch level. 

The STP on the switch level blocks redundant links between switches (and similar network devices).  The port level STP 
will block redundant links within an STP Group. 
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It is advisable to define an STP Group to correspond to a VLAN group of ports. 

The following fields can be set: 

Parameter                          Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From/To  A consecutive group of ports may be configured starting with the selected port. 

External Cost (0 = Auto) External Cost - This defines a metric that indicates the relative cost of forwarding 
packets to the specified port list. Port cost can be set automatically or as a metric 
value. The default value is 0 (auto). 

• 0 (auto) - Setting 0 for the external cost will automatically set the speed for 
forwarding packets to the specified port(s) in the list for optimal efficiency. 
Default port cost: 100Mbps port = 200000. Gigabit port  = 20000. 

• value 1-200000000 - Define a value between 1 and 200000000 to 
determine the external cost. The lower the number, the greater the 
probability the port will be chosen to forward packets. 

Hello Time  The time interval between the transmission of configuration messages by the des-
ignated port, to other devices on the bridged LAN, thus stating that the Switch is still 
functioning. The user may choose a time between 1 and 10 seconds. The default is 
2 seconds. This field is only operable when the Switch is enabled for MSTP. 

Migration  Setting this parameter as "yes" will set the ports to send out BDPU packets to other 
bridges, requesting information on their STP setting If the Switch is configured for 
RSTP, the port will be capable to migrate from 802.1d STP to 802.1w RSTP. If the 
Switch is configured for MSTP, the port is capable of migrating from 802.1d STP to 
802.1s MSTP. RSTP and MSTP can coexist with standard STP, however the 
benefits of RSTP and MSTP are not realized on a port where an 802.1d network 
connects to an 802.1w or 802.1s enabled network. Migration should be set as yes 
on ports connected to network stations or segments that are capable of being 
upgraded to 802.1w RSTP or 802.1s MSTP on all or some portion of the segment. 

Edge  Choosing the true parameter designates the port as an edge port. Edge ports 
cannot create loops, however an edge port can lose edge port status if a topology 
change creates a potential for a loop. An edge port normally should not receive 
BPDU packets. If a BPDU packet is received, it automatically loses edge port 
status. Choosing the false parameter indicates that the port does not have edge 
port status. 

P2P  Choosing the True parameter indicates a point-to-point (P2P) shared link. P2P ports 
are similar to edge ports, however they are restricted in that a P2P port must 
operate in full duplex. Like edge ports, P2P ports transition to a forwarding state 
rapidly thus benefiting from RSTP. A p2p value of false indicates that the port 
cannot have p2p status. Auto allows the port to have p2p status whenever possible 
and operate as if the p2p status were true. If the port cannot maintain this status, 
(for example if the port is forced to half-duplex operation) the p2p status changes to 
operate as if the p2p value were False. The default setting for this parameter is 
True. 

State  This drop-down menu allows the user to enable or disable STP for the selected 
group of ports. The default is Enabled. 

Click Apply to implement changes made. 
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Forwarding & Filtering 
Unicast Forwarding 
Open the Forwarding & Filtering folder in the Configuration menu and click on the Unicast Forwarding link. This will 
open the Unicast Forwarding Table, as shown below:  

 
Figure 6- 32. Unicast Forwarding Table and Static Unicast Forwarding Table window 

To add or edit an entry, define the following parameters and then click Add/Modify: 

Parameter                             Description 

VLAN ID (VID) The VLAN ID number of the VLAN on which the above Unicast MAC address 
resides. 

MAC Address The MAC address to which packets will be statically forwarded. This must be a 
unicast MAC address. 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

Port Allows the selection of the port number on which the MAC address entered above 
resides. 

Click Apply to implement the changes made. Current entries can be found in the Static Unicast Forwarding Table as 
shown in the bottom half of the figure above. To delete an entry in the Static Unicast Forwarding Table, click the 

corresponding  under the Delete heading.  
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Multicast Forwarding 
The following figure and table describe how to set up Multicast Forwarding on the Switch. Open the Forwarding & 
Filtering folder in the Configuration menu, and click on the Multicast Forwarding link to see the entry screen below: 

 
Figure 6- 33.  Static Multicast Forwarding Settings and Current Multicast Forwarding Entries window 

The Static Multicast Forwarding Settings page displays all of the entries made into the Switch's static multicast 
forwarding table. Click the Add button to open the Setup Static Multicast Forwarding Table, as shown below: 

 
Figure 6- 34. Setup Static Multicast Forwarding Table 

The following parameters can be set: 

Parameter                       Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

VID The VLAN ID of the VLAN to which the corresponding MAC address belongs. 

Multicast MAC 
Address 

The MAC address of the static source of multicast packets. This must be a multicast 
MAC address. 

Port Allows the selection of ports that will be members of the static multicast group. The 
options are: 

None - No restrictions on the port dynamically joining the multicast group. When None 
is chosen, the port will not be a member of the Static Multicast Group. 

Egress - The port is a static member of the multicast group. 

Click Apply to implement the changes made. To delete an entry in the Static Multicast Forwarding Table, click the 

corresponding  under the Delete heading. Click the Show All Multicast Forwarding Entries link to return to the Static 
Multicast Forwarding Settings window. 
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VLANs 
Understanding IEEE 802.1p Priority 
Priority tagging is a function defined by the IEEE 802.1p standard designed to provide a means of managing traffic on a 
network where many different types of data may be transmitted simultaneously. It is intended to alleviate problems 
associated with the delivery of time critical data over congested networks. The quality of applications that are dependent on 
such time critical data, such as video conferencing, can be severely and adversely affected by even very small delays in 
transmission. 

Network devices that are in compliance with the IEEE 802.1p standard have the ability to recognize the priority level of 
data packets. These devices can also assign a priority label or tag to packets. Compliant devices can also strip priority tags 
from packets. This priority tag determines the packet's degree of expeditiousness and determines the queue to which it will 
be assigned.  

Priority tags are given values from 0 to 7 with 0 being assigned to the lowest priority data and 7 assigned to the highest. 
The highest priority tag 7 is generally only used for data associated with video or audio applications, which are sensitive to 
even slight delays, or for data from specified end users whose data transmissions warrant special consideration.  

The Switch allows further tailoring of how priority tagged data packets are handled on your network. Using queues to 
manage priority tagged data allows specification of its relative priority, to suit the needs of your network. There may be 
circumstances where it would be advantageous to group two or more differently tagged packets into the same queue. 
Generally, however, it is recommended that the highest priority queue, Queue 1, be reserved for data packets with a 
priority value of 7. Packets that have not been given any priority value are placed in Queue 0 and thus given the lowest 
priority for delivery.  

A weighted round robin system is employed on the Switch to determine the rate at which the queues are emptied of packets. 
The ratio used for clearing the queues is 4:1. This means that the highest priority queue, Queue 1, will clear 4 packets for 
every 1 packet cleared from Queue 0. 

Remember, the priority queue settings on the Switch are for all ports, and all devices connected to the Switch will be 
affected. This priority queuing system will be especially beneficial if your network employs switches with the capability of 
assigning priority tags.  

VLAN Description 
A Virtual Local Area Network (VLAN) is a network topology configured according to a logical scheme rather than the 
physical layout. VLANs can be used to combine any collection of LAN segments into an autonomous user group that 
appears as a single LAN. VLANs also logically segment the network into different broadcast domains so that packets are 
forwarded only between ports within the VLAN. Typically, a VLAN corresponds to a particular subnet, although not nec-
essarily. 

VLANs can enhance performance by conserving bandwidth, and improve security by limiting traffic to specific domains. 

A VLAN is a collection of end nodes grouped by logic instead of physical location. End nodes that frequently 
communicate with each other are assigned to the same VLAN, regardless of where they are physically on the network. 
Logically, a VLAN can be equated to a broadcast domain, because broadcast packets are forwarded to only members of the 
VLAN on which the broadcast was initiated. 

Notes about VLANs in the xStack DGS/DXS-3300 Series  
No matter what basis is used to uniquely identify end nodes and assign these nodes VLAN membership, packets cannot 
cross VLANs without a network device performing a routing function between the VLANs. 

The xStack DGS/DXS-3300 Series switches support IEEE 802.1Q VLANs and Port-Based VLANs. The port untagging 
function can be used to remove the 802.1Q tag from packet headers to maintain compatibility with devices that are tag-
unaware. 

The Switch's default is to assign all ports to a single 802.1Q VLAN named "default."   

The "default" VLAN has a VID = 1.  

The member ports of Port-based VLANs may overlap, if desired.   
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IEEE 802.1Q VLANs 
Some relevant terms: 

Tagging - The act of putting 802.1Q VLAN information into the header of a packet.  

Untagging - The act of stripping 802.1Q VLAN information out of the packet header.  

Ingress port - A port on a switch where packets are flowing into the Switch and VLAN decisions must be made.  

Egress port - A port on a switch where packets are flowing out of the Switch, either to another switch or to an end station, 
and tagging decisions must be made.  

IEEE 802.1Q (tagged) VLANs are implemented on the Switch. 802.1Q VLANs require tagging, which enables them to 
span the entire network (assuming all switches on the network are IEEE 802.1Q-compliant).   

VLANs allow a network to be segmented in order to reduce the size of broadcast domains. All packets entering a VLAN 
will only be forwarded to the stations (over IEEE 802.1Q enabled switches) that are members of that VLAN, and this 
includes broadcast, multicast and unicast packets from unknown sources. 

VLANs can also provide a level of security to your network. IEEE 802.1Q VLANs will only deliver packets between 
stations that are members of the VLAN.  

Any port can be configured as either tagging or untagging. The untagging feature of IEEE 802.1Q VLANs allows VLANs 
to work with legacy switches that don't recognize VLAN tags in packet headers. The tagging feature allows VLANs to 
span multiple 802.1Q-compliant switches through a single physical connection and allows Spanning Tree to be enabled on 
all ports and work normally. 

The IEEE 802.1Q standard restricts the forwarding of untagged packets to the VLAN the receiving port is a member of.   

 

 
                                                                                     Figure 6- 35. IEEE 802.1Q Packet Forwarding 

The main characteristics of IEEE 802.1Q are as
follows: 

• Assigns packets to VLANs by filtering. 

• Assumes the presence of a single global
spanning tree. 

• Uses an explicit tagging scheme with one-
level tagging. 

• 802.1Q VLAN Packet Forwarding 

• Packet forwarding decisions are made
based upon the following three types of
rules: 

• Ingress rules - rules relevant to the
classification of received frames belonging
to a VLAN. 

• Forwarding rules between ports - decides
whether to filter or forward the packet. 

• Egress rules - determines if the packet must
be sent tagged or untagged. 
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802.1Q VLAN Tags 
The figure below shows the 802.1Q VLAN tag. There are four additional octets inserted after the source MAC address. 
Their presence is indicated by a value of 0x8100 in the EtherType field. When a packet's EtherType field is equal to 
0x8100, the packet carries the IEEE 802.1Q/802.1p tag. The tag is contained in the following two octets and consists of 3 
bits of user priority, 1 bit of Canonical Format Identifier (CFI - used for encapsulating Token Ring packets so they can be 
carried across Ethernet backbones), and 12 bits of VLAN ID (VID). The 3 bits of user priority are used by 802.1p. The 
VID is the VLAN identifier and is used by the 802.1Q standard. Because the VID is 12 bits long, 4094 unique VLANs can 
be identified. 

The tag is inserted into the packet header making the entire packet longer by 4 octets. All of the information originally 
contained in the packet is retained. 

 
Figure 6- 36. IEEE 802.1Q Tag 

The EtherType and VLAN ID are inserted after the MAC source address, but before the original EtherType/Length or 
Logical Link Control. Because the packet is now a bit longer than it was originally, the Cyclic Redundancy Check (CRC) 
must be recalculated. 

 
Figure 6- 37. Adding an IEEE 802.1Q Tag 
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Port VLAN ID 
Packets that are tagged (are carrying the 802.1Q VID information) can be transmitted from one 802.1Q compliant network 
device to another with the VLAN information intact. This allows 802.1Q VLANs to span network devices (and indeed, the 
entire network, if all network devices are 802.1Q compliant). 

Unfortunately, not all network devices are 802.1Q compliant. These devices are referred to as tag-unaware. 802.1Q devices 
are referred to as tag-aware. 

Prior to the adoption of 802.1Q VLANs, port-based and MAC-based VLANs were in common use. These VLANs relied 
upon a Port VLAN ID (PVID) to forward packets. A packet received on a given port would be assigned that port's PVID 
and then be forwarded to the port that corresponded to the packet's destination address (found in the Switch's forwarding 
table). If the PVID of the port that received the packet is different from the PVID of the port that is to transmit the packet, 
the Switch will drop the packet.   

Within the Switch, different PVIDs mean different VLANs (remember that two VLANs cannot communicate without an 
external router). So, VLAN identification based upon the PVIDs cannot create VLANs that extend outside a given switch 
(or switch stack). 

Every physical port on a switch has a PVID. 802.1Q ports are also assigned a PVID, for use within the Switch. If no 
VLANs are defined on the Switch, all ports are then assigned to a default VLAN with a PVID equal to 1. Untagged packets 
are assigned the PVID of the port on which they were received. Forwarding decisions are based upon this PVID, so far as 
VLANs are concerned. Tagged packets are forwarded according to the VID contained within the tag. Tagged packets are 
also assigned a PVID, but the PVID is not used to make packet-forwarding decisions, the VID is.    

Tag-aware switches must keep a table to relate PVIDs within the Switch to VIDs on the network. The Switch will compare 
the VID of a packet to be transmitted to the VID of the port that is to transmit the packet. If the two VIDs are different, the 
Switch will drop the packet. Because of the existence of the PVID for untagged packets and the VID for tagged packets, 
tag-aware and tag-unaware network devices can coexist on the same network. 

A switch port can have only one PVID, but can have as many VIDs as the Switch has memory in its VLAN table to store 
them. 

Because some devices on a network may be tag-unaware, a decision must be made at each port on a tag-aware device 
before packets are transmitted - should the packet to be transmitted have a tag or not? If the transmitting port is connected 
to a tag-unaware device, the packet should be untagged. If the transmitting port is connected to a tag-aware device, the 
packet should be tagged. 

Tagging and Untagging 
Every port on an 802.1Q compliant switch can be configured as tagging or untagging. 

Ports with tagging enabled will put the VID number, priority and other VLAN information into the header of all packets 
that flow into and out of it. If a packet has previously been tagged, the port will not alter the packet, thus keeping the 
VLAN information intact. The VLAN information in the tag can then be used by other 802.1Q compliant devices on the 
network to make packet-forwarding decisions.  

Ports with untagging enabled will strip the 802.1Q tag from all packets that flow into and out of those ports. If the packet 
doesn't have an 802.1Q VLAN tag, the port will not alter the packet. Thus, all packets received by and forwarded by an 
untagging port will have no 802.1Q VLAN information. (Remember that the PVID is only used internally within the 
Switch). Untagging is used to send packets from an 802.1Q-compliant network device to a non-compliant network device. 

Ingress Filtering 
A port on a switch where packets are flowing into the Switch and VLAN decisions must be made is referred to as an 
ingress port. If ingress filtering is enabled for a port, the Switch will examine the VLAN information in the packet header 
(if present) and decide whether or not to forward the packet.   

If the packet is tagged with VLAN information, the ingress port will first determine if the ingress port itself is a member of 
the tagged VLAN. If it is not, the packet will be dropped. If the ingress port is a member of the 802.1Q VLAN, the Switch 
then determines if the destination port is a member of the 802.1Q VLAN. If it is not, the packet is dropped. If the 
destination port is a member of the 802.1Q VLAN, the packet is forwarded and the destination port transmits it to its 
attached network segment.  

If the packet is not tagged with VLAN information, the ingress port will tag the packet with its own PVID as a VID (if the 
port is a tagging port). The switch then determines if the destination port is a member of the same VLAN (has the same 
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VID) as the ingress port. If it does not, the packet is dropped. If it has the same VID, the packet is forwarded and the 
destination port transmits it on its attached network segment.   

This process is referred to as ingress filtering and is used to conserve bandwidth within the Switch by dropping packets that 
are not on the same VLAN as the ingress port at the point of reception. This eliminates the subsequent processing of 
packets that will just be dropped by the destination port. 

Default VLANs 
The Switch initially configures one VLAN, VID = 1, called "default." The factory default setting assigns all ports on the 
Switch to the "default." As new VLANs are configured in Port-based mode, their respective member ports are removed 
from the "default."   

Packets cannot cross VLANs. If a member of one VLAN wants to connect to another VLAN, the link must be through an 
external router. 

 

NOTE: Packets with unkown destination addresses, as well as broadcast 
and multicast packets will be flooded to all ports that are a member of the 
VLAN. If no VLAns are configured on the Switch, these packets will be 
dropped. 

An example is presented below: 

VLAN Name VID Switch Ports 

System (default) 1 5, 6, 7, 8, 21, 22, 23, 24 

Engineering 2 9, 10, 11, 12 

Marketing 3 13, 14, 15, 16 

Finance 4 17, 18, 19, 20 

Sales 5 1, 2, 3, 4 

Table 6- 2. VLAN Example - Assigned Ports 

Port-based VLANs 
Port-based VLANs limit traffic that flows into and out of switch ports. Thus, all devices connected to a port are members 
of the VLAN(s) the port belongs to, whether there is a single computer directly connected to a switch, or an entire 
department. 

On port-based VLANs, NICs do not need to be able to identify 802.1Q tags in packet headers. NICs send and receive 
normal Ethernet packets. If the packet's destination lies on the same segment, communications take place using normal 
Ethernet protocols. Even though this is always the case, when the destination for a packet lies on another switch port, 
VLAN considerations come into play to decide if the packet is dropped by the Switch or delivered. 

VLAN Segmentation 
Take for example a packet that is transmitted by a machine on Port 1 that is a member of VLAN 2. If the destination lies on 
another port (found through a normal forwarding table lookup), the Switch then looks to see if the other port (Port 10) is a 
member of VLAN 2 (and can therefore receive VLAN 2 packets). If Port 10 is not a member of VLAN 2, then the packet 
will be dropped by the Switch and will not reach its destination. If Port 10 is a member of VLAN 2, the packet will go 
through. This selective forwarding feature based on VLAN criteria is how VLANs segment networks. The key point being 
that Port 1 will only transmit on VLAN 2. 

Network resources such as printers and servers however, can be shared across VLANs. This is achieved by setting up 
overlapping VLANs. That is ports can belong to more than one VLAN group. For example, setting VLAN 1 members to 
ports 1, 2, 3, and 4 and VLAN 2 members to ports 1, 5, 6, and 7. Port 1 belongs to two VLAN groups. Ports 8, 9, and 10 
are not configured to any VLAN group. This means ports 8, 9, and 10 are in the same VLAN group. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

77 

     

VLAN and Trunk Groups 
The members of a trunk group have the same VLAN setting. Any VLAN setting on the members of a trunk group will 
apply to the other member ports. 

 

NOTE: In order to use VLAN segmentation in conjunction with port trunk 
groups, first set the port trunk group(s), and then the user may configure 
VLAN settings. If changing the port trunk grouping with VLANs already in 
place, the user does not need to reconfigure the VLAN settings after 
changing the port trunk group settings. VLAN settings will automatically 
change in conjunction with the change of the port trunk group settings. 

Protocol VLANs 
The xStack DGS/DXS-3300 Switch Series incorporates the idea of protocol-based VLANs. This standard, defined by the 
IEEE 802.1v standard maps packets to protocol-defined VLANs by examining the type octet within the packet header to 
discover the type of protocol associated with it. After assessing the protocol, the Switch will forward the packets to all 
ports within the protocol-assigned VLAN. This feature will benefit the administrator by better balancing load sharing and 
enhancing traffic classification. The Switch supports fifteen (15) pre-defined protocols for configuration. The user may 
also choose a protocol that is not one of the fifteen defined protocols by properly configuring the userDefined protocol 
VLAN. The supported protocols for the protocol VLAN function on this switch include IP, IPX, DEC, DEC LAT, SNAP, 
NetBIOS, AppleTalk, XNS, SNA, IPv6, RARP and VINES. 

The following is a list of type headers for each protocol listed for VLAN configuration. 

Protocol Type Header in Hexadecimal Form 

IP over Ethernet 0x0800 

IPX 802.3 0xFFFF 

IPX 802.2 0xE0E0 

IPX SNAP 0x8137 

IPX over Ethernet2 0x8137 

decLAT 0x6000 

decOther 0x6009 

SNA 802.2 0x0404 

netBios 0xF0F0 

XNS 0x0600 

VINES 0x0BAD 

IPV6 0x86DD 

AppleTalk 0x809B 

RARP 0x8035  

SNA over Ethernet2 0x80D5 

Table 6- 3. Protocol VLAN and the corresponding type header 

In configuring the user-defined protocol, the administrator must make sure that the pre-defined user type header does not 
match any other type header. A match may cause discrepancies within the local network and failure to define the VLAN to 
forward packets to.    
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Static VLAN Entry 
In the Configuration folder, open the VLAN folder and click the Static VLAN Entry link to open the following window: 

 
Figure 6- 38. Current 802.1Q Static VLANs Entries window 

The 802.1Q Static VLANs menu lists all previously configured VLANs by VLAN ID and VLAN Name. To delete an 

existing 802.1Q VLAN, click the corresponding  button under the Delete heading. 

To create a new 802.1Q VLAN, click the Add button in the 802.1Q Static VLANs menu. A new menu will appear, as 
shown below, to configure the port settings and to assign a unique name and number to the new VLAN. See the table 
below for a description of the parameters in the new menu. 

 
Figure 6- 39. 802.1Q Static VLANs - Add  

To return to the Current 802.1Q Static VLANs Entries window, click the Show All Static VLAN Entries link. To change 
an existing 802.1Q VLAN entry, click the Modify button of the corresponding entry to modify. A new menu will appear to 
configure the port settings and to assign a unique name and number to the new VLAN. See the table below for a 
description of the parameters in the new menu. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

79 

     

 
Figure 6- 40. 802.1Q Static VLANs Entry Settings - Modify 

The following fields can then be set in either the Add or Modify 802.1Q Static VLANs menus: 

Parameter                   Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

VID (VLAN ID) Allows the entry of a VLAN ID in the Add dialog box, or displays the VLAN ID of an 
existing VLAN in the Modify dialog box. VLANs can be identified by either the VID or the 
VLAN name. 

VLAN Name Allows the entry of a name for the new VLAN in the Add dialog box, or for editing the 
VLAN name in the Modify dialog box. 

Advertisement Enabling this function will allow the Switch to send out GVRP packets to outside 
sources, notifying that they may join the existing VLAN. 

Type Displays the type of protocol associated with this VLAN. 

Protocol ID The following parameters allow for the creation of protocol-based VLANs. The Switch 
supports 15 pre-configured protocol-based VLANs plus one user-defined protocol based 
VLAN where the administrator may configure the settings for the appropriate protocol 
and forwarding of packets (16 total). Selecting a specific protocol will indicate which 
protocol will be utilized in determining the VLAN ownership of a tagged packet. Pre-set 
protocol-based VLANs on the Switch include: 

port – Using this parameter will allow the creation of a normal 802.1Q VLAN on the 
Switch. 
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ip – Using this parameter will instruct the Switch to forward packets to this VLAN if the 
tag in the packet header is concurrent with this protocol. This packet header information 
is based on the Ethernet protocol. 

rarp - Using this parameter will instruct the Switch to forward packets to this VLAN if the 
tag in the packet header is concurrent with this protocol. This packet header information 
is defined by the Reverse Address Resolution (RARP) Protocol. 

ipx802dot3 - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by Novell NetWare 802.3 (IPX - Internet Packet Exchange). 

ipx802dot2 - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by Novell NetWare 802.2 (IPX - Internet Packet Exchange). 

ipxSnap - Using this parameter will instruct the Switch to forward packets to this VLAN if 
the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by Novell and the Sub Network Access Protocol (SNAP). 

ipxEthernet2 - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by Novell Ethernet II Protocol. 

appleTalk - Using this parameter will instruct the Switch to forward packets to this VLAN 
if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the AppleTalk protocol. 

decLAT - Using this parameter will instruct the Switch to forward packets to this VLAN if 
the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the Digital Equipment Corporation (DEC) Local Area Transport 
(LAT) protocol. 

decOther - Using this parameter will instruct the Switch to forward packets to this VLAN 
if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the Digital Equipment Corporation (DEC) Protocol. 

sna802dot2 - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the Systems Network Architecture (SNA) 802.2 Protocol. 

snaEthernet2 - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the Systems Network Architecture (SNA) Ethernet II Protocol. 

netBios - Using this parameter will instruct the Switch to forward packets to this VLAN if 
the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the NetBIOS Protocol. 

xns - Using this parameter will instruct the Switch to forward packets to this VLAN if the 
tag in the packet header is concurrent with this protocol. This packet header information 
is defined by the Xerox Network Systems (XNS) Protocol. 

vines - Using this parameter will instruct the Switch to forward packets to this VLAN if 
the tag in the packet header is concurrent with this protocol. This packet header 
information is defined by the Banyan Virtual Integrated Network Service (VINES) 
Protocol. 

ipV6 - Using this parameter will instruct the Switch to forward packets to this VLAN if the 
tag in the packet header is concurrent with this protocol. This packet header information 
is defined by the Internet Protocol Version 6 (IPv6) Protocol. 

userDefined - Using this parameter will instruct the Switch to forward packets to this 
VLAN if the tag in the packet header is concurrent with this protocol defined by the user. 
This packet header information is defined by entering the following information: 

User Defined Pid - Specifies that the VLAN will only accept packets with this 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

81 

     

hexadecimal 802.1Q Ethernet type value in the packet header. The user may define an 
entry, in the hexadecimal form (ffff) to define the packet identification. (The user only 
need enter the final four integers of the hexadecimal format to define the packet ID – 
{hex 0x0 0xffff}) This field is only operable if userDefined is selected in the Protocol ID 
field.  

encap [ethernet | llc | snap | all] – Specifies that the Switch will examine the octet of the 
packet header referring to one of the protocols listed (Ethernet, LLC or SNAP), looking 
for a match of the hexadecimal value previously entered . all will instruct the Switch to 
examine the total packet header. After a match is found, the Switch will forward the 
packet to this VLAN. This field is only operable if userDefined is selected in the Protocol 
ID field. 

Port Settings Allows an individual port to be specified as member of a VLAN. 

Tag Specifies the port as either 802.1Q tagging or 802.1Q untagged. Checking the box will 
designate the port as Tagged. 

None Allows an individual port to be specified as a non-VLAN member. 

Egress Select this to specify the port as a static member of the VLAN. Egress member ports are 
ports that will be transmitting traffic for the VLAN. These ports can be either tagged or 
untagged. 

Forbidden Select this to specify the port as not being a member of the VLAN and that the port is 
forbidden from becoming a member of the VLAN dynamically. 

Click Apply to implement changes made. Click the Show All Static VLAN Entries link to return to the Current 802.1Q 
Static VLAN Entries window.  
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GVRP Settings 
In the Configuration menu, open the VLANs folder and click GVRP Settings.  

The GVRP Settings dialog box, shown below, allows the user to determine whether the Switch will share its VLAN 
configuration information with other GARP VLAN Registration Protocol (GVRP) enabled switches. In addition, Ingress 
Checking can be used to limit traffic by filtering incoming packets whose PVID does not match the PVID of the port. 
Results can be seen in the table under the configuration settings, as seen below. 

 
Figure 6- 41. GVRP Settings and GVRP Table window 

The following fields can be set: 
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Parameter                          Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From/To These two fields allow the user to specify the range of ports that will be included in 
the Port-based VLAN that you are created using the GVRP Settings page. 

GVRP The Group VLAN Registration Protocol (GVRP) enables the port to dynamically 
become a member of a VLAN. GVRP is Disabled by default. 

Ingress Check This field can be toggled using the space bar between Enabled and Disabled.  
Enabled enables the port to compare the VID tag of an incoming packet with the 
PVID number assigned to the port. If the two are different, the port filters (drops) the 
packet. Disabled disables ingress filtering. Ingress Checking is Enabled by default. 

Acceptable Frame 
Type 

This field denotes the type of frame that will be accepted by the port. The user may 
choose between Tagged Only, which means only VLAN tagged frames will be 
accepted, and Admit_All, which means both tagged and untagged frames will be 
accepted. Admit_All is enabled by default. 

PVID The read-only  field in the GVRP Table shows the current PVID assignment for 
each port, which may be manually assigned to a VLAN when created in the 802.1Q 
Port Settings table. The Switch's default is to assign all ports to the default VLAN 
with a VID of 1. The PVID is used by the port to tag outgoing, untagged packets, 
and to make filtering decisions about incoming packets. If the port is specified to 
accept only tagged frames - as tagging, and an untagged packet is forwarded to the 
port for transmission, the port will add an 802.1Q tag using the PVID to write the 
VID in the tag. When the packet arrives at its destination, the receiving device will 
use the PVID to make VLAN forwarding decisions. If a packet is received by the 
port, and Ingress filtering is enabled, the port will compare the VID of the incoming 
packet to its PVID. If the two are unequal, the port will drop the packet. If the two 
are equal, the port will receive the packet. 

Click Apply to implement changes made. 
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Traffic Control 
Use the Traffic Control menu to enable or disable storm control and adjust the threshold for multicast and broadcast 
storms, as well as DLF (Destination Look Up Failure). Traffic control settings are applied to individual Switch modules. 
To view the following window, click Configuration > Traffic Control: 

 
Figure 6- 42. Traffic Control Settings and Traffic Control Table window 

To configure Traffic Control, first select the Switch’s Unit ID number from the pull-down menu and then a group of ports 
by using the Group pull-down menu. Finally, enable or disable the Broadcast Storm, Multicast Storm and Destination 
Unknown using their corresponding pull-down menus. 

The purpose of this window is to limit too many broadcast, multicast or unknown unicast packets folding the network. 
Each port has a counter that tracks the number of broadcast packets received per second, and this counter is cleared once 
every second. If the broadcast, multicast or unknown unicast storm control is enabled, the port will discard all broadcast, 
multicast or unknown unicast packets received when the counter exceeds or equals the Threshold specified. 

The Threshold value is the upper threshold at which the specified traffic control is switched on. This is the number of 
Broadcast, Multicast or DLF packets, in Kpps (kilo packets per second), received by the Switch that will trigger the storm 
traffic control measures. The Threshold value can be set from 0 to 255 kilo packets per second. The default setting is 128. 
The settings of each port may be viewed in the Traffic Control Table in the same window. Click Apply to implement 
changes made. 
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Port Security 

 
                                                                                      Figure 6- 43. Port Security Settings and Table window 

The following parameters can be set: 

Parameter                    Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From/To A consecutive group of ports may be configured starting with the selected port. 

Admin State This pull-down menu allows the user to enable or disable Port Security (locked MAC 
address table for the selected ports). 

Max. Learning 
Addr. (0-64) 

The number of MAC addresses that will be in the MAC address forwarding table for the 
selected switch and group of ports. 

Mode This pull-down menu allows the option of how the MAC address table locking will be 
implemented on the Switch, for the selected group of ports. The options are:  

• Permanent – The locked addresses will only age out after the Switch has 
been reset. 

• DeleteOnTimeout – The locked addresses will age out after the aging timer 
expires. 

• DeleteOnReset – The locked addresses will not age out until the Switch has 
been reset or rebooted. 

Click Apply to implement changes made. 

A given ports’ (or a range of ports')
dynamic MAC address learning can be
locked such that the current source MAC
addresses entered into the MAC address
forwarding table can not be changed once
the port lock is enabled. The port can be
locked by using the Admin State pull-
down menu to Enabled, and clicking
Apply. 

Port Security is a security feature that
prevents unauthorized computers (with
source MAC addresses) unknown to the
Switch prior to locking the port (or ports)
from connecting to the Switch's locked
ports and gaining access to the network. To
view the following window, click
Configuration > Port Security. 
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Port Lock Entries 

 
Figure 6- 44. Port Lock Entries Table 

This window displays the following information: 

Parameter             Description 

VID The VLAN ID of the entry in the forwarding database table that has been permanently 
learned by the Switch. 

VLAN NAME The VLAN Name of the entry in the forwarding database table that has been permanently 
learned by the Switch. 

MAC Address The MAC address of the entry in the forwarding database table that has been permanently 
learned by the Switch. 

Unit The ID number of the Switch in the switch stack that has permanently learned the MAC 
address. 

Port The ID number of the port that has permanently learned the MAC address. 

Type The type of MAC address in the forwarding database table. Only entries marked 
Secured_Permanent can be deleted. 

Delete 
Click the  in this field to delete the corresponding MAC address that was permanently 
learned by the Switch. 

The Port Lock Entry Delete window is used
to remove an entry from the port security
entries learned by the Switch and entered into
the forwarding database. To view this window,
click Configuration > Port Lock Entries. 

This function is only operable if the Mode in
the Port Security window is selected as
Permanent or DeleteOnReset, or in other
words, only addresses that are permanently
learned by the Switch can be deleted. Once the
entry has been defined by entering the correct
information into the window above, click the 
under the Delete heading of the corresponding
MAC address to be deleted. Click the Next
button to view the next page of entries listed in
this table. 
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QoS 
The xStack DGS/DXS-3300 Switch Series supports 802.1p priority queuing Quality of Service. The following section 
discusses the implementation of QoS (Quality of Service) and benefits of using 802.1p priority queuing.   

The Advantages of QoS  
QoS is an implementation of the IEEE 802.1p standard that allows network administrators a method of reserving 
bandwidth for important functions that require a large bandwidth or have a high priority, such as VoIP (voice-over Internet 
Protocol), web browsing applications, file server applications or video conferencing. Not only can a larger bandwidth be 
created, but other less critical traffic can be limited, so excessive bandwidth can be saved. The Switch has separate 
hardware queues on every physical port to which packets from various applications can be mapped to, and, in turn 
prioritized. View the following map to see how the xStack DGS/DXS-3300 Switch Series implements basic 802.1P 
priority queuing. 

 
Figure 6- 45. An Example of the Default QoS Mapping on the Switch 

The picture above shows the default priority setting for the Switch. Class-6 has the highest priority of the seven priority 
classes of service on the Switch. In order to implement QoS, the user is required to instruct the Switch to examine the 
header of a packet to see if it has the proper identifying tag. Then the user may forward these tagged packets to designated 
classes of service on the Switch where they will be emptied, based on priority.  

For example, lets say a user wishes to have a video conference between two remotely set computers. The administrator can 
add priority tags to the video packets being sent out, utilizing the Access Profile commands. Then, on the receiving end, 
the administrator instructs the Switch to examine packets for this tag, acquires the tagged packets and maps them to a class 
queue on the Switch. Then in turn, the administrator will set a priority for this queue so that will be emptied before any 
other packet is forwarded. This results in the end user receiving all packets sent as quickly as possible, thus prioritizing the 
queue and allowing for an uninterrupted stream of packets, which optimizes the use of bandwidth available for the video 
conference.                                                                                                                                                                                      
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Understanding QoS 
The Switch has eight priority classes of service, one of which is internal and not configurable. These priority classes of 
service are labeled as 6, the high class to 0, the lowest class. The eight priority tags, specified in IEEE 802.1p are mapped 
to the Switch's priority classes of service as follows: 

• Priority 0 is assigned to the Switch's Q2 class. 

• Priority 1 is assigned to the Switch's Q0 class. 

• Priority 2 is assigned to the Switch's Q1 class. 

• Priority 3 is assigned to the Switch's Q3 class. 

• Priority 4 is assigned to the Switch's Q4 class. 

• Priority 5 is assigned to the Switch's Q5 class. 

• Priority 6 is assigned to the Switch's Q6 class. 

• Priority 7 is assigned to the Switch's Q6 class. 

For strict priority-based scheduling, any packets residing in the higher priority classes of service are transmitted first. 
Multiple strict priority classes of service are emptied based on their priority tags. Only when these classes are empty, are 
packets of lower priority transmitted.   

For weighted round-robin queuing, the number of packets sent from each priority queue depends upon the assigned weight. 
For a configuration of 8 CoS queues, A~H with their respective weight value: 8~1, the packets are sent in the following 
sequence: A1, B1, C1, D1, E1, F1, G1, H1, A2, B2, C2, D2, E2, F2, G2, A3, B3, C3, D3, E3, F3, A4, B4, C4, D4, E4, A5, 
B5, C5, D5, A6, B6, C6, A7, B7, A8, A1, B1, C1, D1, E1, F1, G1, H1. 

For weighted round-robin queuing, if each CoS queue has the same weight value, then each CoS queue has an equal 
opportunity to send packets just like round-robin queuing. 

For weighted round-robin queuing, if the weight for a CoS is set to 0, then it will continue processing the packets from this 
CoS until there are no more packets for this CoS. The other CoS queues that have been given a nonzero value, and 
depending upon the weight, will follow a common weighted round-robin scheme. 

Remember that the xStack DGS/DXS-3300 Switch Series has 7 configurable priority queues (and seven Classes of Service) 
for each port on the Switch. 

 

NOTICE: The Switch contains eight classes of service for each port on 
the Switch. One of these classes is reserved for internal use on the 
Switch and is therefore not configurable. All references in the following 
section regarding classes of service will refer to only the seven classes of 
service that may be used and configured by the Switch’s Administrator. 
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Bandwidth Control 
The bandwidth control settings are used to place a ceiling on the transmitting and receiving data rates for any selected port. 
In the Configuration folder, click QoS > Bandwidth Control, to view the screen shown below. 

 
Figure 6- 46. Bandwidth Settings and Port Bandwidth Table window 

The following parameters can be set or are displayed: 

Parameter                       Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From/To A consecutive group of ports may be configured starting with the selected port. 

Type This drop-down menu allows a selection between RX (receive,) TX (transmit,) and 
Both. This setting will determine whether the bandwidth ceiling is applied to receiving, 
transmitting, or both receiving and transmitting packets. 

No Limit This drop-down menu allows the user to specify that the selected port will have no 
bandwidth limit. Enabled disables the limit. 

Rate This field allows the input of the data rate, in Mbit/s, that will be the limit for the 
selected port. The user may choose a rate between 1 and 9999 Mbit/s. 

Click Apply to set the bandwidth control for the selected ports. Results of configured Bandwidth Settings will be 
displayed in the Port Bandwidth Table. 
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QoS Scheduling Mechanism 
This drop-down menu allows a selection between a Weight Fair and a Strict mechanism for emptying the priority classes. 
In the Configuration menu open the QoS folder and click QoS Scheduling Mechanism, to view the screen shown below. 

 
Figure 6- 47. QoS Scheduling Mechanism and QoS Scheduling Mechanism Table window 

The Scheduling Mechanism has the following parameters. 

Parameter                      Description 

Strict The highest class of service is the first to process traffic. That is, the highest class of 
service will finish before other queues empty. 

Weight fair Use the weighted round-robin (WRR) algorithm to handle packets in an even 
distribution in priority classes of service. 

Click Apply to let your changes take effect. 
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QoS Output Scheduling 
QoS can be customized by changing the output scheduling used for the hardware classes of service in the Switch. As with 
any changes to QoS implementation, careful consideration should be given to how network traffic in lower priority classes 
of service is affected. Changes in scheduling may result in unacceptable levels of packet loss or significant transmission 
delay. If choosing to customize this setting, it is important to monitor network performance, especially during peak demand, 
as bottlenecks can quickly develop if the QoS settings are not suitable. In the Configuration folder open the QoS folder 
and click QoS Output Scheduling , to view the screen shown below. 

 
Figure 6- 48. QoS Output Scheduling Configuration window 

The following values may be assigned to the QoS classes to set the scheduling. 

Parameter                              Description 

Max. Packets Specifies the maximum number of packets the above specified hardware priority 
class of service will be allowed to transmit before allowing the next lowest priority 
queue to transmit its packets. A value between 0 and 15 can be specified. 

Click Apply to implement changes made. 

 

NOTE: Entering a 0 for the Max Packets field in the QoS Output 
Scheduling Configuration window above will create a Combination 
Queue. For more information on implementation of this feature, see the 
next section, Configuring the Combination Queue. 
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Configuring the Combination Queue 
Utilizing the QoS Output Scheduling Configuration window shown above, the xStack DGS/DXS-3300 Series can 
implement a combination queue for forwarding packets. This combination queue allows for a combination of strict and 
weight-fair (weighted round-robin “WRR”) scheduling for emptying given classes of service. To set the combination 
queue, enter a 0 for the Max Packets entry of the corresponding priority classes of service listed in the window above. 
Priority classes of service that have a 0 in the Max Packet field will forward packets with strict priority scheduling. The 
remaining classes of service, that do not have a 0 in their Max Packet field, will follow a weighted round-robin (WRR) 
method of forwarding packets — as long as the priority classes of service with a 0 in their Max Packet field are empty. 
When a packet arrives in a priority class with a 0 in its Max Packet field, this class of service will automatically begin 
forwarding packets until it is empty. Once a priority class of service with a 0 in its Max Packet field is empty, the 
remaining priority classes of service will reset the weighted round-robin (WRR) cycle of forwarding packets, starting with 
the highest available priority class of service. Priority classes of service with an equal level of priority and equal entries in 
their Max Packet field will empty their fields based on hardware priority scheduling. The Max Packet parameter allows 
the maximum number of packets a given priority class of service can transmit per weighted round-robin (WRR) scheduling 
cycle to be selected. This provides for a controllable CoS behavior while allowing other classes to empty as well. A value 
between 0 and 15 packets can be specified per priority class of service to create the combination queue.  

The example window below displays an example of the combination queue where Class-1 will have a strict priority for 
emptying its class, while the other classes will follow a weight fair scheduling. 

 
Figure 6- 49. QoS Output Scheduling window – Combination queue example 
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802.1p Default Priority 
The Switch allows the assignment of a default 802.1p priority to each port on the Switch. In the Configuration folder open 
the QoS folder and click 802.1p Default Priority, to view the screen shown below. 

 
Figure 6- 50. 802.1p Default Priority and the 802.1p Default Priority for Unit 1 window 

This page allows the user to assign a default 802.1p priority to any given port on the Switch. The priority tags are 
numbered from 0, the lowest priority, to 7, the highest priority. To implement a new default priority, choose the Switch of 
the Switch stack to be configured by using the Unit pull-down menu, choose a port range by using the From and To pull-
down menus and then insert a priority value, from 0-7 in the Priority field. Click Apply to implement settings made. 
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802.1p User Priority 
The xStack DGS/DXS-3300 Switch Series allows the assignment of a class of service to each of the 802.1p priorities. In 
the Configuration folder open the QoS folder and click 802.1p User Priority, to view the screen shown below. 

 
Figure 6- 51. 802.1p User Priority window 

Once a priority has been assigned to the port groups on the Switch, then a Class may be assigned to each of the eight levels 
of 802.1p priorities. Click Apply to set changes made. 

Traffic Segmentation 
Traffic segmentation is used to limit traffic flow from a single port to a group of ports on either a single Switch (in 
standalone mode) or a group of ports on another switch in a switch stack. This method of segmenting the flow of traffic is 
similar to using VLANs to limit traffic, but is more restrictive. It provides a method of directing traffic that does not 
increase the overhead of the Master switch CPU. 

In the Configuration folder open the QoS folder and click Traffic Segmentation, to view the screen shown below. 

 
Figure 6- 52. Current Traffic Segmentation Table  
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Click on the Setup button to open the Setup Forwarding ports page, as shown below. 

 
Figure 6- 53. Setup Forwarding Ports window 

This page allows the user to determine which port on a given switch in a switch stack will be allowed to forward packets to 
other ports on that switch. 

Configuring traffic segmentation on the xStack DGS/DXS-3300 Switch Series is accomplished in two parts. First, specify 
a switch from a switch stack by using the Unit pull-down menu, and then a port from that switch, using the Port pull-down 
menu. Then specify a second switch from the switch stack, and then, select which ports (or different ports on the same 
switch,) on that switch that are able to receive packets from the switch and port specified in the first part. 

Clicking the Apply button will enter the combination of transmitting port and allowed receiving ports into the Switch’s 
Traffic Segmentation table. 

The Unit drop-down menu at the top of the page allows the user to select a switch from a switch stack using that switch’s 
Unit ID. The Port drop-down menu allows the user to select a port from that switch. This is the port that will be 
transmitting packets. 

The Unit drop-down menu under the Setup Forwarding ports heading allows the selection of a switch from a switch stack 
using that switch’s Unit ID. The Forward Port click boxes allow the user to select which of the ports on the selected 
switch will be able to forward packets. These ports will be allowed to receive packets from the port specified above. 

Click Apply to enter the settings into the Switch’s Traffic Segmentation table. 

Clicking the Apply button will enter the combination of transmitting port and allowed receiving ports into the Switch's 
Traffic Segmentation Table. 
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System Log Host 
The Switch can send Syslog messages to up to four designated servers using the System Log Host window. In the 
Configuration folder, click System Log Host, to view the screen shown below. 

 
Figure 6- 54. System Log Host window 

The parameters configured for adding and editing System Log Server settings are the same. To add a new Syslog Server, 
click the Add button. To modify a current entry, click the hyperlinked number of the server in the Index field. Both actions 
will result in the same screen to configure. See the table below for a description of the parameters in the following window. 

 
Figure 6- 55. Configure System Log Server – Edit window 

The following parameters can be set: 

Parameter                    Description 

Index Syslog server settings index (1-4). 

Server IP The IP address of the Syslog server. 

Severity This drop-down menu allows the user to select the level of messages that will be sent. 
The options are Warning, Informational, and All. 

Facility Some of the operating system daemons and processes have been assigned Facility 
values. Processes and daemons that have not been explicitly assigned a Facility may 
use any of the "local use" facilities or they may use the "user-level" Facility. Those 
Facilities that have been designated are shown in the following. Bold font denotes the 
facility values that the Switch currently implements. 

Numerical       Facility 

Code 

0         kernel messages 
1         user-level messages 
2         mail system 
3         system daemons 
4         security/authorization messages 
5         messages generated internally by syslog line printer subsystem 
7         network news subsystem 
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8         UUCP subsystem 
9         clock daemon 
10       security/authorization messages 
11       FTP daemon 
12       NTP subsystem 
13       log audit 
14       log alert 
15       clock daemon 
16       local use 0  (local0) 
17       local use 1  (local1) 
18       local use 2  (local2) 
19       local use 3  (local3) 
20       local use 4  (local4) 
21       local use 5  (local5) 
22       local use 6  (local6) 
23       local use 7  (local7) 

UDP Port (514 or 
6000-65535) 

Enter the UDP port number used for sending Syslog messages. The default is 514. 

Status Choose Enabled or Disabled to activate or deactivate. 

To set the System Log Server configuration, click Apply. To delete an entry from the Current System Log Server 

window, click the corresponding  under the Delete heading of the entry to delete. To return to the Current System 
Log Servers window, click the Show All System Log Servers link. 

 

NOTE: For detailed information regarding Log entries that will appear in 
this window, please refer to Appendix C at the back of this manual. 
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SNTP Settings 
Time Settings 
To configure the time settings for the Switch, open the Configuration folder, then the SNTP folder and click on the Time 
Settings link, revealing the following screen for the user to configure. 

 
Figure 6- 56. Current Time Settings window 

The following parameters can be set or are displayed: 

Parameter                       Description 

Time Settings - Current Time  

System Boot Time Displays the time when the Switch was initially started for this session. 

Current Time Displays the current time. 

Time Source Displays the source of the time settings viewed here.  

SNTP Settings 

SNTP State Use this pull-down menu to Enable or Disable SNTP. 

SNTP Primary Server The IP address of the primary server the SNTP information will be taken from. 

SNTP Secondary 
Server 

The IP address of the secondary server the SNTP information will be taken from. 
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SNTP Poll Interval in 
Seconds (30-99999) 

The interval, in seconds, between requests for updated SNTP information. 

Time Settings - Set Current Time 

Year Enter the current year, to update the system clock. 

Month Enter the current month, to update the system clock. 

Day Enter the current day, to update the system clock. 

Time in HH MM SS Enter the current time in hours and minutes, to update the system clock. 

Click Apply to implement your changes. 

Time Zone and DST 
The following are screens used to configure time zones and Daylight Savings time settings for SNTP. Open the 
Configuration folder, then the SNTP folder and click on the Time Zone and DST link, revealing the following screen. 

 
Figure 6- 57. Time Zone and DST Settings window 

The following parameters can be set: 
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Parameter                   Description 

Time Zone and DST 

Daylight Saving 
Time State 

Use this pull-down menu to Enable or Disable the DST Settings. 

Daylight Saving 
Time Offset in 
Minutes 

Use this pull-down menu to specify the amount of time that will constitute your local DST 
offset - 30, 60, 90, or 120 minutes. 

Time Zone Offset 
from GMT in +/- 
HH:MM 

Use these pull-down menus to specify your local time zone's offset from Greenwich 
Mean Time (GMT.) 

DST Repeating Settings - Using repeating mode will enable DST seasonal time adjustment. Repeating mode 
requires that the DST beginning and ending date be specified using a formula. For example, specify to begin 
DST on Saturday during the second week of April and end DST on Sunday during the last week of October. 

From: Which Day Enter the week of the month that DST will start.  

From: Day of Week Enter the day of the week that DST will start on.  

From: Month Enter the month DST will start on. 

From: Time in 
HH:MM 

Enter the time of day that DST will start on. 

To: Which Day Enter the week of the month the DST will end. 

To: Day of Week Enter the day of the week that DST will end. 

To: Month Enter the month that DST will end. 

To: time in HH:MM Enter the time DST will end. 

DST Annual Settings - Using annual mode will enable DST seasonal time adjustment. Annual mode requires 
that the DST beginning and ending date be specified concisely. For example, specify to begin DST on April 3 
and end DST on October 14. 

From: Month Enter the month DST will start on, each year. 

From: Day Enter the day of the month DST will start on, each year. 

From: Time in 
HH:MM 

Enter the time of day DST will start on, each year. 

To: Month Enter the month DST will end on, each year. 

To: Day Enter the day of the month DST will end on, each year. 

To: Time in HH:MM Enter the time of day that DST will end on, each year. 

Click Apply to implement changes made to the Time Zone and DST window. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

101 

     

Access Profile Table 
Configuring the Access Profile Table 
Access profiles allow the user to establish criteria to determine whether the Switch will forward packets based on the 
information contained in each packet's header. These criteria can be specified on a basis of VLAN, MAC address, IP 
address and now IPv6. 

The user now also has the option of mirroring packets to a selected port for further scrutiny. Configured in the Mode field 
of the Access Profile Rule, the Switch administrator may now copy and send packets that match the criteria specified to a 
mirror port, in conjunction with the Port Mirroring function. For this mirror function to work, the Port Mirroring function 
must be globally enabled and a Mirror target port must be set. Certain restrictions apply to the Access Profile Mirror 
function: 

1. Since this function is capable through the FFP (FAST Filter Processor) of the chip, only ingress packets can be 
mirrored. 

2. The ACL Mirror function is resticted to the rules of the Port Mirroring function. Therefore, mirrored ports can not 
be cross-box, that is, the ports cannot be set across switches in a switch stack. Also, the Port Mirroring function 
shares the mirror port with the ACL Mirror function. 

Creating an access profile is divided into two basic parts. The first is to specify which part or parts of a frame the Switch 
will examine, such as the MAC source address or the IP destination address. The second part is entering the criteria the 
Switch will use to determine what to do with the frame. The entire process is described below in two parts. 

To display the currently configured Access Profiles on the Switch, open the Configuration folder and click on the Access 
Profile Table link. This will open the Access Profile Table page, as shown below. 

 
Figure 6- 58. Access Profile Table 

To add an entry to the Access Profile Table, click the Add button. This will open the Access Profile Configuration page, 
as shown below. There are three Access Profile Configuration pages; one for Ethernet (or MAC address-based) profile 
configuration, one for IP address-based profile configuration, one for the Packet Content Mask and one for IPv6. The 
user can switch between the three Access Profile Configuration pages by using the Type drop-down menu. The page 
shown below is the Ethernet Access Profile Configuration page. 
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Figure 6- 59. Access Profile Configuration (Ethernet) window 

The following parameters can be set, for the Ethernet type: 

Parameter                       Description 

Profile ID (1-8) Type in a unique identifier number for this profile set. This value can be set from 1 - 8.

Type Select profile based on Ethernet (MAC Address), IP address, packet content mask or 
IPv6. This will change the menu according to the requirements for the type of profile.  

• Select Ethernet to instruct the Switch to examine the layer 2 part of each 
packet header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the 
packet header. 

• Select IPv6 to instruct the Switch to examine the IPv6 part of each packet 
header. 

VLAN Selecting this option instructs the Switch to examine the VLAN identifier of each 
packet header and use this as the full or partial criterion for forwarding. 

Source MAC Source MAC Mask - Enter a MAC address mask for the source MAC address. 

Destination MAC Destination MAC Mask - Enter a MAC address mask for the destination MAC 
address. 

802.1p Selecting this option instructs the Switch to examine the 802.1p priority value of each 
packet header and use this as the, or part of the criterion for forwarding. 

Ethernet type Selecting this option instructs the Switch to examine the Ethernet type value in each 
frame's header. 
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The page shown below is the IP Access Profile Configuration page. 

 
Figure 6- 60. Access Profile Configuration (IP) window 

The following parameters can be set, for IP: 

Parameter                        Description 

Profile ID (1-8) Type in a unique identifier number for this profile set. This value can be set from 1 - 8.

Type Select profile based on Ethernet (MAC Address), IP address, Packet Content Mask or 
IPv6. This will change the menu according to the requirements for the type of profile.  

• Select Ethernet to instruct the Switch to examine the layer 2 part of each 
packet header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the 
packet header. 

• Select IPv6 to instruct the Switch to examine the IPv6 part of each packet 
header. 

VLAN Selecting this option instructs the Switch to examine the VLAN part of each packet 
header and use this as the, or part of the criterion for forwarding. 

Source IP Mask Enter an IP address mask for the source IP address. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

104 

     

Destination IP Mask Enter an IP address mask for the destination IP address. 

DSCP Selecting this option instructs the Switch to examine the DiffServ Code part of each 
packet header and use this as the, or part of the criterion for forwarding. 

Protocol Selecting this option instructs the Switch to examine the protocol type value in each 
frame's header, then specify what protocol(s) to include according to the following 
guidelines:  

Select ICMP to instruct the Switch to examine the Internet Control Message Protocol 
(ICMP) field in each frame's header.  

• Select Type to further specify that the access profile will apply an ICMP type 
value, or specify Code to further specify that the access profile will apply an 
ICMP code value. 

Select IGMP to instruct the Switch to examine the Internet Group Management 
Protocol (IGMP) field in each frame's header.  

• Select Type to further specify that the access profile will apply an IGMP type 
value 

Select TCP to use the TCP port number contained in an incoming packet as the 
forwarding criterion. Selecting TCP requires specification that a source port mask 
and/or a destination port mask. The user may also identify which flag bits to filter. Flag 
bits are parts of a packet that determine what to do with the packet. The user may 
filter packets by filtering certain flag bits within the packets, by checking the boxes 
corresponding to the flag bits of the TCP field. The user may choose between urg 
(urgent), ack (acknowledgement), psh (push), rst (reset), syn (synchronize), fin 
(finish). 

• src port mask - Specify a TCP port mask for the source port in hex form 
(hex 0x0-0xffff), to filter. 

• dest port mask - Specify a TCP port mask for the destination port in hex 
form (hex 0x0-0xffff) to filter. 

Select UDP to use the UDP port number contained in an incoming packet as the 
forwarding criterion. Selecting UDP requires specification of a source port mask 
and/or a destination port mask.  

• src port mask - Specify a TCP port mask for the source port in hex form 
(hex 0x0-0xffff). 

• dest port mask - Specify a TCP port mask for the destination port in hex 
form (hex 0x0-0xffff). 

protocol id - Enter a value defining the protocol ID in the packet header to mask. 
Specify the protocol ID mask in hex form (hex 0x0-0xffffffff). 
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The page shown below is the Packet Content Mask configuration window. 

 
Figure 6- 61. Access Profile Configuration (Packet Content Mask) window  

This screen will aid the user in configuring the Switch to mask packet headers beginning with the offset value specified. 
The following fields are used to configure the Packet Content Mask: 

Parameter                 Description 

Profile ID (1-8) Type in a unique identifier number for this profile set. This value can be set from 1 - 8. 

Type Select profile based on Ethernet (MAC Address), IP address, packet content mask or 
IPv6. This will change the menu according to the requirements for the type of profile. 

• Select Ethernet to instruct the Switch to examine the layer 2 part of each packet 
header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the packet 
header. 

• Select IPv6 to instruct the Switch to examine the IPv6 part of each packet 
header. 
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Offset This field will instruct the Switch to mask the packet header beginning with the offset value 
specified: 

• value (0-15) - Enter a value in hex form to mask the packet from the beginning 
of the packet to the 15th byte. 

• value (16-31) – Enter a value in hex form to mask the packet from byte 16 to 
byte 31. 

• value (32-47) – Enter a value in hex form to mask the packet from byte 32 to 
byte 47. 

• value (48-63) – Enter a value in hex form to mask the packet from byte 48 to 
byte 63. 

• value (64-79) – Enter a value in hex form to mask the packet from byte 64 to 
byte 79. 

Click Apply to implement changes made. 

The page shown below is the IPv6 configuration window. 

 
Figure 6- 62. Access Profile Configuration (IPv6) window  

The following parameters can be set, for IP: 

Parameter  Description 

Profile ID (1-8) Type in a unique identifier number for this profile set. This value can be set from 1 - 8.

Type Select profile based on Ethernet (MAC Address), IP address, Packet Content Mask or 
IPv6. This will change the menu according to the requirements for the type of profile.  

• Select Ethernet to instruct the Switch to examine the layer 2 part of each 
packet header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the 
packet header. 

• Select IPv6 to instruct the Switch to examine the IPv6 part of each packet 
header. 
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Class Checking this field will instruct the Switch to examine the class field of the IPv6 
header. This class field is a part of the packet header that is similar to the Type of 
Service (ToS) or Precedence bits field in IPv4. 

Flowlabel Checking this field will instruct the Switch to examine the flow label field of the IPv6 
header. This flow label field is used by a source to label sequences of packets such 
as non-default quality of service or real time service packets. 

Source IPv6 Mask The user may specify an IP address mask for the source IPv6 address by checking 
the corresponding box and entering the IP address mask. 

Destination IPv6 
Mask 

The user may specify an IP address mask for the destination IPv6 address by 
checking the corresponding box and entering the IP address mask. 

Click Apply to implement changes made. 

To establish the rule for a previously created Access Profile: 

To configure the Access Rule for Ethernet, open the Access Profile Table and click Modify for an Ethernet entry. This 
will open the following screen: 

 
Figure 6- 63. Access Rule Table 

To remove a previously created rule, select it and click the  button. To add a new Access Rule, click the Add button: 

 
Figure 6- 64. Access Rule Configuration window - Ethernet. 

To set the Access Rule for Ethernet, adjust the following parameters and click Apply. 
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Parameters               Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded by 
the Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded by the 
Switch and will be filtered. 

Select Mirror to specify that packets that match the access profile are mirrored to a port 
defined in the Port Mirroring window. Port Mirroring must be enabled and a target port 
must be set. Remember, Port Mirroring cannot cross-box, that is they cannot span across 
switches in a switch stack. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 65535. 

• Auto Assign – Checking this field will instruct the Switch to automatically assign 
an Access ID for the rule being created. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content Mask or 
IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet header. 

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Priority (0-7) This parameter is specified to re-write the 802.1p default priority previously set in the 
Switch, which is used to determine the CoS queue to which packets are forwarded to. 
Once this field is specified, packets accepted by the Switch that match this priority are 
forwarded to the CoS queue specified previously by the user. 

Replace priority with − Click the corresponding box to re-write the 802.1p default priority of 
a packet to the value entered in the Priority field, which meets the criteria specified 
previously in this command, before forwarding it on to the specified CoS queue. 
Otherwise, a packet will have its incoming 802.1p user priority re-written to its original 
value before being forwarded by the Switch. 

For more information on priority queues, CoS queues and mapping for 802.1p, see the 
QoS section of this manual. 

Replace DSCP (0-
63) 

Select this option to instruct the Switch to replace the DSCP value (in a packet that meets 
the selected criteria) with the value entered in the adjacent field. 

VLAN Name Allows the entry of a name for a previously configured VLAN. 

Source MAC Source MAC Address - Enter a MAC Address for the source MAC address. 

Destination MAC Destination MAC Address - Enter a MAC Address mask for the destination MAC address. 

802.1p (0-7) Enter a value from 0-7 to specify that the access profile will apply only to packets with this 
802.1p priority value. 

Ethernet Type Specifies that the access profile will apply only to packets with this hexadecimal 802.1Q 
Ethernet type value (hex 0x0-0xffff) in the packet header. The Ethernet type value may be 
set in the form: hex 0x0-0xffff, which means the user may choose any combination of 
letters and numbers ranging from a-f and from 0-9999. 

Port The Access Rule may be configured on a per-port basis by entering the port number of 
the switch in the switch stack into this field When a range of ports is to be configured the
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the switch in the switch stack into this field. When a range of ports is to be configured, the 
Auto Assign check box MUST be clicked in the Access ID field of this window. If not, the 
user will be presented with an error message and the access rule will not be configured. 
The port list is specified by listing the lowest switch number and the beginning port 
number on that switch, separated by a colon. Then the highest switch number, and the 
highest port number of the range (also separated by a colon) are specified. The beginning 
and end of the port list range are separated by a dash. For example, 1:3 specifies switch 
number 1, port 3. 2:4 specifies switch number 2, port 4. 1:3 - 2:4 specifies all of the ports 
between switch 1, port 3 and switch 2, port 4 − in numerical order. Entering all will denote 
all ports on the Switch. 

To view the settings of a previously correctly configured rule, click  in the Access Rule Table to view the following 
screen: 

 
Figure 6- 65. Access Rule Display window (Ethernet) 

 

NOTE: When using the ACL Mirror function, ensure that the Port Mirroring 
function is enabled and a target mirror port is set. 

 

In the Configuration folder, click the Access Profile Table link opening the Access Profile Table. Under the heading 
Access Rule, clicking Modify, will open the following window. 

 
Figure 6- 66. Access Rule Table window – IP  

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously 
created rule, click the corresponding  button. 
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Figure 6- 67. Access Rule Configuration window (IP) 

Configure the following Access Rule Configuration settings for IP: 

Parameter                Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded by 
the Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded by the 
Switch and will be filtered. 

Select Mirror to specify that packets that match the access profile are mirrored to a port 
defined in the Port Mirroring window. Port Mirroring must be enabled and a target port 
must be set. Remember, Port Mirroring cannot cross-box, that is they cannot span across 
switches in a switch stack. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 65535. 

• Auto Assign – Checking this field will instruct the Switch to automatically assign an 
Access ID for the rule being created. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content Mask or 
IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Priority (0-7) This parameter is specified to re-write the 802.1p default priority previously set in the 
Switch, which is used to determine the CoS queue to which packets are forwarded to. 
Once this field is specified, packets accepted by the Switch that match this priority are 
forwarded to the CoS queue specified previously by the user. 

Replace priority with − Click the corresponding box to re-write the 802.1p default priority of 
a packet to the value entered in the Priority field, which meets the criteria specified 
previously in this command, before forwarding it on to the specified CoS queue. 
Otherwise, a packet will have its incoming 802.1p user priority re-written to its original 
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value before being forwarded by the Switch. 

For more information on priority queues, CoS queues and mapping for 802.1p, see the 
QoS section of this manual. 

Replace Dscp (0-
63) 

Select this option to instruct the Switch to replace the DSCP value (in a packet that meets 
the selected criteria) with the value entered in the adjacent field. 

VLAN Name Allows the entry of a name for a previously configured VLAN. 

Source IP Source IP Address - Enter an IP Address mask for the source IP address. 

Destination IP Destination IP Address- Enter an IP Address mask for the destination IP address. 

Dscp (0-63) This field allows the user to enter a DSCP value in the space provided, which will instruct 
the Switch to examine the DiffServ Code part of each packet header and use this as the, 
or part of the criterion for forwarding. The user may choose a value between 0 and 63. 

Protocol This field allows the user to modify the protocol used to configure the Access Rule Table; 
depending on which protocol the user has chosen in the Access Profile Table.  

Port The Access Rule may be configured on a per-port basis by entering the port number of 
the switch in the switch stack into this field. When a range of ports is to be configured, the 
Auto Assign check box MUST be clicked in the Access ID field of this window. If not, the 
user will be presented with an error message and the access rule will not be configured. 
The port list is specified by listing the lowest switch number and the beginning port 
number on that switch, separated by a colon. Then the highest switch number, and the 
highest port number of the range (also separated by a colon) are specified. The beginning 
and end of the port list range are separated by a dash. For example, 1:3 specifies switch 
number 1, port 3. 2:4 specifies switch number 2, port 4. 1:3 - 2:4 specifies all of the ports 
between switch 1, port 3 and switch 2, port 4 − in numerical order. Entering all will denote 
all ports on the Switch. 

To view the settings of a previously correctly configured rule, click  in the Access Rule Table to view the following 
screen: 

 
Figure 6- 68. Access Rule Display window (IP) 

To configure the Access Rule for Packet Content Mask, open the Access Profile Table and click Modify for a Packet 
Content Mask entry. This will open the following screen: 
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NOTE: When using the ACL Mirror function, ensure that the Port Mirroring 
function is enabled and a target mirror port is set. 

 

 
Figure 6- 69. Access Rule Table (Packet Content Mask) 

To remove a previously created rule, select it and click the  button. To add a new Access Rule, click the Add button: 

 
Figure 6- 70. Access Rule Configuration - Packet Content Mask 

To set the Access Rule for the Packet Content Mask, adjust the following parameters and click Apply. 
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Parameter                    Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded by 
the Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded by 
the Switch and will be filtered. 

Select Mirror to specify that packets that match the access profile are mirrored to a port 
defined in the Port Mirroring window. Port Mirroring must be enabled and a target port 
must be set. Remember, Port Mirroring cannot cross-box, that is they cannot span 
across switches in a switch stack. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 65535.

• Auto Assign – Checking this field will instruct the Switch to automatically 
assign an Access ID for the rule being created. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content Mask or 
IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Priority This parameter is specified to re-write the 802.1p default priority previously set in the 
Switch, which is used to determine the CoS queue to which packets are forwarded to. 
Once this field is specified, packets accepted by the Switch that match this priority are 
forwarded to the CoS queue specified previously by the user. 

Replace priority with − Click the corresponding box if you want to re-write the 802.1p 
default priority of a packet to the value entered in the Priority field, which meets the 
criteria specified previously in this command, before forwarding it on to the specified 
CoS queue. Otherwise, a packet will have its incoming 802.1p user priority re-written to 
its original value before being forwarded by the Switch. 

For more information on priority queues, CoS queues and mapping for 802.1p, see the 
QoS section of this manual. 

Replace DSCP (0-
63) 

Select this option to instruct the Switch to replace the DSCP value (in a packet that 
meets the selected criteria) with the value entered in the adjacent field. 

Offset This field will instruct the Switch to mask the packet header beginning with the offset 
value specified: 

• value (0-15) - Enter a value in hex form to mask the packet from the beginning 
of the packet to the 15th byte. 

• value (16-31) - Enter a value in hex form to mask the packet from byte 16 to 
byte 31. 

• value (32-47) - Enter a value in hex form to mask the packet from byte 32 to 
byte 47. 

• value (48-63) - Enter a value in hex form to mask the packet from byte 48 to 
byte 63. 

• value (64-79) - Enter a value in hex form to mask the packet from byte 64 to 
byte 79. 
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Port The Access Rule may be configured on a per-port basis by entering the port number of 
the switch in the switch stack into this field. When a range of ports is to be configured, 
the Auto Assign check box MUST be clicked in the Access ID field of this window. If 
not, the user will be presented with an error message and the access rule will not be 
configured. The port list is specified by listing the lowest switch number and the 
beginning port number on that switch, separated by a colon. Then the highest switch 
number, and the highest port number of the range (also separated by a colon) are 
specified. The beginning and end of the port list range are separated by a dash. For 
example, 1:3 specifies switch number 1, port 3. 2:4 specifies switch number 2, port 4. 
1:3 - 2:4 specifies all of the ports between switch 1, port 3 and switch 2, port 4 − in 
numerical order. Entering all will denote all ports on the Switch. 

To view the settings of a previously correctly configured rule, click  in the Access Rule Table to view the following 
screen: 

 
Figure 6- 71. Access Rule Display window (Packet Content Mask) 

 

NOTE: When using the ACL Mirror function, ensure that the Port Mirroring 
function is enabled and a target mirror port is set. 

 

To configure the Access Rule for IPv6, open the Access Profile Table and click Modify for an IPv6 entry. This will open 
the following screen: 
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Figure 6- 72. Access Profile Table (IPv6) 

To remove a previously created rule, select it and click the  button. To add a new Access Rule, click the Add button: 

 
Figure 6- 73. Access Rule Configuration – IPv6 

To set the Access Rule for the Packet Content Mask, adjust the following parameters and click Apply. 

Parameter                    Description 
Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded 
by the Switch, according to any additional rule added (see below). 
Select Deny to specify that packets that match the access profile are not forwarded 
by the Switch and will be filtered. 
Select Mirror to specify that packets that match the access profile are mirrored to a 
port defined in the Port Mirroring window. Port Mirroring must be enabled and a target 
port must be set. Remember, Port Mirroring cannot cross-box, that is they cannot 
span across switches in a switch stack. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 
65535. 

• Auto Assign – Checking this field will instruct the Switch to automatically 
assign an Access ID for the rule being created. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content Mask 
or IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  
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• Packet Content Mask instructs the Switch to examine the packet header. 
• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Priority This parameter is specified to re-write the 802.1p default priority previously set in the 
Switch, which is used to determine the CoS queue to which packets are forwarded to. 
Once this field is specified, packets accepted by the Switch that match this priority are 
forwarded to the CoS queue specified previously by the user. 
Replace priority with − Click the corresponding box to re-write the 802.1p default 
priority of a packet to the value entered in the Priority field, which meets the criteria 
specified previously in this command, before forwarding it on to the specified CoS 
queue. Otherwise, a packet will have its incoming 802.1p user priority re-written to its 
original value before being forwarded by the Switch. 
For more information on priority queues, CoS queues and mapping for 802.1p, see 
the QoS section of this manual. 

Class Entering a value between 0 and 255 will instruct the Switch to examine the class field 
of the IPv6 header. This class field is a part of the packet header that is similar to the 
Type of Service (ToS) or Precedence bits field of IPv4. 

Flowlabel Configuring this field, in hex form, will instruct the Switch to examine the flow label 
field of the IPv6 header. This flow label field is used by a source to label sequences of 
packets such as non-default quality of service or real time service packets.  

Source IPv6 Address The user may specify an IP address mask for the source IPv6 address by entering the 
IP address mask, in hex form. 

Destination IPv6 
Address 

The user may specify an IP address mask for the destination IPv6 address by and 
entering the IP address mask, in hex form. 

Port The Access Rule may be configured on a per-port basis by entering the port number 
of the switch in the switch stack into this field. When a range of ports is to be 
configured, the Auto Assign check box MUST be clicked in the Access ID field of 
this window. If not, the user will be presented with an error message and the access 
rule will not be configured. The port list is specified by listing the lowest switch number 
and the beginning port number on that switch, separated by a colon. Then the highest 
switch number, and the highest port number of the range (also separated by a colon) 
are specified. The beginning and end of the port list range are separated by a dash. 
For example, 1:3 specifies switch number 1, port 3. 2:4 specifies switch number 2, 
port 4. 1:3 - 2:4 specifies all of the ports between switch 1, port 3 and switch 2, port 4 
− in numerical order. Entering all will denote all ports on the Switch. 

To view the settings of a previously correctly configured rule, click  in the Access Rule Table to view the following 
screen: 
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Figure 6- 74. Access Rule Display window (IPv6) 

 

NOTE: When using the ACL Mirror function, ensure that the Port Mirroring 
function is enabled and a target mirror port is set. 
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CPU Access Profile 
Due to a chipset limitation and needed extra switch security, the xStack DXS/DGS-3300 Switch Series incorporates CPU 
Interface filtering. This added feature increases the running security of the Switch by enabling the user to create a list of 
access rules for packets destined for the Switch’s CPU interface. Employed similarly to the Access Profile feature 
previously mentioned, CPU interface filtering examines Ethernet, IP, Packet Content Mask and IPv6 packet headers 
destined for the CPU and will either forward them or filter them, based on the user’s implementation. As an added feature 
for the CPU Filtering, the xStack DXS/DGS-3300 Switch Series allows the CPU filtering mechanism to be enabled or 
disabled globally, permitting the user to create various lists of rules without immediately enabling them. This setting can be 
found in the Advanced Settings window in the configuration folder. 

Creating an access profile for the CPU is divided into two basic parts. The first is to specify which part or parts of a frame 
the Switch will examine, such as the MAC source address or the IP destination address. The second part is entering the 
criteria the Switch will use to determine what to do with the frame. The following explanation describes the entire process. 

CPU Access Profile Table 
The CPU Access Profile Table displays the CPU Access Profile Table entries created on the Switch. To view the 
configurations for an entry, click the hyperlinked Profile ID number. 

 
Figure 6- 75. CPU Access Profile Table 

To add an entry to the CPU Access Profile Table, click the Add button. This will open the CPU Access Profile 
Configuration page, as shown below. There are four CPU Access Profile Configuration pages; one for Ethernet (or 
MAC address-based) profile configuration, one for IP address-based profile configuration, one for the Packet Content 
Mask and one for IPv6. The user may alternate between the four CPU Access Profile Configuration pages by using the 
Type drop-down menu. The page shown below is the Ethernet CPU Access Profile Configuration page. 

 
Figure 6- 76. CPU Access Profile Configuration window – Ethernet 
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Parameter                       Description 

Profile ID (1-5) Type in a unique identifier number for this profile set. This value can be set from 1 - 5.

Type Select profile based on Ethernet (MAC Address), IP address, packet content mask or 
IPv6. This will change the menu according to the requirements for the type of profile.  

• Select Ethernet to instruct the Switch to examine the layer 2 part of each 
packet header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the 
packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

VLAN Selecting this option instructs the Switch to examine the VLAN identifier of each 
packet header and use this as the full or partial criterion for forwarding. 

Source MAC Source MAC Mask - Enter a MAC address mask for the source MAC address. 

Destination MAC Destination MAC Mask - Enter a MAC address mask for the destination MAC 
address. 

802.1p Enter a value from 0-7 to specify that the access profile will apply only to packets with 
this 802.1p priority value. 

Ethernet type Selecting this option instructs the Switch to examine the Ethernet type value in each 
frame's header. 

Click Apply to set this entry in the Switch’s memory. 
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The page shown below is the IP CPU Access Profile Configuration page. 

 
Figure 6- 77. CPU Access Profile Configuration window- IP 

Parameter                 Description 

Profile ID (1-5) Type in a unique identifier number for this profile set. This value can be set from 1 - 5.

Type Select profile based on Ethernet (MAC Address), IP address, packet content mask or 
IPv6. This will change the menu according to the requirements for the type of profile.  

• Select Ethernet to instruct the Switch to examine the layer 2 part of each 
packet header.  

• Select IP to instruct the Switch to examine the IP address in each frame's 
header.  

• Select Packet Content Mask to specify a mask to hide the content of the 
packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

VLAN Selecting this option instructs the Switch to examine the VLAN part of each packet 
header and use this as the, or part of the criterion for forwarding. 

Source IP Mask Enter an IP address mask for the source IP address. 

Destination IP Mask Enter an IP address mask for the destination IP address. 

DSCP Selecting this option instructs the Switch to examine the DiffServ Code part of each 
packet header and use this as the, or part of the criterion for forwarding. 

Protocol Selecting this option instructs the Switch to examine the protocol type value in each 
frame's header. Then the user must specify what protocol(s) to include according to 
the following guidelines:  
Select ICMP to instruct the Switch to examine the Internet Control Message Protocol 
(ICMP) field in each frame's header.  

• Select Type to further specify that the access profile will apply an ICMP type 
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value, or specify Code to further specify that the access profile will apply an 
ICMP code value. 

Select IGMP to instruct the Switch to examine the Internet Group Management 
Protocol (IGMP) field in each frame's header.  

• Select Type to further specify that the access profile will apply an IGMP type 
value 

Select TCP to use the TCP port number contained in an incoming packet as the 
forwarding criterion. Selecting TCP requires specification of a source port mask 
and/or a destination port mask. The user may also identify which flag bits to filter. Flag 
bits are parts of a packet that determine what to do with the packet. The user may 
filter packets by filtering certain flag bits within the packets, by checking the boxes 
corresponding to the flag bits of the TCP field. The user may choose between urg 
(urgent), ack (acknowledgement), psh (push), rst (reset), syn (synchronize), fin 
(finish). 

• src port mask - Specify a TCP port mask for the source port in hex form 
(hex 0x0-0xffff), to filter. 

• dest port mask - Specify a TCP port mask for the destination port in hex 
form (hex 0x0-0xffff) to filter. 

Select UDP to use the UDP port number contained in an incoming packet as the 
forwarding criterion. Selecting UDP requires that specification of a source port mask 
and/or a destination port mask.  

• src port mask - Specify a TCP port mask for the source port in hex form 
(hex 0x0-0xffff). 

• dest port mask - Specify a TCP port mask for the destination port in hex 
form (hex 0x0-0xffff). 

protocol id - Enter a value defining the protocol ID in the packet header to mask. 
Specify the protocol ID mask in hex form (hex 0x0-0xffffffff). 

Click Apply to set this entry in the Switch’s memory. 
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The page shown below is the Packet Content Mask configuration window. 

 
Figure 6- 78. CPU Access Profile Configuration window (Packet Content). 

This screen will aid the user in configuring the Switch to mask packet headers beginning with the offset value specified. 
The following fields are used to configure the Packet Content Mask: 

Parameter              Description 

Profile ID (1-5) Type in a unique identifier number for this profile set. This value can be set from 1 - 5. 

Type Select profile based on Ethernet (MAC Address), IP address, packet content mask or IPv6. 
This will change the menu according to the requirements for the type of profile. 

• Select Ethernet to instruct the Switch to examine the layer 2 part of each packet 
header.  

• Select IP to instruct the Switch to examine the IP address in each frame's header.  
• Select Packet Content Mask to specify a mask to hide the content of the packet 

header. 
• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Offset This field will instruct the Switch to mask the packet header beginning with the offset value 
specified: 

• value (0-15) - Enter a value in hex form to mask the packet from the beginning of the 
packet to the 15th byte. 

• value (16-31) – Enter a value in hex form to mask the packet from byte 16 to byte 31.
• value (32-47) – Enter a value in hex form to mask the packet from byte 32 to byte 47.
• value (48-63) – Enter a value in hex form to mask the packet from byte 48 to byte 63.
• value (64-79) – Enter a value in hex form to mask the packet from byte 64 to byte 79.

Click Apply to implement changes made. 
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The page shown below is the IPv6 configuration window. 

 
Figure 6- 79. CPU Access Profile Configuration (IPv6) 

The following fields are used to configure the Packet Content Mask: 

Parameter                    Description 

Profile ID This is the identifier number for this profile set. Up to 5 profile ID configurations can be 
created. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content Mask 
or IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

Class Entering a value between 0 and 255 will instruct the Switch to examine the class field 
of the IPv6 header. This class field is a part of the packet header that is similar to the 
Type of Service (ToS) or Precedence bits field of IPv4. 

Flowlabel Configuring this field, in hex form, will instruct the Switch to examine the flow label 
field of the IPv6 header. This flow label field is used by a source to label sequences of 
packets such as non-default quality of service or real time service packets.  

Source IPv6 Address The user may specify an IP address mask for the source IPv6 address by entering the 
IP address mask, in hex form. 

Destination IPv6 
Address 

The user may specify an IP address mask for the destination IPv6 address by and 
entering the IP address mask, in hex form. 

Click Apply to implement changes made. 
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To establish the rule for a previously created CPU Access Profile: 

In the Configuration folder, click the CPU Access Profile Table to open the CPU Access Profile Table. 

 
Figure 6- 80. CPU Access Profile Table 

In this window, the user may add a rule to a previously created CPU access profile by clicking the corresponding Modify 
button of the entry to configure, Ethernet, IP, Packet Content or IPv6. Each entry will open a new and unique window, 
as shown in the examples below. 

 
Figure 6- 81. CPU Access Rule Table (Ethernet) 

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously 
created rule, click the corresponding  button. The following window is used for the Ethernet Access Rule configuration. 

 
Figure 6- 82. CPU Access Rule Configuration – Ethernet 

To set the CPU Access Rule for Ethernet, adjust the following parameters and click Apply. 
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Parameters                     Description 
Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded 
by the Switch, according to any additional rule added (see below). 
Select Deny to specify that packets that match the access profile are not forwarded 
by the Switch and will be filtered. 

Access ID Type in a unique identifier number for this access and priority. This value can be set 
from 1 - 5. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content or 
IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  
• Packet Content Mask instructs the Switch to examine the packet header. 
• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

VLAN Name Allows the entry of a name for a previously configured VLAN. 

Source MAC Source MAC Address - Enter a MAC Address for the source MAC address. 

Destination MAC Destination MAC Address - Enter a MAC Address mask for the destination MAC 
address. 

802.1p (0-7) Enter a value from 0-7 to specify that the access profile will apply only to packets with 
this 802.1p priority value. 

Ethernet Type Specifies that the access profile will apply only to packets with this hexadecimal 
802.1Q Ethernet type value (hex 0x0-0xffff) in the packet header. The Ethernet type 
value may be set in the form: hex 0x0-0xffff, which means the user may choose any 
combination of letters and numbers ranging from a-f and from 0-9999. 

To view the settings of a previously correctly configured rule, click  in the CPU Access Rule Table to view the 
following screen: 

 
Figure 6- 83. CPU Access Rule Display (Ethernet). 

The following window is the CPU Access Rule Table for IP. 
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Figure 6- 84. CPU Access Rule Table  (IP) 

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously 
created rule, click the corresponding  button. The following window is used for the IP Rule configuration. 

 
Figure 6- 85. CPU Access Rule Configuration (IP) 

Configure the following Access Rule Configuration settings for IP: 

Parameter                    Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded by 
the Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded by 
the Switch and will be filtered. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 5. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content or IPv6. 

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 

VLAN Name Allows the entry of a name for a previously configured VLAN. 
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Source IP Source IP Address - Enter an IP Address for the source IP address. 

Destination IP Destination IP Address - Enter an IP Address mask for the destination IP address. 

DSCP (0-63) Select this option to instruct the Switch to replace the DSCP value (in a packet that 
meets the selected criteria) with the value entered in the adjacent field. 

Protocol This field allows the user to modify the protocol used to configure the Access Rule 
Table; depending on which protocol the user has chosen in the Access Profile Table.  

To view the settings of a previously correctly configured rule, click  in the CPU Access Rule Table to view the 
following screen: 

 
Figure 6- 86. CPU Access Rule Display (IP) 

The following window is the CPU Access Rule Table for Packet Content. 

 
Figure 6- 87. CPU Access Rule Table (Packet Content). 

To remove a previously created rule, select it and click the  button. To add a new Access Rule, click the Add button: 
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Figure 6- 88. CPU Access Rule Configuration (Packet Content) 

To set the CPU Access Rule for Ethernet, adjust the following parameters and click Apply. 

Parameters                     Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded by the 
Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded by the 
Switch and will be filtered. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 - 5. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content or IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 
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Offset This field will instruct the Switch to mask the packet header beginning with the offset value 
specified: 

• value (0-15) - Enter a value in hex form to mask the packet from the beginning of the 
packet to the 15th byte. 

• value (16-31) - Enter a value in hex form to mask the packet from byte 16 to byte 31.

• value (32-47) - Enter a value in hex form to mask the packet from byte 32 to byte 47.

• value (48-63) - Enter a value in hex form to mask the packet from byte 48 to byte 63.

• value (64-79) - Enter a value in hex form to mask the packet from byte 64 to byte 79.

To view the settings of a previously correctly configured rule, click  in the CPU Access Rule Table to view the 
following screen: 

 
Figure 6- 89. CPU Access Rule Display (Packet Content). 
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The following window is the CPU Access Rule Table for IPv6. 

 
Figure 6- 90. CPU Access Rule Table (IPv6) 

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously 
created rule, click the corresponding  button. The following window is used for the CPU IP Rule configuration. 

 
Figure 6- 91.  CPU Access Rule Configuration (IPv6) 

The following parameters may be viewed or modified: 

Parameter                    Description 

Profile ID This is the identifier number for this profile set. 

Mode Select Permit to specify that the packets that match the access profile are forwarded 
by the Switch, according to any additional rule added (see below). 

Select Deny to specify that packets that match the access profile are not forwarded 
by the Switch and will be filtered. 

Access ID Type in a unique identifier number for this access. This value can be set from 1 – 5. 

Type Selected profile based on Ethernet (MAC Address), IP address, Packet Content or 
IPv6.  

• Ethernet instructs the Switch to examine the layer 2 part of each packet 
header.  

• IP instructs the Switch to examine the IP address in each frame's header.  

• Packet Content Mask instructs the Switch to examine the packet header. 

• IPv6 instructs the Switch to examine the IPv6 part of each packet header. 
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Class Entering a value between 0 and 255 will instruct the Switch to examine the class field 
of the IPv6 header. This class field is a part of the packet header that is similar to the 
Type of Service (ToS) or Precedence bits field of IPv4. 

Flowlabel Configuring this field, in hex form, will instruct the Switch to examine the flow label 
field of the IPv6 header. This flow label field is used by a source to label sequences of 
packets such as non-default quality of service or real time service packets.  

Source IPv6 Address The user may specify an IP address mask for the source IPv6 address by entering the 
IP address mask, in hex form. 

Destination IPv6 
Address 

The user may specify an IP address mask for the destination IPv6 address by and 
entering the IP address mask, in hex form. 

To view the settings of a previously correctly configured rule, click  in the CPU Access Rule Table to view the 
following screen: 

 
Figure 6- 92. CPU Access Rule Display window (IPv6) 
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System Severity Settings 
The System Severity Window allows users to configure where and when events occurring on the Switch will be recorded. 
These events are classified by the Switch into the following three categories: 

• Information – Events classified as information are basic events occurring on the Switch that are not deemed as 
problematic, such as enabling or disabling various functions on the Switch. This is the lowest severity level. 

• Warning - Events classified as warning are problematic events that are not critical to the overall function of the 
Switch but do require attention, such as unsuccessful downloads or uploads and failed logins. This level is regarded 
as a mid-level warning. 

• Critical – Events classified as critical are fatal exceptions occurring on the Switch, such as hardware failures or 
spoofing attacks. This level is regarded as the highest severity level.  

When an event occurs, the Switch classifies it into one of these three categories. If the severity of the event is higher than 
the level configured, the Switch will send a message to the SNMP trap, the Switch’s log or both, depending on user 
configuration. If the event classified as lower than the configured severity level, the message is regarded as unimportant 
and will be discarded. 

To configure the system severity levels, open the following window by clicking Configuration > System Severity 
Settings in the main menu. 

 
Figure 6- 93. System Severity Settings and Table window 

The user may set the following parameters to configure the System Severity. Configurations will be displayed in the 
System Severity Table. 

Parameter        Description 

System Severity Choose one of the following to identify where severity messages are to be sent. 
• trap – Selecting this parameter will instruct the Switch to send severity 

messages to a SNMP agent for analysis. 
• log – Selecting this parameter will instruct the Switch to send severity messages 

to the Switch’s log for analysis. 
• all – Selecting this parameter will instruct the Switch to send severity messages 

to a SNMP agent and the Switch’s log for analysis. 

Severity Level Choose one of the following to identify what type of severity warnings are to be sent to the 
destination entered above. 

• critical – Entering this parameter along with the proper destination, stated 
above, will instruct the Switch to send only critical events to the Switch’s log or 
SNMP agent. 

• warning – Entering this parameter along with the proper destination, stated 
above, will instruct the Switch to send critical and warning events to the Switch’s 
log and/or SNMP agent. 

• information – Entering this parameter along with the proper destination, stated 
above, will instruct the Switch to send informational, warning and critical events 
to the Switch’s log and/or SNMP agent. 

Click Apply to implement changes made. 
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Port Access Entity (802.1X) 
802.1x Port-Based and MAC-Based Access Control 
The IEEE 802.1x standard is a security measure for authorizing and authenticating users to gain access to various wired or 
wireless devices on a specified Local Area Network by using a Client and Server based access control model. This is 
accomplished by using a RADIUS server to authenticate users trying to access a network by relaying Extensible 
Authentication Protocol over LAN (EAPOL) packets between the Client and the Server. The following figure represents a 
basic EAPOL packet: 

 
Figure 6- 94. The EAPOL Packet 

Utilizing this method, unauthorized devices are restricted from connecting to a LAN through a port to which the user is 
connected. EAPOL packets are the only traffic that can be transmitted through the specific port until authorization is 
granted. The 802.1x Access Control method holds three roles, each of which are vital to creating and upkeeping a stable 
and working Access Control security method.  

 
Figure 6- 95. The three roles of 802.1x 

The following section will explain the three roles of Client, Authenticator and Authentication Server in greater detail. 
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Authentication Server 
The Authentication Server is a remote device that is connected to the same network as the Client and Authenticator, must 
be running a RADIUS Server program and must be configured properly on the Authenticator (Switch). Clients connected 
to a port on the Switch must be authenticated by the Authentication Server (RADIUS) before attaining any services offered 
by the Switch on the LAN. The role of the Authentication Server is to certify the identity of the Client attempting to access 
the network by exchanging secure information between the RADIUS server and the Client through EAPOL packets and, in 
turn, informs the Switch whether or not the Client is granted access to the LAN and/or switches services.  

 
Figure 6- 96. The Authentication Server 

Authenticator 
The Authenticator (the Switch) is an intermediary between the Authentication Server and the Client. The Authenticator 
servers two purposes when utilizing 802.1x. The first purpose is to request certification information from the Client 
through EAPOL packets, which is the only information allowed to pass through the Authenticator before access is granted 
to the Client. The second purpose of the Authenticator is to verify the information gathered from the Client with the 
Authentication Server, and to then relay that information back to the Client. 

Three steps must be implemented on the Switch to properly configure the Authenticator. 

1. The 802.1x State must be Enabled. (Configuration / Advanced Settings) 

2. The 802.1x settings must be implemented by port (Configuration / Port Access Entity / Configure 
Authenticator) 

3. A RADIUS server must be configured on the Switch. (Configuration / Port Access Entity / RADIUS Server) 

 
Figure 6- 97. The Authenticator 
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Client 
The Client is simply the endstation that wishes to gain access to the LAN or switch services. All endstations must be 
running software that is compliant with the 802.1x protocol. For users running Windows XP, that software is included 
within the operating system. All other users are required to attain 802.1x client software from an outside source. The Client 
will request access to the LAN and or Switch through EAPOL packets and, in turn will respond to requests from the 
Switch.  

 
Figure 6- 98. The Client 

Authentication Process 
Utilizing the three roles stated above, the 802.1x protocol provides a stable and secure way of authorizing and 
authenticating users attempting to access the network. Only EAPOL traffic is allowed to pass through the specified port 
before a successful authentication is made. This port is “locked” until the point when a Client with the correct username 
and password (and MAC address if 802.1x is enabled by MAC address) is granted access and therefore successfully 
“unlocks” the port. Once unlocked, normal traffic is allowed to pass through the port. The following figure displays a more 
detailed explanation of how the authentication process is completed between the three roles stated above. 

 
Figure 6- 99. The 802.1x Authentication Process 

The D-Link implementation of 802.1x allows network administrators to choose between two types of Access Control used 
on the Switch, which are: 

1. Port-Based Access Control – This method requires only one user to be authenticated per port by a remote RADIUS 
server to allow the remaining users on the same port access to the network.  

2. MAC-Based Access Control – Using this method, the Switch will automatically learn up to three MAC addresses 
by port and set them in a list. Each MAC address must be authenticated by the Switch using a remote RADIUS 
server before being allowed access to the Network.  
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Understanding 802.1x Port-based and MAC-based Network 
Access Control 
The original intent behind the development of 802.1X was to leverage the characteristics of point-to-point in LANs. As any 
single LAN segment in such infrastructures has no more than two devices attached to it, one of which is a Bridge Port.   
The Bridge Port detects events that indicate the attachment of an active device at the remote end of the link, or an active 
device becoming inactive. These events can be used to control the authorization state of the Port and initiate the process of 
authenticating the attached device if the Port is unauthorized. This is the Port-Based Network Access Control. 

Port-Based Network Access Control 
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Figure 6- 100. Example of Typical Port-Based Configuration 

Once the connected device has successfully been authenticated, the Port then becomes Authorized, and all subsequent 
traffic on the Port is not subject to access control restriction until an event occurs that causes the Port to become 
Unauthorized. Hence, if the Port is actually connected to a shared media LAN segment with more than one attached device, 
successfully authenticating one of the attached devices effectively provides access to the LAN for all devices on the shared 
segment. Clearly, the security offered in this situation is open to attack. 
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MAC-Based Network Access Control 
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Figure 6- 101. Example of Typical MAC-Based Configuration 

In order to successfully make use of 802.1X in a shared media LAN segment, it would be necessary to create “logical” 
Ports, one for each attached device that required access to the LAN. The Switch would regard the single physical Port 
connecting it to the shared media segment as consisting of a number of distinct logical Ports, each logical Port being 
independently controlled from the point of view of EAPOL exchanges and authorization state. The Switch learns each 
attached devices’ individual MAC addresses, and effectively creates a logical Port that the attached device can then use to 
communicate with the LAN via the Switch. 
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Configure Authenticator 
To configure the 802.1X authenticator settings, click Configuration > Port Access Entity  > Configure 802.1x Authenti-
cator Parameter: 

 

Figure 6- 102. Configure 802.1X Authenticator Parameter window 

To view the 802.1X authenticator settings on a different switch in the switch stack, use the Unit pull-down menu to select 
that switch by its ID number in the switch stack. To configure the settings by port, click on the hyperlinked port number 
under the Port heading, which will display the following table to configure: 
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Figure 6- 103. 802.1X Authenticator Settings – Modify window 

This screen allows setting of the following features: 

Parameter                       Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From [   ] To [   ] Enter the port or ports to be set. 

AdmCtrlDir Sets the administrative-controlled direction to either in or both.  

If in is selected, control is only exerted over incoming traffic through the port selected 
in the first field.  

If both is selected, control is exerted over both incoming and outgoing traffic through 
the controlled port selected in the first field. 

PortControl This allows the user to control the port authorization state.  

Select forceAuthorized to disable 802.1X and cause the port to transition to the 
authorized state without any authentication exchange required. This means the port 
transmits and receives normal traffic without 802.1X-based authentication of the 
client.  

If forceUnauthorized is selected, the port will remain in the unauthorized state, 
ignoring all attempts by the client to authenticate. The Switch cannot provide 
authentication services to the client through the interface.  

If Auto is selected, it will enable 802.1X and cause the port to begin in the 
unauthorized state, allowing only EAPOL frames to be sent and received through the 
port. The authentication process begins when the link state of the port transitions from 
down to up, or when an EAPOL-start frame is received. The Switch then requests the 
identity of the client and begins relaying authentication messages between the client 
and the authentication server. 

The default setting is Auto. 
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TxPeriod This sets the TxPeriod of time for the authenticator PAE state machine. This value 
determines the period of an EAP Request/Identity packet transmitted to the client. The 
default setting is 30 seconds. 

QuietPeriod This allows the user to set the number of seconds that the Switch remains in the quiet 
state following a failed authentication exchange with the client. The default setting is 
60 seconds. 

SuppTimeout This value determines timeout conditions in the exchanges between the Authenticator 
and the client. The default setting is 30 seconds. 

ServerTimeout This value determines timeout conditions in the exchanges between the Authenticator 
and the authentication server. The default setting is 30 seconds. 

MaxReq The maximum number of times that the Switch will retransmit an EAP Request to the 
client before it times out of the authentication sessions. The default setting is 2. 

ReAuthPeriod A constant that defines a nonzero number of seconds between periodic 
reauthentication of the client. The default setting is 3600 seconds. 

ReAuth Determines whether regular reauthentication will take place on this port. The default 
setting is Disabled. 

Click Apply to implement your configuration changes. To view configurations for the 802.1X Authenticator Settings on 
a port-by-port basis, see the 802.1X Authenticator Settings table. 

802.1X User 

In the Configuration folder, open the Port Access Entity folder and click 802.1X User to open the 802.1x Local User 
Table Configuration window. This window will allow the user to set different local users on the Switch. 

 
Figure 6- 104. 802.1x User and 802.1x User Table window 

Enter a User Name, Password and confirmation of that password. Properly configured local users will be displayed in the 
802.1x User Table in the same window. 
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PAE System Control 
Existing 802.1x port and MAC settings are displayed and can be configured using the windows below. 

Port Capability 
Click Port Access Entity > PAE System Control > 802.1x Capability Settings to view the following window: 

 
Figure 6- 105. 802.1x Capability Settings and Table window 

To set up the Switch's 802.1x port-based authentication, select the switch in the switch stack by using the Unit pull-down 
menu and then select which ports are to be configured in the From and To fields. Next, enable the ports by selecting 
Authenticator from the drop-down menu under Capability. Click Apply to let your change take effect. 

Configure the following 802.1x capability settings: 

Parameter                       Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From and To Ports being configured for 802.1x settings. 

Capability Two role choices can be selected: 

Authenticator - A user must pass the authentication process to gain access to the 
network. 

None - The port will not be controlled by the 802.1x functions. 
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Initializing Ports for Port Based 802.1x 
Existing 802.1x port and MAC settings are displayed and can be configured using the window below. 

Click Port Access Entity > PAE System Control > Initialize Port(s) to open the following window: 

 
Figure 6- 106. Initialize Port window 

This window allows initialization of a port or group of ports. The Initialize Port Table in the bottom half of the window 
displays the current status of the port(s).  

This window displays the following information: 

Parameter                           Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

From and To Select ports to be initialized. 

Port A read-only  field indicating a port on the Switch. 

MAC Address The MAC address of the Switch connected to the corresponding port, if any. 

Auth PAE State The Authenticator PAE State will display one of the following: Initialize, Discon-
nected, Connecting, Authenticating, Authenticated, Aborting, Held, ForceAuth, 
ForceUnauth, and N/A. 

Backend State The Backend Authentication State will display one of the following: Request, 
Response, Success, Fail, Timeout, Idle, Initialize, and N/A. 

Port Status The status of the controlled port can be Authorized, Unauthorized, or N/A. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

143 

     

Initializing Ports for MAC Based 802.1x 
To initialize ports for the MAC side of 802.1x, the user must first enable 802.1x by MAC address in the Advanced 
Settings window. Click Configuration > Port Access Entity > PAE System Control > Initialize Port(s) to open the 
following window: 

 
Figure 6- 107. Initialize Ports (MAC based 802.1x) 

To initialize ports, first choose the switch in the switch stack by using the Unit pull-down menu, then the range of ports in 
the From and To field. Then the user must specify the MAC address to be initialized by entering it into the MAC Address 
field and checking the corresponding check box. To begin the initialization, click Apply. 

 

NOTE: The user must first globally enable 802.1X in the Advanced 
Settings window in the Configuration folder before initializing ports. 
Information in the Initialize Ports Table cannot be viewed before enabling 
802.1X. 

Reauthenticate Port(s) for Port Based 802.1x 
This window allows reauthentication of a port or group of ports by using the pull-down menus From and To and clicking 
Apply. The Reauthenticate Port Table displays the current status of the reauthenticated port(s) once Apply has been 
clicked.    

Click Configuration > Port Access Entity > PAE System Control > Reauthenticate Port(s) to open the 
Reauthenticate Port(s) window: 

 
Figure 6- 108. Reauthenticate Port and Reauthenticate Port Table window 

This window displays the following information: 
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Parameter                    Description 

Unit Choose the Switch ID number of the Switch in the switch stack to be modified. 

Port The port number of the reauthenticated port. 

MAC Address Displays the physical address of the Switch where the port resides. 

Auth PAE State The Authenticator State will display one of the following: Initialize, Disconnected, 
Connecting, Authenticating, Authenticated, Aborting, Held, ForceAuth, ForceUnauth, 
and N/A. 

BackendState The Backend State will display one of the following: Request, Response, Success, Fail, 
Timeout, Idle, Initialize, and N/A. 

PortStatus The status of the controlled port can be Authorized, Unauthorized, or N/A. 

 

 

NOTE: The user must first globally enable 802.1X in the Advanced 
Settings window in the Configuration folder before reauthenticating 
ports. Information in the Reauthenticate Ports Table cannot be viewed 
before enabling 802.1X. 

Reauthenticate Port(s) for MAC-based 802.1x 
To reauthenticate ports for the MAC side of 802.1x, the user must first enable 802.1x by MAC address in the Advanced 
Settings window. Click Configuration > Port Access Entity > PAE System Control > Reauthenticate Port(s) to open 
the following window: 

 
Figure 6- 109. Reauthenticate Ports window – MAC based 802.1x 

To reauthenticate ports, first choose the switch in the switch stack by using the Unit pull-down menu, then the range of 
ports in the From and To field. Then the user must specify the MAC address to be reauthenticated by entering it into the 
MAC Address field and checking the corresponding check box. To begin the reauthentication, click Apply. 
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RADIUS Server 
The RADIUS feature of the Switch allows the user to facilitate centralized user administration as well as providing 
protection against a sniffing, active hacker. The Web Manager offers three windows.    

Click Configuration > Port Access Entity > RADIUS Server > Authentic RADIUS Server to open the Authentic 
RADIUS Server Setting window shown below: 

 
Figure 6- 110. Authentic RADIUS Server and Current RADIUS Server Settings Table window 

This window displays the following information: 

Parameter                     Description 

Succession  Choose the desired RADIUS server to configure: First, Second or Third. 

RADIUS Server  Set the RADIUS server IP. 

Authentic Port  Set the RADIUS authentic server(s) UDP port. The default port is 1812. 

Accounting Port  Set the RADIUS account server(s) UDP port. The default port is 1813. 

Key Set the key the same as that of the RADIUS server. 

Confirm Key Confirm the shared key is the same as that of the RADIUS server. 

Status This allows the user to set the RADIUS Server as Valid (Enabled) or Invalid (Disabled). 

Click Apply to implement changes made. 
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Layer 3 IP Networking 
Layer 3 Global Advanced Settings 
The L3 Global Advanced Settings window allows the user to enable and disable Layer 3 settings and functions from a 
single window. The full settings and descriptions for these functions will appear later in this section. To view this window, 
open the Configuration folder and then the Layer 3 IP Networking folder and click on the L3 Global Advanced 
Settings link to access the following window. 

 
Figure 6- 111. L3 Global Advanced Settings window 

The user may set the following: 

Parameter    Description 

DVMRP State The user may globally enable or disable the Distance Vector Multicast Routing Protocol 
(DVMRP) function by using the pull-down menu. 

PIM-DM State The user may globally enable or disable the Protocol Independent Multicast - Dense 
Mode (PIM-DM) function by using the pull-down menu. 

RIP State The user may globally enable or disable the Routing Information Protocol (RIP) function 
by using the pull-down menu. 

OSPF State The user may globally enable or disable the Open Shortest Path first (OSPF) function 
by using the pull-down menu. 

ARP Aging Time (0-
65535) 

The user may globally set the maximum amount of time, in minutes, that an Address 
Resolution Protocol (ARP) entry can remain in the Switch’s ARP table, without being 
accessed, before it is dropped from the table. The value may be set in the range of 0-
65535 minutes with a default setting of 20 minutes. 
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IP Multinetting 
IP Multinetting is a function that allows multiple IP interfaces to be assigned to the same VLAN. This is beneficial to the 
administrator when the number of IPs on the original interface is insufficient and the network administrator wishes not to 
resize the interface. IP Multinetting is capable of assigning another IP interface on the same VLAN without affecting the 
original stations or settings of the original interface. 

Two types of interfaces are configured for IP multinetting, primary and secondary, and every IP interface must be 
classified as one of these. A primary interface refers to the first interface created on a VLAN, with no exceptions. All other 
interfaces created will be regarded as secondary only, and can only be created once a primary interface has been 
configured. There may be five interfaces per VLAN (one primary, and up to four secondary) and they are, in most cases, 
independent of each other. Primary interfaces cannot be deleted if the VLAN contains a secondary interface. Once the user 
creates multiple interfaces for a specified VLAN (primary and secondary), that set IP interface cannot be changed to 
another VLAN.  

   

Application Limitation: A multicast router cannot be connected to IP 
interfaces that are utilizing the IP Multinetting function.  

   

 

NOTE: Only the primary IP interface will support the BOOTP relay agent. 

IP Multinetting is a valuable tool for network administrators requiring a multitude of IP addresses, but configuring the 
Switch for IP multinetting may cause troubleshooting and bandwidth problems, and should not be used as a long term 
solution. Problems may include: 

• The Switch may use extra resources to process packets for multiple IP interfaces. 

• The amount of broadcast data, such as RIP update packets and PIM hello packets, will be increased. 

IP Interface Setup 
Each VLAN must be configured prior to setting up the VLAN’s corresponding IP interface.   

An example is presented below: 

VLAN Name VID Switch Ports 

System (default) 1 5, 6, 7, 8, 21, 22, 23, 24 

Engineer 2 9, 10, 11, 12 

Marketing 3 13, 14, 15, 16 

Finance 4 17, 18, 19, 20 

Sales 5 1, 2, 3, 4 

Backbone 6 25, 26 

Table 6- 4.  VLAN Example - Assigned Ports 

In this case, six IP interfaces are required, so a CIDR notation of 10.32.0.0/11 (or a 11-bit) addressing scheme will work. 
This addressing scheme will give a subnet mask of 11111111.11100000.00000000.00000000 (binary) or 255.224.0.0 
(decimal). 
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Using a 10.xxx.xxx.xxx IP address notation, the above example would give six network addresses and six subnets. 

Any IP address from the allowed range of IP addresses for each subnet can be chosen as an IP address for an IP interface 
on the switch.  

For this example, we have chosen the next IP address above the network address for the IP interface’s IP Address: 

VLAN Name VID Network Number  IP Address 

System (default) 1 10.32.0.0 10.32.0.1 

Engineer 2 10.64.0.0 10.64.0.1 

Marketing 3 10.96.0.0 10.96.0.1 

Finance 4 10.128.0.0 10.128.0.1 

Sales 5 10.160.0.0 10.160.0.1 

Backbone 6 10.192.0.0 10.192.0.1 

Table 6- 5. VLAN Example - Assigned IP Interfaces 

The six IP interfaces, each with an IP address (listed in the table above), and a subnet mask of 255.224.0.0 can be entered 
into the Setup IP Interface window. 

To setup IP Interfaces on the Switch: 

Go to the Configuration folder, and click on the Layer 3 IP Networking folder, and then click on the IP Interfaces 
Table link to open the following dialog box:  

 
Figure 6- 112. IP Interface Settings window 

To setup a new IP interface, click the Add button. To edit an existing IP Interface entry, click on an entry under the 
Interface Name heading. Both actions will result in the same screen to configure, as shown below. 

 
Figure 6- 113. IP Interface Settings – Add 
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Figure 6- 114. IP Interface Settings – Edit window 

Enter a name for the new interface to be added in the Interface Name field (if editing an IP interface, the Interface Name 
will already be in the top field as seen in the window above). Enter the interface’s IP address and subnet mask in the 
corresponding fields. Pull the State pull-down menu to Enabled and click Apply to enter to make the IP interface effective. 
To view entries in the IP Interface Table, click the Show All IP Interface Entries hyperlink. Use the Save Changes dialog 
box from the Maintenance folder to enter the changes into NV-RAM. 

The following fields can be set: 

Parameter             Description 

Interface Name This field displays the name for the IP interface. The default IP interface is named 
“System”. 

IP Address This field allows the entry of an IP address to be assigned to this IP interface. 

Subnet Mask This field allows the entry of a subnet mask to be applied to this IP interface. 

VLAN Name This field allows the entry of the VLAN Name for the VLAN the IP interface belongs to.

Secondary  Use the pull-down menu to set the IP interface as True or False. True will set the 
interface as secondary and False will denote the interface as the primary interface of 
the VLAN entered above. Secondary interfaces can only be configured if a primary 
interface is first configured. 

State  This field may be altered between Enabled and Disabled using the pull-down menu. 
This entry determines whether the interface will be active or not. 

Link Status  This read-only  field states the current status of the IP Interface on the Switch. Link Up 
denotes that the IP interface is up and running on the Switch. Link Down will denote 
that the IP interface is not currently set and/or enabled on the Switch. 

Click Apply to implement changes made. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

150 

     

MD5 Key Table Configuration 
The MD5 Key Table Configuration menu allows the entry of a sixteen character Message Digest − version 5 (MD5) key 
which can be used to authenticate every packet exchanged between OSPF routers. It is used as a security mechanism to 
limit the exchange of network topology information to the OSPF routing domain. 

MD5 Keys created here can be used in the OSPF menu below. 

To configure an MD5 Key, click the MD5 Key link to open the following dialog box: 

 
Figure 6- 115. MD5 Key Setting and Table window 

The following fields can be set: 

Parameter            Description 
Key ID A number from 1 to 255 used to identify the MD5 Key. 

Key A alphanumeric string of between 1 and 16 case-sensitive characters used to generate 
the Message Digest which is in turn, used to authenticate OSPF packets within the 
OSPF routing domain. 

Click Apply to enter the new Key ID settings. To delete a Key ID entry, click the corresponding  under the Delete 
heading. 

Route Redistribution Settings 
Route redistribution allows routers on the network, which are running different routing protocols to exchange routing 
information. This is accomplished by comparing the routes stored in the various routers routing tables and assigning 
appropriate metrics. This information is then exchanged among the various routers according to the individual routers 
current routing protocol. The Switch can redistribute routing information between the OSPF and RIP routing protocols to 
all routers on the network that are running OSPF or RIP. Routing information entered into the Static Routing Table on the 
local xStack switch is also redistributed. 

Routing information source − OSPF and the Static Route table. Routing information will be redistributed to RIP. The 
following table lists the allowed values for the routing metrics and the types (or forms) of the routing information that will 
be redistributed. 

Route Source Metric Type 

OSPF 0 to 16 All  
Internal  
External  
ExtType1  
ExtType2  
Inter-E1 Inter-E2 

RIP  0 to 16777214 Type 1 Type 2 

Static 0 to 16777214 Type 1 Type 2 

Local 0 to 16777214 Type 1 Type 2 

Table 6- 6. Route Redistribution Source table 
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Entering the Type combination − internal type_1 type_2 is functionally equivalent to all.  Entering the combination type_1 
type_2 is functionally equivalent to external.  Entering the combination internal external is functionally equivalent to all. 

Entering the metric 0 specifies transparency. 

This window will redistribute routing information between the OSPF and RIP routing protocols to all routers on the 
network that are running OSPF or RIP. To access the Route Redistribution Settings window, go to Configuration > 
Layer 3 IP Networking > Route Redistribution Settings: 

 
Figure 6- 116. Route Redistribution Settings and Table window 

The following parameters may be set or viewed: 

Parameter  Description 

Dst. Protocol Allows for the selection of the protocol for the destination device. Choose between RIP 
and OSPF. 

Src. Protocol Allows for the selection of the protocol for the source device. Choose between RIP, 
OSPF, Static and Local. 

Type Allows for the selection of one of six methods of calculating the metric value. The user 
may choose between All, Internal, External, ExtType1, ExtType2, Inter-E1, Inter-E2. 
See the table above for available metric value types for each source protocol. 

Metric Allows the entry of an OSPF interface cost. This is analogous to a Hop Count in the 
RIP routing protocol. The user may specify a cost between 0 and 16. 

Click Add/Modify to implement changes made.  

 

NOTE: The source protocol (Src. Protocol) entry and the destination 
protocol (Dst. Protocol) entry cannot be the same. 
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Static/Default Route Settings 
Entries into the Switch’s forwarding table can be made using both MAC addresses and IP addresses. Static IP forwarding 
is accomplished by the entry of an IP address into the Switch’s Static IP Routing Table. To view the following window, 
click Configuration > Layer 3 IP Networking > Static/Default Route Settings. 

 
Figure 6- 117. Static/Default Route Settings window 

This window shows the following values: 

Parameter  Description 

IP Address The IP address of the Static/Default Route. 

Subnet Mask The corresponding Subnet Mask of the IP address entered into the table. 

Gateway The corresponding Gateway of the IP address entered into the table.  

Metric Represents the metric value of the IP interface entered into the table. This field may 
read a number between 1-65535 for an OSPF setting, and 1-16 for a RIP setting. 

Protocol Represents the protocol used for the Routing Table entry of the IP interface. This field 
may read OSPF, RIP, Static or Local. 

Backup State Represents the Backup state that this IP interface is configured for. This field may read 
Primary or Backup. 

Delete 
Click the  to delete this entry from the Static/Default Route Settings table.  

To enter an IP Interface into the Switch’s Static/Default Route Settings window, click the Add button, revealing the 
following window to configure. 

 
Figure 6- 118. Static/Default Route Settings – Add window 
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The following fields can be set: 

Parameter                 Description 

IP Address  Allows the entry of an IP address that will be a static entry into the Switch’s Routing 
Table. 

Subnet Mask  Allows the entry of a subnet mask corresponding to the IP address above. 

Gateway IP  Allows the entry of an IP address of a gateway for the IP address above. 

Metric (1-65535)  Allows the entry of a routing protocol metric representing the number of routers 
between the Switch and the IP address above. 

Backup State  The user may choose between Primary and Backup. If the Primary Static/Default 
Route fails, the Backup Route will support the entry. Please take note that the 
Primary and Backup entries cannot have the same Gateway. 

Click Apply to implement changes made. 
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Route Preference Settings 
Route Preference is a way for routers to select the best path when there are two or more different routes to the same 
destination from two different routing protocols. The majority of routing protocols are not compatible when used in 
conjunction with each other. This Switch supports and may be configured for many routing protocols, as a stand-alone 
switch or more importantly, in utilizing the stacking function and Single IP Management of the Switch. Therefore, the 
ability to exchange route information and select the best path is essential to optimal use of the Switch and its capabilities. 

The first decision the Switch will make in selecting the best path is to consult the Route Preference Settings table of the 
switch. This table can be viewed by clicking Configuration > Layer 3 IP Networking > Route Preference Settings, and 
it holds the list of possible routing protocols currently implemented on the Switch, along with a Preference value which 
determines which routing protocol will be the most dependable to route packets. Below is a list of the default route 
preferences set on the Switch. 

 
As shown above, Local will always be the first choice for routing purposes and the next most reliable path is Static due to 
the fact that its has the next lowest value. To set a higher reliability for a route, change its value to a number less than the 
value of a route preference that has a greater reliability value using the New Route Preference Settings window command. 
For example, if the user wishes to make RIP the most reliable route, the user can change its value to one that is less than 
the lowest value (Static - 60) or the user could change the other route values to more than 100.  

The user should be aware of three points before configuring the route preference: 

1. No two route preference values can be the same. Entering the same route preference may cause the Switch to 
crash due to indecision by the Switch. 

2. If the user is not fully aware of all the features and functions of the routing protocols on the Switch, a change in 
the default route preference value may cause routing loops or black holes. 

3. After changing the route preference value for a specific routing protocol, that protocol needs to be restarted 
because the previously learned routes have been dropped from the switch. The Switch must learn the routes again before 
the new settings can take affect. 

To view the Route Preference Settings window, click Configuration > Layer 3 IP Networking > Route Preference 
Settings: 

Route Type Validity Range Default Value 

Local 0 - Permanently set on the Switch and not configurable. 0 

Static 1 - 999 60 

OSPF Intra 1 - 999  80 

OSPF Inter 1 - 999 90 

RIP 1 - 999 100 

OSPF ExtT1 1 - 999 110 

OSPF ExtT2 1 - 999  115 
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Figure 6- 119. Current and New Route Preference Settings window 

The following fields can be viewed or set: 

Parameter                        Description 

RIP (1-999) Enter a value between 1 and 999 to set the route preference for RIP. The lower the 
value, the higher the chance the specified protocol will be chosen as the best path for 
routing packets. The default value is 100. 

OSPF Intra (1-999) Enter a value between 1 and 999 to set the route preference for OSPF Intra. The 
lower the value, the higher the chance the specified protocol will be chosen as the 
best path for routing packets. The default value is 80. 

STATIC (1-999) Enter a value between 1 and 999 to set the route preference for Static. The lower the 
value, the higher the chance the specified protocol will be chosen as the best path for 
routing packets. The default value is 60. 

OSPF Inter (1-999) Enter a value between 1 and 999 to set the route preference for OSPF Inter. The 
lower the value, the higher the chance the specified protocol will be chosen as the 
best path for routing packets. The default value is 90. 

OSPF ExtT1 (1-999) Enter a value between 1 and 999 to set the route preference for OSPF ExtT1. The 
lower the value, the higher the chance the specified protocol will be chosen as the 
best path for routing packets. The default value is 110. 

OSPF ExtT2 (1-999) Enter a value between 1 and 999 to set the route preference for OSPF ExtT2. The 
lower the value, the higher the chance the specified protocol will be chosen as the 
best path for routing packets. The default value is 115. 

Click Apply to implement changes made. 
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Static ARP Table 
The Address Resolution Protocol (ARP) is a TCP/IP protocol that converts IP addresses into physical addresses. This table 
allows network managers to view, define, modify and delete ARP information for specific devices.  

Static entries can be defined in the ARP Table. When static entries are defined, a permanent entry is entered and is used to 
translate IP address to MAC addresses. 

To open the Static ARP Table open the Configuration folder, and then open the Layer 3 IP Networking folder and click 
on the Static ARP Settings link. 

 
Figure 6- 120. Static ARP Settings window 

To add a new entry, click the Add button, revealing the following screen to configure: 

 
Figure 6- 121. Static ARP Settings – Add window 

To modify a current entry, click the corresponding Modify button of the entry to be modified, revealing the following 
screen to configure: 

 
Figure 6- 122. Static ARP Settings – Edit window 

The following fields can be set or viewed: 

Parameter              Description 

IP Address The IP address of the ARP entry. This field cannot be edited in the Static ARP 
Settings – Edit window. 

MAC Address The MAC address of the ARP entry. 

After entering the IP Address and MAC Address of the Static ARP entry, click Apply to implement the new entry. To 
completely clear the Static ARP Settings, click the Clear All button. 
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RIP 
The Routing Information Protocol is a distance-vector routing protocol. Every 30 seconds, a router running RIP broadcasts 
a routing update containing a set of pairs of network addresses and a distance (represented by the number of hops or routers 
between the advertising router and the remote network). So, the vector is the network address and the distance is measured 
by the number of routers between the local router and the remote network. 

RIP measures distance by an integer count of the number of hops from one network to another. A router is one hop from a 
directly connected network, two hops from a network that can be reached through a router, etc. The more routers between a 
source and a destination, the greater the RIP distance (or hop count). 

There are a few rules to the routing table update process that help to improve performance and stability. A router will not 
replace a route with a newly learned one if the new route has the same hop count (sometimes referred to as ‘cost’). So 
learned routes are retained until a new route with a lower hop count is learned. 

When learned routes are entered into the routing table, a timer is started. This timer is restarted every time this route is 
advertised. If the route is not advertised for a period of time (usually 180 seconds), the route is removed from the routing 
table.  

RIP does not have an explicit method to detect routing loops. Many RIP implementations include an authorization 
mechanism (a password) to prevent a router from learning erroneous routes from unauthorized routers. 

To maximize stability, the hop count RIP uses to measure distance must have a low maximum value. Infinity (that is, the 
network is unreachable) is defined as 16 hops. In other words, if a network is more than 16 routers from the source, the 
local router will consider the network unreachable. 

RIP can also be slow to converge (to remove inconsistent, unreachable or looped routes from the routing table) because 
RIP messages propagate relatively slowly through a network. 

Slow convergence can be solved by using split horizon update, where a router does not propagate information about a route 
back to the interface on which it was received. This reduces the probability of forming transient routing loops. 
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RIP Version 1 Message Format 

There are two types of RIP messages: routing information messages and information requests. Both types use the same 
format. 

The Command field specifies an operation according the following table: 

Command Meaning 

1 Request for partial or full routing information 

2 Response containing network-distance pairs from 
sender’s routing table 

3 Turn on trace mode (obsolete) 

4 Turn off trace mode (obsolete) 

5 Reserved for Sun Microsystem’s internal use 

9 Update Request 

10 Update Response 

11 Update Acknowledgement 

RIP Command Codes 
The field VERSION contains the protocol version number (1 in this case), and is used by the receiver to verify which 
version of RIP the packet was sent. 

RIP 1 Message 

RIP is not limited to TCP/IP.  Its address format can support up to 14 octets (when using IP, the remaining 10 octets must 
be zeros).  Other network protocol suites can be specified in the Family of Source Network field (IP has a value of 2).  This 
will determine how the address field is interpreted. 

RIP specifies that the IP address, 0.0.0.0, denotes a default route. 

The distances, measured in router hops are entered in the Distance to Source Network, and Distance to Destination 
Network fields. 

RIP 1 Route Interpretation 

RIP was designed to be used with classed address schemes, and does not include an explicit subnet mask.  An extension to 
version 1 does allow routers to exchange subnetted addresses, but only if the subnet mask used by the network is the same 
as the subnet mask used by the address.  This means the RIP version 1 cannot be used to propagate classless addresses. 

Routers running RIP version 1 must send different update messages for each IP interface to which it is connected.  
Interfaces that use the same subnet mask as the router’s network can contain subnetted routes, other interfaces cannot.  The 
router will then advertise only a single route to the network. 

RIP Version 2 Extensions 

RIP version 2 includes an explicit subnet mask entry, so RIP version 2 can be used to propagate variable length subnet 
addresses or CIDR classless addresses.  RIP version 2 also adds an explicit next hop entry, which speeds convergence and 
helps prevent the formation of routing loops. 
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RIP2 Message Format 

The message format used with RIP2 is an extension of the RIP1 format: 

RIP version 2 also adds a 16-bit route tag that is retained and sent with router updates.  It can be used to identify the origin 
of the route. 

Because the version number in RIP2 occupies the same octet as in RIP1, both versions of the protocols can be used on a 
given router simultaneously without interference. 

RIP Timers 
Every 30 second interval, all neighbor gateways are sent RIP data to ensure the RIP function is working and up to date. At  
times, an over abundance of gateways send out RIP PDUs at the same time, causing collisions on the network. To better 
cope with this problem, RIP Timers are now configurable for the xStack DGS/DXS-3300 Series. Though always present, 
the switch administrator can now configure RIP timers for the RIP update interval, the route timeout value and the garbage 
collection interval. These timers, if properly configured, can reduce the amount of unnecessary traffic passing through the 
Switch. Yet, the switch administrator must be aware of these points: 

1. RIP Timers are set for the whole system and cannot be individually configured by IP interface. 

2. No error checks will be administered for the RIP timers. 

 To configure the RIP Timers, please see the next section, RIP Global Settings. 

RIP Global Settings 
To setup RIP for the IP interfaces configured on the Switch, the user must first globally enable RIP and then configure RIP 
settings for the individual IP interfaces. To globally enable RIP on the Switch, open the Configuration folder to Layer 3 
Networking and then open the RIP folder and click on the RIP Global Settings link to access the following screen: 

 
Figure 6- 123. RIP Global Settings window 

The following RIP Global Settings can be applied as follows: 

Parameter              Description 

RIP Update Interval This interval is used to determine the time unsolicited response messages containing 
the complete routing table are sent to all neighboring routers. The user may select an 
Update Interval between 1 – 65535 seconds with a default setting of 30 seconds. 

RIP Timeout Interval This timeout interval establishes the time a given route is valid on the network. Once 
this timeout has expired, the route will be retained in the routing table for a short 
period of time so neighbor routers can be notified that the route has been dropped. 
The user may set this time between 1 – 65535 seconds with a default setting of 180 
seconds. 

RIP Garbage Collect 
Interval 

This interval represents the time the route will be retained in the routing table before 
being dropped by the Switch. The user may set this time between 1 – 65535 seconds 
with a default setting of 120 seconds. 

State The user may use the pull-down menu to enable or disable RIP globally on the 
Switch. The default is Disabled. 
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Click Apply to implement changes made. 

   

CAUTION: Setting the update timer for an interval less than the default 
value of 30 seconds may cause unnecessary traffic to build on the 
network, thus causing congestion on the network. If there are many 
interfaces and routes set, and the RIP update timer is set to a short period 
of time, RIP PDUs are incapable of being sent. 

RIP Settings 
RIP settings are configured for each IP interface on the Switch. Click the RIP Interface Settings link in the RIP folder. 
The menu appears in table form listing settings for IP interfaces currently on the Switch. To configure RIP settings for an 
individual interface, click on the hyperlinked Interface Name. To view the next page of RIP Interface Settings, click the 
Next button. 

 
Figure 6- 124. RIP Interface Settings window 

Click the hyperlinked name of the interface to set up for RIP, which will give access to the following menu: 

 
Figure 6- 125. RIP Interface Settings - Edit window 

Refer to the table below for a description of the available parameters for RIP interface settings.  

The following RIP settings can be applied to each IP interface: 

Parameter              Description 

Interface Name The name of the IP interface on which RIP is to be setup. This interface must be 
previously configured on the Switch. 

IP Address The IP address corresponding to the Interface Name showing in the field above. 

TX Mode  Toggle among Disabled, V1 Only, V1 Compatible, and V2 Only. This entry specifies 
which version of the RIP protocol will be used to transmit RIP packets. Disabled 
prevents the transmission of RIP packets. 
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RX Mode  Toggle among Disabled, V1 Only, V2 Only, and V1 or V2. This entry specifies which 
version of the RIP protocol will be used to interpret received RIP packets. Disabled 
prevents the reception of RIP packets. 

Authentication Toggle between Disabled and Enabled to specify that routers on the network should 
us the Password above to authenticate router table exchanges. 

Password A password to be used to authenticate communication between routers on the 
network. 

State Toggle between Disabled and Enabled to disable or enable this RIP interface on the 
switch. 

Interface Metric A read-only  field that denotes the Metric value of the current IP Interface setting. 

Click Apply to implement changes made. 
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OSPF 
The Open Shortest Path First (OSPF) routing protocol uses a link-state algorithm to determine routes to network 
destinations. A “link” is an interface on a router and the “state” is a description of that interface and its relationship to 
neighboring routers. The state contains information such as the IP address, subnet mask, type of network the interface is 
attached to, other routers attached to the network, etc. The collection of link-states is then collected in a link-state database 
that is maintained by routers running OSPF. 

OSPF specifies how routers will communicate to maintain their link-state database and defines several concepts about the 
topology of networks that use OSPF. 

To limit the extent of link-state update traffic between routers, OSPF defines the concept of Area. All routers within an 
area share the exact same link-state database, and a change to this database on one router triggers an update to the link-state 
database of all other routers in that area. Routers that have interfaces connected to more than one area are called Border 
Routers and take the responsibility of distributing routing information between areas. 

One area is defined as Area 0 or the Backbone. This area is central to the rest of the network in that all other areas have a 
connection (through a router) to the backbone.  Only routers have connections to the backbone and OSPF is structured such 
that routing information changes in other areas will be introduced into the backbone, and then propagated to the rest of the 
network. 

When constructing a network to use OSPF, it is generally advisable to begin with the backbone (area 0) and work outward 

Link-State Algorithm 
An OSPF router uses a link-state algorithm to build a shortest path tree to all destinations known to the router. The 
following is a simplified description of the algorithm’s steps: 

• When OSPF is started, or when a change in the routing information changes, the router generates a link-state 
advertisement. This advertisement is a specially formatted packet that contains information about all the link-
states on the router.   

• This link-state advertisement is flooded to all router in the area. Each router that receives the link-state 
advertisement will store the advertisement and then forward a copy to other routers.   

• When the link-state database of each router is updated, the individual routers will calculate a Shortest Path Tree to 
all destinations − with the individual router as the root. The IP routing table will then be made up of the 
destination address, associated cost, and the address of the next hop to reach each destination.  

• Once the link-state databases are updated, Shortest Path Trees calculated, and the IP routing tables written − if 
there are no subsequent changes in the OSPF network (such as a network link going down) there is very little 
OSPF traffic. 

Shortest Path Algorithm 
The Shortest Path to a destination is calculated using the Dijkstra algorithm. Each router is places at the root of a tree and 
then calculates the shortest path to each destination based on the cumulative cost to reach that destination over multiple 
possible routes. Each router will then have its own Shortest Path Tree (from the perspective of its location in the network 
area) even though every router in the area will have and use the exact same link-state database. 

The following sections describe the information used to build the Shortest Path Tree. 

OSPF Cost 
Each OSPF interface has an associated cost (also called “metric”) that is representative of the overhead required to send 
packets over that interface. This cost is inversely proportional to the bandwidth of the interface (i.e. a higher bandwidth 
interface has a lower cost). There is then a higher cost (and longer time delays) in sending packets over a 56 Kbps dial-up 
connection than over a 10 Mbps Ethernet connection.  The formula used to calculate the OSPF cost is as follows: 

Cost = 100,000,000 / bandwidth in bps 

As an example, the cost of a 10 Mbps Ethernet line will be 10 and the cost to cross a 1.544 Mbps T1 line will be 64. 
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Shortest Path Tree 
To build Router A’s shortest path tree for the network diagramed below, Router A is put at the root of the tree and the 
smallest cost link to each destination network is calculated. 

 
Figure 6- 126. Constructing a Shortest Path Tree 

Router A

Router B
Router C

Router D

128.213.0.0

192.213.11.0

222.211.10.0

0

1010

5
5

10

10

 
Figure 6- 127. Constructing a Shortest Path Tree 

The diagram above shows the network from the viewpoint of Router A. Router A can reach 192.213.11.0 through Router B 
with a cost of 10 + 5 = 15. Router A can reach 222.211.10.0 through Router C with a cost of 10 + 10 = 20. Router A can 
also reach 222.211.10.0 through Router B and Router D with a cost of 10 + 5 + 10 = 25, but the cost is higher than the 
route through Router C. This higher-cost route will not be included in the Router A’s shortest path tree. The resulting tree 
will look like this: 
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Router A

Router B
Router C

128.213.0.0

192.213.11.0 222.211.10.0

0

1010

5 10

 
Figure 6- 128. Constructing a Shortest Path Tree - Completed 

Note that this shortest path tree is only from the viewpoint of Router A. The cost of the link from Router B to Router A, for 
instance is not important to constructing Router A’s shortest path tree, but is very important when Router B is constructing 
its shortest path tree. 

Note also that directly connected networks are reached at a cost of zero, while other networks are reached at the cost 
calculated in the shortest path tree. 

Router A can now build its routing table using the network addresses and costs calculated in building the above shortest 
path tree. 

Areas and Border Routers 
OSPF link-state updates are forwarded to other routers by flooding to all routers on the network. OSPF uses the concept of 
areas to define where on the network routers that need to receive particular link-state updates are located. This helps ensure 
that routing updates are not flooded throughout the entire network and to reduce the amount of bandwidth consumed by 
updating the various router’s routing tables. 

Areas establish boundaries beyond which link-state updates do not need to be flooded. So the exchange of link-state 
updates and the calculation of the shortest path tree are limited to the area that the router is connected to. 

Routers that have connections to more than one area are called Border Routers (BR). The Border Routers have the 
responsibility of distributing necessary routing information and changes between areas. 

Areas are specific to the router interface. A router that has all of its interfaces in the same area is called an Internal Router.  
A router that has interfaces in multiple areas is called a Border Router. Routers that act as gateways to other networks 
(possibly using other routing protocols) are called Autonomous System Border Routers (ASBRs). 

Link-State Packets 
There are a number of different types of link-state packets, four of which are illustrated below: 

• Router Link-State Updates − These describe a router’s links to destinations within an area. 

• Summary Link-State Updates – Issued by Border Routers and describe links to networks outside the area but 
within the Autonomous System (AS). 

• Network Link-State Updates – Issued by multi-access areas that have more than one attached router. One router is 
elected as the Designated Router (DR) and this router issues the network link-state updates describing every 
router on the segment. 

• External Link-State Updates – Issued by an Autonomous System Border Router and describes routes to 
destinations outside the AS or a default route to the outside AS. 

The format of these link-state updates is described in more detail below. 
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Router link-state updates are flooded to all routers in the current area. These updates describe the destinations reachable 
through all of the router’s interfaces. 

Summary link-state updates are generated by Border Routers to distribute routing information about other networks within 
the AS. Normally, all Summary link-state updates are forwarded to the backbone (area 0) and are then forwarded to all 
other areas in the network. Border Routers also have the responsibility of distributing routing information from the 
Autonomous System Border Router in order for routers in the network to get and maintain routes to other Autonomous 
Systems. 

Network link-state updates are generated by a router elected as the Designated Router on a multi-access segment (with 
more than one attached router). These updates describe all of the routers on the segment and their network connections. 

External link-state updates carry routing information to networks outside the Autonomous System. The Autonomous 
System Border Router is responsible for generating and distributing these updates. 

OSPF Authentication 
OSPF packets can be authenticated as coming from trusted routers by the use of predefined passwords. The default for 
routers is to use not authentication. 

There are two other authentication methods − simple password authentication (key) and Message Digest authentication 
(MD-5). 

Message Digest Authentication (MD-5) 
MD-5 authentication is a cryptographic method. A key and a key-ID are configured on each router. The router then uses an 
algorithm to generate a mathematical “message digest” that is derived from the OSPF packet, the key and the key-ID. This 
message digest (a number) is then appended to the packet. The key is not exchanged over the wire and a non-decreasing 
sequence number is included to prevent replay attacks. 

Simple Password Authentication 
A password (or key) can be configured on a per-area basis. Routers in the same area that participate in the routing domain 
must be configured with the same key. This method is possibly vulnerable to passive attacks where a link analyzer is used 
to obtain the password. 

Backbone and Area 0 
OSPF limits the number of link-state updates required between routers by defining areas within which a given router 
operates. When more than one area is configured, one area is designated as area 0 − also called the backbone. 

The backbone is at the center of all other areas − all areas of the network have a physical (or virtual) connection to the 
backbone through a router. OSPF allows routing information to be distributed by forwarding it into area 0, from which the 
information can be forwarded to all other areas (and all other routers) on the network. 

In situations where an area is required, but is not possible to provide a physical connection to the backbone, a virtual link 
can be configured. 

Virtual Links 
Virtual links accomplish two purposes: 

• Linking an area that does not have a physical connection to the backbone. 

• Patching the backbone in case there is a discontinuity in area 0. 

Areas Not Physically Connected to Area 0 
All areas of an OSPF network should have a physical connection to the backbone, but is some cases it is not possible to 
physically connect a remote area to the backbone. In these cases, a virtual link is configured to connect the remote area to 
the backbone. A virtual path is a logical path between two border routers that have a common area, with one border router 
connected to the backbone. 
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Partitioning the Backbone 
OSPF also allows virtual links to be configured to connect the parts of the backbone that are discontinuous. This is the 
equivalent to linking different area 0s together using a logical path between each area 0. Virtual links can also be added for 
redundancy to protect against a router failure. A virtual link is configured between two border routers that both have a 
connection to their respective area 0s. 

Neighbors 
Routers that are connected to the same area or segment become neighbors in that area. Neighbors are elected via the Hello 
protocol. IP multicast is used to send out Hello packets to other routers on the segment. Routers become neighbors when 
they see themselves listed in a Hello packet sent by another router on the same segment. In this way, two-way 
communication is guaranteed to be possible between any two neighbor routers. 

Any two routers must meet the following conditions before the become neighbors: 

• Area ID − Two routers having a common segment − their interfaces have to belong to the same area on that 
segment. Of course, the interfaces should belong to the same subnet and have the same subnet mask. 

• Authentication − OSPF allows for the configuration of a password for a specific area. Two routers on the same 
segment and belonging to the same area must also have the same OSPF password before they can become 
neighbors. 

• Hello and Dead Intervals − The Hello interval specifies the length of time, in seconds, between the hello packets 
that a router sends on an OSPF interface.  The dead interval is the number of seconds that a router’s Hello packets 
have not been seen before its neighbors declare the OSPF router down.  OSPF routers exchange Hello packets on 
each segment in order to acknowledge each other’s existence on a segment and to elect a Designated Router on 
multi-access segments.  OSPF requires these intervals to be exactly the same between any two neighbors. If any of 
these intervals are different, these routers will not become neighbors on a particular segment. 

• Stub Area Flag − Any two routers also have to have the same stub area flag in their Hello packets in order to 
become neighbors. 

Adjacencies 
Adjacent routers go beyond the simple Hello exchange and participate in the link-state database exchange process. OSPF 
elects one router as the Designated Router (DR) and a second router as the Backup Designated Router (BDR) on each 
multi-access segment (the BDR is a backup in case of a DR failure). All other routers on the segment will then contact the 
DR for link-state database updates and exchanges. This limits the bandwidth required for link-state database updates. 

Designated Router Election 
The election of the DR and BDR is accomplished using the Hello protocol. The router with the highest OSPF priority on a 
given multi-access segment will become the DR for that segment.  In case of a tie, the router with the highest Router ID 
wins.  The default OSPF priority is 1. A priority of zero indicates a router that cannot be elected as the DR. 

Building Adjacency 
Two routers undergo a multi-step process in building the adjacency relationship. The following is a simplified description 
of the steps required: 

• Down − No information has been received from any router on the segment. 
• Attempt − On non-broadcast multi-access networks (such as Frame Relay or X.25), this state indicates that no 

recent information has been received from the neighbor. An effort should be made to contact the neighbor by 
sending Hello packets at the reduced rate set by the Poll Interval. 

• Init − The interface has detected a Hello packet coming from a neighbor but bi-directional communication has not 
yet been established. 

• Two-way − Bi-directional communication with a neighbor has been established. The router has seen its address in 
the Hello packets coming from a neighbor. At the end of this stage the DR and BDR election would have been 
done. At the end of the Two-way stage, routers will decide whether to proceed in building an adjacency or not.  
The decision is based on whether one of the routers is a DR or a BDR or the link is a point-to-point or virtual link. 

• Exstart − (Exchange Start) Routers establish the initial sequence number that is going to be used in the 
information exchange packets. The sequence number insures that routers always get the most recent information.  
One router will become the primary and the other will become secondary. The primary router will poll the 
secondary for information. 
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• Exchange − Routers will describe their entire link-state database by sending database description packets.   
• Loading − The routers are finalizing the information exchange. Routers have link-state request list and a link-

state retransmission list. Any information that looks incomplete or outdated will be put on the request list. Any 
update that is sent will be put on the retransmission list until it is acknowledged. 

• Full − The adjacency is now complete. The neighboring routers are fully adjacent. Adjacent routers will have the 
same link-state database. 

Adjacencies on Point-to-Point Interfaces 
OSPF Routers that are linked using point-to-point interfaces (such as serial links) will always form adjacencies.  The 
concepts of DR and BDR are unnecessary. 

OSPF Packet Formats 
All OSPF packet types begin with a standard 24-byte header and there are five packet types. The header is described first, 
and each packet type is described in a subsequent section. 

All OSPF packets (except for Hello packets) forward link-state advertisements. Link-State Update packets, for example, 
flood advertisements throughout the OSPF routing domain. 

• OSPF packet header  

• Hello packet  

• Database Description packet  

• Link-State Request packet  

• Link-State Update packet  

• Link-State Acknowledgment packet 
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OSPF Packet Header 

Every OSPF packet is preceded by a common 24-byte header. This header contains the information necessary for a 
receiving router to determine if the packet should be accepted for further processing. 

The format of the OSPP packet header is shown below: 

OSPF Packet Header

Type Packet Length

Router ID

Area ID

Checksum Authentication Type

Authentication

Authentication

Version No.

 

Figure 6- 129. OSPF Packet Header Format 

Field Description 

Version No. The OSPF version number 

Type The OSPF packet type. The OSPF packet types are as follows: Type  
Description Hello Database Description Link-State Request Link-State 
Update Link-State Acknowledgment 

Packet Length The length of the packet in bytes. This length includes the 24-byte 
header. 

Router ID The Router ID of the packet’s source. 

Area ID A 32-bit number identifying the area that this packet belongs to. All 
OSPF packets are associated with a single area. Packets traversing a 
virtual link are assigned the backbone Area ID of 0.0.0.0 

Checksum A standard IP checksum that includes all of the packet’s contents 
except for the 64-bit authentication field. 

Authentication Type The type of authentication to be used for the packet. 

Authentication A 64-bit field used by the authentication scheme. 
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Hello Packet 

Hello packets are OSPF packet type 1. They are sent periodically on all interfaces, including virtual links, in order to 
establish and maintain neighbor relationships. In addition, Hello Packets are multicast on those physical networks having a 
multicast or broadcast capability, enabling dynamic discovery of neighboring routers. 

All routers connected to a common network must agree on certain parameters such as the Network Mask, the Hello 
Interval, and the Router Dead Interval. These parameters are included in the hello packets, so that differences can inhibit 
the forming of neighbor relationships. A detailed explanation of the receive process for Hello packets is necessary so that 
differences can inhibit the forming of neighbor relationships. 

The format of the Hello packet is shown below: 
Hello Packet

1 Packet Length

Router ID

Area ID

Version No.

Checksum Authentication Type

Authentication

Authentication

Network Mask

Hello Interval Options Router Priority

Router Dead Interval

Designated Router

Backup Designated Router

Neighbor  
Figure 6- 130. Hello Packet 

Field Description 

Network Mask The network mask associated with this interface. 

Options The optional capabilities supported by the router. 

Hello Interval The number of seconds between this router’s Hello packets. 

Router Priority This router’s Router Priority. The Router Priority is used in the 
election of the DR and BDR. If this field is set to 0, the router is 
ineligible  become the DR or the BDR. 

Router Dead Interval The number of seconds that must pass before declaring a 
silent router as down. 

Designated Router The identity of the DR for this network, in the view of the 
advertising router. The DR is identified here by its IP interface 
address on the network. 

Backup Designated Router The identity of the Backup Designated Router (BDR) for this 
network. The BDR is identified here by its IP interface address 
on the network. This field is set to 0.0.0.0 if there is no BDR. 

Field Description 

Neighbor The Router IDs of each router from whom valid Hello packets 
have been seen within the Router Dead Interval on the 
network. 
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Database Description Packet 
Database Description packets are OSPF packet type 2. These packets are exchanged when an adjacency is being initialized.  
They describe the contents of the topological database. Multiple packets may be used to describe the database. For this 
purpose, a poll-response procedure is used. One of the routers is designated to be master, the other a slave. The master 
seconds Database Description packets (polls) that are acknowledged by Database Description packets sent by the slave 
(responses).  The responses are linked to the polls via the packets’ DD sequence numbers. 

Database Description Packet

Version No. 2 Packet Length

Router ID

Area ID

Authentication Type

Authentication

Authentication

Checksum

Options

DD Sequence No.

Reserved Reserved

Link-State Advertisement Header ...

I MMS

 
Figure 6- 131. Database Description Packet 

Field Description 

Options The optional capabilities supported by the router. 

I - bit The Initial bit. When set to 1, this packet is the first in the sequence 
of Database Description packets. 

M - bit The More bit. When set to 1, this indicates that more Database 
Description packets will follow. 

MS - bit The Master Slave bit. When set to 1, this indicates that the router is 
the master during the Database Exchange process. A zero 
indicates the opposite. 

DD Sequence Number User to sequence the collection of Database Description Packets.  
The initial value (indicated by the Initial bit being set) should be 
unique. The DD sequence number then increments until the 
complete database description has been sent. 

The rest of the packet consists of a list of the topological database’s pieces. Each link state advertisement in the database is 
described by its link state advertisement header. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

171 

     

Link-State Request Packet 

Link-State Request packets are OSPF packet type 3. After exchanging Database Description packets with a neighboring 
router, a router may find that parts of its topological database are out of date. The Link-State Request packet is used to 
request the pieces of the neighbor’s database that are more up to date. Multiple Link-State Request packets may need to be 
used. The sending of Link-State Request packets is the last step in bringing up an adjacency. 

A router that sends a Link-State Request packet has in mind the precise instance of the database pieces it is requesting, 
defined by LS sequence number, LS checksum, and LS age, although these fields are not specified in the Link-State 
Request packet itself. The router may receive even more recent instances in response. 

The format of the Link-State Request packet is shown below: 

Version No. Packet Length

Router ID

Area ID

Authentication Type

Authentication

Authentication

Checksum

Link-State Request Packet

3

Link-State Type

Link-State ID

Advertising Router  
Figure 6- 132. Link-State Request Packet 

Each advertisement requested is specified by its Link-State Type, Link-State ID, and Advertising Router. This uniquely 
identifies the advertisement, but not its instance. Link-State Request packets are understood to be requests for the most 
recent instance. 

Link-State Update Packet 
Link-State Update packets are OSPF packet type 4. These packets implement the flooding of link-state advertisements.  
Each Link-State Update packet carries a collection of link-state advertisements one hop further from its origin. Several 
link-state advertisements may be included in a single packet. 

Link-State Update packets are multicast on those physical networks that support multicast/broadcast. In order to make the 
flooding procedure reliable, flooded advertisements are acknowledged in Link-State Acknowledgment packets. If 
retransmission of certain advertisements is necessary, the retransmitted advertisements are always carried by unicast Link-
State Update packets. 

The format of the Link-State Update packet is shown below: 

Version No. Packet Length

Router ID

Area ID

Authentication Type

Authentication

Authentication

Checksum

Link-State Update Packet

4

Number of Advertisements

Link-State Advertisements ...  
Figure 6- 133. Link-State Update Packet 
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The body of the Link-State Update packet consists of a list of link-state advertisements. Each advertisement begins with a 
common 20-byte header, the link-state advertisement header. Otherwise, the format of each of the five types of link-state 
advertisements is different. 

Link-State Acknowledgment Packet 
Link-State Acknowledgment packets are OSPF packet type 5. To make the folding of link-state advertisements reliable, 
flooded advertisements are explicitly acknowledged. This acknowledgment is accomplished through the sending and 
receiving of Link-State Acknowledgment packets. Multiple link-state advertisements can be acknowledged in a single 
Link-State Acknowledgment packet. 

Depending on the state of the sending interface and the source of the advertisements being acknowledged, a Link-State 
Acknowledgment packet is sent either to the multicast address AllSPFRouters, to the multicast address AllDRouters, or as 
a unicast packet. 

The format of this packet is similar to that of the Data Description packet. The body of both packets is simply a list of link-
state advertisement headers. 

The format of the Link-State Acknowledgment packet is shown below: 

Version No. Packet Length

Router ID

Area ID

Authentication Type

Authentication

Authentication

Checksum

Link-State Acknowledgment Packet

5

Link-State Advertisement Header ...
 

Figure 6- 134. Link State Acknowledge Packet 

Each acknowledged link-state advertisement is described by its link-state advertisement header. It contains all the 
information required to uniquely identify both the advertisement and the advertisement’s current instance. 

Link-State Advertisement Formats 
There are five distinct types of link-state advertisements. Each link-state advertisement begins with a standard 20-byte link-
state advertisement header.  Succeeding sections then diagram the separate link-state advertisement types. 

Each link-state advertisement describes a piece of the OSPF routing domain. Every router originates a router links 
advertisement. In addition, whenever the router is elected as the Designated Router, it originates a network links 
advertisement. Other types of link-state advertisements may also be originated. The flooding algorithm is reliable, ensuring 
that all routers have the same collection of link-state advertisements. The collection of advertisements is called the link-
state (or topological) database. 

From the link-state database, each router constructs a shortest path tree with itself as root.  This yields a routing table. 

There are four types of link state advertisements, each using a common link state header. These are: 

• Router Links Advertisements 

• Network Links Advertisements 

• Summary Link Advertisements 

• Autonomous System Link Advertisements 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

173 

     

Link State Advertisement Header 
All link state advertisements begin with a common 20-byte header. This header contains enough information to uniquely 
identify the advertisements (Link State Type, Link State ID, and Advertising Router). Multiple instances of the link state 
advertisement may exist in the routing domain at the same time. It is then necessary to determine which instance is more 
recent. This is accomplished by examining the link state age, link state sequence number and link state checksum fields 
that are also contained in the link state advertisement header. 

The format of the Link State Advertisement Header is shown below: 

Link-State Advertisement Header

Link-State Age Options Link-State Type

Link-State ID

Advertising Router

Link-State Sequence Number

Link-State Checksum Length  
Figure 6- 135. Link State Advertisement Header 

Field Description 

Link State Age The time is seconds since the link state advertisement was originated. 

Options The optional capabilities supported by the described portion of the 
routing domain. 

Link State Type The type of the link state advertisement. Each link state type has a 
separate advertisement format.  

The link state type are as follows: Router Links, Network Links, 
Summary Link (IP Network), Summary Link (ASBR), AS External Link. 

Link State ID This field identifies the portion of the internet environment that is being 
described by the advertisement. The contents of this field depend on the 
advertisement’s Link State Type. 

Advertising Router The Router ID of the router that originated the Link State Advertisement. 
For example, in network links advertisements this field is set to the Router 
ID of the network’s Designated Router. 

Link State Sequence 
Number 

Detects old or duplicate link state advertisements. Successive instances 
of a link state advertisement are given successive Link State Sequence 
numbers. 

Link State Checksum The Fletcher checksum of the complete contents of the link state 
advertisement, including the link state advertisement header by accepting 
the Link State Age field. 

Length The length in bytes of the link state advertisement. This includes the 20-
byte link state advertisement header. 
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Router Links Advertisements 
Router links advertisements are type 1 link state advertisements. Each router in an area originates a routers links 
advertisement. The advertisement describes the state and cost of the router’s links to the area. All of the router’s links to 
the area must be described in a single router links advertisement. 

The format of the Router Links Advertisement is shown below: 

Link-State Age Options Link-State Type

Link-State ID

Advertising Router

Link-State Sequence Number

Link-State Checksum Length

Routers Links Advertisements

Reserved Reserved Number of Links

Link ID

Link Data

Type No. Of TOS TOS 0 Metric

TOS Metric

...

TOS Metric

...

Link ID

Link Data

0

0

V BE

 
Figure 6- 136. Routers Links Advertisements 

In router links advertisements, the Link State ID field is set to the router’s OSPF Router ID. The T - bit is set in the 
advertisement’s Option field if and only if the router is able to calculate a separate set of routes for each IP Type of Service 
(TOS). Router links advertisements are flooded throughout a single area only. 

Field Description 

V - bit When set, the router is an endpoint of an active virtual link that is 
using the described area as a Transit area (V is for Virtual link 
endpoint). 

E - bit When set, the router is an Autonomous System (AS) boundary 
router (E is for External). 

B - bit When set, the router is an area border router (B is for Border). 

Number of Links The number of router links described by this advertisement. This 
must be the total collection of router links to the area. 
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The following fields are used to describe each router link. Each router link is typed. The Type field indicates the kind of 
link being described. It may be a link to a transit network, to another router or to a stub network. The values of all the other 
fields describing a router link depend on the link’s Type. For example, each link has an associated 32-bit data field. For 
links to stub networks, this field specifies the network’s IP address mask. For other link types, the Link Data specifies the 
router’s associated IP interface address. 

Field Description 

Type A quick classification of the router link.  One of the following: 
Type     Description Point-to-point connection to another router. 
Connection to a transit network. Connection to a stub network. 
Virtual link. 

Link ID Identifies the object that this router link connects to. Value 
depends on the link’s Type.  When connecting to an object that 
also originates a link state advertisement (i.e. another router or 
a transit network) the Link ID is equal to the neighboring 
advertisement’s Link State ID. This provides the key for looking 
up an advertisement in the link state database. Type     Link ID 
Neighboring router’s Router ID. IP address of Designated 
Router. IP network/subnet number. Neighboring router’s 
Router ID 

Link Data Contents again depend on the link’s Type field. For 
connections to stub networks, it specifies the network’s IP 
address mask. For unnumbered point-to-point connection, it 
specifies the interface’s MIB-II ifIndex value. For other link 
types it specifies the router’s associated IP interface address.  
This latter piece of information is needed during the routing 
table build process, when calculating the IP address of the next 
hop. 

No. of TOS The number of different Type of Service (TOS) metrics given 
for this link, not counting the required metric for TOS 0. If no 
additional TOS metrics are given, this field should be set to 0. 

TOS 0 Metric The cost of using this router link for TOS 0. 

For each link, separate metrics may be specified for each Type of Service (TOS). The metric for TOS 0 must always be 
included, and was discussed above. Metrics for non-zero TOS are described below. Note that the cost for non-zero TOS 
values that are not specified defaults to the TOS 0 cost. Metrics must be listed in order of increasing TOS encoding. For 
example, the metric for TOS 16 must always follow the metric for TOS 8 when both are specified. 

Field Description 

TOS IP Type of Service that this metric refers to. 

Metric The cost of using this outbound router link, for traffic of the 
specified TOS. 
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Network Links Advertisements 

Network links advertisements are Type 2 link state advertisements. A network links advertisement is originated for each 
transit network in the area. A transit network is a multi-access network that has more than one attached router. The network 
links advertisement is originated by the network’s Designated router. The advertisement describes all routers attached to 
the network, including the Designated Router itself. The advertisement’s Link State ID field lists the IP interface address of 
the Designated Router. 

The distance from the network to all attached routers is zero, for all TOS. This is why the TOS and metric fields need not 
be specified in the network links advertisement. 

The format of the Network Links Advertisement is shown below: 

Link-State Age Options

Link-State ID

Advertising Router

Link-State Sequence Number

Link-State Checksum Length

Network Link Advertisements

2

Network Mask

Attached Router
 

Figure 6- 137. Network Link Advertisements 

Field Description 

Network Mask The IP address mask for the network. 

Attached Router The Router IDs of each of the routers attached to the network.  Only 
those routers that are fully adjacent to the Designated Router (DR) 
are listed. The DR includes itself in this list. 
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Summary Link Advertisements 

Summary link advertisements are Type 3 and 4 link state advertisements. These advertisements are originated by Area 
Border routers. A separate summary link advertisement is made for each destination known to the router, which belongs to 
the Autonomous System (AS), yet is outside the area. 

Type 3 link state advertisements are used when the destination is an IP network. In this case, the advertisement’s Link 
State ID field is an IP network number. When the destination is an AS boundary router, a Type 4 advertisement is used, 
and the Link State ID field is the AS boundary router’s OSPF Router ID. Other that the difference in the Link State ID 
field, the format of Type 3 and 4 link state advertisements is identical. 

Link-State Age Options

Link-State ID

Advertising Router

Link-State Sequence Number

Link-State Checksum Length

2

Network Mask

Summary Link Advertisements

TOS Metric
 

Figure 6- 138. Summary Link Advertisements 
For stub area, Type 3 summary link advertisements can also be used to describe a default route on a per-area basis. Default 
summary routes are used in stub area instead of flooding a complete set of external routes. When describing a default 
summary route, the advertisement’s Link State ID is always set to the Default Destination − 0.0.0.0, and the Network Mask 
is set to 0.0.0.0. 

Separate costs may be advertised for each IP Type of Service. Note that the cost for TOS 0 must be included, and is always 
listed first. If the T-bit is reset in the advertisement’s Option field, only a route for TOS 0 is described by the advertisement. 
Otherwise, routes for the other TOS values are also described. If a cost for a certain TOS is not included, its cost defaults to 
that specified for TOS 0. 

Field Description 

Network Mask For Type 3 link state advertisements, this indicates the destination 
network’s IP address mask. For example, when advertising the 
location of a class A network the value 0xff000000  

TOS The Type of Service that the following cost is relevant to. 

Metric The cost of this route. Expressed in the same units as the interface 
costs in the router links advertisements. 
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Autonomous Systems External Link Advertisements 

Autonomous Systems (AS) link advertisements are Type 5 link state advertisements. These advertisements are originated 
by AS boundary routers.  A separate advertisement is made for each destination known to the router that is external to the 
AS. 

AS external link advertisements usually describe a particular external destination. For these advertisements the Link State 
ID field specifies an IP network number. AS external link advertisements are also used to describe a default route. Default 
routes are used when no specific route exists to the destination. When describing a default route, the Link Stat ID is always 
set the Default Destination address (0.0.0.0) and the Network Mask is set to 0.0.0.0. 

The format of the AS External Link Advertisement is shown below: 

Link-State Age Options

Link-State ID

Advertising Router

Link-State Sequence Number

Link-State Checksum Length

Network Mask

TOS Metric

AS External Link Advertisements

5

Forwarding Address

External Route Tag

E

 
Figure 6- 139. AS External Link Advertisements 

Field Description 

Network Mask The IP address mask for the advertised destination. 

E - bit The type of external metric. If the E - bit is set, the metric specified 
is a Type 2 external metric. This means the metric is considered 
larger than any link state path. If the E - bit is zero, the specified 
metric is a Type 1 external metric. This means that is comparable 
directly to the link state metric. 

Forwarding Address Data traffic for the advertised destination will be forwarded to this 
address. If the Forwarding Address is set to 0.0.0.0, data traffic will 
be forwarded instead to the advertisement’s originator. 

TOS The Type of Service that the following cost is relevant to. 

Metric The cost of this route. The interpretation of this metric depends on 
the external type indication (the E - bit above). 

External Route Tag A 32-bit field attached to each external route. This is not used by 
the OSPF protocol itself.  
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OSPF Global Settings 
The OSPF Global Settings menu allows OSPF to be enabled or disabled on the Switch − without changing the Switch’s 
OSPF configuration.  

To view the following window, click Configuration > Layer 3 IP Networking > OSPF > OSPF Global Settings. To 
enable OSPF, first supply an OSPF Route ID (see below), select Enabled from the State drop-down menu and click the 
Apply button. 

 
Figure 6- 140. OSPF General Settings window 

The following parameters are used for general OSPF configuration: 

Parameter              Description 

OSPF Route ID A 32-bit number (in the same format as an IP address − xxx.xxx.xxx.xxx) that uniquely 
identifies the Switch in the OSPF domain. It is common to assign the highest IP 
address assigned to the Switch (router). In this case, it would be 10.53.13.189, but any 
unique 32-bit number will do. If 0.0.0.0 is entered, the highest IP address assigned to 
the Switch will become the OSPF Route ID. 

Current Route ID Displays the OSPF Route ID currently in use by the Switch. This Route ID is displayed 
as a convenience to the user when changing the Switch’s OSPF Route ID. 

State Allows OSPF to be enabled or disabled globally on the Switch without changing the 
OSPF configuration. 

OSPF Area Setting 
This menu allows the configuration of OSPF Area IDs and to designate these areas as either Normal or Stub. Normal 
OSPF areas allow Link-State Database (LSDB) advertisements of routes to networks that are external to the area. Stub 
areas do not allow the LSDB advertisement of external routes. Stub areas use a default summary external route (0.0.0.0 or 
Area 0) to reach external destinations. 

To set up an OSPF area configuration click Configuration > Layer 3 IP Networking > OSPF  > OSPF Area Settings 
link to open the following dialog box: 

 
Figure 6- 141. OSPF Area Settings and Table window 
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To add an OSPF Area to the table, type a unique Area ID (see below) select the Type from the drop-down menu. For a 
Stub type, choose Enabled or Disabled from the Stub Import Summary LSA drop-down menu and determine the Stub 
Default Cost. Click the Add/Modify button to add the area ID set to the table.  

To remove an Area ID configuration set, simply click  in the Delete column for the configuration. 

To change an existing set in the list, type the Area ID of the set to change, make the changes and click the Add/Modify 
button. The modified OSPF area ID will appear in the table. 

 
Figure 6- 142. OSPF Area Settings example window 

See the parameter descriptions below for information on the OSPF Area ID Settings.  

The Area ID settings are as follows: 

Parameter             Description 

Area ID A 32-bit number in the form of an IP address (xxx.xxx.xxx.xxx) that uniquely identifies 
the OSPF area in the OSPF domain. 

Type This field can be toggled between Normal and Stub using the space bar. When it is 
toggled to Stub, additional fields appear − Stub Import Summary LSA, and the Stub 
Default Cost. 

Stub Import 
Summary LSA 

Displays whether or not the selected Area will allow Summary Link-State 
Advertisements (Summary LSAs) to be imported into the area from other areas. 

Stub Default Cost Displays the default cost for the route to the stub of between 0 and 65,535. The default 
is 1. 
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OSPF Interface Settings 
To set up OSPF interfaces, click Configuration > Layer 3 IP Networking > OSPF  > OSPF Interface Settings to view 
OSPF settings for existing IP interfaces. If there are no IP interfaces configured (besides the default System interface), only 
the System interface settings will appear listed. To change settings for in IP interface, click on the hyperlinked name of the 
interface to see the configuration menu for that interface. 

 
Figure 6- 143. OSPF Interface Settings window 

 
Figure 6- 144. OSPF Interface Settings - Edit window 

Configure each IP interface individually using the OSPF Interface Settings - Edit menu. Click the Apply button when the 
user has entered the settings. The new configuration appears listed in the OSPF Interface Settings table. To return to the 
OSPF Interface Settings table, click the Show All OSPF Interface Entries link. 

OSPF interface settings are described below. Some OSPF interface settings require previously configured OSPF settings. 
Read the descriptions below for details. 

 

 

 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

182 

     

Parameter               Description 

Interface Name Displays the of an IP interface previously configured on the Switch. 

Area ID Allows the entry of an OSPF Area ID configured above. 

Router Priority (0-
255) 

Allows the entry of a number between 0 and 255 representing the OSPF priority of the 
selected area. If a Router Priority of 0 is selected, the Switch cannot be elected as the 
Designated Router for the network. 

Hello Interval (1-
65535) 

Allows the specification of the interval between the transmission of OSPF Hello 
packets, in seconds. Between 1 and 65535 seconds can be specified. The Hello 
Interval, Dead Interval, Authorization Type, and Authorization Key should be the 
same for all routers on the same network. 

Dead Interval (1-
65535) 

Allows the specification of the length of time between the receipt of Hello packets from 
a neighbor router before the selected area declares that router down. An interval 
between 1 and 65535 seconds can be specified. The Dead Interval must be evenly 
divisible by the Hello Interval. 

State Allows the OSPF interface to be disabled for the selected area without changing the 
configuration for that area. 

Auth Type This field can be toggled between None, Simple, and MD5 using the space bar. This 
allows a choice of authorization schemes for OSPF packets that may be exchanged 
over the OSPF routing domain.  

• None specifies no authorization.  

• Simple uses a simple password to determine if the packets are from an 
authorized OSPF router. When Simple is selected, the Auth Key field allows 
the entry of an 8-character password that must be the same as a password 
configured on a neighbor OSPF router.  

• MD5 uses a cryptographic key entered in the MD5 Key Table Configuration 
menu. When MD5 is selected, the Auth Key ID field allows the specification 
of the Key ID as defined in the MD5 configuration above. This must be the 
same MD5 Key as used by the neighboring router. 

Password/Auth. Key 
ID 

Enter a Key ID of up to 5 characters to set the Auth. Key ID for either the Simple Auth 
Type or the MD5 Auth Type, as specified in the previous parameter. 

Metric (1-65535) This field allows the entry of a number between 1 and 65,535 that is representative of 
the OSPF cost of reaching the selected OSPF interface. The default metric is 1. 

DR State A read-only  field describing the Designated Router state of the IP interface. This field 
many read DR if the interface is the designated router, or Backup DR if the interface 
is the Backup Designated Router. The highest IP address will be the Designated 
Router and is determined by the OSPF Hello Protocol of the Switch. 

DR Address The IP address of the aforementioned Designated Router. 

Backup DR Address The IP address of the aforementioned Backup Designated Router. 

Transmit Delay A read-only  field that denotes the estimated time to transmit a Link State Update 
Packet over this interface, in seconds. 

Retransmit Time A read-only  field that denotes the time between LSA retransmissions over this 
interface, in seconds. 
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OSPF Virtual Link Settings 
Click the OSPF Virtual Interface Settings link to view the current OSPF Virtual Interface Settings. There are not 
virtual interface settings configured by default, so the first time this table is viewed there will be not interfaces listed. To 
add a new OSPF virtual interface configuration set to the table, click the Add button. A new menu appears (see below). To 
change an existing configuration, click on the hyperlinked Transit Area ID for the set to change. The menu to modify an 
existing set is the same as the menu used to add a new one. To eliminate an existing configuration, click the  in the 
Delete column.  

 
Figure 6- 145. OSPF Virtual Link Settings 

The status of the virtual interface appears (Up or Down) in the Status column. 

 
Figure 6- 146. OSPF Virtual Link Settings – Add 

Configure the following parameters to add or change an OSPF Virtual Interface: 

Parameter                      Description 

Transit Area ID Allows the entry of an OSPF Area ID − previously defined on the Switch − that allows 
a remote area to communicate with the backbone (area 0). A Transit Area cannot be a 
Stub Area or a Backbone Area. 

Neighbor Router The OSPF router ID for the remote router. This is a 32-bit number in the form of an IP 
address (xxx.xxx.xxx.xxx) that uniquely identifies the remote area’s Area Border 
Router. 

Hello Interval (1-
65535) 

Specify the interval between the transmission of OSPF Hello packets, in seconds.  
Enter a value between 1 and 65535 seconds. The Hello Interval, Dead Interval, 
Authorization Type, and Authorization Key should have identical settings for all 
routers on the same network. 
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Dead Interval (1-
65535) 

Specify the length of time between (receiving) Hello packets from a neighbor router 
before the selected area declares that router down. Again, all routers on the network 
should use the same setting.  

Auth Type If using authorization for OSPF routers, select the type being used. MD5 key 
authorization must be set up in the MD5 Key Settings menu. 

Password/Auth. Key 
ID  

Enter a case-sensitive password for simple authorization or enter the MD5 key set in 
the MD5 Key settings menu. 

Transmit Delay The number of seconds required to transmit a link state update over this virtual link. 
Transit delay takes into account transmission and propagation delays. This field is 
fixed at 1 second. 

RetransInterval The number of seconds between link state advertisement retransmissions for 
adjacencies belonging to this virtual link. This field is fixed at 5 seconds. 

Click Apply to implement changes made. 

 

NOTE: For OSPF to function properly some settings should be identical 
on all participating OSPF devices. These settings include the Hello Interval 
and Dead Interval. For networks using authorization for OSPF devices, the 
Authorization Type and Password or Key used must likewise be identical. 
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OSPF Area Aggregation Settings 
Area Aggregation allows all of the routing information that may be contained within an area to be aggregated into a 
summary LSDB advertisement of just the network address and subnet mask. This allows for a reduction in the volume of 
LSDB advertisement traffic as well as a reduction in the memory overhead in the Switch used to maintain routing tables. 

Click Configuration > Layer 3 IP Networking > OSPF > OSPF Area Aggregation Settings link to view the current 
settings. There are no aggregation settings configured by default, so there will not be any listed the first accessing the menu. 
To add a new OSPF Area Aggregation setting, click the Add button. A new menu (pictured below) appears. To change 
an existing configuration, click on the hyperlinked Area ID for the set to change. The menu to modify an existing 
configuration is the same as the menu used to add a new one. To eliminate an existing configuration, click the  in the 
Delete column for the configuration being removed. 

 
Figure 6- 147. OSPF Area Aggregation Settings table 

Use the menu below to change settings or add a new OSPF Area Aggregation setting. 

 
Figure 6- 148. OSPF Area Aggregation Settings – Add window 

Specify the OSPF aggregation settings and click the Apply button to add or change the settings. The new settings will 
appear listed in the OSPF Area Aggregation Configuration table. To view the table, click the Show All OSPF 
Aggregation Entries link to return to the previous window.  

Use the following parameters to configure the following settings for OSPF Area Aggregation: 

Parameter            Description 

Area ID Allows the entry the OSPF Area ID for which the routing information will be 
aggregated. This Area ID must be previously defined on the Switch. 

Network Number Sometimes called the Network Address. The 32-bit number in the form of an IP 
address that uniquely identifies the network that corresponds to the OSPF Area 
above. 

Network Mask The corresponding network mask for the Network Number specified above. 

LSDB Type Specifies the type of address aggregation, which is set at Summary.  

Advertisement Select Enabled or Disabled to determine whether the selected OSPF Area will 
advertise it’s summary LSDB (Network-Number and Network-Mask). 

Click Apply to implement changes made. 
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OSPF Host Route Settings 
OSPF host routes work in a way analogous to RIP, only this is used to share OSPF information with other OSPF routers. 
This is used to work around problems that might prevent OSPF information sharing between routers. 

To configure OSPF host routes, click the OSPF Host Route Settings link. To add a new OSPF Route, click the Add 
button. Configure the setting in the menu that appears. The Add and Modify menus for OSPF host route setting are nearly 
identical. The difference being that if changing an existing configuration, the user will be unable to change the Host 
Address. To change an existing configuration, click on the hyperlinked Host Address in the list for the configuration to 
change and proceed to change the metric or area ID. To eliminate an existing configuration, click the  in the Delete 
column for the configuration being removed. 

 
Figure 6- 149. OSPF Host Route Settings table 

Use the menu below to set up OSPF host routes. 

 
Figure 6- 150. OSPF Host Route Settings – Add window 

Specify the host route settings and click the Apply button to add or change the settings. The new settings will appear listed 
in the OSPF Host Route Settings list. To view the previous window, click the Show All OSPF Host Route Entries link to 
return to the previous window. 

The following fields are configured for OSPF host route: 

Parameter              Description 

Host Address The IP address of the OSPF host. 

Metric A value between 1 and 65535 that will be advertised for the route. 

Area ID A 32-bit number in the form of an IP address (xxx.xxx.xxx.xxx) that uniquely identifies 
the OSPF area in the OSPF domain. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

187 

     

DHCP / BOOTP Relay  
The BOOTP hops count limit allows the maximum number of hops (routers) that the BOOTP messages can be relayed 
through to be set. If a packet’s hop count is more than the hop count limit, the packet is dropped. The range is between 1 
and 16 hops, with a default value of 4. The relay time threshold sets the minimum time (in seconds) that the Switch will 
wait before forwarding a BOOTREQUEST packet. If the value in the seconds field of the packet is less than the relay time 
threshold, the packet will be dropped. The range is between 0 and 65,536 seconds, with a default value of 0 seconds. 

DHCP / BOOTP Relay Information 
To enable and configure BOOTP or DHCP on the Switch, click Configuration > DHCP/BOOTP Relay > 
DHCP/BOOTP Relay Global Settings: 

 
Figure 6- 151.  DHCP/ BOOTP Relay Global Settings window 

The following fields can be set: 

Parameter                 Description 

BOOTP Relay State  This field can be toggled between Enabled and Disabled using the pull-down menu.  
It is used to enable or disable the BOOTP/DHCP Relay service on the Switch. The 
default is Disabled 

BOOTP Relay Hops 
Count Limit (1-16)  

This field allows an entry between 1 and 16 to define the maximum number of router 
hops BOOTP messages can be forwarded across. The default hop count is 4. 

BOOTP Relay Time 
Threshold (0-65535) 

Allows an entry between 0 and 65535 seconds, and defines the maximum time limit 
for routing a BOOTP/DHCP packet. If a value of 0 is entered, the Switch will not 
process the value in the seconds field of the BOOTP or DHCP packet. If a non-zero 
value is entered, the Switch will use that value, along with the hop count to determine 
whether to forward a given BOOTP or DHCP packet. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

188 

     

DHCP/BOOTP Relay Interface Settings 
The DHCP/ BOOTP Relay Interface Settings allow the user to set up a server, by IP address, for relaying DHCP/ 
BOOTP information to the Switch. The user may enter a previously configured IP interface on the Switch that will be 
connected directly to the DHCP/BOOTP server using the following window. Properly configured settings will be displayed 
in the BOOTP Relay Table at the bottom of the following window, once the user clicks the Add button under the Apply 
heading. The user may add up to four server IPs per IP interface on the Switch. Entries may be deleted by clicking it’s 
corresponding . 

 
Figure 6- 152. DHCP/BOOTP Relay Interface Settings and DHCP/BOOTP Relay Interface Table window 

The following parameters may be configured or viewed. 

Parameter                      Description 

Interface The IP interface on the Switch that will be connected directly to the Server. 

Server IP Enter the IP address of the DHCP/BOOTP server. Up to four server IPs can be 
configured per IP Interface 
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DNS Relay 
Computer users usually prefer to use text names for computers for which they may want to open a connection. Computers 
themselves, require 32 bit IP addresses. Somewhere, a database of network devices’ text names and their corresponding IP 
addresses must be maintained. 

The Domain Name System (DNS) is used to map names to IP addresses throughout the Internet and has been adapted for 
use within intranets.   

For two DNS servers to communicate across different subnets, the DNS Relay of the Switch must be used. The DNS 
servers are identified by IP addresses. 

Mapping Domain Names to Addresses 
Name-to-address translation is performed by a program called a Name server. The client program is called a Name resolver. 
A Name resolver may need to contact several Name servers to translate a name to an address. 

The Domain Name System (DNS) servers are organized in a somewhat hierarchical fashion. A single server often holds 
names for a single network, which is connected to a root DNS server - usually maintained by an ISP. 

Domain Name Resolution 
The domain name system can be used by contacting the name servers one at a time, or by asking the domain name system 
to do the complete name translation. The client makes a query containing the name, the type of answer required, and a code 
specifying whether the domain name system should do the entire name translation, or simply return the address of the next 
DNS server if the server receiving the query cannot resolve the name. 

When a DNS server receives a query, it checks to see if the name is in its sub domain. If it is, the server translates the name 
and appends the answer to the query, and sends it back to the client. If the DNS server cannot translate the name, it 
determines what type of name resolution the client requested. A complete translation is called recursive resolution and 
requires the server to contact other DNS servers until the name is resolved. Iterative resolution specifies that if the DNS 
server cannot supply an answer, it returns the address of the next DNS server the client should contact. 

Each client must be able to contact at least one DNS server, and each DNS server must be able to contact at least one root 
server. 

The address of the machine that supplies domain name service is often supplied by a DHCP or BOOTP server, or can be 
entered manually and configured into the operating system at startup. 

Configuring DNS Relay Information 
To configure the DNS function on the Switch, click Configuration > Layer 3 IP Networking > DNS Relay > DNS Relay 
Global Settings, which will open the DNS Relay Global Settings window, as seen below: 

 
Figure 6- 153. DNS Relay Global Settings window 

The following fields can be set: 
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Parameter               Description 

DNS State  This field can be toggled between Disabled and Enabled using the pull-down menu, 
and is used to enable or disable the DNS Relay service on the Switch. 

Primary Name Server  Allows the entry of the IP address of a primary domain name server (DNS). 

Secondary Name 
Server 

Allows the entry of the IP address of a secondary domain name server (DNS). 

DNSR Cache Status  This can be toggled between Disabled and Enabled. This determines if a DNS cache 
will be enabled on the Switch. 

DNSR Static Table 
State 

This field can be toggled using the pull-down menu between Disabled and Enabled. 
This determines if the static DNS table will be used or not. 

Click Apply to implement changes made. 

DNS Relay Static Settings 
To view the DNS Relay Static Settings, click Configuration > Layer 3 IP Networking > DNS Relay > DNS Relay 
Static Settings, which will open the DNS Relay Static Settings window, as seen below: 

 
Figure 6- 154. DNS Relay Static Settings and Table window 

To add an entry into the DNS Relay Static Table, simply enter a Domain Name with its corresponding IP address and 
click Add under the Apply heading. A successful entry will be presented in the table below, as shown in the example 

above. To erase an entry from the table, click the  corresponding of the entry to delete. 
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VRRP 
VRRP or Virtual Routing Redundancy Protocol is a function on the Switch that dynamically assigns responsibility for a 
virtual router to one of the VRRP routers on a LAN. The VRRP router that controls the IP address associated with a virtual 
router is called the Master, and will forward packets sent to this IP address. This will allow any Virtual Router IP address 
on the LAN to be used as the default first hop router by end hosts. Utilizing VRRP, the administrator can achieve a higher 
available default path cost without needing to configure every end host for dynamic routing or routing discovery protocols.  

Statically configured default routes on the LAN are prone to a single point of failure. VRRP is designed to eliminate these 
failures by setting an election protocol that will assign a responsibility for a virtual router to one of the VRRP routers on 
the LAN. When a virtual router fails, the election protocol will select a virtual router with the highest priority to be the 
Master router on the LAN. This retains the link and the connection is kept alive, regardless of the point of failure.  

To configure VRRP for virtual routers on the Switch, an IP interface must be present on the system and it must be a part of 
a VLAN. VRRP IP interfaces may be assigned to every VLAN, and therefore IP interface, on the Switch. VRRP routers 
within the same VRRP group must be consistent in configuration settings for this protocol to function optimally. 

VRRP Global Settings 

To enable VRRP globally on the Switch, click Configuration > Layer 3 IP Networking > VRRP > VRRP Global 
Settings: 

 
Figure 6- 155. VRRP Global Settings window 

The following fields can be set: 

Parameter Description 

VRRP State Use the pull-down menu to enable or disable VRRP globally on the Switch. The 
default is Disabled.  

Non-owner response 
PING 

Enabling this parameter will allow the virtual IP address to be pinged from other host 
end nodes to verify connectivity. This will only enable the ping connectivity check 
function. This command is Disabled by default. 

Click Apply to implement changes made. 
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VRRP Virtual Router Settings 
The following window will allow the user to view the parameters for the VRRP function on the Switch. To view this 
window, click Configuration > Layer 3 IP Networking > VRRP > VRRP Virtual Router Settings: 

 
Figure 6- 156. VRRP Virtual Router Settings window 

The following fields are displayed in the window above: 

Parameter              Description 

VRID / Interface 
Name 

VRID - Displays the virtual router ID set by the user. This will uniquely identify the 
VRRP Interface on the network. 

Interface Name - An IP interface name that has been enabled for VRRP. This entry 
must have been previously set in the IP Interfaces table. 

Virtual IP Address The IP address of the Virtual router configured on the Switch. 

Master IP Address Displays the IP address of the Master router for the VRRP function. 

Virtual Router State Displays the current state of the Virtual Router on the Switch. Possible states include 
Initialize, Master and Backup. 

State Displays the VRRP state of the corresponding VRRP entry. 

Display 
Click the  button to display the settings for this particular VRRP entry. 

Delete Click the  to delete this VRRP entry. 

Click the Add button to display the following window to configure a VRRP interface. 

 
Figure 6- 157. VRRP Virtual Router Settings – Add window 
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Or, the user may click the hyperlinked Interface Name to view the same window: 

The following parameters may be set to configure an existing or new VRRP virtual router.  

Parameter               Description 

Interface Name Enter the name of a previously configured IP interface for which to create a VRRP 
entry. This IP interface must be assigned to a VLAN on the Switch. 

VRID (1-255) Enter a value between 1 and 255 to uniquely identify this VRRP group on the Switch. 
All routers participating in this group must be assigned the same VRID value. This 
value MUST be different from other VRRP groups set on the Switch. 

IP Address Enter the IP address that will be assigned to the VRRP router. This IP address is also 
the default gateway that will be statically assigned to end hosts and must be set for all 
routers that participate in this group. 

State Used to enable (Up) and disable (Down) the VRRP IP interface on the Switch. 

Priority (1-254) Enter a value between 1 and 254 to indicate the router priority. The VRRP Priority 
value may determine if a higher priority VRRP router overrides a lower priority VRRP 
router. A higher priority will increase the probability that this router will become the 
Master router of the group. A lower priority will increase the probability that this router 
will become the backup router. VRRP routers that are assigned the same priority 
value will elect the highest physical IP address as the Master router. The default value 
is 100. (The value of 255 is reserved for the router that owns the IP address 
associated with the virtual router and is therefore set automatically.) 

Advertisement 
Interval (1-255) 

Enter a time interval value, in seconds, for sending VRRP message packets. This 
value must be consistent with all participating routers. The default is 1 second. 

Preempt Mode This entry will determine the behavior of backup routers within the VRRP group by 
controlling whether a higher priority backup router will preempt a lower priority Master 
router. A True entry, along with having the backup router’s priority set higher than the 
masters priority, will set the backup router as the Master router. A False entry will 
disable the backup router from becoming the Master router. This setting must be 
consistent with all routers participating within the same VRRP group. The default 
setting is True. 

Critical IP Address Enter the IP address of the physical device that will provide the most direct route to 
the Internet or other critical network connections from this virtual router. This must be 
a real IP address of a real device on the network. If the connection from the virtual 
router to this IP address fails, the virtual router will automatically disabled. A new 
Master will be elected from the backup routers participating in the VRRP group. 
Different critical IP addresses may be assigned to different routers participating in the 
VRRP group, and can therefore define multiple routes to the Internet or other critical 
network connections. 

Checking Critical IP  Use the pull-down menu to enable or disable the Critical IP address entered above.   

Click Apply to implement changes made. 

To view the settings for a particular VRRP setting, click the corresponding  in the VRRP Interface Table of the 
entry, which will display the following: 
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Figure 6- 158. VRRP Virtual Router Settings - Display window 

This window displays the following information: 

Parameter                 Description 

Interface Name An IP interface name that has been enabled for VRRP. This entry must have been 
previously set in the IP Interface Settings table. 

Authentication type Displays the type of authentication used to compare VRRP packets received by a 
virtual router. Possible authentication types include:   

• No authentication - No authentication has been selected to compare VRRP 
packets received by a virtual router.  

• Simple Text Password - A Simple password has been selected to compare 
VRRP packets received by a virtual router, for authentication.   

• IP Authentication Header - An MD5 message digest algorithm has been 
selected to compare VRRP packets received by a virtual router, for 
authentication. 

VRID Displays the virtual router ID set by the user. This will uniquely identify the VRRP 
Interface on the network. 

Virtual IP Address The IP address of the Virtual router configured on the Switch. 

Virtual MAC Address The MAC address of the device that holds the Virtual router. 

Virtual Router State Displays the current status of the virtual router. Possible states include Initialize, 
Master and Backup. 
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Admin. State Displays the current state of the router. Up will be displayed if the virtual router is 
enabled and Down, if the virtual router is disabled. 

Priority Displays the priority of the virtual router. A higher priority will increase the probability 
that this router will become the Master router of the group. A lower priority will 
increase the probability that this router will become the backup router. The lower the 
number, the higher the priority. 

Master IP Address Displays the IP address of the Master router for the VRRP function. 

Critical IP Address Displays the critical IP address of the VRRP function. This address will judge if a 
virtual router is qualified to be a master router. 

Checking Critical IP Displays the status of the Critical IP address. May be enabled or disabled. 

Advertisement 
Interval  

Displays the time interval, in seconds, which VRRP messages are sent out to the 
network.  

Preempt Mode Displays the mode for determining the behavior of backup routers set on this VRRP 
interface. True will denote that this will be the backup router, if the routers priority is 
set higher than the master router. False will disable the backup router from becoming 
the master router. 

Virtual Router Up 
Time 

Displays the time, in minutes, since the virtual router has been initialized 

VRRP Authentication Settings 
The VRRP Authentication Settings window is used to set the authentication for each Interface configured for VRRP. 
This authentication is used to identify incoming message packets received by a router. If the authentication is not consistent 
with incoming packets, they will be discarded. The Authentication Type must be consistent with all routers participating 
within the VRRP group. 

To view the following window, click Configuration > Layer 3 IP Networking > VRRP > VRRP Authentication 
Settings. 

 
Figure 6- 159. VRRP Authentication Settings window 

To configure the authentication for a pre-created interface, click its hyperlinked name, revealing the following window to 
configure: 

 
Figure 6- 160. VRRP Authentication Settings – Edit window 
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The following parameters may be viewed or configured: 

Parameter  Description 

Interface Name The name of a previously created IP interface for which to configure the VRRP 
authentication. 

Authentication Type Specifies the type of authentication used. The Authentication Type must be 
consistent with all routers participating within the VRRP group. The choices are:  

• None - Selecting this parameter indicates that VRRP protocol exchanges 
will not be authenticated.  

• Simple - Selecting this parameter will require the user to set a simple 
password in the Auth. Data field for comparing VRRP message packets 
received by a router. If the two passwords are not exactly the same, the 
packet will be dropped.  

• IP - Selecting this parameter will require the user to set a MD5 message 
digest for authentication in comparing VRRP messages received by the 
router. If the two values are inconsistent, the packet will be dropped. 

Authentication Data This field is only valid if the user selects Simple or IP in the Authentication Type 
field.  

• Simple will require the user to enter an alphanumeric string of no more than 
eight characters to identify VRRP packets received by a router.  

• IP will require the user to enter a MD5 message digest for authentication in 
comparing VRRP messages received by the router from 1 –16 characters. 

 This entry must be consistent with all routers participating in the same IP interface. 

Click Apply to implement changes made. 
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IP Multicast Routing Protocol 
The functions supporting IP multicasting are added under the IP Multicast Routing Protocol folder, from the Layer 3 IP 
Networking folder. 

IGMP, DVMRP, and PIM-DM can be enabled or disabled on the Switch without changing the individual protocol’s 
configuration. 

IGMP  
Computers and network devices that want to receive multicast transmissions need to inform nearby routers that they will 
become members of a multicast group. The Internet Group Management Protocol (IGMP) is used to communicate this 
information. IGMP is also used to periodically check the multicast group for members that are no longer active. 

In the case where there is more than one multicast router on a subnetwork, one router is elected as the ‘querier’. This router 
then keeps track of the membership of the multicast groups that have active members.  The information received from 
IGMP is then used to determine if multicast packets should be forwarded to a given subnetwork or not. The router can 
check, using IGMP, to see if there is at least one member of a multicast group on a given subnetwork. If there are no 
members on a subnetwork, packets will not be forwarded to that subnetwork. 

IGMP Versions 1 and 2 
Multicast groups allow members to join or leave at any time. IGMP provides the method for members and multicast 
routers to communicate when joining or leaving a multicast group. 

IGMP version 1 is defined in RFC 1112. It has a fixed packet size and no optional data. 

The format of an IGMP packet is shown below: 

 
Figure 6- 161.  IGMP Message Format 

The IGMP Type codes are shown below: 

Type Meaning 

0x11 Membership Query (if Group Address is 0.0.0.0) 

0x11 Specific Group Membership Query (if Group Address is Present) 

0x16 Membership Report (version 2) 

0x17 Leave a Group (version 2) 

0x12 Membership Report (version 1) 

Table 6- 7. IGMP Type Codes 

IGMP packets enable multicast routers to keep track of the membership of multicast groups, on their respective 
subnetworks. The following outlines what is communicated between a multicast router and a multicast group member 
using IGMP. 

A host sends an IGMP “report” to join a group 

A host will never send a report when it wants to leave a group (for version 1). 

A host will send a “leave” report when it wants to leave a group (for version 2). 
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Multicast routers send IGMP queries (to the all-hosts group address: 224.0.0.1) periodically to see whether any group 
members exist on their subnetworks.  If there is no response from a particular group, the router assumes that there are no 
group members on the network.   

The Time-to-Live (TTL) field of query messages is set to 1 so that the queries will not be forwarded to other subnetworks. 

IGMP version 2 introduces some enhancements such as a method to elect a multicast querier for each LAN, an explicit 
leave message, and query messages that are specific to a given group. 

The states a computer will go through to join or to leave a multicast group are shown below: 

 
Figure 6- 162. IGMP State Transitions 

IGMP Version 3 

The current release of the xStack DGS/DXS-3300 Switch Series now implements IGMPv3. Improvements of IGMPv3 
over version 2 include: 

• The introduction of the SSM or Source Specific Multicast. In previous versions of IGMP, the host would receive all 
packets sent to the multicast group. Now, a host will receive packets only from a specific source or sources. This is 
done through the implementation of include and exclude filters used to accept or deny traffic from these specific 
sources. 

• In IGMP v2, Membership reports could contain only one multicast group whereas in v3, these reports can contain 
multiple multicast groups and multiple sources within the multicast group. 

• Leaving a multicast group could only be accomplished using a specific leave message in v2. In v3, leaving a 
multicast group is done through a Membership report which includes a block message in the group report packet. 

• For version 2, the host could respond to a group query but in version 3, the host is now capable to answer queries 
specific to the group and the source. 

IGMP v3 is backwards compatible with other versions of IGMP. 

The IGMPv3 Type supported codes are shown below: 

Type Meaning 

0x11 Membership Query  

0x12 Version 1 Membership Report 

0x16 Version 2 Membership Report 

0x17 Version 2 Leave Group 

0x22 IGMPv3 Membership Report 
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Timers 

As previously mentioned, IGMPv3 incorporates filters to include or exclude sources. These filters are kept updated using 
timers. IGMPv3 utilizes two types of timers, one for the group and one for the source. The purpose of the filter mode is to 
reduce the reception state of a multicast group so that all members of the multicast group are satisfied. This filter mode is 
dependant on membership reports and timers of the multicast group. These filters are used to maintain a list of multicast 
sources and groups of multicast receivers that more accurately reflect the actual sources and receiving groups at any one 
time on the network.   

Source timers are used to keep sources present and active within a multicast group on the Switch. These source timers are 
refreshed if a group report packet is received by the Switch, which holds information pertaining to the active source group 
record part of a report packet. If the filter mode is exclude, traffic is being denied from at least one specific source, yet 
other hosts may be accepting traffic from the multicast group. If the group timer expires for the multicast group, the filter 
mode is changed to include and other hosts can receive traffic from the source. If no group report packet is received and the 
filter mode is include, the Switch presumes that traffic from the source is no longer wanted on the attached network and the 
source record list is then deleted after all source timers expire. If there is no source list record in the multicast group, the 
multicast group will be deleted from the Switch. 

Timers are also used for IGMP version 1 and 2 members, which are a part of a multicast group when the Switch is running 
IGMPv3. This timer is based on a host within the multicast group that is running IGMPv1 or v2. Receiving a group report 
from an IGMPv1 or v2 host within the multicast group will refresh the timer and keep the v1 and/or v2 membership alive 
in v3. 

 

NOTE: The length of time for all timers utilized in IGMPv3 can be determined using 
IGMP configurations to perform the following calculation: 

(Group Membership Interval x Robustness Variable) + One Query Response Interval
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IGMP Interface Configuration 
The Internet Group Multicasting Protocol (IGMP) can be configured on the Switch on a per-IP interface basis. To view the 
IGMP Interface Table, open the IP Multicast Routing Protocol folder under Configuration and click Layer 3 IP 
Networking > IGMP Interface Settings. Each IP interface configured on the Switch is displayed in the below IGMP 
Interface Table dialog box. To configure IGMP for a particular interface, click the corresponding hyperlink for that IP 
interface. This will open another IGMP Interface Configuration window: 

 
Figure 6- 163. IGMP Interface Settings window 

 
Figure 6- 164. IGMP Interface Settings - Edit window 
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This window allows the configuration of IGMP for each IP interface configured on the Switch. IGMP can be configured as 
Version 1, 2 or 3 by toggling the Version field using the pull-down menu. Enter a value between 1 and 31,744 seconds in 
the Query Interval field to alter the length of time between queries. Enter a value in the Max Response Time field to vary 
the maximum length of time between the receipt of a query and the sending of an IGMP response report. 

The Robustness Variable field allows IGMP to be ‘tuned’ for sub-networks that are expected to lose many packets. A 
high value (max. 255) for the robustness variable will help compensate for ‘lossy’ sub-networks. A low value (min. 2) 
should be used for less ‘lossy’ sub-networks. 

The following fields can be set: 

Parameter                     Description 

Interface Name  Displays the name of the IP interface that is to be configured for IGMP. This must be a 
previously configured IP interface. 

IP Address Displays the IP address corresponding to the IP interface name above. 

Version  Enter the IGMP version (1, 2 or 3) that will be used to interpret IGMP queries on the 
interface. 

Query Interval  Allows the entry of a value between 1 and 31744 seconds, with a default of 125 
seconds. This specifies the length of time between sending IGMP queries. 

Max Response Time  Sets the maximum amount of time allowed before sending an IGMP response report.  
A value between 1 and 25 seconds can be entered, with a default of 10 seconds. 

Robustness Variable  A tuning variable to allow for subnetworks that are expected to lose a large number of 
packets. A value between 2 and 255 can be entered, with larger values being 
specified for subnetworks that are expected to lose larger numbers of packets. The 
default value is 2. 

Last Member Query 
Interval  

Specifies the maximum amount of time between group-specific query messages, 
including those sent in response to leave group messages. A value between 1 and 25. 
The default is 1 second. 

State  This field can be toggled between Enabled and Disabled and enables or disables 
IGMP for the IP interface. The default is Disabled. 

Click Apply to implement changes made. 
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DVMRP Interface Configuration 
The Distance Vector Multicast Routing Protocol (DVMRP) is a hop-based method of building multicast delivery trees 
from multicast sources to all nodes of a network. Because the delivery trees are ‘pruned’ and ‘shortest path’, DVMRP is 
relatively efficient. Because multicast group membership information is forwarded by a distance-vector algorithm, 
propagation is slow. DVMRP is optimized for high delay (high latency) relatively low bandwidth networks, and can be 
considered as a ‘best-effort’ multicasting protocol.   

DVMRP resembles the Routing Information Protocol (RIP), but is extended for multicast delivery. DVMRP builds a 
routing table to calculate ‘shortest paths’ back to the source of a multicast message, but defines a ‘route cost’ (similar to the 
hop count in RIP) as a relative number that represents the real cost of using this route in the construction of a multicast 
delivery tree to be ‘pruned’ - once the delivery tree has been established.   

When a sender initiates a multicast, DVMRP initially assumes that all users on the network will want to receive the 
multicast message. When an adjacent router receives the message, it checks its unicast routing table to determine the 
interface that gives the shortest path (lowest cost) back to the source. If the multicast was received over the shortest path, 
then the adjacent router enters the information into its tables and forwards the message. If the message is not received on 
the shortest path back to the source, the message is dropped. 

Route cost is a relative number that is used by DVMRP to calculate which branches of a multicast delivery tree should be 
‘pruned’. The ‘cost’ is relative to other costs assigned to other DVMRP routes throughout the network. 

The higher the route cost, the lower the probability that the current route will be chosen to be an active branch of the 
multicast delivery tree (not ‘pruned’) - if there is an alternative route. 

DVMRP Global Settings 
To enable DVMRP globally on the Switch, click Configuration > Layer 3 IP Networking > IP Multicast Routing 
Protocol > DVMRP Global Settings. This will give the user access to the following screen: 

 
Figure 6- 165. DVMRP Global Settings window 

Use the pull-down menu, choose Enabled, and click Apply to implement the DVMRP function on the Switch. 

DVMRP Interface Settings 
To view the DVMRP Interface Table, click Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol 
> DVMRP Interface Settings. This menu allows the Distance-Vector Multicast Routing Protocol (DVMRP) to be 
configured for each IP interface defined on the Switch. Each IP interface configured on the Switch is displayed in the 
below DVMRP Interface Configuration dialog box. To configure DVMRP for a particular interface, click the 
corresponding hyperlink for that IP interface. This will open the DVMRP Interface Settings window: 

 
Figure 6- 166. DVMRP Interface Settings window 
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Figure 6- 167. DVMRP Interface Settings – Edit window 

The following fields can be set: 

Parameter             Description 

Interface Name  Displays the name of the IP interface for which DVMRP is to be configured. This must 
be a previously defined IP interface. 

IP Address Displays the IP address corresponding to the IP Interface name entered above. 

Neighbor Timeout 
Interval (1-65535)  

This field allows an entry between 1 and 65,535 seconds and defines the time period 
DVMRP will hold Neighbor Router reports before issuing poison route messages. The 
default is 35 seconds. 

Probe Interval (1-
65535)  

This field allows an entry between 1 and 65,535 seconds and defines the interval 
between ‘probes’. The default is 10. 

Metric (1-31)  This field allows an entry between 1 and 31 and defines the route cost for the IP 
interface. The DVMRP route cost is a relative number that represents the real cost of 
using this route in the construction of a multicast delivery tree. It is similar to, but not 
defined as, the hop count in RIP. The default cost is 1. 

State  This field can be toggled between Enabled and Disabled and enables or disables 
DVMRP for the IP interface. The default is Disabled. 

Click Apply to implement changes made. Click Show All DVMRP Interface Entries to return to the DVMRP Interface 
Settings window. 
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PIM Protocol 
PIM or Protocol Independent Multicast is a method of forwarding traffic to multicast groups over the network using any 
pre-existing unicast routing protocol, such as RIP or OSPF, set on routers within a multicast network. The xStack 
DGS/DXS-3300 Series supports two types of PIM, Dense Mode (PIM-DM) and Sparse Mode (PIM-SM). 

PIM-SM 
PIM-SM or Protocol Independent Multicast – Sparse Mode is a method of forwarding multicast traffic over the network 
only to multicast routers who actually request this information. Unlike most multicast routing protocols which flood the 
network with multicast packets, PIM-SM will forward traffic to routers who are explicitly a part of the multicast group 
through the use of a Rendezvous Point (RP). This RP will take all requests from PIM-SM enabled routers, analyze the 
information and then returns multicast information it receives from the source, to requesting routers within its configured 
network. Through this method, a distribution tree is created, with the RP as the root. This distribution tree holds all PIM-
SM enabled routers within which information collected from these router is stored by the RP.  

Two other types of routers also exist with the PIM-SM configuration. When many routers are a part of a multiple access 
network, a Designated Router (DR) will be elected. The DR’s primary function is to send Join/Prune messages to the RP. 
The router with the highest priority on the LAN will be selected as the DR. If there is a tie for the highest priority, the 
router with the higher IP address will be chosen. 

The third type of router created in the PIM-SM configuration is the Boot Strap Router (BSR). The goal of the Boot Strap 
Router is to collect and relay RP information to PIM-SM enabled routers on the LAN. Although the RP can be statically 
set, the BSR mechanism can also determine the RP. Multiple Candidate BSRs (C-BSR) can be set on the network but only 
one BSR will be elected to process RP information. If it is not explicitly apparent which C-BSR is to be the BSR, all C-
BSRs will emit Boot Strap Messages (BSM) out on the PIM-SM enabled network to determine which C-BSR has the 
higher priority and once determined, will be elected as the BSR. Once determined, the BSR will collect RP data emanating 
from candidate RPs on the PIM-SM network, compile it and then send it out on the land using periodic Boot Strap 
Messages (BSM). All PIM-SM Routers will get the RP information from the Boot Stap Mechanism and then store it in 
their database.  

Discovering and Joining the Multicast Group 
Although Hello packets discover PIM-SM routers, these routers can only join or be “pruned” from a multicast group 
through the use of Join/Prune Messages exchanged between the DR and RP. Join/Prune Messages are packets relayed 
between routers that effectively state which interfaces are, or are not to be receiving multicast data. These messages can be 
configured for their frequency to be sent out on the network and are only valid to routers if a Hello packet has first been 
received. A Hello packet will simply state that the router is present and ready to become a part of the RP’s distribution tree. 
Once a router has accepted a member of the IGMP group and it is PIM-SM enabled, the interested router will then send an 
explicit Join/Prune message to the RP, which will in turn route multicast data from the source to the interested router, 
resulting in a unidirectional distribution tree for the group. Multicast packets are then sent out to all nodes on this tree. 
Once a prune message has been received for a router that is a member of the RP’s distribution tree, the router will drop the 
interface from its distribution tree. 

Distribution Trees 
Two types of distribution trees can exist within the PIM-SM protocol, a Rendezvous-Point Tree (RPT) and a Shortest Path 
Tree (SPT). The RP will send out specific multicast data that it receives from the source to all outgoing interfaces enabled 
to receive multicast data. Yet, once a router has determined the location of its source, an SPT can be created, eliminating 
hops between the source and the destination, such as the RP. This can be configured by the switch administrator by setting 
the multicast data rate threshold. Once the threshold has been passed, the data path will switch to the SPT. Therefore, a 
closer link can be created between the source and destination, eliminating hops previously used and shortening the time a 
multicast packet is sent from the source to its final destination. 

Register and Register Suppression Messages 
Multicast sources do not always join the intended receiver group. The first hop router (DR) can send multicast data without 
being the member of a group or having a designated source, which essentially means it has no information about how to 
relay this information to the RP distribution tree. This problem is alleviated through Register and Register-Stop messages. 
The first multicast packet received by the DR is encapsulated and sent on to the RP which in turn removes the 
encapsulation and sends the packet on down the RP distribution tree. When the route has been established, a SPT can be 
created to directly connect routers to the source, or the multicast traffic flow can begin, traveling from the DR to the RP. 
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When the latter occurs, the same packet may be sent twice, one type encapsulated, one not. The RP will detect this flaw 
and then return a Register Suppression message to the DR requesting it to discontinue sending encapsulated packets.  

Assert Messages 
At times on the PIM-SM enabled network, parallel paths are created from source to receiver, meaning some receivers will 
receive the same multicast packets twice. To improve this situation, Assert messages are sent from the receiving device to 
both multicast sources to determine which single router will send the receiver the necessary multicast data. The source with 
the shortest metric (hop count) will be elected as the primary multicast source. This metric value is included within the 
Assert message.  

PIM-DM Interface Configuration 
The Protocol Independent Multicast - Dense Mode (PIM-DM) protocol should be used in networks with a low delay (low 
latency) and high bandwidth as PIM-DM is optimized to guarantee delivery of multicast packets, not to reduce overhead. 

The PIM-DM multicast routing protocol is assumes that all downstream routers want to receive multicast messages and 
relies upon explicit prune messages from downstream routers to remove branches from the multicast delivery tree that do 
not contain multicast group members. 

PIM-DM has no explicit ‘join’ messages. It relies upon periodic flooding of multicast messages to all interfaces and then 
either waiting for a timer to expire (the Join/Prune Interval) or for the downstream routers to transmit explicit ‘prune’ 
messages indicating that there are no multicast members on their respective branches. PIM-DM then removes these 
branches (‘prunes’ them) from the multicast delivery tree. 

Because a member of a pruned branch of a multicast delivery tree may want to join a multicast delivery group (at some 
point in the future), the protocol periodically removes the ‘prune’ information from its database and floods multicast 
messages to all interfaces on that branch. The interval for removing ‘prune’ information is the Join/Prune Interval. 

 PIM Global Settings 
To enable PIM globally on the Switch, go to Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol 
> PIM Protocol > PIM Global Settings. This will give the user access to the following screen: 

 
Figure 6- 168. PIM Global Settings window 

Use the pull-down menu, choose Enabled, and click Apply to set the PIM function on the Switch. 

PIM Interface Settings 
To configure the settings for the PIM Protocol per IP interface, go to Configuration > Layer 3 IP Networking > IP 
Multicast Routing Protocol > PIM Protocol > PIM Interface Settings. This will give the user access to the following 
screen: 

 
Figure 6- 169. PIM Interface Settings window 

To configure an IP interface for PIM, click its corresponding link which will lead you to the following screen: 
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Figure 6- 170. PIM Interface Settings – Edit window 

The following fields can be set: 

Parameter             Description 

Interface Name This read-only field denotes the IP interface selected to be configured for PIM. 

IP Address This read-only field denotes the IP address of the IP interface selected to be configured 
for PIM. 

Designated Router This read-only field denotes the IP address of the Designated Router of the distribution 
tree to which this IP address belongs. 

Hello Interval This field will set the interval time between the sending of Hello Packets from this IP 
interface to neighboring routers one hop away. These Hello packets are used to 
discover other PIM enabled routers and state their priority as the Designated Router 
(DR) on the PIM enabled network. The user may state an interval time between 1 – 
18724 seconds with a default interval time of 30 seconds. 

Join/Prune Interval This field will set the interval time between the sending of Join/Prune packets stating 
which multicast groups are to join the PIM enabled network and which are to be 
removed or “pruned” from that group. The user may state an interval time between 1 – 
18724 seconds with a default interval time of 30 seconds. 

Mode  Use the pull-down menu to select the type of PIM protocol to use, Sparse Mode (SM) or 
Dense Mode (DM). The default setting is DM. 

State Use the pull-down menu to enable or disable PIM for this IP interface. The default is 
Disabled. 

DR priority Enter the priority of this IP interface to become the Designated Router for the multiple 
access network. The user may enter a DR priority between 0 and 4,294,967,294 with a 
default setting of 1.  

Click Apply to implement changes made. 
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PIM Candidate BSR Settings 
The following windows are used to configure the Candidate Boot Strap Router settings for the switch and the priority of 
the selected IP interface to become the Boot Strap Router (BSR) for the PIM enabled network. The Boot Strap Router 
holds the information which determines which router on the network is to be elected as the RP for the multicast group and 
then to gather and distribute RP information to other PIM-SM enabled routers. To view the Candidate BSR window, click 
Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol > PIM Protocol > PIM Candidate BSR 
Settings. 

 
Figure 6- 171. PIM Candidate BSR Global Settings window 

The following fields can be set: 

Parameter             Description 

Hash Mask Len Enter a hash mask length, which will be used with the IP address of the candidate RP 
and the multicast group address, to calculate the hash algorithm used by the router to 
determine which C-RP on the PIM-SM enabled network will be the RP. The user may 
select a length between 0 –32 with a default setting of 30. 

Bootstrap Period Enter a time period between 1-255 to determine the interval the Switch will send out 
Boot Strap Messages (BSM) to the PIM enabled network. The default setting is 60 
seconds. 

Interface Name To find an IP interface on the Switch, enter the interface name into the space provided 
and click Find. If found, the Interface Name will appear alone in the PIM Candidate 
BSR Settings window below. 

To view the CBSR settings for an IP interface and set its BSR priority, click its hyperlinked name, which will lead you to 
the following window. 

 
Figure 6- 172. PIM Candidate BSR Settings – Edit 

The following fields can be viewed or set: 
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Parameter             Description 

Interface Name This read-only field denotes the IP Interface Name to be edited for its C-BSR priority. 

IP Address Denotes the IP Address of the IP Interface Name to be edited for its C-BSR priority. 

Priority Used to state the Priority of this IP Interface to become the BSR. The user may select a 
priority between -1 to 255. An entry of -1 states that the interface will be disabled to be 
the BSR. 

Click Apply to set the priority for this IP Interface. 

PIM Parameter Settings 
The following window will configure the parameter settings for the PIM distribution tree. To view this window, click 
Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol > PIM Protocol > PIM Parameter Settings. 

 
Figure 6- 173. PIM Parameter Settings window 

The following fields can be viewed or set: 

Parameter             Description 

Last Hop SPT 
Threshold 

This field is to be configured for the last hop router in the RP tree. When the amount of 
multicast packets per second reaches the configured threshold, the last hop router will 
change its distribution tree to a (Shortest Path Tree) SPT. The user may enter a value 
between 0-65535 packets per second. 0 will denote that the last hop router will 
immediately enter the SPT once a multicast packet has been received. An entry of 
infinity will disable the last hop router from entering the SPT. The default setting is 0. 

RP SPT Threshold This field is to be configured for the RP of the distribution tree. When the amount of 
register packets per second reaches the configured threshold, it will trigger the RP to 
switch to an SPT, between the RP and the first hop router. The user may enter a value 
between 0-65535 packets per second. 0 will denote that the RP will immediately enter 
the SPT once a register packet has been received. An entry of infinity will disable the 
RP from entering an SPT. The default setting is 0. 

Register Probe 
Time 

This command is used to set a time to send a probe message from the DR to the RP 
before the Register Suppression time expires. If a Register Stop message is received 
by the DR, the Register Suppression Time will be restarted. If no Register Stop 
message is received within the probe time, Register Packets will be resent to the 
RP.The user may configure a time between 1-127 seconds with a default setting of 5 
seconds.  

Register 
Suppression Time 

This field is to be configured for the first hop router from the source. After this router 
sends out a Register message to the RP, and the RP replies with a Register stop 
message, it will wait for the time configured here to send out another register message 
to the RP. The user may set a time between 3-255 with a default setting of 60 seconds. 

Click Apply to implement changes made.  



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

209 

     

 

NOTE: The Probe time value must be less than half of the Register 
Suppression Time value. If not, the administrator will be presented with an 
error message after clicking Apply. 

 

PIM Candidate RP Global Settings 
The following window is used to set the Parameters for this Switch to become the RP of its distribution tree. To view this 
window, click Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol > PIM Protocol > PIM 
Candidate RP Global Settings. 

 
Figure 6- 174. PIM Candidate RP Global Settings 

The following fields can be viewed or set: 

Parameter             Description 

Hold Time This field is used to set the time Candidate RP (CRP) advertisements are valid on the 
PIM-SM enabled network. If CRP advertisements are not received by the BSR within 
this time frame, the CRP is removed from the list of candidates. The user may set a 
time between 0 - 255 seconds with a default setting of 150 seconds. An entry of 0 will 
send out one advertisement that states to the BSR that it should be immediately 
removed from CRP status on the PIM-SM network. 

Priority Enter a priority value to determine which CRP will become the RP for the distribution 
tree. This priority value will be included in the router’s CRP advertisements. A lower 
value means a higher priority, yet, if there is a tie for the highest priority, the router 
having the higher IP address will become the RP. The user may set a priority between 
0 – 255 with a default setting of 0. 

Wildcard Prefix 
Count 

The user may set the Prefix Count value of the wildcard group address here by 
choosing a value between 0 and 1 with a default setting of 0.  

Click Apply to implement changes made. 

PIM Candidate RP Settings 
The following window will display the parameters for the switch to become a CRP. To view this window, click 
Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol > PIM Protocol > PIM Candidate RP 
Settings. 

 
Figure 6- 175. PIM Candidate RP Settings window 

To configure the settings for this window, click the Add button, which will reveal the following window for the 
administrator to configure. 
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Figure 6- 176. PIM Candidate RP Settings – Add window 

The following fields can be viewed or set: 

Parameter             Description 

Group Address Enter the multicast group address for this CRP. This address must be a class D 
address. 

Group Mask Enter the mask for the multicast group address stated above. 

Interface Name Enter the name of the PIM-SM enabled interface the switch administrator wishes to 
become the CRP for this group. 

Click Apply to implement changes made. 

PIM Register Checksum Settings 
This window is used to set a first hop router to create checksums to be included with the data in Registered packets. To 
view this window, click Configuration > Layer 3 IP Networking > IP Multicast Routing Protocol > PIM Protocol > 
PIM Register Checksum Settings. 

 
Figure 6- 177. PIM Register Checksum Include Data RP List Settings window 

To configure the settings for this window, click the Add button, which will reveal the following window for the 
administrator to configure. 

 
Figure 6- 178. PIM Register Checksum Include Data RP List Settings - Add window 

The following fields can be set: 

Parameter             Description 

RP Address Enter the IP address of the RP that will verify checksums included with Registered 
packets. 

Click Apply to set the RP as a checksum enabled router. 
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PIM Static RP Settings 
This window is used to view the Static RP settings for this router. To view this window, click Configuration > Layer 3 IP 
Networking > IP Multicast Routing Protocol > PIM Protocol > PIM Static RP Settings. 

 
Figure 6- 179. PIM Static RP Settings window 

To configure the settings for this window and set this router as the Static RP, click the Add button, which will reveal the 
following window for the administrator to configure. 

 
Figure 6- 180. PIM Static RP Settings – Add window 

The following fields can be set: 

Parameter             Description 

Group Address Enter the multicast group IP address to identify who is the RP. This address must be a 
class D address. 

Group Mask Enter the mask for the Group address stated above. 

RP Address Enter the RP’s IP address to be set for the Group Address stated above. 

Click Apply to set the static RP. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

212 

     

Section 7 

Security Management 
Security IP 

User Accounts 

Access Authentication Control (TACACS) 

Secure Sockets Layer (SSL) 

Secure Shell (SSH) 

The following section will aid the user in configuring security functions for the Switch. The Switch includes various 
functions for security, including TACACS, Security IPs, SSL, and SSH, all discussed in detail in the following section. 

Security IP  
Go to the Security Management folder and click on the Security IP link; the following screen will appear. 

 
Figure 7- 1. Security IP window 

Use the Security IP Management to permit remote stations to manage the Switch. If choosing to define one or more 
designated management stations, only the chosen stations, as defined by IP address, will be allowed management privilege 
through the web manager or Telnet session. To define a management station IP setting, type in the IP address and click the 
Apply button. 
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User Accounts 
Use the User Accounts Management window to control user privileges. To view existing User Accounts, open the 
Security Management folder and click on the User Accounts link.  This will open the User Account Management page, 
as shown below. 

 
Figure 7- 2. User Accounts window 

To add a new user, click on the Add button. To modify or delete an existing user, click on the Modify button for that user. 

 
Figure 7- 3. User Accounts Add Table 

Add a new user by typing in a User Name, and New Password and retype the same password in the Confirm New 
Password. Choose the level of privilege (Admin or User) from the Access Right drop-down menu. 

 
Figure 7- 4. User Account Modify Table 

Modify or delete an existing user account in the User Account Modify Table. To delete the user account, click on the 
Delete button. To change the password, type in the New Password and retype it in the Confirm New Password entry field. 
The Access Right field will display the level of privilege (Admin or User).  
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Admin and User Privileges 
There are two levels of user privileges, Admin and User. Some menu selections available to users with Admin privileges 
may not be available to those with User privileges.  

The following table summarizes the Admin and User privileges: 

Management                                                             Admin                           User 

Configuration Yes Read-only  

Network Monitoring Yes Read-only  

Community Strings and Trap Stations Yes Read-only  

Update Firmware and Configuration Files Yes No 

System Utilities Yes No 

Factory Reset Yes No 

User Account Management 

Add/Update/Delete User Accounts Yes No 

View User Accounts Yes No 

Table 7- 1. Admin and User Privileges 

After establishing a User Account with Admin-level privileges, be sure to save the changes by opening the Maintenance 
folder, opening the Save Changes window and clicking the Save Configuration button.  
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Access Authentication Control 
The TACACS / XTACACS / TACACS+ / RADIUS commands allows secure access to the Switch using the TACACS / 
XTACACS / TACACS+ / RADIUS protocols. When a user logs in to the Switch or tries to access the administrator level 
privilege, he or she is prompted for a password. If TACACS / XTACACS / TACACS+ / RADIUS authentication is 
enabled on the Switch, it will contact a TACACS / XTACACS / TACACS+ / RADIUS server to verify the user. If the user 
is verified, he or she is granted access to the Switch. 

There are currently three versions of the TACACS security protocol, each a separate entity. The Switch's software supports 
the following versions of TACACS: 

• TACACS (Terminal Access Controller Access Control System) - Provides password checking and 
authentication, and notification of user actions for security purposes utilizing via one or more centralized 
TACACS servers, utilizing the UDP protocol for packet transmission. 

• Extended TACACS (XTACACS) - An extension of the TACACS protocol with the ability to provide more 
types of authentication requests and more types of response codes than TACACS. This protocol also uses UDP 
to transmit packets. 

• TACACS+ (Terminal Access Controller Access Control System plus) - Provides detailed access control for 
authentication for network devices. TACACS+ is facilitated through Authentication commands via one or more 
centralized servers. The TACACS+ protocol encrypts all traffic between the Switch and the TACACS+ daemon, 
using the TCP protocol to ensure reliable delivery 

In order for the TACACS / XTACACS / TACACS+ / RADIUS security function to work properly, a TACACS / 
XTACACS / TACACS+ / RADIUS server must be configured on a device other than the Switch, called an Authentication 
Server Host and it must include usernames and passwords for authentication. When the user is prompted by the Switch to 
enter usernames and passwords for authentication, the Switch contacts the TACACS / XTACACS / TACACS+ / RADIUS 
server to verify, and the server will respond with one of three messages: 

• The server verifies the username and password, and the user is granted normal user privileges on the Switch.  

• The server will not accept the username and password and the user is denied access to the Switch. 

• The server doesn't respond to the verification query. At this point, the Switch receives the timeout from the 
server and then moves to the next method of verification configured in the method list. 

The Switch has four built-in Authentication Server Groups, one for each of the TACACS, XTACACS, TACACS+ and 
RADIUS protocols. These built-in Authentication Server Groups are used to authenticate users trying to access the Switch. 
The users will set Authentication Server Hosts in a preferable order in the built-in Authentication Server Groups and when 
a user tries to gain access to the Switch, the Switch will ask the first Authentication Server Hosts for authentication. If no 
authentication is made, the second server host in the list will be queried, and so on. The built-in Authentication Server 
Groups can only have hosts that are running the specified protocol. For example, the TACACS Authentication Server 
Groups can only have TACACS Authentication Server Hosts. 

The administrator for the Switch may set up six different authentication techniques per user-defined method list (TACACS 
/ XTACACS / TACACS+ / RADIUS / local / none) for authentication. These techniques will be listed in an order 
preferable, and defined by the user for normal user authentication on the Switch, and may contain up to eight 
authentication techniques. When a user attempts to access the Switch, the Switch will select the first technique listed for 
authentication. If the first technique goes through its Authentication Server Hosts and no authentication is returned, the 
Switch will then go to the next technique listed in the server group for authentication, until the authentication has been 
verified or denied, or the list is exhausted. 

Please note that users granted access to the Switch will be granted normal user privileges on the Switch. To gain access to 
administrator level privileges, the user must access the Enable Admin window and then enter a password, which was 
previously configured by the administrator of the Switch. 

 

NOTE: TACACS, XTACACS and TACACS+ are separate entities and are 
not compatible. The Switch and the server must be configured exactly the 
same, using the same protocol. (For example, if the Switch is set up for 
TACACS authentication, so must be the host server.) 
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Authentication Policy & Parameters 
This command will enable an administrator-defined authentication policy for users trying to access the Switch. When 
enabled, the device will check the Login Method List and choose a technique for user authentication upon login.   

To access the following window, click Security Management > Access Authentication Control > Authentication 
Policy & Parameter Settings: 

 
Figure 7- 5. Authentication Policy and Parameter Settings window 

The following parameters can be set: 

Parameters                            Description  

Authentication Policy Use the pull-down menu to enable or disable the Authentication Policy on the 
Switch. 

Response Timeout (0-
255) 

This field will set the time the Switch will wait for a response of authentication from 
the user. The user may set a time between 0 and 255 seconds. The default set-
ting is 30 seconds. 

User Attempts (1-255) This command will configure the maximum number of times the Switch will accept 
authentication attempts. Users failing to be authenticated after the set amount of 
attempts will be denied access to the Switch and will be locked out of further 
authentication attempts. Command line interface users will have to wait 60 
seconds before another authentication attempt. Telnet and web users will be 
disconnected from the Switch. The user may set the number of attempts from 1 to 
255. The default setting is 3. 

Click Apply to implement changes made. 
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Application's Authentication Settings 
This window is used to configure switch configuration applications (console, Telnet, SSH, web) for login at the user level 
and at the administration level (Enable Admin) utilizing a previously configured method list. To view the following 
window, click Security Management > Access Authentication Control > Application Authentication Settings: 

 
Figure 7- 6. Application's Authentication Settings window 

The following parameters can be set: 

Parameter                              Description 

Application Lists the configuration applications on the Switch. The user may configure the 
Login Method List and Enable Method List for authentication for users utilizing 
the Console (Command Line Interface) application, the Telnet application, SSH 
and the Web (HTTP) application. 

Login Method List Using the pull-down menu, configure an application for normal login on the user 
level, utilizing a previously configured method list. The user may use the default 
Method List or other Method List configured by the user. See the Login Method 
Lists window, in this section, for more information. 

Enable Method List Using the pull-down menu, configure an application for admin login on the user 
level, utilizing a previously configured method list. The Enable Method Lists are 
used to promote users with user-level access to Adminstrator-level privileges 
using the selected Appilcation stated previously. The user may use the default 
Method List or other Method List configured by the user. See the Enable Method 
Lists window, in this section, for more information 

Click Apply to implement changes made. 
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Authentication Server Group 
This window will allow users to set up Authentication Server Groups on the Switch. A server group is a technique used to 
group TACACS/XTACACS/TACACS+/RADIUS server hosts into user-defined categories for authentication using 
method lists. The user may define the type of server group by protocol or by previously defined server group. The Switch 
has three built-in Authentication Server Groups that cannot be removed but can be modified. Up to eight authentication 
server hosts may be added to any particular group. 

To view the following window, click Security Management > Access Authentication Control > Authentication Server 
Group: 

 
Figure 7- 7. Authentication Server Group window 

This screen displays the Authentication Server Groups on the Switch. The Switch has four built-in Authentication Server 
Groups that cannot be removed but can be modified. To modify a particular group, click its hyperlinked Group Name, 
which will then display the following window. 

 
Figure 7- 8. Add a Server Host to Server Group (XTACACS) window. 

To add an Authentication Server Host to the list, enter its IP address in the IP Address field, choose the protocol associated 
with the IP address of the Authentication Server Host and click Add to Group to add this Authentication Server Host to 
the group. 

To add a server group other than the ones listed, click the add button, revealing the following window to configure. 
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Figure 7- 9. Authentication Server Group Table Add Settings window 

Enter a group name of up to 15 characters into the Group Name field and click Apply. The entry should appear in the 
Authentication Server Group Settings window, as shown in Figure 7-8 (Trinity). 

 

NOTE: The user must configure Authentication Server Hosts using the 
Authentication Server Hosts window before adding hosts to the list. 
Authentication Server Hosts must be configured for their specific protocol 
on a remote centralized server before this function can work properly. 

 

 

NOTE: The three built in server groups can only have server hosts running 
the same TACACS daemon. TACACS/XTACACS/TACACS+ protocols are 
separate entities and are not compatible with each other. 

Authentication Server Host 
This window will set user-defined Authentication Server Hosts for the TACACS / XTACACS / TACACS+ / RADIUS 
security protocols on the Switch. When a user attempts to access the Switch with Authentication Policy enabled, the 
Switch will send authentication packets to a remote TACACS / XTACACS / TACACS+ / RADIUS server host on a 
remote host. The TACACS / XTACACS / TACACS+ / RADIUS server host will then verify or deny the request and return 
the appropriate message to the Switch. More than one authentication protocol can be run on the same physical server host 
but, remember that TACACS / XTACACS / TACACS+ / RADIUS are separate entities and are not compatible with each 
other. The maximum supported number of server hosts is 16. 

To view the following window, click Security Management > Access Authentication Control > Authentication Server 
Host: 

 
Figure 7- 10. Authentication Server Host window 

To add an Authentication Server Host, click the Add button, revealing the following window: 
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Figure 7- 11. Authentication Server Host Setting - Add window 

Configure the following parameters to add an Authentication Server Host: 

Parameter                       Description 

IP Address The IP address of the remote server host the user wishes to add. 

Protocol The protocol used by the server host. The user may choose one of the following: 

• TACACS - Enter this parameter if the server host utilizes the TACACS 
protocol. 

• XTACACS - Enter this parameter if the server host utilizes the XTACACS 
protocol. 

• TACACS+ - Enter this parameter if the server host utilizes the TACACS+ 
protocol. 

• RADIUS - Enter this parameter if the server host utilizes the RADIUS 
protocol. 

Port (1-65535) Enter a number between 1 and 65535 to define the virtual port number of the 
authentication protocol on a server host. The default port number is 49 for 
TACACS/XTACACS/TACACS+ servers and 1813 for RADIUS servers but the user 
may set a unique port number for higher security. 

Timeout (1-255) Enter the time in seconds the Switch will wait for the server host to reply to an 
authentication request. The default value is 5 seconds. 

Retransmit (1-255) Enter the value in the retransmit field to change how many times the device will 
resend an authentication request when the TACACS server does not respond. 

Key Authentication key to be shared with a configured TACACS+ or RADIUS servers only. 
Specify an alphanumeric string up to 254 characters. 

Click Apply to add the server host. 

 

NOTE: More than one authentication protocol can be run on the same 
physical server host but, remember that TACACS/XTACACS/TACACS+ 
are separate entities and are not compatible with each other 
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Login Method Lists 
This command will configure a user-defined or default Login Method List of authentication techniques for users logging 
on to the Switch. The sequence of techniques implemented in this command will affect the authentication result. For 
example, if a user enters a sequence of techniques, for example TACACS - XTACACS- local, the Switch will send an 
authentication request to the first TACACS host in the server group. If no response comes from the server host, the Switch 
will send an authentication request to the second TACACS host in the server group and so on, until the list is exhausted. At 
that point, the Switch will restart the same sequence with the following protocol listed, XTACACS. If no authentication 
takes place using the XTACACS list, the local account database set in the Switch is used to authenticate the user. When the 
local method is used, the privilege level will be dependant on the local account privilege configured on the Switch. 

Successful login using any of these techniques will give the user a "User" privilege only. If the user wishes to upgrade his 
or her status to the administrator level, the user must use the Enable Admin window, in which the user must enter a 
previously configured password, set by the administrator. (See the Enable Admin part of this section for more detailed 
information concerning the Enable Admin command.) 

To view the following screen click Security Management > Access Authentication Control > Login Method Lists: 

 
Figure 7- 12. Login Method Lists window 

The Switch contains one Method List that is set and cannot be removed, yet can be modified. To delete a Login Method 

List defined by the user, click the  under the Delete heading corresponding to the entry desired to be deleted. To 
modify a Login Method List, click on its hyperlinked Method List Name. To configure a new Method List, click the Add 
button.  

Both actions will result in the same screen to configure: 

 
Figure 7- 13. Login Method List - Edit window (default) 
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Figure 7- 14. Login Method List – Add window 

To define a Login Method List, set the following parameters and click Apply: 

Parameter                       Description 

Method List Name Enter a method list name defined by the user of up to 15 characters. 

Method 1, 2, 3, 4 The user may add one, or a combination of up to four (4) of the following 
authentication methods to this method list: 

• tacacs - Adding this parameter will require the user to be authenticated 
using the TACACS protocol from a remote TACACS server. 

• xtacacs - Adding this parameter will require the user to be authenticated 
using the XTACACS protocol from a remote XTACACS server. 

• tacacs+ - Adding this parameter will require the user to be authenticated 
using the TACACS+ protocol from a remote TACACS+ server. 

• radius - Adding this parameter will require the user to be authenticated using 
the RADIUS protocol from a remote RADIUS server. 

• server_group - Adding this parameter will require the user to be 
authenticated using a user-defined server group previously configured on 
the Switch. 

• local - Adding this parameter will require the user to be authenticated using 
the local user account database on the Switch.  

• none - Adding this parameter will require no authentication to access the 
Switch. 
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Enable Method Lists 
The Enable Method Lists window is used to set up Method Lists to promote users with user level privileges to 
Administrator (Admin) level privileges using authentication methods on the Switch. Once a user acquires normal user level 
privileges on the Switch, he or she must be authenticated by a method on the Switch to gain administrator privileges on the 
Switch, which is defined by the Administrator. A maximum of eight (8) Enable Method Lists can be implemented on the 
Switch, one of which is a default Enable Method List. This default Enable Method List cannot be deleted but can be 
configured. 

The sequence of methods implemented in this command will affect the authentication result. For example, if a user enters a 
sequence of methods like TACACS - XTACACS - Local Enable, the Switch will send an authentication request to the first 
TACACS host in the server group. If no verification is found, the Switch will send an authentication request to the second 
TACACS host in the server group and so on, until the list is exhausted. At that point, the Switch will restart the same 
sequence with the following protocol listed, XTACACS. If no authentication takes place using the XTACACS list, the 
Local Enable password set in the Switch is used to authenticate the user.  

Successful authentication using any of these methods will give the user an "Admin" privilege. 

 

NOTE: To set the Local Enable Password, see the next section, entitled 
Local Enable Password. 

To view the following table, click Security Management > Access Authentication Control > Enable Method Lists: 

 
Figure 7- 15. Enable Method Lists window 

To delete an Enable Method List defined by the user, click the  under the Delete heading corresponding to the entry 
desired to be deleted. To modify an Enable Method List, click on its hyperlinked Method List Name. To configure a 
Method List, click the Add button.  

Both actions will result in the same screen to configure: 

 
Figure 7- 16. Enable Method List - Edit window 
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Figure 7- 17. Enable Method List - Add window 

To define an Enable Login Method List, set the following parameters and click Apply: 

Parameter                       Description 

Method List Name Enter a method list name defined by the user of up to 15 characters. 

Method 1, 2, 3, 4 The user may add one, or a combination of up to four (4) of the following 
authentication methods to this method list: 

• local_enable - Adding this parameter will require the user to be 
authenticated using the local enable password database on the Switch. The 
local enable password must be set by the user in the next section entitled 
Local Enable Password. 

• none - Adding this parameter will require no authentication to access the 
Switch. 

• radius - Adding this parameter will require the user to be authenticated using 
the RADIUS protocol from a remote RADIUS server. 

• tacacs - Adding this parameter will require the user to be authenticated 
using the TACACS protocol from a remote TACACS server. 

• xtacacs - Adding this parameter will require the user to be authenticated 
using the XTACACS protocol from a remote XTACACS server. 

• tacacs+ - Adding this parameter will require the user to be authenticated 
using the TACACS protocol from a remote TACACS server. 

• server_group - Adding a previously configured server group will require the 
user to be authenticated using a user-defined server group previously 
configured on the Switch. 
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Configure Local Enable Password 
This window will configure the locally enabled password for the Enable Admin command. When a user chooses the 
"local_enable" method to promote user level privileges to administrator privileges, he or she will be prompted to enter the 
password configured here that is locally set on the Switch. 

To view the following window, click Security Management > Access Authentication Control > Configure Local 
Enable Password: 

 
Figure 7- 18. Configure Local Enable Password window 

To set the Local Enable Password, set the following parameters and click Apply. 

Parameter                          Description 

Old Local Enable 
Password 

If a password was previously configured for this entry, enter it here in order to 
change it to a new password 

New Local Enable 
Password 

Enter the new password on the Switch used to authenticate users attempting to 
access Administrator Level privileges on the Switch. The user may set a password 
of up to 15 characters. 

Confirm Local Enable 
Password 

Confirm the new password entered above. Entering a different password here from 
the one set in the New Local Enabled field will result in a fail message. 

Click Apply to implement changes made. 
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Enable Admin 
The Enable Admin window is for users who have logged on to the Switch on the normal user level, and wish to be 
promoted to the administrator level. After logging on to the Switch, users will have only user level privileges. To gain 
access to administrator level privileges, the user will open this window and will have to enter an authentication password. 
Possible authentication methods for this function include TACACS/XTACACS/TACACS+/RADIUS, user defined server 
groups, local enable (local account on the Switch), or no authentication (none). Because XTACACS and TACACS do not 
support the enable function, the user must create a special account on the server host, which has the username "enable", 
and a password configured by the administrator that will support the "enable" function. This function becomes inoperable 
when the authentication policy is disabled. 

To view the following window, click Security Management > Access Authentication Control > Enable Admin: 

 
Figure 7- 19. Enable Admin Screen 

When this screen appears, click the Enable Admin button revealing a window for the user to enter authentication 
(password, username), as seen below. A successful entry will promote the user to Administrator level privileges on the 
Switch. 

 
Figure 7- 20. Enter Network Password window 
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Secure Socket Layer (SSL) 
Secure Sockets Layer or SSL is a security feature that will provide a secure communication path between a host and client 
through the use of authentication, digital signatures and encryption. These security functions are implemented through the 
use of a ciphersuite, which is a security string that determines the exact cryptographic parameters, specific encryption 
algorithms and key sizes to be used for an authentication session and consists of three levels: 

1. Key Exchange: The first part of the cyphersuite string specifies the public key algorithm to be used. This switch 
utilizes the Rivest Shamir Adleman (RSA) public key algorithm and the Digital Signature Algorithm (DSA), 
specified here as the DHE DSS Diffie-Hellman (DHE) public key algorithm. This is the first authentication process 
between client and host as they “exchange keys” in looking for a match and therefore authentication to be accepted 
to negotiate encryptions on the following level.  

2. Encryption: The second part of the ciphersuite that includes the encryption used for encrypting the messages sent 
between client and host. The Switch supports two types of cryptology algorithms: 

• Stream Ciphers – There are two types of stream ciphers on the Switch, RC4 with 40-bit keys and RC4 with 128-
bit keys. These keys are used to encrypt messages and need to be consistent between client and host for optimal 
use.  

• CBC Block Ciphers – CBC refers to Cipher Block Chaining, which means that a portion of the previously 
encrypted block of encrypted text is used in the encryption of the current block. The Switch supports the 3DES 
EDE encryption code defined by the Data Encryption Standard (DES) to create the encrypted text. 

3. Hash Algorithm: This part of the ciphersuite allows the user to choose a message digest function which will 
determine a Message Authentication Code. This Message Authentication Code will be encrypted with a sent 
message to provide integrity and prevent against replay attacks. The Switch supports two hash algorithms, MD5 
(Message Digest 5) and SHA (Secure Hash Algorithm). 

These three parameters are uniquely assembled in four choices on the Switch to create a three-layered encryption code for 
secure communication between the server and the host. The user may implement any one or combination of the 
ciphersuites available, yet different ciphersuites will affect the security level and the performance of the secured connection. 
The information included in the ciphersuites is not included with the Switch and requires downloading from a third source 
in a file form called a certificate. This function of the Switch cannot be executed without the presence and implementation 
of the certificate file and can be downloaded to the Switch by utilizing a TFTP server. The Switch supports SSLv3. Other 
versions of SSL may not be compatible with this Switch and may cause problems upon authentication and transfer of 
messages from client to host. 
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Download Certificate 
This window is used to download a certificate file for the SSL function on the Switch from a TFTP server. The certificate 
file is a data record used for authenticating devices on the network. It contains information on the owner, keys for 
authentication and digital signatures. Both the server and the client must have consistent certificate files for optimal use of 
the SSL function. The Switch only supports certificate files with .der file extensions. Currently, all members of the xStack 
DGS/DXS-3300 Series come with a certificate pre-loaded though the user may need to download more, depending on user 
circumstances. 

To view the following window, click Security Management > Secure Socket Layer (SSL) > Download Certificate: 

 
Figure 7- 21. Download Certificate window 

To download certificates, set the following parameters and click Apply. 

Parameter    Description 

Certificate Type Enter the type of certificate to be downloaded. This type refers to the server 
responsible for issuing certificates. This field has been limited to Local for this 
firmware release. 

Server IP Enter the IP address of the TFTP server where the certificate files are located. 

Certificate File Name Enter the path and the filename of the certificate file to download. This file must have 
a .der extension. (Ex. c:/cert.der) 

Key File Name Enter the path and the filename of the key file to download. This file must have a .der 
extension (Ex. c:/pkey.der) 

Click Apply to implement changes made. 
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Configuration 
This screen will allow the user to enable SSL on the Switch and implement any one or combination of listed ciphersuites 
on the Switch. A ciphersuite is a security string that determines the exact cryptographic parameters, specific encryption 
algorithms and key sizes to be used for an authentication session. The Switch possesses four possible ciphersuites for the 
SSL function, which are all enabled by default. To utilize a particular ciphersuite, disable the unwanted ciphersuites, 
leaving the desired one for authentication.  

When the SSL function has been enabled, the web will become disabled. To manage the Switch through the web based 
management while utilizing the SSL function, the web browser must support SSL encryption and the header of the URL 
must begin with https://. (Ex. https://10.90.90.90) Any other method will result in an error and no access can be authorized 
for the web-based management. 

To view the following window, click Security Management > Secure Socket Layer (SSL) > Configuration: 

 
Figure 7- 22. Ciphersuite window 

To set up the SSL function on the Switch, configure the following parameters and click Apply.  

Parameter  Description 

Configuration 

SSL Status Use the pull-down menu to enable or disable the SSL status on the switch. The 
default is Disabled. 

Cache Timeout (60-
86400) 

This field will set the time between a new key exchange between a client and a host 
using the SSL function. A new SSL session is established every time the client and 
host go through a key exchange. Specifying a longer timeout will allow the SSL 
session to reuse the master key on future connections with that particular host, 
therefore speeding up the negotiation process. The default setting is 600 seconds. 

Ciphersuite 

RSA with RC4 128 
MD5 

This ciphersuite combines the RSA key exchange, stream cipher RC4 encryption with 
128-bit keys and the MD5 Hash Algorithm. Use the pull-down menu to enable or 
disable this ciphersuite. This field is Enabled by default. 

RSA with 3DES EDE 
CBC SHA 

This ciphersuite combines the RSA key exchange, CBC Block Cipher 3DES_EDE 
encryption and the SHA Hash Algorithm. Use the pull-down menu to enable or disable 
this ciphersuite. This field is Enabled by default. 

DHS DSS with 3DES 
EDE CBC SHA 

This ciphersuite combines the DSA Diffie Hellman key exchange, CBC Block Cipher 
3DES_EDE encryption and SHA Hash Algorithm. Use the pull-down menu to enable 
or disable this ciphersuite. This field is Enabled by default. 

RSA EXPORT with 
RC4 40 MD5 

This ciphersuite combines the RSA Export key exchange and stream cipher RC4 
encryption with 40-bit keys. Use the pull-down menu to enable or disable this 
ciphersuite. This field is Enabled by default. 
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NOTE: Certain implementations concerning the function and configuration 
of SSL are not available on the web-based management of this Switch 
and need to be configured using the command line interface. For more 
information on SSL and its functions, see the xStack DGS/DXS-3300 
Series CLI Manual, located on the documentation CD of this product. 

 

 

NOTE: Enabling the SSL command will disable the web-based switch 
management. To log on to the Switch again, the header of the URL must 
begin with https://. Entering anything else into the address field of the web 
browser will result in an error and no authentication will be granted. 
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Secure Shell (SSH) 
SSH is an abbreviation of Secure Shell, which is a program allowing secure remote login and secure network services over 
an insecure network. It allows a secure login to remote host computers, a safe method of executing commands on a remote 
end node, and will provide secure encrypted and authenticated communication between two non-trusted hosts. SSH, with 
its array of unmatched security features is an essential tool in today’s networking environment. It is a powerful guardian 
against numerous existing security hazards that now threaten network communications. 

The steps required to use the SSH protocol for secure communication between a remote PC (the SSH client) and the 
Switch (the SSH server) are as follows: 

1. Create a user account with admin-level access using the User Accounts window in the Security Management 
folder. This is identical to creating any other admin-level User Account on the Switch, including specifying a 
password. This password is used to logon to the Switch, once a secure communication path has been established 
using the SSH protocol. 

2. Configure the User Account to use a specified authorization method to identify users that are allowed to establish 
SSH connections with the Switch using the SSH User Authentication window. There are three choices as to the 
method SSH will use to authorize the user, which are Host Based, Password and Public Key. 

3. Configure the encryption algorithm that SSH will use to encrypt and decrypt messages sent between the SSH 
client and the SSH server, using the SSH Algorithm window. 

4. Finally, enable SSH on the Switch using the SSH Configuration window. 

After completing the preceding steps, a SSH Client on a remote PC can be configured to manage the Switch using a secure, 
in band connection. 

SSH Server Configuration 
The following window is used to configure and view settings for the SSH server and can be opened by clicking Security 
Management > Secure Shell (SSH) > SSH Server Configuration: 

 
Figure 7- 23. SSH Server Configuration and Settings window 
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To configure the SSH server on the Switch, modify the following parameters and click Apply: 

Parameter                    Description 

SSH Server Status Use the pull-down menu to enable or disable SSH on the Switch. The default is 
Disabled. 

Max Session (1-3) Enter a value between 1 and 3 to set the number of users that may simultaneously 
access the Switch. The default setting is 3. 

Connection 
TimeOut (120-600) 

Allows the user to set the connection timeout. The use may set a time between 120 and 
600 seconds. The default setting is 120 seconds. 

Auth. Fail (2-20) Allows the Administrator to set the maximum number of attempts that a user may try to 
log on to the SSH Server utilizing the SSH authentication. After the maximum number of 
attempts has been exceeded, the Switch will be disconnected and the user must 
reconnect to the Switch to attempt another login. The number of maximum attempts 
may be set between 2 and 20. The default setting is 2. 

Session Rekeying This field is used to set the time period that the Switch will change the security shell 
encryptions by using the pull-down menu. The available options are Never, 10 min, 30 
min, and 60 min. The default setting is Never. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

233 

     

SSH Authentication Mode and Algorithm Settings 
The SSH Algorithm window allows the configuration of the desired types of SSH algorithms used for authentication 
encryption. There are three categories of algorithms listed and specific algorithms of each may be enabled or disabled by 
using their corresponding pull-down menus. All algorithms are enabled by default. To open the following window, click 
Security Management > Secure Shell (SSH) > SSH Authentication Mode and Algorithm Settings: 

 
Figure 7- 24. SSH Algorithms window 

The following algorithms may be set: 

Parameter                        Description 

SSH Authentication Mode and Algorithm Settings 

Password This field may be enabled or disabled to choose if the administrator wishes to use a 
locally configured password for authentication on the Switch. This field is Enabled by 
default. 

Public Key This field may be enabled or disabled to choose if the administrator wishes to use a 
publickey configuration set on a SSH server, for authentication. This field is Enabled 
by default. 
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Host-based This field may be enabled or disabled to choose if the administrator wishes to use a 
host computer for authentication. This parameter is intended for Linux users requiring 
SSH authentication techniques and the host computer is running the Linux operating 
system with a SSH program previously installed. This field is Enabled by default. 

Encryption Algorithm 

3DES-CBC Use the pull-down to enable or disable the Triple Data Encryption Standard encryption 
algorithm with Cipher Block Chaining. The default is Enabled. 

Blow-fish CBC Use the pull-down to enable or disable the Blowfish encryption algorithm with Cipher 
Block Chaining. The default is Enabled. 

AES128-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES128 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

AES192-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES192 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

AES256-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES-256 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

ARC4 Use the pull-down to enable or disable the Arcfour encryption algorithm with Cipher 
Block Chaining. The default is Enabled. 

Cast128-CBC Use the pull-down to enable or disable the Cast128 encryption algorithm with Cipher 
Block Chaining. The default is Enabled. 

Twofish128 Use the pull-down to enable or disable the twofish128 encryption algorithm. The 
default is Enabled. 

Twofish192 Use the pull-down to enable or disable the twofish192 encryption algorithm. The 
default is Enabled. 

Twofish256 Use the pull-down to enable or disable the twofish256 encryption algorithm. The 
default is Enabled. 

Data Integrity Algorithm 

HMAC-SHA1 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication 
Code) mechanism utilizing the Secure Hash algorithm. The default is Enabled. 

HMAC-MD5 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication 
Code) mechanism utilizing the MD5 Message Digest encryption algorithm. The default 
is Enabled. 

Public Key Algorithm 

HMAC-RSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication 
Code) mechanism utilizing the RSA encryption algorithm. The default is Enabled. 

HMAC-DSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication 
Code) mechanism utilizing the Digital Signature Algorithm (DSA) encryption. The 
default is Enabled. 

Click Apply to implement changes made. 
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SSH User Authentication Mode 
The following windows are used to configure parameters for users attempting to access the Switch through SSH. To access 
the following window, click Security Management > Secure Shell > SSH User Authentication Mode.  

 
Figure 7- 25. SSH User Authentication Mode window 

In the example screen above, the User Account “Trinity” has been previously set using the User Accounts window in the 
Security Management folder. A User Account MUST be set in order to set the parameters for the SSH user. To configure 
the parameters for a SSH user, click on the hyperlinked User Name in the SSH User Authentication window, which will 
reveal the following window to configure. 

 
Figure 7- 26. SSH User window 

The user may set the following parameters: 

Parameter    Description 
User Name  Enter a User Name of no more than 15 characters to identify the SSH user. This User 

Name must be a previously configured user account on the Switch. 

Auth. Mode The administrator may choose one of the following to set the authorization for users 
attempting to access the Switch. 
Host Based – This parameter should be chosen if the administrator wishes to use a 
remote SSH server for authentication purposes. Choosing this parameter requires the 
user to input the following information to identify the SSH user. 

• Host Name – Enter an alphanumeric string of no more than 32 characters to 
identify the remote SSH user. 

• Host IP – Enter the corresponding IP address of the SSH user. 
Password – This parameter should be chosen if the administrator wishes to use an 
administrator-defined password for authentication. Upon entry of this parameter, the 
Switch will prompt the administrator for a password, and then to re-type the password 
for confirmation. 
Public Key – This parameter should be chosen if the administrator wishes to use the 
publickey on a SSH server for authentication. 

Host Name Enter an alphanumeric string of no more than 32 characters to identify the remote 
SSH user. This parameter is only used in conjunction with the Host Based choice in 
the Auth. Mode field. 

Host IP Enter the corresponding IP address of the SSH user. This parameter is only used in 
conjunction with the Host Based choice in the Auth. Mode field. 

Click Apply to implement changes made. 

 

NOTE: To set the SSH User Authentication parameters on the Switch, a User Account 
must be previously configured. For more information on configuring local User Accounts 
on the Switch, see the User Accounts section of this manual located in this section. 
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Section 8 

SNMP Manager 
SNMP Settings 
Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed specifically for managing 
and monitoring network devices. SNMP enables network management stations to read and modify the settings of gateways, 
routers, switches, and other network devices.  Use SNMP to configure system features for proper operation, monitor 
performance and detect potential problems in the Switch, switch group or network. 

Managed devices that support SNMP include software (referred to as an agent), which runs locally on the device. A 
defined set of variables (managed objects) is maintained by the SNMP agent and used to manage the device. These objects 
are defined in a Management Information Base (MIB), which provides a standard presentation of the information 
controlled by the on-board SNMP agent. SNMP defines both the format of the MIB specifications and the protocol used to 
access this information over the network. 

The xStack DGS/DXS-3300 Switch Series supports the SNMP versions 1, 2c, and 3. You can specify which version of the 
SNMP to use to monitor and control the Switch. The three versions of SNMP vary in the level of security provided 
between the management station and the network device.   

In SNMP v.1 and v.2, user authentication is accomplished using 'community strings', which function like passwords. The 
remote user SNMP application and the Switch SNMP must use the same community string. SNMP packets from any 
station that has not been authenticated are ignored (dropped). 

The default community strings for the Switch used for SNMP v.1 and v.2 management access are: 

public - Allows authorized management stations to retrieve MIB objects. 

private - Allows authorized management stations to retrieve and modify MIB objects. 

SNMPv3 uses a more sophisticated authentication process that is separated into two parts. The first part is to maintain a list 
of users and their attributes that are allowed to act as SNMP managers. The second part describes what each user on that 
list can do as an SNMP manager.  

The Switch allows groups of users to be listed and configured with a shared set of privileges. The SNMP version may also 
be set for a listed group of SNMP managers. Thus, the user may create a group of SNMP managers that are allowed to 
view read-only information or receive traps using SNMPv1 while assigning a higher level of security to another group, 
granting read/write privileges using SNMPv3. 

Using SNMPv3 individual users or groups of SNMP managers can be allowed to perform or be restricted from performing 
specific SNMP management functions. The functions allowed or restricted are defined using the Object Identifier (OID) 
associated with a specific MIB. An additional layer of security is available for SNMPv3 in that SNMP messages may be 
encrypted. To read more about how to configure SNMPv3 settings for the Switch read the next section. 

Traps 
Traps are messages that alert network personnel of events that occur on the Switch. The events can be as serious as a 
reboot (someone accidentally turned OFF the Switch), or less serious like a port status change. The Switch generates traps 
and sends them to the trap recipient (or network manager). Typical traps include trap messages for Authentication Failure, 
Topology Change and Broadcast\Multicast Storm. 

MIBs 
Management and counter information are stored by the Switch in the Management Information Base (MIB). The Switch 
uses the standard MIB-II Management Information Base module. Consequently, values for MIB objects can be retrieved 
from any SNMP-based network management software. In addition to the standard MIB-II, the Switch also supports its own 
proprietary enterprise MIB as an extended Management Information Base. The proprietary MIB may also be retrieved by 
specifying the MIB Object Identifier. MIB values can be either read-only or read-write. 

 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

237 

     

The xStack DGS/DXS-3300 Switch Series incorporate a flexible SNMP management for the switching environment. 
SNMP management can be customized to suit the needs of the networks and the preferences of the network administrator. 
Use the SNMP V3 menus to select the SNMP version used for specific tasks. 

The xStack DGS/DXS-3300 Switch Series support the Simple Network Management Protocol (SNMP) versions 1, 2c, and 
3. The administrator can specify the SNMP version used to monitor and control the Switch. The three versions of SNMP 
vary in the level of security provided between the management station and the network device. 

SNMP settings are configured using the menus located on the SNMP V3 folder of the web manager. Workstations on the 
network that are allowed SNMP privileged access to the Switch can be restricted with the Management Station IP Address 
menu. 

SNMP User Table 
The SNMP User Table displays all of the SNMP User's currently configured on the Switch. 

In the SNMP Manager folder, click on the SNMP User Table link. This will open the SNMP User Table, as shown 
below. 

 
Figure 8- 1. SNMP User Table 

To delete an existing SNMP User Table entry, click the  below the Delete heading corresponding to the entry to delete. 

To display the detailed entry for a given user, click on the hyperlinked User Name. This will open the SNMP User Table 
Display page, as shown below. 

 
Figure 8- 2. SNMP User Table Display 

The following parameters are displayed: 

Parameter                       Description 

User Name An alphanumeric string of up to 32 characters. This is used to identify the SNMP 
users. 

Group Name This name is used to specify the SNMP group created can request SNMP messages. 

SNMP Version V1 - Indicates that SNMP version 1 is in use.  

V2 - Indicates that SNMP version 2 is in use. 

V3 - Indicates that SNMP version 3 is in use. 

Auth-Protocol None - Indicates that no authorization protocol is in use. 
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MD5 - Indicates that the HMAC-MD5-96 authentication level will be used. 

SHA - Indicates that the HMAC-SHA authentication protocol will be used. 

Priv-Protocol None - Indicates that no authorization protocol is in use. 

DES - Indicates that DES 56-bit encryption is in use based on the CBC-DES (DES-
56) standard. 

To return to the SNMP User Table, click the Show All SNMP User Table Entries link. 

To add a new entry to the SNMP User Table Configuration, click on the Add button on the SNMP User Table page.  
This will open the SNMP User Table Configuration page, as shown below. 

 
Figure 8- 3. SNMP User Table Configuration window 

The following parameters can set: 

Parameter                       Description 

User Name Enter an alphanumeric string of up to 32 characters. This is used to identify the SNMP 
user. 

Group Name This name is used to specify the SNMP group created can request SNMP messages. 

SNMP Version V1 - Specifies that SNMP version 1 will be used.  
V2c - Specifies that SNMP version 2 will be used.  
V3 - Specifies that SNMP version 3 will be used. 

Auth-Protocol MD5 - Specifies that the HMAC-MD5-96 authentication level will be used. This field is 
only operable when V3 is selected in the SNMP Version field and the Encryption 
field has been checked. This field will require the user to enter a password. 
SHA - Specifies that the HMAC-SHA authentication protocol will be used. This field is 
only operable when V3 is selected in the SNMP Version field and the Encryption 
field has been checked. This field will require the user to enter a password. 

Priv-Protocol None - Specifies that no authorization protocol is in use.  
DES - Specifies that DES 56-bit encryption is in use, based on the CBC-DES (DES-
56) standard. This field is only operable when V3 is selected in the SNMP Version 
field and the Encryption field has been checked. This field will require the user to 
enter a password between 8 and 16 alphanumeric characters. 

Encrypted Checking the corresponding box will enable encryption for SNMP V3 and is only oper-
able in SNMP V3 mode. 

To implement changes made, click Apply. To return to the SNMP User Table, click the Show All SNMP User Table 
Entries link. 
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SNMP View Table 
The SNMP View Table is used to assign views to community strings that define which MIB objects can be accessed by a 
remote SNMP manager. To view the SNMP View Table, open the SNMP Manager folder and click the SNMP View 
Table entry. The following screen should appear: 

 
Figure 8- 4. SNMP View Table 

To delete an existing SNMP View Table entry, click the  in the Delete column corresponding to the entry to delete. 
To create a new entry, click the Add button and a separate menu will appear. 

 
Figure 8- 5. SNMP View Table Configuration window 

The SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in 
the previous menu. 

The following parameters can set: 

Parameter                       Description 

View Name Type an alphanumeric string of up to 32 characters. This is used to identify the new 
SNMP view being created. 

Subtree OID Type the Object Identifier (OID) Subtree for the view. The OID identifies an object tree 
(MIB tree) that will be included or excluded from access by an SNMP manager. 

View Type Select Included to include this object in the list of objects that an SNMP manager can 
access. Select Excluded to exclude this object from the list of objects that an SNMP 
manager can access. 

To implement your new settings, click Apply. To return to the SNMP View Table, click the Show All SNMP View Table 
Entries link. 
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SNMP Group Table 
An SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in the 
previous menu. To view the SNMP Group Table, open the SNMP Manager folder and click the SNMP Group Table 
entry. The following screen should appear: 

 
Figure 8- 6. SNMP Group Table 

To delete an existing SNMP Group Table entry, click the corresponding  under the Delete heading. 

To display the current settings for an existing SNMP Group Table entry, click the hyperlink for the entry under the 
Group Name. 

 
Figure 8- 7. SNMP Group Table Display – View window 

To add a new entry to the Switch's SNMP Group Table, click the Add button in the upper left-hand corner of the SNMP 
Group Table page.  This will open the SNMP Group Table Configuration page, as shown below. 
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Figure 8- 8. SNMP Group Table Configuration – Add window 

The following parameters can set: 

Parameter                           Description 

Group Name Type an alphanumeric string of up to 32 characters. This is used to identify the new 
SNMP group of SNMP users. 

Read View Name This name is used to specify the SNMP group created can request SNMP mes-
sages. 

Write View Name Specify a SNMP group name for users that are allowed SNMP write privileges to 
the Switch's SNMP agent. 

Notify View Name Specify a SNMP group name for users that can receive SNMP trap messages 
generated by the Switch's SNMP agent. 

Security Model SNMPv1 - Specifies that SNMP version 1 will be used.   

SNMPv2 - Specifies that SNMP version 2c will be used. The SNMPv2 supports both 
centralized and distributed network management strategies. It includes 
improvements in the Structure of Management Information (SMI) and adds some 
security features. 

SNMPv3 - Specifies that the SNMP version 3 will be used. SNMPv3 provides 
secure access to devices through a combination of authentication and encrypting 
packets over the network.   

Security Level The Security Level settings only apply to SNMPv3. 

• NoAuthNoPriv - Specifies that there will be no authorization and no 
encryption of packets sent between the Switch and a remote SNMP 
manager. 

• AuthNoPriv - Specifies that authorization will be required, but there will be 
no encryption of packets sent between the Switch and a remote SNMP 
manager. 

• AuthPriv - Specifies that authorization will be required, and that packets 
sent between the Switch and a remote SNMP manger will be encrypted. 

To implement your new settings, click Apply. To return to the SNMP Group Table, click the Show All SNMP Group 
Table Entries link. 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

242 

     

SNMP Community Table  
Use this table to create an SNMP community string to define the relationship between the SNMP manager and an agent. 
The community string acts like a password to permit access to the agent on the Switch. One or more of the following 
characteristics can be associated with the community string: 

• An Access List of IP addresses of SNMP managers that are permitted to use the community string to gain access 
to the Switch's SNMP agent. 

• Any MIB view that defines the subset of all MIB objects will be accessible to the SNMP community. 

• Read/write or read-only level permission for the MIB objects accessible to the SNMP community. 

To configure SNMP Community entries, open the SNMP Manager folder, and click the SNMP Community Table link, 
which will open the following screen: 

 
Figure 8- 9. SNMP Community Table window 

The following parameters can set: 

Parameter                       Description 

Community Name Type an alphanumeric string of up to 32 characters that is used to identify members of 
an SNMP community. This string is used like a password to give remote SNMP 
managers access to MIB objects in the Switch's SNMP agent. 

View Name Type an alphanumeric string of up to 32 characters that is used to identify the group 
of MIB objects that a remote SNMP manager is allowed to access on the Switch. The 
view name must exist in the SNMP View Table. 

Access Right Read-only  - Specifies that SNMP community members using the community string 
created can only read the contents of the MIBs on the Switch. 

Read Write - Specifies that SNMP community members using the community string 
created can read from, and write to the contents of the MIBs on the Switch. 

To implement the new settings, click Apply. To delete an entry from the SNMP Community Table, click the  under 
the Delete heading, corresponding to the entry to delete. 
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SNMP Host Table 
Use the SNMP Host Table to set up SNMP trap recipients. 

Open the SNMP Manager folder and click on the SNMP Host Table link. This will open the SNMP Host Table page, as 
shown below. 

To delete an existing SNMP Host Table entry, click the corresponding  under the Delete heading. 

To display the current settings for an existing SNMP Group Table entry, click the blue link for the entry under the Host 
IP Address heading. 

 
Figure 8- 10. SNMP Host Table 

To add a new entry to the Switch's SNMP Host Table, click the Add button in the upper left-hand corner of the page.  
This will open the SNMP Host Table Configuration page, as shown below. 

 
Figure 8- 11. SNMP Host Table Configuration window 

The following parameters can set: 

Parameter                          Description 

Host IP Address Type the IP address of the remote management station that will serve as the SNMP 
host for the Switch. 

SNMP Version V1 - To specify that SNMP version 1 will be used.   

V2 - To specify that SNMP version 2 will be used.  

V3-NoAuth-NoPriv - To specify that the SNMP version 3 will be used, with a 
NoAuth-NoPriv security level. 

V3-Auth-NoPriv - To specify that the SNMP version 3 will be used, with an Auth-
NoPriv security level. 

V3-Auth-Priv - To specify that the SNMP version 3 will be used, with an Auth-Priv 
security level. 

Community String or 
SNMP V3 User Name 

Type in the community string or SNMP V3 user name as appropriate. 

To implement your new settings, click Apply. To return to the SNMP Host Table, click the Show All SNMP Host Table 
Entries link. 
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SNMP Engine ID 
The Engine ID is a unique identifier used for SNMP V3 implementations. This is an alphanumeric string used to identify 
the SNMP engine on the Switch. 

To display the Switch's SNMP Engine ID, open the SNMP Manger folder and click on the SNMP Engine ID link.  This 
will open the SNMP Engine ID Configuration window, as shown below. 

 
Figure 8- 12. SNMP Engine ID Configuration window 

To change the Engine ID, type the new Engine ID in the space provided and click the Apply button. 

 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

245 

     

Section 9 

Monitoring 
Port Utilization 

CPU Utilization 

Packets 

Errors 

Size 

Stacking Information  

Module Information 

Device Status 

MAC Address 

Switch History Log 

IGMP Snooping Group 

IGMP Snooping Forward 

Browse Router Port 

Port Access Control 

Layer 3 Feature  

     Browse IP Address Table 

     Browse Routing Table 

     Browse ARP Table  

     Browse IP Multicast Forwarding Table 

     Browse IGMP Group Table 

     OSPF Monitor 

     DVMRP Monitor 

     PIM Monitor 
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Port Utilization 
The Port Utilization page displays the percentage of the total available bandwidth being used on the port. 

To view the port utilization, open the Monitoring folder and then the Port Utilization link: 

 
Figure 9- 1. Port Utilization window 

To select a port to view these statistics for, first select the Switch in the switch stack by using the Unit pull-down menu and 
then select the port by using the Port pull-down menu. The user may also use the real-time graphic of the Switch and/or 
switch stack at the top of the web page by simply clicking on a port. The following field can be set: 

Parameter                       Description 

Time Interval Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Click Clear to refresh the graph. Click Apply to implement changes made. 
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CPU Utilization  
The CPU Utilization displays the percentage of the CPU being used, expressed as an integer percentage and calculated as 
a simple average by time interval. To view the CPU Utilization window, open the Monitoring folder and click the CPU 
Utilization link. 

 
Figure 9- 2. CPU Utilization graph 

To select a port to view these statistics for, first select the Switch in the switch stack by using the Unit pull-down menu. To 
view the CPU utilization by port, use the real-time graphic of the Switch and/or switch stack at the top of the web page by 
simply clicking on a port. Click Apply to implement the configured settings. The window will automatically refresh with 
new updated statistics. 

The information is described as follows: 

Parameter                       Description 

Time Interval [1s ] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Utilization Check whether or not to display Utilization. 
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Packets 
The Web Manager allows various packet statistics to be viewed as either a line graph or a table. Six windows are offered. 

Received (RX) 
Click the Received (RX) link in the Packets folder of the Monitoring menu to view the following graph of packets 
received on the Switch. To select a port to view these statistics for, first select the Switch in the switch stack by using the 
Unit pull-down menu and then select the port by using the Port pull-down menu. The user may also use the real-time 
graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 9- 3. Rx Packets Analysis window (line graph for Bytes and Packets) 

To view the Received Packets Table, click the link View Table, which will show the following table: 
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Figure 9- 4. Rx Packets Analysis Table  

The following fields may be set or viewed: 

Parameter                       Description 

Time Interval [1s ] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Bytes Counts the number of bytes received on the port. 

Packets Counts the number of packets received on the port. 

Unicast Counts the total number of good packets that were received by a unicast address. 

Multicast Counts the total number of good packets that were received by a multicast address. 

Broadcast Counts the total number of good packets that were received by a broadcast address. 

Show/Hide Check whether to display Bytes and Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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UMB Cast (RX) 
Click the UMB Cast (RX) link in the Packets folder of the Monitoring menu to view the following graph of UMB cast 
packets received on the Switch. To select a port to view these statistics for, first select the Switch in the switch stack by 
using the Unit pull-down menu and then select the port by using the Port pull-down menu. The user may also use the real-
time graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 9- 5. Rx Packets Analysis window (line graph for Unicast, Multicast, and Broadcast Packets) 

To view the UMB Cast Table, click the View Table link, which will show the following table: 
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Figure 9- 6. Rx Packets Analysis window (table for Unicast, Multicast, and Broadcast Packets) 

The following fields may be set or viewed: 

Parameter                        Description 

Time Interval [1s] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Unicast Counts the total number of good packets that were received by a unicast address. 

Multicast Counts the total number of good packets that were received by a multicast address. 

Broadcast Counts the total number of good packets that were received by a broadcast address. 

Show/Hide Check whether or not to display Multicast, Broadcast, and Unicast Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Transmitted (TX) 
Click the Transmitted (TX) link in the Packets folder of the Monitoring menu to view the following graph of packets 
transmitted from the Switch. To select a port to view these statistics for, first select the Switch in the switch stack by using 
the Unit pull-down menu and then select the port by using the Port pull-down menu. The user may also use the real-time 
graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 9- 7. Tx Packets Analysis window (line graph for Bytes and Packets) 

To view the Transmitted (TX) Table, click the link View Table, which will show the following table: 
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Figure 9- 8. Tx Packets Analysis window (table for Bytes and Packets) 

The following fields may be set or viewed: 

Parameter                       Description 

Time Interval [1s] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Bytes Counts the number of bytes successfully sent from the port. 

Packets Counts the number of packets successfully sent on the port. 

Unicast Counts the total number of good packets that were transmitted by a unicast address. 

Multicast Counts the total number of good packets that were transmitted by a multicast 
address. 

Broadcast Counts the total number of good packets that were transmitted by a broadcast 
address. 

Show/Hide Check whether or not to display Bytes and Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Errors 
The Web Manager allows port error statistics compiled by the Switch's management agent to be viewed as either a line 
graph or a table. Four windows are offered. 

Received (RX) 
Click the Received (RX) link in the Error folder of the Monitoring menu to view the following graph of error packets 
received on the Switch. To select a port to view these statistics for, first select the Switch in the switch stack by using the 
Unit pull-down menu and then select the port by using the Port pull-down menu. The user may also use the real-time 
graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 9- 9. Rx Error Analysis window (line graph) 

To view the Received Error Packets Table, click the link View Table, which will show the following table: 
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Figure 7- 27. Rx Error Analysis window (table) 

The following fields can be set: 

Parameter                       Description 

Time Interval [1s] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

Crc Error Counts otherwise valid packets that did not end on a byte (octet) boundary. 

UnderSize The number of packets detected that are less than the minimum permitted packets 
size of 64 bytes and have a good CRC. Undersize packets usually indicate collision 
fragments, a normal network occurrence. 

OverSize Counts packets received that were longer than 1518 octets, or if a VLAN frame is 
1522 octets, and less than the MAX_PKT_LEN. Internally, MAX_PKT_LEN is equal to 
1522. 

Fragment The number of packets less than 64 bytes with either bad framing or an invalid CRC. 
These are normally the result of collisions. 

Jabber The number of packets with lengths more than the MAX_PKT_LEN bytes. Internally, 
MAX_PKT_LEN is equal to 1522. 

Drop The number of packets that are dropped by this port since the last Switch reboot. 

Show/Hide Check whether or not to display CRC Error, Under Size, Over Size, Fragment, 
Jabber, and Drop errors. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Transmitted (TX) 
Click the Transmitted (TX) link in the Error folder of the Monitoring menu to view the following graph of error packets 
received on the Switch. To select a port to view these statistics for, first select the Switch in the switch stack by using the 
Unit pull-down menu and then select the port by using the Port pull-down menu. The user may also use the real-time 
graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 7- 28. Tx Error Analysis window (line graph) 

To view the Transmitted Error Packets Table, click the link View Table, which will show the following table: 
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Figure 7- 29. Tx Error Analysis window (table) 

The following fields may be set or viewed: 

Parameter                        Description 

Time Interval [1s ] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

ExDefer Counts the number of packets for which the first transmission attempt on a particular 
interface was delayed because the medium was busy. 

CRC Error Counts otherwise valid packets that did not end on a byte (octet) boundary. 

LateColl Counts the number of times that a collision is detected later than 512 bit-times into the 
transmission of a packet. 

ExColl Excessive Collisions. The number of packets for which transmission failed due to 
excessive collisions. 

SingColl Single Collision Frames. The number of successfully transmitted packets for which 
transmission is inhibited by more than one collision. 

Coll An estimate of the total number of collisions on this network segment. 

Show/Hide Check whether or not to display ExDefer, LateColl, ExColl, SingColl, and Coll errors. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Size 
The Web Manager allows packets received by the Switch, arranged in six groups and classed by size, to be viewed as 
either a line graph or a table. Two windows are offered. To select a port to view these statistics for, first select the Switch 
in the switch stack by using the Unit pull-down menu and then select the port by using the Port pull-down menu. The user 
may also use the real-time graphic of the Switch and/or switch stack at the top of the web page by simply clicking on a port. 

 
Figure 7- 30. Rx Size Analysis window (line graph) 

To view the Packet Size Analysis Table, click the link View Table, which will show the following table: 

 
Figure 7- 31. Rx Size Analysis window (table) 
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The following fields can be set or viewed: 

Parameter                          Description 

Time Interval [1s] Select the desired setting between 1s and 60s, where "s" stands for seconds. The 
default value is one second. 

Record Number [200] Select number of times the Switch will be polled between 20 and 200. The default 
value is 200. 

64 The total number of packets (including bad packets) received that were 64 octets in 
length (excluding framing bits but including FCS octets). 

65-127 The total number of packets (including bad packets) received that were between 65 
and 127 octets in length inclusive (excluding framing bits but including FCS octets). 

128-255 The total number of packets (including bad packets) received that were between 
128 and 255 octets in length inclusive (excluding framing bits but including FCS 
octets). 

256-511 The total number of packets (including bad packets) received that were between 
256 and 511 octets in length inclusive (excluding framing bits but including FCS 
octets). 

512-1023 The total number of packets (including bad packets) received that were between 
512 and 1023 octets in length inclusive (excluding framing bits but including FCS 
octets). 

1024-1518 The total number of packets (including bad packets) received that were between 
1024 and 1518 octets in length inclusive (excluding framing bits but including FCS 
octets). 

Show/Hide Check whether or not to display 64, 65-127, 128-255, 256-511, 512-1023, and 
1024-1518 packets received. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Stacking Information 
To change a switch’s default stacking configuration (for example, the order in the stack), see Box Information in the 
Configuration folder. 

The number of switches in the switch stack (up to 12 total) are displayed in the upper right-hand corner of your web-
browser. The icons are in the same order as their respective Unit numbers, with the Unit 1 switch corresponding to the icon 
in the upper left-most corner of the icon group. 

When the switches are properly interconnected through their optional Stacking Modules, information about the resulting 
switch stack is displayed under the Stack Information link.   

To view the stacking information, click on the Stacking Information link from the Monitoring folder: 

 
Figure 9- 10. Stacking Information window 

The Stacking Information window holds the following information: 

Parameters     Description 

Box ID Displays the Switch’s order in the stack.   

User Set Box ID can be assigned automatically (Auto), or can be assigned statically. The 
default is Auto. 

Type Displays the model name of the corresponding switch in a stack. 

Exist Denotes whether a switch does or does not exist in a stack. 

Priority Displays the priority ID of the Switch. The lower the number, the higher the priority. 
The box (switch) with the lowest priority number in the stack denotes the Master 
switch. The DGS-3324SRi will always be the master switch in a Star topology. 
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Prom Version Shows the PROM in use for the Switch. This may be different from the values shown 
in the illustration. 

Runtime Version Shows the firmware version in use for the Switch. This may be different from the 
values shown in the illustrations. 

H/W Version Shows the hardware version in use for the Switch. This may be different from the 
values shown in the illustration. 

Topology Show the current topology employed using this Switch. 

My Box ID Displays the Box ID of the Switch currently in use. 

Current State Displays the current stacking state of the Switch, which may be MASTER or SLAVE 

Box Count Displays the number of switches in the switch stack. 
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Module Information 
This window is used to view information about the DEM-420X or the DEM-420CX uplink module added to a member of 
the xStack DGS/DXS-3300 Switch Series. Currently, only the DXS-3326GSR and the DXS-3350SR members of the 
xStack DGS/DXS-3300 Switch Series have the capability to add the optional module. Although the DGS-3324SR and the 
DGS-3324SRi do not support the optional module, information about the module can be viewed on these switches if they 
are stacked with one of the switches that support the optional module. To view the following window, click Monitoring > 
Module Information:  

 
Figure 9- 11. Module Information window 

This window holds the following information: 

Parameter  Description 

Box ID The ID number of the switch in the switch stack that has the uplink module. 

Module Name The name of the optional module. Currently, switches in the xStack DGS/DXS-3300 
Switch Series only support the DEM-420X and DEM-420CX optional modules. 

Rev. No. The hardware revision number of the optional module. 

Serial The serial number associated with this particular optional module. 

Description A brief description of the optional module including port count and module type. 
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Device Status 
The Device Status window can be found in the Monitoring menu by clicking the Device Status link. This window shows 
the status of the physical attributes of the Switch, including power sources and fans. 

 
Figure 9- 12. Device Status window 

The following fields may be viewed in this window: 

Parameter   Description 

ID The Box ID of the Switch in the switch stack. 

Internal Power A read-only  field denoting the current status of the internal power supply. Active will 
suggest the mechanism is functioning correctly while Fail will show the mechanism is 
not functioning correctly. 

External Power A read-only  field denoting the current status of the external power supply. Active will 
suggest the mechanism is functioning correctly while Fail will show the mechanism is 
not functioning correctly. 

Side Fan A read-only  field denoting if the side fan of the Switch is functioning properly. 

Back Fan A read-only  field denoting if the back fan of the Switch is functioning properly. 
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MAC Address 
This allows the Switch's dynamic MAC address forwarding table to be viewed. When the Switch learns an association 
between a MAC address and a port number, it makes an entry into its forwarding table. These entries are then used to 
forward packets through the Switch. 

To view the MAC Address forwarding table, from the Monitoring menu, click the MAC Address link: 

 
Figure 9- 13. MAC Address Table 
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The following fields can be viewed or set: 

Parameter                       Description 

VLAN Name Enter a VLAN Name for the forwarding table to be browsed by. 

MAC Address Enter a MAC address for the forwarding table to be browsed by. 

Unit – Port  Select the switch Unit ID of the switch in the Switch stack and then the port by using 
the corresponding pull-down menus.  

Find Allows the user to move to a sector of the database corresponding to a user defined 
port, VLAN, or MAC address. 

VID The VLAN ID of the VLAN of which the port is a member. 

MAC Address The MAC address entered into the address table. 

Unit Refers to the Unit of the switch stack from which the MAC address was learned. 

Port The port to which the MAC address above corresponds. 

Type Describes the method which the Switch discovered the MAC address. The possible 
entries are Dynamic, Self, and Static. 

Next Click this button to view the next page of the address table. 

Clear Dynamic Entry Clicking this button will clear Dynamic entries learned by the Switch. This may be 
accomplished by VLAN Name or by Port. 

View All Entry Clicking this button will allow the user to view all entries of the address table. 

Clear All Entry Clicking this button will allow the user to delete all entries of the address table. 
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Switch History Log 
The Web manager allows the Switch's history log, as compiled by the Switch's management agent, to be viewed. To view 
the Switch history log, open the Maintenance folder and click the Switch History Log link. 

 
Figure 9- 14. Switch History Log window 

The Switch can record event information in its own logs, to designated SNMP trap receiving stations, and to the PC 
connected to the console manager. Click Next to go to the next page of the Switch History Log. Clicking Clear will allow 
the user to clear the Switch History Log. 

 

NOTE: For detailed information regarding Log entries that will appear in 
this window, please refer to Appendix C at the back of this manual. 

The information is described as follows: 

Parameter                       Description 

Sequence A counter incremented whenever an entry to the Switch's history log is made. The 
table displays the last entry (highest sequence number) first.   

Time Displays the time in days, hours, and minutes since the Switch was last restarted. 

Log Text Displays text describing the event that triggered the history log entry. 
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IGMP Snooping Group 
This window allows the Switch’s IGMP Snooping Group Table to be viewed. IGMP Snooping allows the Switch to read 
the Multicast Group IP address and the corresponding MAC address from IGMP packets that pass through the Switch. The 
number of IGMP reports that were snooped is displayed in the Reports field. 

To view the IGMP Snooping Group Table, click IGMP Snooping Group on the Monitoring menu: 

 
Figure 9- 15. IGMP Snooping Group Table 

The user may search the IGMP Snooping Group Table by VLAN Name by entering it in the top left hand corner and 
clicking Search. 

The following field can be viewed: 

Parameter                       Description 

VLAN Name The VLAN Name of the multicast group. 

Multicast Group The IP address of the multicast group. 

MAC Address The MAC address of the multicast group. 

Reports The total number of reports received for this group. 

Port Member These are the ports where the IGMP packets were snooped are displayed. 

 

 

NOTE: To configure IGMP snooping for the xStack DGS/DXS-3300 
Switch Series, go to the Configuration folder and select IGMP Snooping. 
Configuration and other information concerning IGMP snooping may be 
found in Section 6 of this manual under IGMP Snooping. 
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IGMP Snooping Forwarding  
This window will display the current IGMP snooping forwarding table entries currently configured on the Switch. To view 
the following screen, open the Monitoring folder and click the IGMP Snooping Forwarding link. 

 
Figure 9- 16. IGMP Snooping Forwarding Table 

The user may search the IGMP Snooping Forwarding Table by VLAN Name using the top left hand corner Search. 

The following field can be viewed: 

Parameter                       Description 

VLAN Name The VLAN Name of the multicast group. 

Source IP The Source IP address of the multicast group. 

Multicast Group The IP address of the multicast group. 

Port Map These are the ports where the IP multicast packets are being forwarded to. 
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Browse Router Port 
This displays which of the Switch’s ports are currently configured as router ports. A router port configured by a user (using 
the console or Web-based management interfaces) is displayed as a static router port, designated by S. A router port that is 
dynamically configured by the Switch is designated by D. 

 
Figure 9- 17. Browse Router Port window 
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Port Access Control 
The following screens are used to monitor 802.1x statistics of the Switch, on a per port basis. To view the Port Access 
Control screens, open the monitoring folder and click the Port Access Control folder. There are six screens to monitor. 

 

NOTE: The Authenticator State, Authenticator Statistics, Authenticator 
Session Statistics and Authenticator Diagnostics windows in this 
section cannot be viewed on the xStack DGS/DXS-3300 Switch Series 
unless 802.1x is enabled by port or by MAC address. To enable 802.1x, 
go to the Switch 802.1x entry in the Advanced Settings window under 
the Configuration menu.  

Authenticator State 
The following section describes the 802.1X Status on the Switch. To view the Authenticator State, click Monitoring > 
Port Access Control > Authenticator State. 

 
Figure 9- 18.  Authenticator State window – Port-based 802.1x 
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Figure 9- 19. Authenticator State window – MAC-Based 802.1x 

This window displays the Authenticator State for individual ports on a selected device. To select unit within the switch 
stack, use the pull-down menu at the top of the window and click Apply. A polling interval between 1 and 60 seconds can 
be set using the drop-down menu at the top of the window and clicking OK. 

The information on this window is described as follows: 

Parameter                          Description 

Auth PAE State The Authenticator PAE State value can be: Initialize, Disconnected, Connecting, 
Authenticating, Authenticated, Aborting, Held, Force_Auth, Force_Unauth, or N/A. 
N/A (Not Available) indicates that the port's authenticator capability is disabled. 

Backend State The Backend Authentication State can be Request, Response, Success, Fail, 
Timeout, Idle, Initialize, or N/A. N/A (Not Available) indicates that the port's 
authenticator capability is disabled. 

Port Status Controlled Port Status can be Authorized, Unauthorized, or N/A. 
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Authenticator Statistics 
 This table contains the statistics objects for the Authenticator PAE associated with each port. An entry appears in this table 
for each port that supports the Authenticator function. To view the Authenticator Statistics, click Monitoring > Port 
Access Control > Authenticator Statistics. 

 
Figure 9- 20. Authenticator Statistics window 

The user can specify a switch in a switch stack using that switch’s Unit ID by using the pull-down menu in the top left 
hand corner. The user may also select the desired time interval to update the statistics, between 1s and 60s, where “s” 
stands for seconds. The default value is one second. 

The following fields can be viewed: 

Parameter                       Description 

Port The identification number assigned to the Port by the System in which the Port 
resides. 

Frames Rx The number of valid EAPOL frames that have been received by this Authenticator. 

Frames Tx The number of EAPOL frames that have been transmitted by this Authenticator. 

Rx Start The number of EAPOL Start frames that have been received by this Authenticator. 

TxReqId The number of EAP Req/Id frames that have been transmitted by this Authenticator. 

RxLogOff The number of EAPOL Logoff frames that have been received by this Authenticator. 

Tx Req The number of EAP Request frames (other than Rq/Id frames) that have been 
transmitted by this Authenticator. 

Rx RespId The number of EAP Resp/Id frames that have been received by this Authenticator. 

Rx Resp The number of valid EAP Response frames (other than Resp/Id frames) that have 
been received by this Authenticator. 
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Rx Invalid The number of EAPOL frames that have been received by this Authenticator in which 
the frame type is not recognized. 

Rx Error The number of EAPOL frames that have been received by this Authenticator in which 
the Packet Body Length field is invalid. 

Last Version The protocol version number carried in the most recently received EAPOL frame. 

Last Source The source MAC address carried in the most recently received EAPOL frame. 

Authenticator Session Statistics 
This table contains the session statistics objects for the Authenticator PAE associated with each port. An entry appears in 
this table for each port that supports the Authenticator function. To view the Authenticator Session Statistics, click 
Monitoring > Port Access Control > Authenticator Session Statistics. 

 
Figure 9- 21. Authenticator Session Statistics window 

The user can specify a switch in a switch stack using that switch’s Unit ID by using the pull-down menu in the top left 
hand corner. The user may also select the desired time interval to update the statistics, between 1s and 60s, where “s” 
stands for seconds. The default value is one second. 

The following fields can be viewed: 

Parameter          Description 

Port The identification number assigned to the Port by the System in which the Port resides. 

Octets Rx The number of octets received in user data frames on this port during the session. 

Octets Tx The number of octets transmitted in user data frames on this port during the session. 

Frames Rx The number of user data frames received on this port during the session. 
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Frames Tx The number of user data frames transmitted on this port during the session. 

ID A unique identifier for the session, in the form of a printable ASCII string of at least three 
characters. 

Authentic Method  The authentication method used to establish the session. Valid Authentic Methods include:

 (1) Remote Authentic Server - The Authentication Server is external to the Authenticator’s 
System. 

 (2) Local Authentic Server - The Authentication Server is located within the 
Authenticator’s System. 

Time The duration of the session in seconds. 

Terminate Cause The reason for the session termination. There are eight possible reasons for termination.  

     1) Supplicant Logoff 

     2) Port Failure 

     3) Supplicant Restart 

     4) Reauthentication Failure 

     5) AuthControlledPortControl set to ForceUnauthorized 

     6) Port re-initialization 

     7) Port Administratively Disabled 

     8) Not Terminated Yet 

UserName The User-Name representing the identity of the Supplicant PAE. 
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Authenticator Diagnostics 
This table contains the diagnostic information regarding the operation of the Authenticator associated with each port. An 
entry appears in this table for each port that supports the Authenticator function. To view the Authenticator Diagnostics, 
click Monitoring > Port Access Control > Authenticator Diagnostics. 

 
Figure 9- 22. Authenticator Diagnostics window 

The user can specify a switch in a switch stack using that switch’s Unit ID by using the pull-down menu in the top left 
hand corner. The user may also select the desired time interval to update the statistics, between 1s and 60s, where “s” 
stands for seconds. The default value is one second. 

The following fields can be viewed: 

Parameter                         Description 

Port The identification number assigned to the Port by the System in which the Port 
resides. 

Connect Enter Counts the number of times that the state machine transitions to the CONNECTING 
state from any other state. 

Connect LogOff Counts the number of times that the state machine transitions from CONNECTING to 
DISCONNECTED as a result of receiving an EAPOL-Logoff message. 

Auth Enter Counts the number of times that the state machine transitions from CONNECTING to 
AUTHENTICATING, as a result of an EAP-Response/Identity message being 
received from the Supplicant. 

Auth Success Counts the number of times that the state machine transitions from 
AUTHENTICATING to AUTHENTICATED, as a result of the Backend Authentication 
state machine indicating successful authentication of the Supplicant (authSuccess = 
TRUE). 

Auth Timeout Counts the number of times that the state machine transitions from 
AUTHENTICATING to ABORTING, as a result of the Backend Authentication state 
machine indicating authentication timeout (authTimeout = TRUE). 

Auth Fail Counts the number of times that the state machine transitions from 
AUTHENTICATING to HELD, as a result of the Backend Authentication state 
machine indicating authentication failure (authFail = TRUE). 

Auth Reauth Counts the number of times that the state machine transitions from 
AUTHENTICATING to ABORTING, as a result of a reauthentication request 
(reAuthenticate = TRUE). 
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Auth Start Counts the number of times that the state machine transitions from 
AUTHENTICATING to ABORTING, as a result of an EAPOL-Start message being 
received from the Supplicant. 

Auth LogOff Counts the number of times that the state machine transitions from 
AUTHENTICATING to ABORTING, as a result of an EAPOL-Logoff message being 
received from the Supplicant. 

Authed Reauth Counts the number of times that the state machine transitions from 
AUTHENTICATED to CONNECTING, as a result of a reauthentication request 
(reAuthenticate = TRUE). 

Authed Start Counts the number of times that the state machine transitions from 
AUTHENTICATED to CONNECTING, as a result of an EAPOL-Start message being 
received from the Supplicant. 

Authed LogOff Counts the number of times that the state machine transitions from 
AUTHENTICATED to DISCONNECTED, as a result of an EAPOL-Logoff message 
being received from the Supplicant. 

Responses Counts the number of times that the state machine sends an initial Access-Request 
packet to the Authentication server (i.e., executes sendRespToServer on entry to the 
RESPONSE state). Indicates that the Authenticator attempted communication with 
the Authentication Server. 

AccessChallenges Counts the number of times that the state machine receives an initial Access-
Challenge packet from the Authentication server (i.e., aReq becomes TRUE, causing 
exit from the RESPONSE state). Indicates that the Authentication Server has 
communication with the Authenticator. 

OtherReqToSupp Counts the number of times that the state machine sends an EAP-Request packet 
(other than an Identity, Notification, Failure, or Success message) to the Supplicant 
(i.e., executes txReq on entry to the REQUEST state). Indicates that the 
Authenticator chose an EAP-method. 

NonNakRespFromSup Counts the number of times that the state machine receives a response from the 
Supplicant to an initial EAP-Request, and the response is something other than EAP-
NAK (i.e., rxResp becomes TRUE, causing the state machine to transition from 
REQUEST to RESPONSE, and the response is not an EAP-NAK). Indicates that the 
Supplicant can respond to the Authenticator’s chosen EAP-method. 

Bac Auth Success Counts the number of times that the state machine receives an Accept message from 
the Authentication Server (i.e., aSuccess becomes TRUE, causing a transition from 
RESPONSE to SUCCESS). Indicates that the Supplicant has successfully 
authenticated to the Authentication Server. 

Bac Auth Fail Counts the number of times that the state machine receives a Reject message from 
the Authentication Server (i.e., aFail becomes TRUE, causing a transition from 
RESPONSE to FAIL). Indicates that the Supplicant has not authenticated to the 
Authentication Server. 
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RADIUS Authentication 
This table contains information concerning the activity of the RADIUS authentication client on the client side of the 
RADIUS authentication protocol. It has one row for each RADIUS authentication server that the client shares a secret with. 
To view the RADIUS Authentication, click Monitoring > Port Access Control > RADIUS Authentication. 

 
Figure 9- 23. RADIUS Authentication window 

The user may also select the desired time interval to update the statistics, between 1s and 60s, where “s” stands for seconds. 
The default value is one second. To clear the current statistics shown, click the Clear button in the top left hand corner. 

The following fields can be viewed: 

Parameter    Description 

ServerIndex The identification number assigned to each RADIUS Authentication server that the 
client shares a secret with. 

InvalidServerAddr The number of RADIUS Access-Response packets received from unknown 
addresses. 

Identifier The NAS-Identifier of the RADIUS authentication client. (This is not necessarily the 
same as sysName in MIB II.) 

AuthServerAddr The (conceptual) table listing the RADIUS authentication servers with which the client 
shares a secret. 

ServerPortNumber The UDP port the client is using to send requests to this server. 

RoundTripTime The time interval (in hundredths of a second) between the most recent Access-
Reply/Access-Challenge and the Access-Request that matched it from this RADIUS 
authentication server. 

AccessRequests The number of RADIUS Access-Request packets sent to this server. This does not 
include retransmissions. 

AccessRetrans The number of RADIUS Access-Request packets retransmitted to this RADIUS 
authentication server. 

AccessAccepts The number of RADIUS Access-Accept packets (valid or invalid) received from this 
server. 

AccessRejects The number of RADIUS Access-Reject packets (valid or invalid) received from this 
server. 

AccessChallenges The number of RADIUS Access-Challenge packets (valid or invalid) received from this 
server. 

AccessResponses The number of malformed RADIUS Access-Response packets received from this 
server. Malformed packets include packets with an invalid length. Bad authenticators 
or Signature attributes or known types are not included as malformed access 
responses. 
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BadAuthenticators The number of RADIUS Access-Response packets containing invalid authenticators 
or Signature attributes received from this server. 

PendingRequests The number of RADIUS Access-Request packets destined for this server that have 
not yet timed out or received a response. This variable is incremented when an 
Access-Request is sent and decremented due to receipt of an Access-Accept, 
Access-Reject or Access-Challenge, a timeout or retransmission. 

Timeouts The number of authentication timeouts to this server. After a timeout the client may 
retry to the same server, send to a different server, or give up. A retry to the same 
server is counted as a retransmit as well as a timeout. A send to a different server is 
counted as a Request as well as a timeout. 

UnknownTypes The number of RADIUS packets of unknown type which were received from this 
server on the authentication port 

PacketsDropped The number of RADIUS packets of which were received from this server on the 
authentication port and dropped for some other reason. 

RADIUS Accounting 
This window shows managed objects used for managing RADIUS accounting clients, and the current statistics associated 
with them. It has one row for each RADIUS authentication server that the client shares a secret with. To view the RADIUS 
Accounting, click Monitoring > Port Access Control > RADIUS Accounting. 

 
Figure 9- 24. RADIUS Accounting window 

The user may also select the desired time interval to update the statistics, between 1s and 60s, where “s” stands for seconds. 
The default value is one second. To clear the current statistics shown, click the Clear button in the top left hand corner. 

The following fields can be viewed: 

Parameter    Description 

ServerIndex The identification number assigned to each RADIUS Accounting server that the client 
shares a secret with. 

InvalidServerAddr The number of RADIUS Accounting-Response packets received from unknown 
addresses. 

Identifier The NAS-Identifier of the RADIUS accounting client. (This is not necessarily the same 
as sysName in MIB II.) 

ServerAddress The (conceptual) table listing the RADIUS accounting servers with which the client 
shares a secret. 

ServerPortNumber The UDP port the client is using to send requests to this server. 
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RoundTripTime The time interval between the most recent Accounting-Response and the Accounting-
Request that matched it from this RADIUS accounting server. 

Requests The number of RADIUS Accounting-Request packets sent. This does not include 
retransmissions. 

Retransmissions The number of RADIUS Accounting-Request packets retransmitted to this RADIUS 
accounting server. Retransmissions include retries where the Identifier and Acct-
Delay have been updated, as well as those in which they remain the same. 

Responses The number of RADIUS packets received on the accounting port from this server. 

MalformedResponses The number of malformed RADIUS Accounting-Response packets received from this 
server. Malformed packets include packets with an invalid length. Bad authenticators 
and unknown types are not included as malformed accounting responses. 

BadAuthenticators The number of RADIUS Accounting-Response packets, which contained invalid 
authenticators, received from this server. 

PendingRequests The number of RADIUS Accounting-Request packets sent to this server that have not 
yet timed out or received a response. This variable is incremented when an 
Accounting-Request is sent and decremented due to receipt of an Accounting-
Response, a timeout or a retransmission. 

Timeouts The number of accounting timeouts to this server. After a timeout the client may retry 
to the same server, send to a different server, or give up. A retry to the same server is 
counted as a retransmit as well as a timeout. A send to a different server is counted 
as an Accounting-Request as well as a timeout. 

UnknownTypes The number of RADIUS packets of unknown type which were received from this 
server on the accounting port. 

PacketsDropped The number of RADIUS packets, which were received from this server on the 
accounting port and dropped for some other reason. 

 

 

 

Note: To configure 802.1x features for members of the xStack DGS/DXS-
3300 Switch Series, go to the Configuration folder and select Port 
Access Entity. Configuration and other information concerning 802.1x 
may be found in Section 6 of this manual under Port Access Entity. 
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Layer 3 Feature 
This folder in the Monitoring section will display information concerning settings configured in Layer 3 IP Networking 
of the Configuration folder. These settings and parameters have been previously described in Section 6 of this manual, 
under Layer 3 IP Networking. 

Browse IP Address Table 
The IP Address Table may be found in the Monitoring menu in the Layer 3 Feature folder. The IP Address Table is a 
read-only  screen where the user may view IP addresses discovered by the Switch. To search a specific IP address, enter it 
into the field labeled IP Address at the top of the screen and click Find to begin your search. 

 
Figure 9- 25. IP Address Table 
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Browse Routing Table  
The Routing Table window may be found in the Monitoring menu in the Layer 3 Feature folder. This screen shows the 
current IP routing table of the Switch. To find a specific IP route, enter an IP address into the Destination Address field 
along with a proper subnet mask into the Mask field and click Find. 

 
Figure 9- 26. Browse Routing Table window 

Browse ARP Table 
The ARP Table window may be found in the Monitoring menu in the Layer 3 Feature folder. This window will show 
current ARP entries on the Switch. To search a specific ARP entry, enter an interface name into the Interface Name or an 
IP address and click Find. To clear the ARP Table, click Clear All. 

 
Figure 9- 27. Browse ARP Table window 
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Browse IP Multicast Forwarding Table 
The IP Multicast Forwarding Table window may be found in the Monitoring menu in the Layer 3 Feature folder. This 
window will show current IP multicasting information on the Switch. To search a specific entry, enter an multicast group 
IP address into the Multicast Group field or a Source IP address and click Find. 

 
Figure 9- 28. Browse IP Multicast Forwarding Table 
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Browse IGMP Group Table 
The IGMP Group Table window may be found in the Monitoring menu in the Layer 3 Feature folder. This window will 
show current IGMP group entries on the Switch. To search a specific IGMP group entry, enter an interface name into the 
Interface Name field or a Multicast Group IP address and click Find. 

 
Figure 9- 29. Browse IGMP Group Table 

To view the specific details for an entry, click the corresponding  icon revealing the following window: 

 
Figure 7- 32. IGMP Group Detail and Source List Table window 

This window holds the following information: 
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Parameter  Description 

IGMP Group Detail 

Interface Name Defines the interface name of the reporting multicast group. 

Multicast Group The IP address of the reporting Multicast Group. 

Last Reporter IP The IP address of the host member of the multicast group to last report being a 
member of that group. 

Querier IP The IP Address of a selected multicast router, which is designated to query host 
interfaces about their multicast reception state. 

Expire Time The length of time, in seconds, until the entry will change filter mode from exclude to 
include. If the filter is in include mode, this timer will display 0. If the filter is in exclude 
mode, this timer will be counting down to zero from a pre-calculated figure based on 
the users implementation of IGMP. 

Group Filter Mode The filter mode of the multicast group. The purpose of the filter mode is to reduce the 
reception state of a multicast group so that all members of the multicast group are 
satisfied. This filter mode is dependant on membership reports and timers of the 
group. There are two possibilities: 
exclude – In exclude mode, the host is excluding packets from the SSM and therefore 
does not desire traffic from the source. This timer will be updated upon the reception 
of a group report packet. If no group report packet is received, the timer will expire 
and the filter mode will change to include. If a group report is received, the timer will 
be updated and packets will continue to be denied. 
include – This state denotes that members are accepting packets from the SSM 
(Specific Source Multicast). Once in include mode, source timers will start counting 
down until a group report is received which has information pertaining to the source. If 
no group report packet is received, all source timers will time out and the group record 
is deleted. 

V1 Host Timer This timer is based on a host within the multicast group that is running IGMPv1. 
Receiving a group report from an IGMPv1 host within the multicast group will refresh 
the timer. If no IGMPv1 host is a member of the multicast group, this field will always 
read 0. 

V2 Host Timer This timer is based on a host within the multicast group that is running IGMPv2. 
Receiving a group report from an IGMPv2 host within the multicast group will refresh 
the timer. If no IGMPv2 host is a member of the multicast group, this field will always 
read 0. 

Source List Table 

Source Address Displays the IP address of the SSM (Source Specific Multicast). 

Timer The timer for the source address (SSM). If the multicast group receives group reports 
from a host, the timer will be refreshed. If no group reports are received by the source, 
the timer will expire and the source record will be deleted from the Switch. 

 

 

NOTE: All timers within the preceding window can be determined using IGMP 
configurations to perform the following calculation: 

(Group Membership Interval x Robustness Variable) + One Query Response Interval
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OSPF Monitoring 
This section offers windows regarding OSPF (Open Shortest Path First) information on the Switch, including the OSPF 
LSDB Table, OSPF Neighbor Table and the OSPF Virtual Neighbor Table. To view these tables, open the Monitoring 
folder and click OSPF Monitoring. 

Browse OSPF LSDB Table 
This table can be found in the OSPF Monitoring folder by clicking on the Browse OSPF LSDB Table link. The OSPF 
Link-State Database Table displays the current link-state database in use by the OSPF routing protocol on a per-OSPF 
area basis. 

 
Figure 9- 30. Browse OSPF LSDB Table  

The user may search for a specific entry by entering the following information into the fields at the top of the screen: 

To browse the OSPF LSDB Table, the user must first select which browse method to use in the Search Type field. The 
choices are All, Area ID, Advertise Router ID, LSDB, Area ID & Advertise Router ID, Area ID & LSDB, and Advertise 
Router ID & LSDB.  

If Area ID is selected as the browse method, it is necessary to enter the IP address in the Area ID field, and then click Find.  
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If Adv. Router ID is selected, it is necessary to enter the IP address in the Advertisement Router ID field, and then click 
Find. 

If LSDB is selected, it is necessary to select the type of link state (RtrLink, NetLink, Summary, ASSummary and ASExtLink) 
in the LSDB Type field, and then click Find. 

The following fields are displayed in the OSPF LSDB Table: 

Parameter    Description 

Area ID Allows the entry of an OSPF Area ID.  This Area ID will then be used to search the 
table, and display an entry − if there is one. 

LSDB Type Displays which one of eight types of link advertisements by which the current link was 
discovered by the Switch: All, Router link (RTRLink), Network link (NETLink), 
Summary link (Summary), Autonomous System link (ASSummary), Autonomous 
System external link (ASExternal), MCGLink (Multicast Group), and NSSA (Not So 
Stubby Area) 

Adv. Router ID Displays the Advertising Router’s ID. 

Link State ID This field identifies the portion of the Internet environment that is being described by 
the advertisement. The contents of this field depend on the advertisement's LS type. 

LS Type    Link State ID 

____________________________________________ 
1          The originating router's Router ID. 

2          The IP interface address of the network's Designated Router.      

3          The destination network's IP address. 

4              The Router ID of the described AS boundary router. 

Cost Displays the cost of the table entry. 

Sequence Displays a sequence number corresponding to number of times the current link has 
been advertised as changed. 
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Browse OSPF Neighbor Table  
This table can be found in the OSPF Monitoring folder by clicking on the Browse OSPF Neighbor Table link. Routers 
that are connected to the same area or segment become neighbors in that area. Neighbors are elected via the Hello protocol.  
IP multicast is used to send out Hello packets to other routers on the segment. Routers become neighbors when they see 
themselves listed in a Hello packet sent by another router on the same segment. In this way, two-way communication is 
guaranteed to be possible between any two neighbor routers. This table displays OSPF neighbors of the Switch. 

 
Figure 9- 31. OSPF Neighbor Table 

To search for OSPF neighbors, enter an IP address and click Find. Valid OSPF neighbors will appear in the OSPF 
Neighbor Table below. 

OSPF Virtual Neighbor 
This table can be found in the OSPF Monitoring folder by clicking on the Browse OSPF Virtual Neighbor Table link. 
This table displays a list of Virtual OSPF Neighbors of the Switch. The user may choose specifically search a virtual 
neighbor by using one of the two search options at the top of the screen, which are: 

Parameter     Description 

Transit Area ID Allows the entry of an OSPF Area ID − previously defined on the Switch − that allows 
a remote area to communicate with the backbone (area 0). A Transit Area cannot be 
a Stub Area or a Backbone Area. 

Virtual Neighbor 
Router ID 

The OSPF router ID for the remote router. This IP address uniquely identifies the 
remote area’s Area Border Router. 

 

 
Figure 9- 32.OSPF Virtual Neighbor Table 
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DVMRP Monitoring 
This menu allows the DVMRP (Distance-Vector Multicast Routing Protocol) to be monitored for each IP interface defined 
on the Switch. This folder, found in the Monitoring folder, offers 3 screens for monitoring; DVMRP Routing Table, 
DVMRP Neighbor Address Table and DVMRP Routing Next Hop Table. Information on DVMRP and its features in 
relation to the xStack DGS/DXS-3300 Series can be found in Section 6, under IP Multicast Routing Protocol. 

Browse DVMRP Routing Table 
Multicast routing information is gathered and stored by DVMRP in the DVMRP Routing Table, which may be found in 
the Monitoring folder under Browse DVMRP Monitoring, contains one row for each port in a DVMRP mode. Each 
routing entry contains information about the source and multicast group, and incoming and outgoing interfaces. You may 
define your search by entering a Source IP Address and its subnet mask into the fields at the top of the page. 

 
Figure 9- 33. DVMRP Routing Table 
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Browse DVMRP Neighbor Table  
This table, found in the Monitoring menu under DVMRP Monitor > Browse DVMRP Neighbor Table contains 
information about DVMRP neighbors of the Switch. To search this table, enter either an Interface Name or Neighbor 
Address into the respective field and click the Find button. DVMRP neighbors of that entry will appear in the DVMRP 
Neighbor Table below. 

 
Figure 9- 34. DVMRP Neighbor Table 

Browse DVMRP Routing Next Hop Table 
The DVMRP Routing Next Hop Table contains information regarding the next-hop for forwarding multicast packets on 
outgoing interfaces. Each entry in the DVMRP Routing Next Hop Table refers to the next-hop of a specific source to a 
specific multicast group address. This table is found in the Monitoring menu under DVMRP Monitoring, with the 
heading Browse DVMRP Routing Next Hop Table. To search this table, enter either an Interface Name or Source IP 
Address into the respective field and click the Find button. The next hop of that DVMRP Routing entry will appear in the 
DVMRP Routing Next Hop Table below. 

 
Figure 9- 35. DVMRP Routing Next Hop Table 
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PIM Monitoring 
Multicast routers use Protocol Independent Multicast (PIM) to determine which other multicast routers should receive 
multicast packets. To find out more information concerning PIM and its configuration on the Switch, see the IP Multicast 
Routing Protocol chapter of Section 6, Configuration. 

Browse PIM Neighbor Table 
The PIM Neighbor Table contains information regarding each of a router’s PIM neighbors. This screen may be found by 
clicking Monitoring > PIM Monitor > Browse PIM Neighbor Table. To search this table, enter either an Interface 
Name or Neighbor Address into the respective field and click the Find button. PIM neighbors of that entry will appear in 
the PIM Neighbor Table below. 

 
Figure 9- 36. PIM Neighbor Table 

PIM IP MRoute Table 
The PIM IP MRoute Table is used to view information regarding the multicast data route entries in the Switch. This screen 
may be found by clicking Monitoring > Layer 3 Feature > PIM Monitor > Browse PIM IP MRoute Table. 

 
Figure 9- 37. PIM IP MRoute Table 
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Browse PIM RP Set Table 
The following window is used to assess information regarding the Rendezvous Point (RP) Set on the Switch. This screen 
may be found by clicking Monitoring > Layer 3 Feature > PIM Monitor > Browse PIM RP Set Table. 

 
Figure 9- 38. PIM RP Set Table 
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Section 10 
Switch Maintenance 

TFTP Services 

Multiple Image Services 

CF Services 

Ping Test 

Save Changes 

Reset 

Reboot System 

Logout 

TFTP Services 
Trivial File Transfer Protocol (TFTP) services allow the Switch’s firmware to be upgraded by transferring a new 
firmware file from a TFTP server to the Switch. A configuration file can also be loaded into the Switch from a TFTP server, 
switch settings can be saved to the TFTP server, and a history log can be uploaded from the Switch to the TFTP server. 

Download Firmware 
To update the Switch’s firmware, open the TFTP Services folder in the Maintenance folder and then click the Download 
Firmware link: 

 
Figure 10- 1. Download Firmware window 

Unit ID − Select which switch of a switch stack to update the firmware on. This allows the selection of a particular switch 
from a switch stack if the optional stacking module is installed and switches have been properly interconnected All 
indicates all switches in a switch stack will download the same firmware. 

Enter the IP address of the TFTP server in the Server IP Address field. 

Select the Image ID of the firmware. Members of the xStack DGS/DXS-3300 Switch Series can hold two firmware images 
in its memory. Image ID 1 will always be the boot up firmware for the Switch unless specified by the user. Choosing 
Active will download the firmware to the Boot Up Image ID, depending on the user’s configuration. Information on 
configuring Image IDs can be found in this section, under the heading MULTIPLE IMAGE Services. 

Enter the path and the filename to the firmware file on the TFTP server. Note that in the above example, the firmware file 
is in the root directory of the D drive of the TFTP server. 

The TFTP server must be running TFTP server software to perform the file transfer. TFTP server software is a part of 
many network management software packages – such as NetSight, or can be obtained as a separate program. 

Click Start to record the IP address of the TFTP server and initiate the file transfer. 
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Download Configuration File 
To download a configuration file from a TFTP server, click on the TFTP Service folder in the Maintenance folder and 
then the Download Configuration File link: 

 
Figure 10- 2. Download Configuration window 

Enter the IP address of the TFTP server and specify the location of the switch configuration file on the TFTP server. 

Click Start to initiate the file transfer. 

Download PROM 
The PROM, or Programmable Read-only  Memory, is a form of digital memory that cannot be configured but is necessary 
for read-only  memory of the Switch. It is recommended to have the latest PROM code set in the Switch for optimal use. 
To download the PROM code to the Switch, set the following parameters and click Start.  

 
Figure 10- 3. Download PROM window 

Parameter   Description 

Server IP Address Enter the IP address of the TFTP server where the PROM code is being stored. 

File Name Enter the path and the filename of the PROM code on the TFTP server. 

Upload Configuration 
To upload the Switch’s settings to a TFTP server, click on the TFTP Service folder in the Maintenance folder and then 
click the Upload Configuration link: 

 
Figure 10- 4. Upload Configuration window 

Enter the IP address of the TFTP server and the path and filename for the configuration file on the TFTP server.  

Click Start to initiate the file transfer. 
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Upload Log 
To upload the Switch history log file to a TFTP server, open the TFTP Service folder in the Maintenance folder and then 
click the Upload Log link: 

 
Figure 10- 5. Upload Log window 

Enter the IP address of the TFTP server and the path and filename for the history log on the TFTP server.  

Click Start to record the IP address of the TFTP server and to initiate the file transfer. 
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Multiple Image Services 
The Multiple Image Services folder allows users of the xStack DGS/DXS-3300 Series switches to configure and view 
information regarding firmware located on the Switch. The Switch allows two firmware images to be stored in its memory 
and either can be configured to be the boot up firmware for the Switch. For information regarding firmware images located 
on the Switch, open the Firmware Information link. The default setting for the Switch’s firmware will have the boot up 
firmware stored in Image 1, but the user may set either firmware stored to be the boot up firmware by using the Config 
Firmware Image window.  

Firmware Information 
The following screen allows the user to view information about current firmware images stored on the Switch. To access 
the following screen, click Maintenance > MULTIPLE IMAGE Services > Firmware Information. 

 
Figure 10- 6. Firmware Information window 

This window holds the following information: 

Parameter          Description 

BOX States the stacking ID number of the switch in the switch stack. 

ID States the image ID number of the firmware in the Switch’s memory. The Switch can store 
2 firmware images for use. Image ID 1 will be the default boot up firmware for the Switch 
unless otherwise configured by the user. 

Version States the firmware version.  

Size States the size of the corresponding firmware, in bytes. 

Update Time States the specific time the firmware version was downloaded to the Switch.  

From States the IP address of the origin of the firmware. There are five ways firmware may be 
downloaded to the Switch. 

• R – If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the Console Serial Port (RS-232). 

• T - If the IP address has this letter attached to it, it denotes a firmware upgrade 
through Telnet. 

• S - If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the Simple Network Management Protocol (SNMP). 

• W - If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the web-based management interface. 

• SIM – If the IP address has this letter attached to it, it denotes a firmware 
upgrade through the Single IP Management feature. 

User States the user who downloaded the firmware. This field may read “Anonymous” or 
“Unknown” for users that are not identified. 
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Config Firmware Image 
The Config Firmware Image window allows users to configure firmware images saved in the memory of the Switch. To 
access the following window, click Maintenance > MULTIPLE IMAGE Services > Config Firmware Image. 

 
Figure 10- 7. Config Firmware Image window 

This window offers the following information: 

Parameter     Description 

Image  Select the firmware image to be configured using the pull-down menu. The Switch 
allows two firmware images to be stored in the Switch’s memory.  

Action This field has two options for configuration. 

• Delete – Select this option to delete the firmware image specified in the 
Image field above. 

• Boot – Select this option to set the firmware image specified above as the 
boot up firmware for the Switch. This firmware will be set as the boot up 
firmware after a switch reboot has been performed. The default setting has 
firmware image ID 1 as the boot up firmware image for the Switch unless 
specified here. 

Click Apply to implement changes made. 
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CompactFlash Services 
At the rear of the DGS-3324SRi Switch only, there is an open slot for a CompactFlash card. This 32MB PCMCIA flash 
card provides high capacity solid-state flash memory for storing information for and from the Switch, such as firmware, 
configuration files and even save log information kept on the Switch. It also supports True IDE Mode that is electrically 
compatible with an IDE disk drive. It is recommended that the user store a backup of the startup configuration file and 
firmware runtime image on the CompactFlash card of the control module and on a central server.  

To install the CompactFlash card, insert it into the available slot on the back of the Switch, as shown below, and ensure 
that the card “clicks” into place. When correctly inserted, the CF Card Button should protrude. To eject the card from the 
slot, press the CF Card button in and the CompactFlash card should pop out. 

 
Figure 10- 8. CompactFlash Card Installation 

 

 

 

CF Card Information 
The CF Card Information window allows the user to view information about the CompactFlash card located at the back 
of the Switch. To view the following window, click Maintenance > CF Services > CF Card Information: 

 
Figure 10- 9. CF Card Information window 

This window holds the following information: 

Parameter   Description 

Drive ID Specifies the drives located on the CF Card. 

Media Type Describes the type of media accessory located in the Switch. In the example above, 
the CompactFlash card is being used. 

Size Specifies the size of the media accessory’s memory. 

Label Specifies the label placed on the CF card, if any. 

FS Type Describes the type of File System by which that the card was formatted. 

 

NOTE: This CompactFlash Card is hot swappable, and therefore it is 
unnecessary to power down the Switch when changing CompactFlash cards.
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Download Firmware from CF 
To download firmware saved on the CompactFlash card, click Maintenance > CF Services > Download & Upload > 
Download Firmware form CF which will open the following window: 

 
Figure 10- 10. Download Firmware from CF window 

Enter the file name, path and Image ID where the user wishes to place the firmware, into the space provided. The Image 
ID field has three options, Active, 1 and 2. Choosing Active will download the firmware to the Boot Up Image ID, 
depending on the user’s configuration. Clicking the Start button will begin the firmware download from the CompactFlash 
card to the Switch. Upon completion of the download, the Switch will reboot and the user will have to re-login to access 
the Web manager. 

 
Figure 10- 11. Download Firmware from CF Transfer window 

Download Configuration from CF 
To download a configuration file from the CompactFlash card, first open the Download Configuration from CF window 
by clicking Maintenance > CF Services > Download & Upload > Download Configuration from CF. 

 
Figure 10- 12. Download Configuration from CF window 

Enter the file name and path into the space provided and click Start. This will begin the configuration download from the 
CompactFlash card to the Switch. If the user wishes to implement a complete configuration setting, click the Reset box of 
the Config Control field. If the user wishes to download increments of the configuration, leave the Reset box unchecked. 

 
Figure 10- 13. Save Settings from CF window 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

299 

     

Upload Firmware to CF 
To upload firmware to the CompactFlash card, first open the Upload Firmware to CF window by clicking Maintenance 
> CF Services > Download & Upload > Upload Firmware to CF. 

 
Figure 10- 14. Upload Firmware to CF window 

Enter the file name and path into the space provided, along with the location of the Firmware on the Switch by specifying 
the Image ID, and click Start. This will begin the firmware upload from the host to the CompactFlash card for later use. 

Upload Config to CF 
The user may save a certain configuration setting of the Switch to the CompactFlash for future implementation. Initially, 
the user must save the current configuration file to the NV-RAM on the Switch by going to the Save Changes window, 
also in the Maintenance folder, and click the Save Configuration button. After the configuration has been saved, the user 
should open the Upload Config to CF window by clicking Maintenance > CF Services > Download & Upload > 
Upload Config to CF. In the following window, enter a new path name (e.g. c:/3324sri.cfg) in the File Name field and 
click Start. 

 
Figure 10- 15. Upload Config to CF window. 

Upon initiation of the upload sequence, the following window will appear, notifying the user of the file transfer status and 
completion. 

 
Figure 10- 16. Save Settings to CF window 



xStack DGS/DXS-3300 Series Layer 3 Stackable Gigabit Ethernet Switch User Manual 

300 

     

Upload Log to CF 
The user has the option of saving entries made into the Switch History Log onto the CompactFlash drive as well. These 
entries will be saved as a text file on the CompactFlash. To save a Switch History Log to the CompactFlash memory, first 
go to the Upload Log to CF window by clicking Maintenance > CF Services > Download & Upload > Upload Log to 
CF. 

 
Figure 10- 17. Upload Log to CF window 

Enter a path name chosen by the user, into the File Name field in the window above, and click Start to initiate the file 
transfer. The following window should appear, notifying the user of the current transfer status and completion of the 
upload. 

 
Figure 10- 18. Save Log to CF window 
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FS Commands 
The windows of this section are used for formatting and changing the settings for the CompactFlash card located at the 
back of the Switch. These commands relate to the CompactFlash card only and cannot be used for the Switch’s internal 
memory. Therefore, it will only be used with the DGS-3324SRi member of the xStack DGS/DXS-3300 Switch Series. 

Format 
The following window is used to format the CompactFlash card. To view this window, click Maintenance > CF Services 
> FS Command  > Format. 

 
Figure 10- 19. Format CF Card Settings window 

This window offers the following fields to aid the user in formatting the CompactFlash card.  

Parameter        Description 
Drive ID Allows the user to specify the drive on the CF card to be formatted. For this release, only 

c: drive can be set or specified. 

FS Type Allows the user to choose the type of File System to be formatted. For this release, only a 
FAT16 file system can be used for formatting. 

Option Choose the type of formatting to be done. 
• fast denotes formatting just the file architecture of the storage media accessory. 
• full denotes a full format.  
• full_with_MBR – Denotes that a full format will occur and all sectors of the card 

will be cleared, including the Master Boot Record. 
No information will remain on the storage media accessory after a full format. 

Label Enter a previously set name associated with this storage media accessory. 

Click Start to initiate the formatting of the CompactFlash drive. 

Copy 
This window is used to copy a directory located within the CompactFlash drive. To view this window, click Maintenance 
> CF Services > FS Command  > Copy. Click Start to initiate copying the file. 

 
Figure 10- 20. Copy File window 

This window offers the following fields to aid the user in copying files located in the CompactFlash card. 

Parameter       Description 
Source File (Full Path) Enter the full path and file name of the directory to be copied. This entry cannot 

exceed 64 characters in length. 

Target File (Full Path) Enter the file name of the directory and the path to place the copy. This entry cannot 
exceed 64 characters in length. 
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Md/Mkdir 
The following window is used to make a new directory on the CompactFlash card. To view this window, click 
Maintenance > CF Services > FS Command  > Md/Mkdir. To accomplish this, enter a new path and filename into the 
space provided and click the Apply button. 

 
Figure 10- 21. Make a new Directory window 

Rd/Rmdir 
The following window is used to delete a file located on the CompactFlash Card. To view this window, click Maintenance 
> CF Services > FS Command  > Rd/Rmdir. 

 
Figure 10- 22. Remove a Directory window 

To remove a directory, enter the full name and path into the space provided and click Apply. 

Dir 
This window is used to view directories and files located on the CompactFlash card. To view this window, click 
Maintenance > CF Services > FS Command  > Dir. 

 
Figure 10- 23. Dir window 

To search for a specific file located on the CF card, enter the full name and path of the file into the Path Name field and 
click Find. Files found will be displayed in the Dir Result Table located at the bottom of the screen. 

Rename 
This window is used to rename files located on the CompactFlash card. To view this window, click Maintenance > CF 
Services > FS Command  > Rename. 

 
Figure 10- 24. Rename window 

To rename a file, enter the current name of the file into the Old File Name field and then enter the updated file name into 
the New File Name and click Apply. 
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Ping Test 
Ping is a small program that sends ICMP Echo packets to a specified IP address. The destination node then responds to or 
"echoes" the packets sent from the Switch. This is very useful to verify connectivity between the Switch and other nodes 
on the network. 

 
Figure 10- 25. Ping Test 

The user may use Infinite times radio button, in the Repeat Pinging for: field, which will tell the ping program to keep 
sending ICMP Echo packets to the specified IP address until the program is stopped. The user may opt to choose a specific 
number of times to ping the Target IP Address by clicking its radio button and entering a number between 1 and 255. 
Click Start to initiate the Ping program. 

Save Changes 
The xStack DGS/DXS-3300 Switch Series has two levels of memory, normal RAM and non-volatile or NV-RAM. 
Configuration changes are made effective clicking the Apply button. When clicked, the settings will be immediately 
applied to the switching software in RAM, and will immediately take effect.  

Some settings, though, require restarting the Switch before taking effect. Restarting the Switch erases all settings in RAM 
and reloads the stored settings from the NV-RAM. Thus, it is necessary to save all setting changes to NV-RAM before 
rebooting the switch. 

To permanently retain any configuration changes, click on the Save button in the Save Changes page, as shown below. 

 
Figure 10- 26.  Save Changes screen 

The Switch has three levels of save, which are as follows: 

Parameter    Description 

Save (Only save 
config) 

Clicking the radio button for this entry will save only the current switch configuration to 
NV-RAM. 

Save Log (Only save 
log) 

Clicking the radio button for this entry will save only the current log file to NV-RAM. 

Save All (Save config 
and log) 

Clicking the radio button for this entry will save both the current switch configuration 
and the current log file to NV-RAM. 

These settings will be used every time the Switch is rebooted. See the Reset section for more information on changing 
configurations saved to NV-Ram.   
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Reset 
The Reset function has several options when resetting the Switch. Some of the current configuration parameters can be 
retained while resetting all other configuration parameters to their factory defaults.  

 

 

 

 

 

 
Figure 10- 27. Factory Reset to Default Value window 

 

 

NOTE: Only the Reset System option will enter the factory default 
parameters into the Switch’s non-volatile RAM, and then restart the 
Switch. All other options enter the factory defaults into the current 
configuration, but do not save this configuration. Reset System will 
return the Switch’s configuration to the state it was when it left the 
factory 
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Reboot System 
The following menu is used to restart the Switch. 

 
Figure 10- 28. Reboot System window 

Clicking the Yes click-box will instruct the Switch to save the current configuration to non-volatile RAM before restarting 
the Switch. 

Clicking the No click-box instructs the Switch not to save the current configuration before restarting the Switch. All of the 
configuration information entered from the last time Save Changes was executed, will be lost. 

Click the Restart button to restart the Switch. 

Logout 
Use the Logout page to logout of the Switch’s Web-based management agent by clicking on the Logout button. 

 
Figure 10- 29. Logout window 
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Section 11 

D-Link Single IP Management 
Single IP Management (SIM) Overview 

Topology 

Firmware Upgrade 

Configuration Backup/Restore 

Single IP Management (SIM) Overview 
Simply put, D-Link Single IP Management is a concept that will stack switches together over Ethernet instead of using 
stacking ports or modules. There are some advantages in implementing the "Single IP Management" feature: 

1. SIM can simplify management of small workgroups or wiring closets while scaling the network to handle 
increased bandwidth demand. 

2. SIM can reduce the number of IP address needed in your network. 

3. SIM can eliminate any specialized cables for stacking connectivity and remove the distance barriers that typically 
limit your topology options when using other stacking technology.  

Switches using D-Link Single IP Management (labeled here as SIM) must conform to the following rules: 

• SIM is an optional feature on the Switch and can easily be enabled or disabled through the Command Line 
Interface or Web Interface. SIM grouping has no effect on the normal operation of the Switch in the user's 
network. 

• There are three classifications for switches using SIM. The Commander Switch (CS), which is the master 
switch of the group, Member Switch (MS), which is a switch that is recognized by the CS a member of a SIM 
group, and a Candidate Switch (CaS), which is a Switch that has a physical link to the SIM group but has not 
been recognized by the CS as a member of the SIM group. 

• A SIM group can only have one Commander Switch (CS). 

• All switches in a particular SIM group must be in the same IP subnet (broadcast domain). Members of a SIM 
group cannot cross a router. 

• A SIM group accepts up to 32 switches (numbered 0-31), including the Commander Switch (numbered 0). 

• Ports linking switches within the SIM stack must be on the default VLAN. If the default VLAN is tagged, then 
each switch  in the SIM stack must use the same VLAN ID (VID = 1) for the default VLAN. 

• A compatibility issue arises with SSH and SSL. Packets between a Commander Switch and a  PC site can be 
protected through the use of SSH and SSL. However, packets between a CS and an MS cannot have SSH and 
SSL packets going back and forth between them. Therefore, the user must disable both of these security features 
when looking to add MSs to the CS, or the addition cannot take place. 

There is no limit to the number of SIM groups in the same IP subnet (broadcast domain), however a single switch can only 
belong to one group. 

If multiple VLANs are configured, the SIM group will only utilize the default VLAN on any switch. 

SIM allows intermediate devices that do not support SIM. This enables the user to manage switches that are more than one 
hop away from the CS. 

The SIM group is a group of switches that are managed as a single entity. Switches in the xStack DGS/DXS-3300 Series 
may take on three different roles: 

1. Commander Switch (CS) - This is a switch that has been manually configured as the controlling device for a 
group, and takes on the following characteristics:  

•  It has an IP Address. 
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•  It is not a command switch or member switch of another Single IP group. 

•  It is connected to the member switches through its management VLAN. 

2. Member Switch (MS) - This is a switch that has joined a single IP group and is accessible from the CS, and it 
takes on the following characteristics: 

•  It is not a CS or MS of another IP group. 

•  It is connected to the CS through the CS management VLAN. 

3. Candidate Switch (CaS) - This is a switch that is ready to join a SIM group but is not yet a member of the SIM 
group. The Candidate Switch may join the SIM group of the xStack DGS/DXS-3300 Switch Series by manually 
configuring it to be a MS of a SIM group. A switch configured as a CaS is not a member of a SIM group and will 
take on the following characteristics: 

•  It is not a CS or MS of another Single IP group. 

•  It is connected to the CS through the CS management VLAN 

The following rules also apply to the above roles: 

• Each device begins in a Commander state. 

• CSs must change their role to CaS and then to MS, to become a MS of a SIM group. Thus, the CS cannot 
directly be converted to a MS. 

• The user can manually configure a CS to become a CaS. 

A MS can become a CaS by: 

• Being configured as a CaS through the CS. 

• If report packets from the CS to the MS time out. 

• The user can manually configure a CaS to become a CS 

• The CaS can be configured through the CS to become a MS.  

After configuring one switch to operate as the CS of a SIM group, additional xStack DGS/DXS-3300 Series switches may 
join the group by manually configuring the Switch to be a MS. The CS will then serve as the in band entry point for access 
to the MS. The CS's IP address will become the path to all MS's of the group and the CS's Administrator's password, and/or 
authentication will control access to all MS's of the SIM group. 

With SIM enabled, the applications in the CS will redirect the packet instead of executing the packets. The applications 
will decode the packet from the administrator, modify some data, then send it to the MS. After execution, the CS may 
receive a response packet from the MS, which it will encode and send it back to the administrator. 

When a CS becomes a MS, it automatically becomes a member of the first SNMP community (include read/write and read-
only ) to which the CS belongs. However, if a MS has its own IP address, it can belong to SNMP communities to which 
other switches in the group, including the CS, do not belong. 

The Upgrade to v1.6. 
To better improve SIM management, the xStack DGS/DXS-3300 Series switches have been upgraded to version 1.6 in this 
release. Many improvements have been made, including: 

1. The Commander Switch (CS) now has the capability to automatically rediscover member switches that have left the SIM 
group, either through a reboot or web malfunction. This feature is accomplished through the use of Discover packets and 
Maintain packets that previously set SIM members will emit after a reboot. Once a MS has had its MAC address and 
password saved to the CS’s database, if a reboot occurs in the MS, the CS will keep this MS information in its database and 
when a MS has been rediscovered, it will add the MS back into the SIM tree automatically. No configuration will be 
necessary to rediscover these switches. 

There are some instances where pre-saved MS switches cannot be rediscovered. For example, if the Switch is still powered 
down, if it has become the member of another group, or if it has been configured to be a Commander Switch, the 
rediscovery process cannot occur. 
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3. This version will support multiple switch upload and downloads for firmware, configuration files and log files, as 
follows: 

Firmware – The switch now supports multiple MS firmware downloads from a TFTP server. 

Configuration Files – This switch now supports multiple downloading and uploading of configuration files both to (for 
configuration restoration) and from (for configuration backup) MS’s, using a TFTP server.. 

Log – The switch now supports uploading multiple MS log files to a TFTP server. 

4. This SIM version now supports encryption and decryption of SIM packets for added security between SIM enabled 
switches within the same SIM group. 

5. The user may zoom in and zoom out when utilizing the topology window to get a better, more defined view of the 
configurations. 

 

2. The topology map now includes new features for connections that are a member 
of a port trunking group. It will display the speed and number of Ethernet 
connections creating this port trunk group, as shown in the adjacent picture. 

 

NOTE: For more details regarding improvements made 
in SIMv1.6, please refer to the D-Link Single IP 
Management White Paper located on the D-Link 
website. 
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SIM Using the Web Interface 
All switches in the xStack DGS/DXS-3300 Series are set as Candidate (CaS) switches as their factory default configuration 
and Single IP Management will be disabled. To enable SIM for the Switch using the Web interface, go to the Single IP 
Management folder and click the SIM Settings link, revealing the following window. 

 
Figure 11- 1. SIM Settings window (disabled) 

Change the SIM State to Enabled using the pull-down menu and click Apply. The screen will then refresh and the SIM 
Settings window will look like this: 

 
Figure 11- 2. SIM Settings window (enabled) 

The following parameters can be set: 

Parameters                  Description 

SIM State Use the pull-down menu to either enable or disable the SIM state on the Switch. Dis-
abled will render all SIM functions on the Switch inoperable. 

Role State Use the pull-down menu to change the SIM role of the Switch. The two choices are: 
• Candidate - A Candidate Switch (CaS) is not the member of a SIM group but 

is connected to a Commander Switch. This is the default setting for the SIM 
role. 

• Commander - Choosing this parameter will make the Switch a Commander 
Switch (CS). The user may join other switches to this Switch, over Ethernet, to 
be part of its SIM group. Choosing this option will also enable the Switch to be 
configured for SIM. 

Discovery Interval The user may set the discovery protocol interval, in seconds that the Switch will send 
out discovery packets. Returning information to a Commander Switch will include 
information about other switches connected to it. (Ex. MS, CaS). The user may set the 
Discovery Interval from 30 to 90 seconds. 

Holdtime This parameter may be set for the time, in seconds the Switch will hold information sent 
to it from other switches, utilizing the Discovery Interval. The user may set the hold 
time from 100 to 255 seconds. 

Click Apply to implement the settings changed. 

After enabling the Switch to be a Commander Switch (CS), the Single IP Management folder will then contain three 
added links to aid the user in configuring SIM through the web, including Topology, Firmware Upgrade and 
Configuration Backup/Restore. 
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Topology 
The Topology window will be used to configure and manage the Switch within the SIM group and requires Java script to 
function properly on your computer. The following message should appear the first time the user clicks the Topology link 
in the Single IP Management folder. 

 
Figure 11- 3. Java window 

Clicking the here link will setup the Java Runtime Environment on your server and lead to the topology window, as seen 
below. 

 
Figure 11- 4. Single IP Management window - Tree View 

The Tree View window holds the following information under the Data tab: 

Parameter                       Description  

Device Name This field will display the Device Name of the switches in the SIM group configured by 
the user. If no Device Name is configured by the name, it will be given the name 
default and tagged with the last six digits of the MAC Address to identify it. 

Local Port Displays the number of the physical port on the CS that the MS or CaS is connected 
to. The CS will have no entry in this field. 

Speed Displays the connection speed between the CS and the MS or CaS. 

Remote Port Displays the number of the physical port on the MS or CaS that the CS is connected 
to. The CS will have no entry in this field. 
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MAC Address Displays the MAC Address of the corresponding Switch. 

Model Name Displays the full Model Name of the corresponding Switch. 

To view the Topology Map, click the View menu in the toolbar and then Topology, which will produce the following 
screen. The Topology View will refresh itself periodically (20 seconds by default). 

 
Figure 11- 5. Topology View 

This screen will display how the devices within the Single IP Management Group are connected to other groups and 
devices. Possible icons in this screen are as follows: 

Icon                  Description 

 
Group 

 
Layer 2 commander switch 

 
Layer 3 commander switch 

 
Commander switch of other group 

 
Layer 2 member switch. 
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Layer 3 member switch 

 
Member switch of other group 

 
Layer 2 candidate switch 

 
Layer 3 candidate switch 

 
Unknown device 

 

Non-SIM devices 

Tool Tips 
In the Topology view window, the mouse plays an important role in configuration and in viewing device information. 
Setting the mouse cursor over a specific device in the topology window (tool tip) will display the same information about a 
specific device as the Tree view does. See the window below for an example.  

 
Figure 11- 6. Device Information Utilizing the Tool Tip 

Setting the mouse cursor over a line between two devices will display the connection speed between the two devices, as 
shown below. 
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Figure 11- 7. Port Speed Utilizing the Tool Tip 
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Right Click 
Right clicking on a device will allow the user to perform various functions, depending on the role of the Switch in the SIM 
group and the icon associated with it. 

Group Icon 

      
Figure 11- 8. Right Clicking a Group Icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail.  

• Property - to pop up a window to display the group information. 

 
Figure 11- 9. Property window 
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Commander Switch Icon 

        
Figure 11- 10. Right Clicking a Commander Icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail.  

• Property - to pop up a window to display the group information. 

 
Figure 11- 11. Property window 

Member Switch Icon 

      
Figure 11- 12. Right Clicking a Member icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail. 
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• Remove from group - remove a member from a group. 

• Configure - launch the web management to configure the Switch. 

• Property - to pop up a window to display the device information. 

 
Figure 11- 13. Property window 

Candidate Switch Icon 

   
Figure 11- 14. Right Clicking a Candidate icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail. 

• Add to group - add a candidate to a group. Clicking this option will reveal the following screen for the user to 
enter a password for authentication from the Candidate Switch before being added to the SIM group. Click OK 
to enter the password or Cancel to exit the window. 

 
Figure 11- 15. Input password window. 

• Property - to pop up a window to display the device information, as shown below. 
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Figure 11- 16. Device Property window. 

This window holds the following information: 

Parameter                        Description  

Device Name This field will display the Device Name of the switches in the SIM group configured by 
the user. If no Device Name is configured by the name, it will be given the name 
default and tagged with the last six digits of the MAC Address to identify it. 

Module Name Displays the full module name of the switch that was right-clicked. 

MAC Address Displays the MAC Address of the corresponding Switch. 

Remote Port No. Displays the number of the physical port on the MS or CaS that the CS is connected 
to. The CS will have no entry in this field. 

Local Port No. Displays the number of the physical port on the CS that the MS or CaS is connected 
to. The CS will have no entry in this field. 

Port Speed Displays the connection speed between the CS and the MS or CaS 

Click Close to close the Property window. 
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Menu Bar 
The Single IP Management window contains a menu bar for device configurations, as seen below.  

 
Figure 11- 17. Menu Bar of the Topology View 

The five menus on the menu bar are as follows. 

File 
• Print Setup - will view the image to be printed. 
• Print Topology - will print the topology map. 
• Preference - will set display properties, such as polling interval, and the views to open at SIM startup. 

Group 
• Add to group - add a candidate to a group. Clicking this option will reveal the following screen for the user to 

enter a password for authentication from the Candidate Switch before being added to the SIM group. Click OK 
to enter the password or Cancel to exit the window. 

 
Figure 11- 18. Input password window 

• Remove from Group - remove an MS from the group. 

Device 

• Configure - will open the web manager for the specific device. 

View 

• Refresh - update the views with the latest status. 

• Topology - display the Topology view. 

Help 

• About - Will display the SIM information, including the current SIM version. 

 

 

NOTE: Upon this firmware release, some functions of the SIM can only be 
configured through the Command Line Interface. See the xStack DGS/DXS-3300 
Series CLI Manual for more information on SIM and its configurations. 
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Firmware Upgrade 
This screen is used to upgrade firmware from the Commander Switch to the Member Switch. To access the following 
window, click Single IP Management > Firmware Upgrade. Member Switches will be listed in the table and will be 
specified by Port (port on the CS where the MS resides), MAC Address, Model Name and Version. To specify a certain 
Switch for firmware download, click its corresponding check box under the Port heading. To update the firmware, enter 
the Server IP Address where the firmware resides and enter the Path/Filename of the firmware. Click Download to 
initiate the file transfer. 

 
Figure 11- 19. Firmware Upgrade window 

Configuration File Backup/Restore 
This screen is used to upgrade configuration files from the Commander Switch to the Member Switch using a TFTP server. 
Member Switches will be listed in the table and will be specified by Port (port on the CS where the MS resides), MAC 
Address, Model Name and Version. To specify a certain Switch for upgrading configuration files, click its corresponding 
radio button under the Port heading. To update the configuration file, enter the Server IP Address where the file resides 
and enter the Path/Filename of the configuration file. Click Download to initiate the file transfer from a TFTP server to 
the Switch. Click Upload to backup the configuration file to a TFTP server. 

 
Figure 11- 20. Configuration File Backup/Restore window  

Upload Log File 
The following window is used to upload log files from SIM member switches to a specified PC. To view this window click 
Single IP Management > Upload Log File. To upload a log file, enter the IP address of the SIM member switch and then 
enter a path on your PC where you wish to save this file. Click Upload to initiate the file transfer. 

 
Figure 11- 21. Upload Log File 
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Appendix A 
General 

Standards 

IEEE 802.3u 100BASE-TX Fast Ethernet 

IEEE 802.3ab 1000BASE-T Gigabit Ethernet 

IEEE 802.1D Spanning Tree 

IEEE 802.1w Rapid Spanning Tree 

IEEE 802.1s Multiple Spanning Tree 

IEEE 802.1 P/Q VLAN 

IEEE 802.1p Priority Queues 

IEEE 802.1x Port and MAC Based Access Control 

IEEE 802.3ad Link Aggregation Control 

IEEE 802.3x Full-duplex Flow Control 

IEEE 802.3 Nway auto-negotiation 

Protocols CSMA/CD 

Data Transfer Rates: 

 

Ethernet  

Fast Ethernet 

Gigabit Ethernet 

 

Fiber Optic  

Half-duplex Full-duplex  

 

10 Mbps 20Mbps 

100Mbps 200Mbps  

1000Mbps 2000Mbps 

 

IEC 793-2:1992 

Type A1a - 50/125um multimode 

Type A1b - 62.5/125um multimode  

Both types use LC optical connector 

Topology Star / Ring 

Network Cables 

UTP Cat.5 for 100Mbps 

UTP Cat.3, 4, 5 for 10Mbps 

EIA/TIA-568 100-ohm screened twisted-pair (STP)(100m) 

Physical And Environment 

AC inputs & External 
Redundant Power 
Supply 

100 - 240 VAC, 200 to 240VAC, 50/60 Hz (internal universal power supply) 

Power Consumption 

DGS-3324SR/ DGS-3324SRi - 90 watts maximum 

DXS-3326GSR – 88.09 watts maximum 

DXS-3350SR – 140 watts maximum 
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DC fans: 
DGS-3324SR / DGS-3324SRi / DXS-3326GSR – Two built-in 40 x 40 x10 mm 
fans; One built-in 60 x 60 x 18 mm fan 

DXS-3350SR – Two 40 x 40 x 18mm DC fans 

Operating Temperature: 0 to 40 degrees Celsius 

Storage Temperature -25 to 55 degrees Celsius 

Humidity 
Operating: 5% to 95% RH non-condensing                    

Storage: 0% to 95% RH non-condensing 

Dimensions 

DGS-3324SR / DGS-3324SRi – 441 mm x 207 mm x 44 mm (1U), 19 inch rack-
mount width 

DXS-3326GSR / DXS-3350SR – 441 mm x 430 mm x 44 mm (1U), 19 inch rack-
mount width 

Weight 

DGS-3324SR and DGS-3324SRi – 3.15kg 

DXS-3326GSR – 6.5kg 

DXS-3350SR – 6.41kg 

EMI: 
FCC Part 15 Class A/ ICES-003 Class (Canada) 

EN55022  Class A/ EN55024 

Safety: CSA International 

Performance 

Transmission Method Store-and-forward 

RAM Buffer 
DGS-3324SR / DGS-3324SRi / DXS-3326GSR – 2 MB per device  

DXS-3350SR – 4 MB per device 

Filtering Address 
Table: 

16 K MAC addresses per device 

3K IP addresses per device 

Packet Filtering/ 
Forwarding Rate: 

Full-wire speed for all connections.  

148,800 pps per port (for 100Mbps) 

1,488,000 pps per port (for 1000Mbps) 

MAC Address 
Learning Automatic update. 

Forwarding Table Age 
Time: 

Max age: 10 - 1000000 seconds.  

Default = 300. 
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Appendix B 
Cables and Connectors 
When connecting the Switch to another switch, a bridge or hub, a normal cable is necessary. Please review these products 
for matching cable pin assignment. 

The following diagrams and tables show the standard RJ-45 receptacle/connector and their pin assignments. 

  

 
Appendix 1- 1. The standard RJ-45 port and connector 

RJ-45 Pin Assignments 

Contact MDI-X Port MDI-II Port 

1 RD+ (receive) TD+ (transmit) 

2 RD- (receive) TD- (transmit) 

3 TD+ (transmit) RD+ (receive) 

4 Not used Not used 

5 Not used Not used 

6 TD- (transmit) RD- (receive) 

7 Not used Not used 

8 Not used Not used 

Appendix 1- 2. The standard RJ-45 pin assignments 
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Appendix C 
System Log Entries 
The following table lists all possible entries and their corresponding meanings that will appear in the System Log of this 
Switch. 

Category  Event 
Description Log Content Severity Remark 

system  System started up System warm start Critical  

system  System started up System cold start Critical  

 Configuration 
saved to flash 

Configuration and log saved 
to flash by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational 

"by console" and "IP: 
<ipaddr>, MAC: <macaddr>" 
are XOR shown in log strings, 
which means if the user logs 
in through the console, no IP 
or MAC address information 
will be included in the log. 

 Internal Power 
failed Internal Power failed Critical  

 Internal Power is 
recovered Internal Power is recovered Critical  

 Redundant Power 
failed Redundant Power failed Critical  

 Redundant Power 
is working Redundant Power is working Critical  

up/down-
load 

Firmware 
upgraded 
successfully 

Firmware upgraded by 
console successfully 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Firmware 
upgrade was 
unsuccessful  

Firmware upgrade by console 
was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
successfully 
downloaded 

Configuration successfully 
downloaded by console 
(Username: <username>, IP: 
<ipaddr> MAC: <macaddr>)

Informational 
by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
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Category  Event 
Description Log Content Severity Remark 

<ipaddr>, MAC: <macaddr>) through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
download was 
unsuccessful 

Configuration download by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
successfully 
uploaded 

Configuration successfully 
uploaded by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
upload was 
unsuccessful 

Configuration upload by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Log message 
successfully 
uploaded 

Log message successfully 
uploaded by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Log message 
upload was 
unsuccessful  

Log message upload by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

Interface Port link up  Port <portNum> link up, <link 
state> Informational Port link state (ex: , 100Mbps 

FULL duplex) 

 Port link down Port <portNum> link down Informational  

Console Successful login 
through Console 

Successful login through 
Console (Username: 
<username>) 

Informational 
If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 
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Category  Event 
Description Log Content Severity Remark 

 Login failed 
through Console  

Login failed through Console 
(Username: <username>) Warning 

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 Logout through 
Console  

Logout through Console 
(Username: <username>) Informational 

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 Console session 
timed out  

Console session timed out 
(Username: <username>) Informational 

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

Web Successful login 
through Web  

Successful login through Web 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Login failed 
through Web  

Login failed through Web 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
Web 

Logout through Web 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Successful login 
through SSL 

Successful login through Web 
(SSL) (Username: <string>, IP: 
<ip>, MAC: <mac>) 

Informational  

 Logout through 
SSL 

Logout through Web (SSL) 
(Username: <string>, IP: <ip>, 
MAC: <mac>) 

Informational  

 Login failed 
through SSL  

Login failed through Web 
(SSL) (Username: <string>, IP: 
<ip>, MAC: <mac>) 

Warning  

Telnet Successful login 
through Telnet 

Successful login through 
Telnet (Username: 
<username>, IP: <ipaddr>, 
MAC: <macaddr>) 

Informational  

 Login failed 
through Telnet  

Login failed through Telnet 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
Telnet  

Logout through Telnet 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Telnet session 
timed out  

Telnet session timed out 
(Username: <username>, IP: 

i dd MAC dd )

Informational  
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Category  Event 
Description Log Content Severity Remark 

<ipaddr>, MAC: <macaddr>) 

SNMP 
SNMP request 
received with 
invalid 
community string  

SNMP request received from 
<ipAddress> with invalid 
community string! 

Informational  

STP Topology 
changed  Topology changed Informational  

 New Root 
selected  New Root selected Informational  

 BPDU Loop Back 
on port 

BPDU Loop Back on Port 
<portNum> Warning  

 
Spanning Tree 
Protocol is 
enabled  

Spanning Tree Protocol is 
enabled Informational  

 
Spanning Tree 
Protocol is 
disabled 

Spanning Tree Protocol is 
disabled Informational  

SSH Successful login 
through SSH  

Successful login through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Login failed 
through SSH  

Login failed through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
SSH  

Logout through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 SSH session 
timed out  

SSH session timed out 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Enable SSH 
server SSH server is enabled Informational  

 Disable SSH 
server SSH server is disabled Informational  

AAA Authentication 
Policy is enabled 

Authentication Policy is 
enabled (Module: AAA) Informational  

 Authentication 
Policy is disabled 

Authentication Policy is 
disabled (Module: AAA) Informational  
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Category  Event 
Description Log Content Severity Remark 

 

Successful login 
through Console 
authenticated by 
AAA local 
method 

Successful login through 
Console authenticated by 
AAA local method (Username: 
<username>) 

Informational  

 

Login failed 
through Console 
authenticated by 
AAA local 
method 

Login failed through Console 
authenticated by AAA local 
method (Username: 
<username>) 

Warning  

 

Successful login 
through Web 
authenticated by 
AAA local 
method 

Successful login through Web 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Login failed 
through Web 
authenticated by 
AAA local 
method 

Login failed through Web 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA local 
method 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Web 
(SSL) 
authenticated by 
AAA local 
method 

Login failed through Web 
(SSL) from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful login 
through Telnet 
authenticated by 
AAA local 
method 

Successful login through 
Telnet from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Telnet 
authenticated by 
AAA local 
method 

Login failed through Telnet 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 
Successful login 
through SSH 
authenticated by 
AAA local 

Successful login through SSH 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 

Informational  
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Category  Event 
Description Log Content Severity Remark 

method MAC: <macaddr>) 

 

Login failed 
through SSH 
authenticated by 
AAA local 
method 

Login failed through SSH from 
<userIP> authenticated by 
AAA local method (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful login 
through Console 
authenticated by 
AAA none 
method 

Successful login through 
Console authenticated by 
AAA none method (Username: 
<username>) 

Informational  

 

Successful login 
through Web 
authenticated by 
AAA none 
method 

Successful login through Web 
from <userIP> authenticated 
by AAA none method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA none 
method 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful login 
through Telnet 
authenticated by 
AAA none 
method 

Successful login through 
Telnet from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful login 
through SSH 
authenticated by 
AAA none 
method 

Successful login through SSH 
from <userIP> authenticated 
by AAA none method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Successful login 
through Console 
authenticated by 
AAA server 

Successful login through 
Console authenticated by 
AAA server <serverIP> 
(Username: <username>) 

Informational 
If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 
Login failed 
through Console 
authenticated by 
AAA server 

Login failed through Console 
authenticated by AAA server 
<serverIP> (Username: 
<username>) 

Warning There are no IP and MAC if 
login by console. 
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Category  Event 
Description Log Content Severity Remark 

 

Login failed 
through Console 
due to AAA 
server timeout or 
improper 
configuration 

Login failed through Console 
due to AAA server timeout or 
improper configuration 
(Username: <username>) 

Warning  

 
Successful login 
through Web 
authenticated by 
AAA server 

Successful login through Web 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Login failed 
through Web 
authenticated by 
AAA server 

Login failed through Web 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Login failed 
through Web due 
to AAA server 
timeout or 
improper 
configuration 

Login failed through Web 
from <userIP> due to AAA 
server timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA server 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Web 
(SSL) 
authenticated by 
AAA server 

Login failed through Web 
(SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Login failed 
through Web 
(SSL) due to 
AAA server 
timeout or 
improper 
configuration 

Login failed through 
Web(SSL) from <userIP> due 
to AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 
Successful login 
through Telnet 
authenticated by 
AAA server 

Successful login through 
Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  
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Category  Event 
Description Log Content Severity Remark 

 
Login failed 
through Telnet 
authenticated by 
AAA server 

Login failed through Telnet 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Login failed 
through Telnet 
due to AAA 
server timeout or 
improper 
configuration 

Login failed through Telnet 
from <userIP> due to AAA 
server timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 
Successful login 
through SSH 
authenticated by 
AAA server 

Successful login through SSH 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Login failed 
through SSH 
authenticated by 
AAA server 

Login failed through SSH from 
<userIP> authenticated by 
AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Login failed 
through SSH due 
to AAA server 
timeout or 
improper 
configuration 

Login failed through SSH from 
<userIP> due to AAA server 
timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Console 
authenticated by AAA 
local_enable method 
(Username: <username>) 

Informational  

 

Enable Admin 
failed through 
Console 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Console authenticated by 
AAA local_enable method 
(Username: <username>) 

Warning  

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  
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Category  Event 
Description Log Content Severity Remark 

 

Enable Admin 
failed through 
Web 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Web from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web (SSL) 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Web (SSL) from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Telnet 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Telnet from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
SSH 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
<Telnet or Web or SSH> from 
<userIP> authenticated by 
AAA local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  
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Category  Event 
Description Log Content Severity Remark 

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Console 
authenticated by AAA none 
method (Username: 
<username>) 

Informational  

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA none method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA server 

Successful Enable Admin 
through Console 
authenticated by AAA server 
<serverIP> (Username: 
<username>) 

Informational  

 

Enable Admin 
failed through 
Console 
authenticated by 
AAA server 

Enable Admin failed through 
Console authenticated by 
AAA server <serverIP> 
(Username: <username>) 

Warning  

 

Enable Admin 
failed through 
Console due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Console due to AAA server 
timeout or improper 
configuration (Username: 
<username>) 

Warning  
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Category  Event 
Description Log Content Severity Remark 

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA server 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web 
authenticated by 
AAA server 

Enable Admin failed through 
Web from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
Web due to AAA 
server timeout or 
improper 
configuration 

Enable Admin failed through 
Web from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA server 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web (SSL) 
authenticated by 
AAA server 

Enable Admin failed through 
Web (SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
Web (SSL) due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Web (SSL) from <userIP> due 
to AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA server 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
Telnet 
authenticated by 
AAA server 

Enable Admin failed through 
Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 

dd )

Warning  
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Category  Event 
Description Log Content Severity Remark 

<macaddr>) 

 

Enable Admin 
failed through 
Telnet due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Telnet from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA server 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
SSH 
authenticated by 
AAA server 

Enable Admin failed through 
SSH from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
SSH due to AAA 
server timeout or 
improper 
configuration 

Enable Admin failed through 
SSH from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 AAA server 
timed out 

AAA server <serverIP> 
(Protocol: <protocol>) 
connection failed 

Warning 
<protocol> is one of 
TACACS, XTACACS, 
TACACS+ or RADIUS 

Port 
Security 

port security has 
reached its 
maximum 
learning size and 
will not learn any 
new addresses 

Port security violation (Port: 
<portNum>, MAC: <macaddr>) Warning  

IP-MAC-
PORT 
Binding 

Unauthenticated 
IP address 
discarded by IP 
mac port binding 

Unauthenticated IP-MAC 
address and discarded by ip 
mac port binding (IP: 
<ipaddr>, MAC: <macaddr>, 
Port <portNum>) 

Warning  

Safeguard 
Engine 

Safeguard Engine 
is in normal mode 

SafeGuard Engine enters 
NORMAL mode Informational  
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Category  Event 
Description Log Content Severity Remark 

 
Safeguard Engine 
is in filtering 
packet mode 

Safeguard Engine enters 
EXHAUSTED mode Warning  

Packet 
Storm 

Broadcast storm 
occurence 

Broadcast storm is occurring 
(port: <id>) Warning  

 Broadcast storm 
has cleared 

Broadcast storm has cleared 
(port: <id>) Informational  

 Multicast storm 
occurence 

Multicast storm is occurring 
(port: <id>) Warning  

 Multicast storm 
has cleared 

Multicast storm has cleared 
(port: <id>) Informational  

Security 

Packet received 
containing a 
MAC address 
identical to the 
MAC address of 
the device’s 
interface 

Possible spoofing attack from 
<mac> port <u16> Critical  
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Appendix D 
Cable Lengths 
Use the following table to as a guide for the maximum cable lengths. 

Standard Media Type Maximum Distance 

Mini-GBIC 1000BASE-LX, Single-mode fiber module 

1000BASE-SX, Multi-mode fiber module 

1000BASE-LHX, Single-mode fiber module 

1000BASE-ZX, Single-mode fiber module 

10km 

550m 

40km 

80km 

1000BASE-T Category 5e UTP Cable 

Category 5 UTP Cable (1000 Mbps) 

100m 

100BASE-TX Category 5 UTP Cable (100 Mbps) 100m 

10BASE-T Category 3 UTP Cable (10 Mbps) 100m 
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Glossary 
1000BASE-LX: A short laser wavelength on multimode fiber optic cable for a maximum length of 550 meters 

1000BASE-SX: A long wavelength for a "long haul" fiber optic cable for a maximum length of 10 kilometers 

100BASE-FX: 100Mbps Ethernet implementation over fiber. 

100BASE-TX: 100Mbps Ethernet implementation over Category 5 and Type 1 Twisted Pair cabling. 

10BASE-T: The IEEE 802.3 specification for Ethernet over Unshielded Twisted Pair (UTP) cabling. 

aging: The automatic removal of dynamic entries from the Switch Database which have timed-out and are no longer valid. 

ATM: Asynchronous Transfer Mode. A connection oriented transmission protocol based on fixed length cells (packets). 
ATM is designed to carry a complete range of user traffic, including voice, data and video signals. 

auto-negotiation: A feature on a port which allows it to advertise its capabilities for speed, duplex and flow control. When 
connected to an end station that also supports auto-negotiation, the link can self-detect its optimum operating setup.  

backbone port: A port which does not learn device addresses, and which receives all frames with an unknown address. 
Backbone ports are normally used to connect the Switch to the backbone of your network. Note that backbone ports were 
formerly known as designated downlink ports. 

backbone: The part of a network used as the primary path for transporting traffic between network segments. 

bandwidth: Information capacity, measured in bits per second, that a channel can transmit. The bandwidth of Ethernet is 
10Mbps, the bandwidth of Fast Ethernet is 100Mbps. 

baud rate: The switching speed of a line. Also known as line speed between network segments. 

BOOTP: The BOOTP protocol allows automatic mapping of an IP address to a given MAC address each time a device is 
started. In addition, the protocol can assign the subnet mask and default gateway to a device. 

bridge: A device that interconnects local or remote networks no matter what higher level protocols are involved. Bridges 
form a single logical network, centralizing network administration. 

broadcast: A message sent to all destination devices on the network. 

broadcast storm: Multiple simultaneous broadcasts that typically absorb available network bandwidth and can cause 
network failure. 

console port: The port on the Switch accepting a terminal or modem connector. It changes the parallel arrangement of data 
within computers to the serial form used on data transmission links. This port is most often used for dedicated local 
management. 

CSMA/CD: Channel access method used by Ethernet and IEEE 802.3 standards in which devices transmit only after 
finding the data channel clear for some period of time. When two devices transmit simultaneously, a collision occurs and 
the colliding devices delay their retransmissions for a random amount of time. 

data center switching: The point of aggregation within a corporate network where a switch provides high-performance 
access to server farms, a high-speed backbone connection and a control point for network management and security. 

Ethernet: A LAN specification developed jointly by Xerox, Intel and Digital Equipment Corporation. Ethernet networks 
operate at 10Mbps using CSMA/CD to run over cabling. 

Fast Ethernet: 100Mbps technology based on the Ethernet/CD network access method. 

Flow Control: (IEEE 802.3z) A means of holding packets back at the transmit port of the connected end station. Prevents 
packet loss at a congested switch port. 

forwarding: The process of sending a packet toward its destination by an internetworking device. 

full duplex: A system that allows packets to be transmitted and received at the same time and, in effect, doubles the 
potential throughput of a link. 

half duplex: A system that allows packets to be transmitted and received, but not at the same time. Contrast with full 
duplex. 
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IP address: Internet Protocol address. A unique identifier for a device attached to a network using TCP/IP. The address is 
written as four octets separated with full-stops (periods), and is made up of a network section, an optional subnet section 
and a host section. 

IPX: Internetwork Packet Exchange. A protocol allowing communication in a NetWare network. 

LAN - Local Area Network: A network of connected computing resources (such as PCs, printers, servers) covering a 
relatively small geographic area (usually not larger than a floor or building). Characterized by high data rates and low error 
rates. 

latency: The delay between the time a device receives a packet and the time the packet is forwarded out of the destination 
port. 

line speed: See baud rate. 

main port: The port in a resilient link that carries data traffic in normal operating conditions. 

MDI - Medium Dependent Interface: An Ethernet port connection where the transmitter of one device is connected to 
the receiver of another device. 

MDI-X - Medium Dependent Interface Cross-over: An Ethernet port connection where the internal transmit and receive 
lines are crossed. 

MIB - Management Information Base: Stores a device's management characteristics and parameters. MIBs are used by 
the Simple Network Management Protocol (SNMP) to contain attributes of their managed systems. The Switch contains its 
own internal MIB.  

multicast: Single packets copied to a specific subset of network addresses. These addresses are specified in the 
destination-address field of the packet. 

protocol: A set of rules for communication between devices on a network. The rules dictate format, timing, sequencing 
and error control. 

resilient link: A pair of ports that can be configured so that one will take over data transmission should the other fail. See 
also main port and standby port. 

RJ-45: Standard 8-wire connectors for IEEE 802.3 10BASE-T networks. 

RMON: Remote Monitoring. A subset of SNMP MIB II that allows monitoring and management capabilities by 
addressing up to ten different groups of information. 

RPS - Redundant Power System: A device that provides a backup source of power when connected to the Switch. 

server farm: A cluster of servers in a centralized location serving a large user population. 

SLIP - Serial Line Internet Protocol: A protocol which allows IP to run over a serial line connection. 

SNMP - Simple Network Management Protocol: A protocol originally designed to be used in managing TCP/IP 
internets. SNMP is presently implemented on a wide range of computers and networking equipment and may be used to 
manage many aspects of network and end station operation. 

Spanning Tree Protocol (STP): A bridge-based system for providing fault tolerance on networks. STP works by allowing 
the user to implement parallel paths for network traffic, and ensure that redundant paths are disabled when the main paths 
are operational and enabled if the main paths fail. 

stack: A group of network devices that are integrated to form a single logical device. 

standby port: The port in a resilient link that will take over data transmission if the main port in the link fails. 

switch: A device which filters, forwards and floods packets based on the packet's destination address. The switch learns 
the addresses associated with each switch port and builds tables based on this information to be used for the switching 
decision. 

TCP/IP: A layered set of communications protocols providing Telnet terminal emulation, FTP file transfer, and other 
services for communication among a wide range of computer equipment. 

telnet: A TCP/IP application protocol that provides virtual terminal service, letting a user log in to another computer 
system and access a host as if the user were connected directly to the host. 

TFTP - Trivial File Transfer Protocol: Allows the user to transfer files (such as software upgrades) from a remote device 
using your switch's local management capabilities. 
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UDP - User Datagram Protocol: An Internet standard protocol that allows an application program on one device to send a 
datagram to an application program on another device. 

VLAN - Virtual LAN: A group of location- and topology-independent devices that communicate as if they are on a 
common physical LAN. 

VLT - Virtual LAN Trunk: A Switch-to-Switch link which carries traffic for all the VLANs on each Switch. 

VT100: A type of terminal that uses ASCII characters. VT100 screens have a text-based appearance. 
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FCC Warning 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with this manual, may cause harmful interference to 
radio communications.  Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense. 

CE Mark Warning 

This is a Class A product. In a domestic environment, this product may cause radio interference in which case the user may be required to take adequate 
measures. 

Warnung! 

Dies ist ein Produkt der Klasse A. Im Wohnbereich kann dieses Produkt Funkstoerungen verursachen. In diesem Fall kann vom Benutzer verlangt werden, 
angemessene Massnahmen zu ergreifen. 

Precaución! 

Este es un producto de Clase A. En un entorno doméstico, puede causar interferencias de radio, en cuyo case, puede requerirse al usuario para que adopte 
las medidas adecuadas. 

Attention! 

Ceci est un produit de classe A. Dans un environnement domestique, ce produit pourrait causer des interférences radio, auquel cas l`utilisateur devrait 
prendre les mesures adéquates. 

Attenzione! 
Il presente prodotto appartiene alla classe A. Se utilizzato in ambiente domestico il prodotto può causare interferenze radio, nel cui caso è possibile che 
l`utente debba assumere provvedimenti adeguati. 

BSMI Warning 
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LIMITED WARRANTY 
D-Link provides this limited warranty for its product only to the person or entity who originally purchased the product from D-Link or its authorized 
reseller or distributor. D-Link would fulfill the warranty obligation according to the local warranty policy in which you purchased our products. 

Limited Hardware Warranty: D-Link warrants that the hardware portion of the D-Link products described below 
(“Hardware”) will be free from material defects in workmanship and materials from the date of original retail purchase of 
the Hardware, for the period set forth below applicable to the product type (“Warranty Period”) if the Hardware is used and 
serviced in accordance with applicable documentation; provided that a completed Registration Card is returned to an 
Authorized D-Link Service Office within ninety (90) days after the date of original retail purchase of the Hardware.  If a 
completed Registration Card is not received by an authorized D-Link Service Office within such ninety (90) period, then 
the Warranty Period shall be ninety (90) days from the date of purchase. 

Product Type Warranty Period 
Product (including Power Supplies and Fans) 

One (1) Year 
Spare parts and pare kits 

Ninety (90) days 

D-Link’s sole obligation shall be to repair or replace the defective Hardware at no charge to the original owner.  Such repair or replacement will be 
rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be new or of an identical make, model or part; D-Link 
may in its discretion may replace the defective Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is 
substantially equivalent (or superior) in all material respects to the defective Hardware.  The Warranty Period shall extend for an additional ninety (90) 
days after any repaired or replaced Hardware is delivered. If a material defect is incapable of correction, or if D-Link determines in its sole discretion that 
it is not practical to repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware will be refunded by D-
Link upon return to D-Link of the defective Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is 
refunded, shall become the property of D-Link upon replacement or refund. 

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will substantially conform to D-Link’s then current 
functional specifications for the Software, as set forth in the applicable documentation, from the date of original delivery of the Software for a period of 
ninety (90) days (“Warranty Period”), if the Software is properly installed on approved hardware and operated as contemplated in its documentation.  
D-Link further warrants that, during the Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical defects.  
D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media) with software that substantially conforms to D-Link’s 
functional specifications for the Software.  Except as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original 
licensee, and is subject to the terms and conditions of the license granted by D-Link for the Software.  The Warranty Period shall extend for an additional 
ninety (90) days after any replacement Software is delivered.  If a material non-conformance is incapable of correction, or if D-Link determines in its sole 
discretion that it is not practical to replace the non-conforming Software, the price paid by the original licensee for the non-conforming Software will be 
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned to D-Link.  The license granted respecting any 
Software for which a refund is given automatically terminates.   

What You Must Do For Warranty Service: 

Registration Card.  The Registration Card provided at the back of this manual must be completed and returned to an Authorized D-Link Service Office for 
each D-Link product within ninety (90) days after the product is purchased and/or licensed.  The addresses/telephone/fax list of the nearest Authorized 
D-Link Service Office is provided in the back of this manual.  FAILURE TO PROPERLY COMPLETE AND TIMELY RETURN THE 
REGISTRATION CARD MAY AFFECT THE WARRANTY FOR THIS PRODUCT. 

Submitting A Claim.  Any claim under this limited warranty must be submitted in writing before the end of the Warranty Period to an Authorized D-Link 
Service Office.  The claim must include a written description of the Hardware defect or Software nonconformance in sufficient detail to allow D-Link to 
confirm the same.  The original product owner must obtain a Return Material Authorization (RMA) number from the Authorized D-Link Service Office 
and, if requested, provide written proof of purchase of the product (such as a copy of the dated purchase invoice for the product) before the warranty 
service is provided.  After an RMA number is issued, the defective product must be packaged securely in the original or other suitable shipping package 
to ensure that it will not be damaged in transit, and the RMA number must be prominently marked on the outside of the package.  The packaged product 
shall be insured and shipped to Authorized D-Link Service Office with all shipping costs prepaid.  D-Link may reject or return any product that is not 
packaged and shipped in strict compliance with the foregoing requirements, or for which an RMA number is not visible from the outside of the package.  
The product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged and shipped in 
accordance with the foregoing requirements, or that is determined by D-Link not to be defective or non-conforming. 

What Is Not Covered:   

This limited warranty provided by D-Link does not cover: 

Products that have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse, faulty installation, lack of reasonable care, 
repair or service in any way that is not contemplated in the documentation for the product, or if the model or serial number has been altered, tampered 
with, defaced or removed; 

Initial installation, installation and removal of the product for repair, and shipping costs; 

Operational adjustments covered in the operating manual for the product, and normal maintenance;  

Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage; and 

Any hardware, software, firmware or other products or services provided by anyone other than D-Link. 

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE PRODUCT IS PROVIDED “AS-IS” 
WITHOUT ANY WARRANTY OF ANY KIND INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.  IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY 
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TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90) DAYS.  
EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, 
SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT. 

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR 
DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, 
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, LOSS OF INFORMATION OR 
DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) 
RESULTING FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS 
LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  THE SOLE REMEDY FOR A 
BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-
CONFORMING PRODUCT. 

GOVERNING LAW: This Limited Warranty shall be governed by the laws of the state of California. 

Some states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty lasts, so the foregoing 
limitations and exclusions may not apply.  This limited warranty provides specific legal rights and the product owner may also have other rights which vary from 
state to state. 

 

Trademarks 

Copyright ©2005 D-Link Corporation. Contents subject to change without prior notice. D-Link is a registered trademark of 
D-Link Corporation/D-Link Systems, Inc.  All other trademarks belong to their respective proprietors. 

 

Copyright Statement 
No part of this publication may be reproduced in any form or by any means or used to make any derivative such as translation, transformation, or 
adaptation without permission from D-Link Corporation/D-Link Systems Inc., as stipulated by the United States Copyright Act of 1976. 
 
FCC Warning 
 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures: 
-Reorient or relocate the receiving antenna. 
-Increase the separation between the equipment and receiver. 
-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
-Consult the dealer or an experienced radio/ TV technician for help. 
 
FCC Radiation Exposure Statement 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated 
with minimum 20cm between the radiator and your body. 
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited Warranty: 

• Only to the person or entity that originally purchased the product from D-Link or its authorized reseller or distributor, and 

• Only for products purchased and delivered within the fifty states of the United States, the District of Columbia, U.S. Possessions or 
Protectorates, U.S. Military Installations, or addresses with an APO or FPO.  

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link product described below (“Hardware”) will be free from material defects 
in workmanship and materials under normal use from the date of original retail purchase of the product, for the period set forth below (“Warranty 
Period”), except as otherwise stated herein.  

• Hardware (excluding power supplies and fans): Five (5) Years 

• Power supplies and fans: One (1) Year 

• Spare parts and spare kits: Ninety (90) days 

The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited Warranty will be, at D-Link’s option, to 
repair or replace the defective Hardware during the Warranty Period at no charge to the original owner or to refund the actual purchase price paid.  Any 
repair or replacement will be rendered by D-Link at an Authorized D-Link Service Office.  The replacement hardware need not be new or have an 
identical make, model or part.  D-Link may, at its option, replace the defective Hardware or any part thereof with any reconditioned product that D-Link 
reasonably determines is substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or replacement hardware will 
be warranted for the remainder of the original Warranty Period or ninety (90) days, whichever is longer, and is subject to the same limitations and 
exclusions.  If a material defect is incapable of correction, or if D-Link determines that it is not practical to repair or replace the defective Hardware, the 
actual price paid by the original purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective Hardware.  All 
Hardware or part thereof that is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon replacement 
or refund. 

Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will substantially conform to D-Link’s then 
current functional specifications for the Software, as set forth in the applicable documentation, from the date of original retail purchase of the Software for 
a period of ninety (90) days (“Software Warranty Period”), provided that the Software is properly installed on approved hardware and operated as 
contemplated in its documentation. D-Link further warrants that, during the Software Warranty Period, the magnetic media on which D-Link delivers the 
Software will be free of physical defects.  The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited 
Warranty will be, at D-Link’s option, to replace the non-conforming Software (or defective media) with software that substantially conforms to D-Link’s 
functional specifications for the Software or to refund the portion of the actual purchase price paid that is attributable to the Software.  Except as 
otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee, and is subject to the terms and conditions of the 
license granted by D-Link for the Software.  Replacement Software will be warranted for the remainder of the original Warranty Period and is subject to 
the same limitations and exclusions.  If a material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not 
practical to replace the non-conforming Software, the price paid by the original licensee for the non-conforming Software will be refunded by D-Link; 
provided that the non-conforming Software (and all copies thereof) is first returned to D-Link.  The license granted respecting any Software for which a 
refund is given automatically terminates. 

Non-Applicability of Warranty:  The Limited Warranty provided hereunder for Hardware and Software portions of D-Link's products will not be 
applied to and does not cover any refurbished product and any product purchased through the inventory clearance or liquidation sale or other sales in 
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being 
sold "As-Is" without any warranty whatsoever including, without limitation, the Limited Warranty as described herein, notwithstanding anything stated 
herein to the contrary.   

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return policy.  In case the return policy period 
has expired and the product is within warranty, the customer shall submit a claim to D-Link as outlined below: 

• The customer must submit with the product as part of the claim a written description of the Hardware defect or Software nonconformance in 
sufficient detail to allow D-Link to confirm the same, along with proof of purchase of the product (such as a copy of the dated purchase invoice for 
the product) if the product is not registered. 

• The customer must obtain a Case ID Number from D-Link Technical Support at 1-877-453-5465, who will attempt to assist the customer in 
resolving any suspected defects with the product.  If the product is considered defective, the customer must obtain a Return Material Authorization 
(“RMA”) number by completing the RMA form and entering the assigned Case ID Number at https://rma.dlink.com/. 

• After an RMA number is issued, the defective product must be packaged securely in the original or other suitable shipping package to ensure 
that it will not be damaged in transit, and the RMA number must be prominently marked on the outside of the package.  Do not include any manuals 
or accessories in the shipping package.  D-Link will only replace the defective portion of the product and will not ship back any accessories. 

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery (“COD”) is allowed.  Products sent COD will 
either be rejected by D-Link or become the property of D-Link.  Products shall be fully insured by the customer and shipped to D-Link Systems, 
Inc., 17595 Mt. Herrmann, Fountain Valley, CA 92708.  D-Link will not be held responsible for any packages that are lost in transit to D-Link.  
The repaired or replaced packages will be shipped to the customer via UPS Ground or any common carrier selected by D-Link.  Return shipping 
charges shall be prepaid by D-Link if you use an address in the United States, otherwise we will ship the product to you freight collect. Expedited 
shipping is available upon request and provided shipping charges are prepaid by the customer. 

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing requirements, or for which an RMA 
number is not visible from the outside of the package. The product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any 
product that is not packaged and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective or non-
conforming. 

What Is Not Covered: The Limited Warranty provided herein by D-Link does not cover: Products that, in D-Link’s judgment, have been subjected to 
abuse, accident, alteration, modification, tampering, negligence, misuse, faulty installation, lack of reasonable care, repair or service in any way that is not 
contemplated in the documentation for the product, or if the model or serial number has been altered, tampered with, defaced or removed; Initial 
installation, installation and removal of the product for repair, and shipping costs; Operational adjustments covered in the operating manual for the 
product, and normal maintenance; Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;  Any hardware, 
software, firmware or other products or services provided  by anyone other than D-Link; and Products that have been purchased from inventory clearance 
or liquidation sales or other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product.  
While necessary maintenance or repairs on your Product can be performed by any company, we recommend that you use only an Authorized D-Link 
Service Office. Improper or incorrectly performed maintenance or repair voids this Limited Warranty. 

https://rma.dlink.com/
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Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE PRODUCT IS PROVIDED “AS-IS” 
WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE 
DISCLAIMED IN ANY TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED 
TO THE DURATION OF THE APPLICABLE WARRANTY PERIOD SET FORTH ABOVE. EXCEPT AS EXPRESSLY COVERED UNDER THE 
LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE 
PRODUCT IS WITH THE PURCHASER OF THE PRODUCT. 

 

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE PRODUCT, 
INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
(INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S 
PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY 
PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING TO 
WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR, 
REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM LIABILITY OF D-LINK UNDER 
THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING 
EXPRESS WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, 
EXPRESS, IMPLIED OR STATUTORY. 

Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states do not allow exclusion or limitation of 
incidental or consequential damages, or limitations on how long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. 
This Limited Warranty provides specific legal rights and you may also have other rights which vary from state to state.   

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks are the property of their respective 
owners.  
Copyright Statement:  No part of this publication or documentation accompanying this product may be reproduced in any form or by any means or 
used to make any derivative such as translation, transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as 
stipulated by the United States Copyright Act of 1976 and any amendments thereto.  Contents are subject to change without prior notice.  Copyright 2004 
by D-Link Corporation/D-Link Systems, Inc. All rights reserved. 

CE Mark Warning:  This is a Class A product. In a residential environment, this product may cause radio interference, in which case the user may be 
required to take adequate measures. 

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference in a commercial installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communication. However, there is no guarantee that interference will not occur in a particular installation. Operation of this equipment in a residential 
environment is likely to cause harmful interference to radio or television reception.  If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more 
of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

For detailed warranty information applicable to products purchased outside the United States, please contact the corresponding local D-Link office.  
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Product Registration 
 
 
 
 
 
 
 
 
 
 
 
 

Register your D-Link product online at 
340Hhttp://support.dlink.com/register 
Product registration is entirely voluntary and failure to complete or return this 
f ill t di i i h t i ht
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D-Link Europe Limited Lifetime Warranty 

 

Dear Customer, 

please read below to understand the details of the warranty coverage you have.  

 

Warranty terms for D-LINK xStack products: 

All D-Link xStack products* are supplied with a 5 year warranty as standard. To enable the 
Limited Lifetime Warranty on this product you must register the product, within the first three 
months of purchase**, on the following website: 
http://www.dlink.biz/productregistration/ 

 

D-Link will then provide you with a Limited Lifetime Warranty reference number for this product. 
Please retain your original dated proof of purchase with a note of the serial number, and Limited 
Lifetime Warranty reference number together with this warranty statement and place each 
document in a safe location. When you make a warranty claim on a defective product, you may 
be asked to provide this information. 

 

Nothing in this Limited Lifetime Warranty affects your statutory rights as a consumer. The 
following are special terms applicable to your Limited Lifetime hardware warranty.  

 

Warranty beneficiary 

The warranty beneficiary is the original end user. The original end user is defined as the person 
that purchases the product as the first owner.  

 

Duration of Limited Lifetime Warranty 

As long as the original end-user continues to own or use the product with the following conditions:  

- fan and power supplies are limited to a five (5) year warranty only  

- in the event of discontinuance of product manufacture, D-Link warranty support is limited 
to five (5) years from the announcement of discontinuance. If a product is no longer 
available for replacement, D-Link will issue a product comparable or better to the one 
originally purchased.  

 

Replacement, Repair or Refund Procedure for Hardware 

D-Link or its service center will use commercially reasonable efforts to ship a replacement part 
within ten (10) working days after receipt of the RMA request. Actual delivery times may vary 
depending on customer location. D-Link reserves the right to refund the purchase price as its 
exclusive warranty remedy.2 

To Receive a Return Materials Authorization (RMA) Number, please visit: http://service.dlink.biz 
and for Italy and Spain, please use: http://rma.dlink.es or http://rma.dlink.it. 

http://www.dlink.biz/productregistration/
http://service.dlink.biz/
http://rma.dlink.es/
http://rma.dlink.it/
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D-Link Limited Lifetime Warranty  

Hardware: D-Link warrants the D-Link hardware named above against defects in materials and 
workmanship for the period specified above. If D-Link receives notice of such defects during the 
warranty period, D-Link will, at its option, either repair or replace products proving to be 
defective. Replacement products may be either new or like-new.  

Software. D-Link warrants that D-Link software will not fail to execute its programming 
instructions, for the period specified above, due to defects in material and workmanship when 
properly installed and used. If D-Link receives notice of such defects during the warranty period, 
D-Link will replace software media that does not execute its programming instructions due to 
such defects.  

 

Warranty exclusions   

This warranty does not apply if the software, product or any other equipment upon which the 
software is authorized to be used (a) has been altered, except by D-Link or its authorized 
representative, (b) has not been installed, operated, repaired, or maintained in accordance with 
instructions supplied by D-Link (improper use or improper maintenance), (c) has been subjected 
to abnormal physical or electrical stress, misuse, negligence, or accident; (d) is licensed, for beta, 
evaluation, testing or demonstration purposes for which D-Link does not charge a purchase price 
or license fee or (e) defects are caused by force majeure (lightning, floods, war, etc.), soiling, by 
extraordinary environmental influences or by other circumstances of which D-Link is not 
responsible. 

 

Disclaimer of warranty  

Please note, some countries do not allow the disclaimer of implied terms in contracts with consumers and the disclaimer below may not apply to you.  

To the extend allowed by local law, the above warranties are exclusive and no other warranty, 
condition or other term, whether written or oral, is expressed or implied. D-Link specifically 
disclaims any implied warranties, conditions and terms of merchantability, satisfactory quality, 
and fitness for a particular purpose.  

To the extent allowed by local law, the remedies in this warranty statement are customer’s sole 
and exclusive remedies. Except as indicated above, in no event will D-Link or its suppliers be 
liable for loss of data or for indirect, special, incidental, consequential (including lost profit or 
data), or other damage, whether based in a contract, tort, or otherwise.  

To the extent local law mandatorily requires a definition of “Lifetime Warranty” different from 
that provided here, then the local law definition will supersede and take precedence.  

 

Valid law 

The warranty is subject to the valid laws in the country of purchase and is to be interpreted in 
the warranty terms with the said laws. You may have additional legal rights that are not 
restricted by this warranty. Nothing in this Limited Lifetime Warranty affects your statutory rights 
as a consumer. 

 

* DES-6500 series is excluded from the Limited Lifetime Warranty offering and will be supplied with a 
standard 5 year warranty. 

** Failure to register this product within the first three months of purchase [by the first user only] will 
invalidate the Limited Lifetime Warranty. 
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Tech Support 

Technical Support 
You can find software updates and user documentation on the D-Link website. 

 

Tech Support for customers within Australia: 

D-Link Technical Support over the Telephone: 
1300-766-868 

Monday to Friday 8:00am to 8:00pm EST 

Saturday 9:00am to 1:00pm EST 

D-Link Technical Support over the Internet: 
http://www.dlink.com.au 

email:support@dlink.com.au 
 

Tech Support for customers within New Zealand: 

D-Link Technical Support over the Telephone: 
0800-900-900 

Monday to Friday 8:30am to 8:30pm 

Saturday 9:00am to 5:00pm 

D-Link Technical Support over the Internet: 
http://www.dlink.co.nz 

email:support@dlink.co.nz 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

349 

     

 

Technical Support 
You can find software updates and user documentation on the D-Link website. 

 

Tech Support for customers within South Eastern Asia and Korea: 
 

D-Link South Eastern Asia and Korea Technical Support over the Telephone: 
+65-6895-5355 

Monday to Friday 9:00am to 12:30pm, 2:00pm-6:00pm Singapore Time 

 

D-Link Technical Support over the Internet: 
email:support@dlink.com.sg 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

350 

     

 

Technical Support 
You can find software updates and user documentation on the D-Link website. 

Tech Support for customers within India 

D-Link Technical Support over the Telephone: 
+91-22-26526741 

+91-22-26526696 –ext 161 to 167 
Monday to Friday 9:30AM to 7:00PM 

D-Link Technical Support over the Internet: 
http://ww.dlink.co.in 

http://www.dlink.co.in/dlink/drivers/support.asp 

ftp://support.dlink.co.in 

email: techsupport@dlink.co.in 
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Technical Support 
You can find software updates and user documentation on the D-Link website. 

 

D-Link provides free technical support for customers 

 for the duration of the warranty period on this product. 

 

Customers can contact D-Link technical support through our web site or by phone. 
 

Tech Support for customers within the Russia 

D-Link Technical Support over the Telephone: 
(495) 744-00-99 

Monday to Friday 10:00am to 6:30pm 

 

D-Link Technical Support over the Internet 
http://www.dlink.ru 

email: support@dlink.ru 
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Technical Support 
You can find software updates and user documentation on the D-Link website. 

Tech Support for customers within the U.A.E & North Africa: 
D-Link Technical Support over the Telephone: 

(971) 4-391-6480 (U.A.E) 

Sunday to Wednesday 9:00am to 6:00pm GMT+4 

Thursday 9:00am to 1:00pm GMT+4 

D-Link Middle East & North Africa 

D-Link Technical Support over the Internet: 

http://support.dlink-me.com 

email:support@dlink-me.com  

Tech Support for customers within Israel: 
D-Link Technical Support over the Telephone: 

(972) 9-9715701 

Sunday to Thursday 9:00am to 5:00pm  

D-Link Technical Support over the Internet: 

http://www.dlink.co.il/support/ 

e-mail: support@dlink.co.il 

Tech Support for customers within Turkey: 
D-Link Technical Support over the Telephone: 

0090 312 473 40 55 

Monday to Friday 9:00am to 6:00pm 

D-Link Technical Support over the Internet: 

http://www.dlink.com.tr 

e-mail: turkiye@dlink-me.com 

Tech Support for customers within Egypt: 
D-Link Technical Support over the Telephone: 

+202-2919035, +202-2919047 

Sunday to Thursday 9:00am to 5:00pm  

D-Link Technical Support over the Internet: 

http://support.dlink-me.com 

e-mail: amostafa@dlink-me.com 
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Technical Support 
You can find software updates and user documentation on the D-Link website. 

Tech Support for customers within South Africa and Sub Sahara Region: 

D-Link South Africa and Sub Sahara Technical Support over the Telephone: 
+27-12-665-2165 

08600 DLINK ( For South Africa only ) 
Monday to Friday 8:30am to 9:00pm South Africa Time 

D-Link Technical Support over the Internet: 
http://www.d-link.co.za 

email:support@d-link.co.za 
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Technical Support 
 

You can find updates and user documentation on the D-Link website 

Tech Support for Latin America customers: 

 

D-Link Technical Support over the followings Telephones: 

 

Argentina: 0800-666 1442 Monday to Friday 09:00am to 22:00pm 

Chile: 800-214 422   Monday to Friday 08:00am to 21:00pm 

Colombia: 01800-700 1588  Monday to Friday 07:00am to 20:00pm 

Ecuador: 1800-777 711  Monday to Friday 07:00am to 20:00pm 

El Salvador: 800-6137   Monday to Friday 06:00am to 19:00pm 

Guatemala:1800-300 0017  Monday to Friday 06:00am to 19:00pm 

Panama: 0800-560 0193  Monday to Friday 07:00am to 20:00pm 

Peru: 0800-52049   Monday to Friday 07:00am to 20:00pm 

Venezuela: 0800-100 3470  Monday to Friday 08:00am to 21:00pm 

D-Link Technical Support over the Internet: 

www.dlinkla.com 

www.dlinklatinamerica.com 

email:support@dlink.cl 

Tech Support for customers within Brazil: 

 

D-Link Technical Support over the Telephone: 
0800-7014104 

Monday to Friday 8:30am to 18:30pm  

D-Link Technical Support over the Internet: 
www.dlinkbrasil.com.br 

email:suporte@dlinkbrasil.com.br 
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Техническая поддержка 
 

Обновления программного обеспечения и документация 
доступны на Интернет-сайте D-Link. 

 
D-Link предоставляет бесплатную поддержку для клиентов в 

течение гарантийного срока. 
 

Клиенты могут обратиться в группу технической поддержки D-
Link по телефону или через Интернет. 

 
Техническая поддержка D-Link: 

(495) 744-00-99 
 

Техническая поддержка через Интернет  
http://www.dlink.ru 

email: support@dlink.ru 
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Asistencia Técnica 
D-Link Latin América pone a disposición de sus clientes, especificaciones, 

documentación y software mas reciente a través de nuestro Sitio Web  
www.dlinkla.com 

El servicio de soporte técnico tiene presencia en numerosos países de la 
Región Latino América, y presta asistencia gratuita a todos los clientes de 

D-Link, en forma telefónica e internet, a través de la casilla  
soporte@dlinkla.com 

Soporte Técnico Help Desk Argentina: 
Teléfono: 0800-6661442 Lunes a Viernes 09:00 am a 22:00 pm 

Soporte Técnico Help Desk Chile: 
Teléfono: 800 8 35465 Lunes a Viernes 08:00 am a 21:00 pm 

Soporte Técnico Help Desk Colombia: 
Teléfono: 01800-7001588 Lunes a Viernes 07:00 am a 20:00 pm 

Soporte Técnico Help Desk Ecuador: 
Teléfono: 1800-777 711 Lunes a Viernes 07:00 am a 20:00 pm 

Soporte Técnico Help Desk El Salvador: 
Teléfono: 800-6137 Lunes a Viernes 06:00 am a 19:00 pm 

Soporte Técnico Help Desk Guatemala: 
Teléfono: 1800-300 0017 Lunes a Viernes 06:00 am a 19:00 pm 

Soporte Técnico Help Desk Panamá: 
Teléfono: 0800-560 0193  Lunes a Viernes 07:00 am a 20:00 pm 

Soporte Técnico Help Desk Perú: 
Teléfono: 0800-52049 Lunes a Viernes 07:00 am a 20:00 pm 

Soporte Técnico Help Desk Venezuela: 
Teléfono: 0800-1003470 Lunes a Viernes 08:00 am a 21:00 pm 
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Suporte Técnico 
 

Você pode encontrar atualizações de software e 
documentação de usuário no site da D-Link Brasil 

www.dlinkbrasil.com.br. 

 

A D-Link fornece suporte técnico gratuito para clientes no 
Brasil durante o período de vigência da garantia deste 

produto.  
 

Suporte Técnico para clientes no Brasil: 
 

Telefone 
São Paulo (11) 2185-9301 

Segunda à sexta  

Das 8h30 às 18h30 

Demais Regiões do Brasil 0800 70 24 104 

 

E-mail: 

email:suporte@dlinkbrasil.com.br 
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359 

     

Technical Support 
You can find software updates and user documentation 

on the D-Link website. 
 

D-Link provides free technical support for customers 
within the United States and within Canada for the 

duration of the warranty period on this product. 
 

U.S. and Canadian customers can contact D-Link 
technical support through our website, or by phone. 

 
Tech Support for customers within the 

United States: 
D-Link Technical Support over the Telephone: 

(888) 843-6100 
Hours of Operation: 8:00AM to 6:00PM PST 

D-Link Technical Support over the Internet: 
http://support.dlink.com 

email:support@dlink.com 
 

Tech Support for customers within Canada: 
D-Link Technical Support over the Telephone: 

(800) 361-5265 
Monday to Friday 7:30am to 12:00am EST 

D-Link Technical Support over the Internet: 
http://support.dlink.ca 

email:support@dlink.ca 
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Technical Support 
You can find software updates and user documentation on the D-Link websites. 

 

If you require product support, we encourage you to browse our 
FAQ section on the Web Site before contacting the Support line. 
We have many FAQ’s which we hope will provide you a speedy 

resolution for your problem.  

For Customers within  

The United Kingdom & Ireland: 

D-Link UK & Ireland Technical Support over the Internet: 

http://www.dlink.co.uk 

ftp://ftp.dlink.co.uk 

D-Link UK & Ireland Technical Support over the Telephone: 

08456 12 0003 (United Kingdom) 

+1890 886 899 (Ireland) 

Lines Open 

8.00am-10.00pm Mon-Fri 

10.00am-7.00pm Sat & Sun 

For Customers within Canada: 
D-Link Canada Technical Support over the Telephone: 

1-800-361-5265 (Canada) 

Mon. to Fri. 7:30AM to 9:00PM EST 

D-Link Canada Technical Support over the Internet: 

http://support.dlink.ca 

email: support@dlink.ca 
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Technische Unterstützung 
Aktualisierte Versionen von Software und 

Benutzerhandbuch finden Sie auf der Website von 
D-Link. 

 

D-Link bietet kostenfreie technische Unterstützung 
für Kunden innerhalb Deutschlands, Österreichs, der 

Schweiz und Osteuropas. 

 

Unsere Kunden können technische Unterstützung 
über unsere Website, per E-Mail oder telefonisch 

anfordern. 

 
Web: http://www.dlink.de 
E-Mail: support@dlink.de 
Telefon: +49 (1805)2787 

0,12€/Min aus dem Festnetz der Deutschen Telekom. 

 

Telefonische technische Unterstützung erhalten Sie 
Montags bis Freitags von 09.00 bis 17.30 Uhr. 

 

Unterstützung erhalten Sie auch bei der 
Premiumhotline für D-Link Produkte unter der 

Rufnummer 09001-475767  

Montag bis Freitag von 6-22 Uhr und am 
Wochenende von 11-18 Uhr. 

1,75€/Min aus dem Festnetz der Deutschen Telekom. 

 
Wenn Sie Kunde von D-Link außerhalb 

Deutschlands, Österreichs, der Schweiz und 
Osteuropas sind, wenden Sie sich bitte an die 

zuständige Niederlassung aus der Liste im 
Benutzerhandbuch. 
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Assistance technique 
 

Vous trouverez la documentation et les logiciels les plus récents sur le site web D-Link. 

Vous pouvez contacter le service technique de 

D-Link par notre site internet ou par téléphone. 

 

Support technique destiné aux clients établis en France: 
Assistance technique D-Link par téléphone : 

0820 0803 03 

N° INDIGO - 0,12€ TTC/min* 

*Prix en France Métropolitaine au 3 mars 2005 

Du lundi au samedi – de 9h00 à 19h00 

Assistance technique D-Link sur internet : 

http://www.dlink.fr 

e-mail : support@dlink.fr 

 

Support technique destiné aux clients établis au Canada : 
Assistance technique D-Link par téléphone : 

(800) 361-5265 

Lun.-Ven. 7h30 à 21h00 HNE. 

Assistance technique D-Link sur internet : 

http ://support.dlink.ca 

e-mail : support@dlink.ca 
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Asistencia Técnica 
 

Puede encontrar las últimas versiones de software 
así como documentación técnica en el sitio web de 

D-Link. 

 

D-Link ofrece asistencia técnica gratuita para 
clientes residentes en España durante el periodo de 

garantía del producto. 

 

 

Asistencia Técnica de D-Link por teléfono: 
+34 902 30 45 45 

Lunes a Viernes de 9:00 a 14:00 y de 15:00 a 18:00 

 

 

Asistencia Técnica de D-Link a través de Internet: 
http://www.dlink.es/support/ 

e-mail: soporte@dlink.es 
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Supporto tecnico 
 

Gli ultimi aggiornamenti e la documentazione sono  

disponibili sul sito D-Link. 

Supporto tecnico per i clienti residenti in Italia 
 

D-Link Mediterraneo S.r.L. 
 

Via N. Bonnet 6/B 20154 Milano 
 

Supporto Tecnico dal lunedì al venerdì dalle ore  
9.00 alle ore 19.00 con orario continuato  

Telefono: 02-39607160 

 
URL : http://www.dlink.it/supporto.html  

Email: tech@dlink.it  
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Technical Support 
You can find software updates and user documentation on 

the D-Link website. 

 

D-Link provides free technical support for customers 
within Benelux for the duration of the warranty period on 

this product. 

 

Benelux customers can contact D-Link technical support 
through our website, or by phone. 

Tech Support for customers within the Netherlands: 

D-Link Technical Support over the Telephone: 

0900 501 2007 

Monday to Friday 9:00 am to 10:00 pm 

D-Link Technical Support over the Internet: 

www.dlink.nl 

 

Tech Support for customers within Belgium: 

D-Link Technical Support over the Telephone: 

070 66 06 40 

Monday to Friday 9:00 am to 10:00 pm 

D-Link Technical Support over the Internet: 

www.dlink.be 

 

 

Tech Support for customers within  
Luxemburg: 

D-Link Technical Support over the Telephone: 

+32 70 66 06 40 

Monday to Friday 9:00 am to 10:00 pm 
 

D-Link Technical Support over the Internet: 

www.dlink.be 
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Pomoc techniczna 
 

Najnowsze wersje oprogramowania i dokumentacji 
użytkownika można znaleźć w serwisie internetowym 

firmy D-Link. 

 

D-Link zapewnia bezpłatną pomoc techniczną 
klientom w Polsce w okresie gwarancyjnym produktu. 

 

Klienci z Polski mogą się kontaktować z działem 
pomocy technicznej firmy D-Link za pośrednictwem 

Internetu lub telefonicznie. 

 
Telefoniczna pomoc techniczna firmy D-Link: 

(+48 12) 25-44-000 

 
Pomoc techniczna firmy D-Link świadczona przez Internet: 

URL: http://www.dlink.pl 

e-mail: dlink@fixit.pl  
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Technická podpora 
 

Aktualizované verze software a uživatelských 
příruček najdete na webové stránce firmy D-Link. 

 

D-Link poskytuje svým zákazníkům bezplatnou 
technickou podporu 

 

Zákazníci mohou kontaktovat oddělení technické 
podpory přes webové stránky, mailem nebo 

telefonicky 

 

Web: http://www.dlink.cz/suppport/ 

E-mail: support@dlink.cz 

Telefon: 224 247 503 

 

Telefonická podpora je v provozu: 

PO- PÁ od 09.00 do 17.00 
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Technikai Támogatás 
 

 

Meghajtó programokat és frissítéseket a D-Link 
Magyarország weblapjáról tölthet le. 

Telefonon technikai segítséget munkanapokon 
hétfőtől-csütörtökig 9.00 – 16.00 óráig és pénteken 

9.00 – 14.00 óráig kérhet  
a (1) 461-3001 telefonszámon vagy a 

support@dlink.hu emailcímen. 

 

Magyarországi technikai támogatás : 
 

D-Link Magyarország 
 

1074 Budapest, Alsóerdősor u. 6. – R70 Irodaház 1 em. 
 

Tel. : 06 1 461-3001 

Fax : 06 1 461-3004 

 

email : support@dlink.hu 

URL : http://www.dlink.hu 
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Teknisk Support 
Du kan finne programvare oppdateringer og bruker  

dokumentasjon på D-Links  web sider.  

D-Link tilbyr sine kunder gratis teknisk support under  
produktets garantitid.  

Kunder kan kontakte D-Links teknisk support via våre  
hjemmesider, eller på tlf. 

Teknisk Support: 
D-Link Teknisk telefon Support: 

800 10 610  

(Hverdager 08:00-20:00)  
 

D-Link Teknisk Support over Internett: 
http://www.dlink.no 
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Teknisk Support 
Du finder software opdateringer og bruger- 

dokumentation på D-Link’s hjemmeside. 
 

D-Link tilbyder gratis teknisk support til kunder  
i Danmark i hele produktets garantiperiode. 

 
Danske kunder kan kontakte D-Link’s tekniske  
support via vores hjemmeside eller telefonisk. 

  

D-Link teknisk support over telefonen: 
Tlf. 7026 9040 

Hverdager: kl. 08:00 – 20:00 
 

D-Link teknisk support på Internettet: 
http://www.dlink.dk 
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Teknistä tukea asiakkaille Suomessa: 
D-Link tarjoaa teknistä tukea asiakkailleen.  

Tuotteen takuun voimassaoloajan.  

Tekninen tuki palvelee seuraavasti: 
  

Arkisin klo. 9 - 21  
 numerosta  

0800-114 677 
 

Internetin kautta  
Ajurit ja lisätietoja tuotteista. 

http://www.dlink.fi  
 

Sähköpostin kautta  
voit myös tehdä kyselyitä. 
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Teknisk Support 
På vår hemsida kan du hitta mer information om 

mjukvaru uppdateringar och annan 
användarinformation. 

D-Link tillhandahåller teknisk support till kunder i 
Sverige under hela garantitiden för denna 

produkt. 

Teknisk Support för kunder i Sverige: 
D-Link Teknisk Support via telefon: 

0770-33 00 35  

Vardagar 08.00-20.00 

 
D-Link Teknisk Support via Internet: 

http://www.dlink.se 
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Suporte Técnico  
 

Você pode encontrar atualizações de software e 
documentação de utilizador no site de D-Link Portugal 

http://www.dlink.pt. 
 

A D-Link fornece suporte técnico gratuito para clientes no 
Portugal durante o período de vigência de garantia deste 

produto.  
 

 

Suporte Técnico para clientes no Portugal: 
 
 

Assistência Técnica: 
 

Email: soporte@dlink.es 

http://www.dlink.pt/support/ 

ftp://ftp.dlink.es 
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Τεχνική Υποστήριξη 
 

Μπορείτε να βρείτε software updates και πληροφορίες για τη 
χρήση των προϊόντων στις ιστοσελίδες της D-Link 

 

Η D-Link προσφέρει στους πελάτες της δωρεάν υποστήριξη  

στον Ελλαδικό χώρο 

 

Μπορείτε να επικοινωνείτε με το τμήμα τεχνικής υποστήριξης 
μέσω της ιστοσελίδας ή μέσω τηλεφώνου 

 

Για πελάτες εντός του Ελλαδικού χώρου: 

Τηλεφωνική υποστήριξη D-Link : 

 

Τηλ: 210 86 11 114   
Φαξ: 210 86 53 172 

(Δευτέρα-Παρασκευή 09:00-17:00) 
 

e-mail: support@dlink.gr 
 

Τεχνική υποστήριξη D-Link μέσω Internet: 

 

http://www.dlink.gr  

ftp://ftp.dlink.it  
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International Offices 
U.S.A 
17595 Mt. Herrmann Street 
Fountain Valley, CA 92708 
TEL: 1-800-326-1688 
URL: www.dlink.com 
Canada 
2180 Winston Park Drive  
Oakville, Ontario, L6H 5W1 
Canada 
TEL: 1-905-8295033 
FAX: 1-905-8295223 
URL: www.dlink.ca 
Europe (U. K.) 
4th Floor, Merit House 
Edgware Road, Colindale 
London NW9 5AB 
U.K. 
TEL: +44-20-8955-9000 
FAX: +44-20-8955-9001 
URL: www.dlink.co.uk 
Germany 
Schwalbacher Strasse 74 
D-65760 Eschborn 
Germany 
TEL: 49-6196-77990 
FAX: 49-6196-7799300 
URL: www.dlink.de 
France 
No.2 all’ee de la Fresnerie  
78330 Fontenay le Fleury  
France 
TEL: 33-1-30238688 
FAX: 33-1-30238689 
URL: www.dlink.fr 
Netherlands 
Weena 290 
3012 NJ, Rotterdam 
Netherlands 
Tel: +31-10-282-1445 
Fax: +31-10-282-1331 
URL: www.dlink.nl 
Belgium 
Rue des Colonies 11 
B-1000 Brussels 
Belgium 
Tel: +32(0)2 517 7111 
Fax: +32(0)2 517 6500 
URL: www.dlink.be 
Italy 
Via Nino Bonnet n. 6/b 
20154 – Milano 
Italy 
TEL: 39-02-2900-0676 
FAX: 39-02-2900-1723 
URL: www.dlink.it 
Sweden 
P.O. Box 15036, S-167 15 Bromma 
Sweden 
TEL: 46-(0)8564-61900 
FAX: 46-(0)8564-61901 
URL: www.dlink.se 
Denmark 
Naverland 2, DK-2600 
Glostrup, Copenhagen 
Denmark 
TEL: 45-43-969040 
FAX: 45-43-424347 
URL: www.dlink.dk 
Norway 
Karihaugveien 89 
N-1086 Oslo 
Norway 
TEL: +47 99 300 100 
FAX: +47 22 30 95 80 
URL: www.dlink.no 
Finland 
Latokartanontie 7A  
FIN-00700 HELSINKI 
Finland 
TEL: +358-10 309 8840 
FAX: +358-10 309 8841 
URL: www.dlink.fi 

Spain 
Avenida Diagonal, 593-95, 9th floor 
08014 Barcelona 
Spain 
TEL: 34 93 4090770 
FAX: 34 93 4910795 
URL: www.dlink.es 
Portugal 
Rua Fernando Pahla 
50 Edificio Simol 
1900 Lisbon Portugal 
TEL: +351 21 8688493 
URL: www.dlink.es 
Czech Republic 
Vaclavske namesti 36, Praha 1  
Czech Republic 
TEL :+420 (603) 276 589 
URL: www.dlink.cz 
Switzerland 
Glatt Tower, 2.OG CH-8301  
Glattzentrum Postfach 2.OG  
Switzerland 
TEL : +41 (0) 1 832 11 00 
FAX: +41 (0) 1 832 11 01 
URL: www.dlink.ch 
Greece 
101, Panagoulis Str. 163-43  
Helioupolis Athens, Greece 
TEL : +30 210 9914 512 
FAX: +30 210 9916902 
URL: www.dlink.gr 
Luxemburg 
Rue des Colonies 11, 
B-1000 Brussels,  
Belgium 
TEL: +32 (0)2 517 7111 
FAX: +32 (0)2 517 6500 
URL: www.dlink.be 
Poland 
Budynek Aurum ul. Walic-w 11  
PL-00-851 
Warszawa 
Poland 
TEL : +48 (0) 22 583 92 75 
FAX: +48 (0) 22 583 92 76 
URL: www.dlink.pl 
Hungary 
R-k-czi-t 70-72  
HU-1074 
Budapest 
Hungary 
TEL : +36 (0) 1 461 30 00 
FAX: +36 (0) 1 461 30 09  
URL: www.dlink.hu 
Singapore 
1 International Business Park 
#03-12 The Synergy  
Singapore 609917 
TEL: 65-6774-6233 
FAX: 65-6774-6322 
URL: www.dlink-intl.com 
Australia 
1 Giffnock Avenue 
North Ryde, NSW 2113 
Australia 
TEL: 61-2-8899-1800 
FAX: 61-2-8899-1868 
URL: www.dlink.com.au 
India 
D-Link House, Kurla Bandra Complex Road 
Off CST Road, Santacruz (East) 
Mumbai - 400098 
India 
TEL: 91-022-26526696/56902210 
FAX: 91-022-26528914 
URL: www.dlink.co.in 

Middle East (Dubai) 
P.O.Box: 500376 
Office: 103, Building:3 
Dubai Internet City 
Dubai, United Arab Emirates 
Tel: +971-4-3916480 
Fax: +971-4-3908881 
URL: www.dlink-me.com 
Turkey 
Cetin Emec Bulvari, 74.sokak, ABC Plaza No:9/3 
Ovecler/Ankara- TURKEY 
TEL: 0090 312 473 40 55  
FAX: 0090 312 473 40 58 
URL: www.dlink.com.tr  
Egypt 
47,El Merghany street,Heliopolis 
Cairo-Egypt 
TEL: +202-2919035, +202-2919047 
FAX: +202-2919051 
URL: www.dlink-me.com 
Israel 
11 Hamanofim Street 
Ackerstein Towers, Regus Business Center 
P.O.B  2148, Hertzelia-Pituach 46120 
Israel 
TEL: +972-9-9715700 
FAX: +972-9-9715601 
URL: www.dlink.co.il 
Latin America 
Isidora Goyeechea 2934 
Ofcina 702 
Las Condes 
Santiago – Chile 
TEL: 56-2-232-3185 
FAX: 56-2-232-0923 
URL: www.dlink.cl 
Brazil 
Av das Nacoes Unidas 
11857 – 14- andar - cj 141/142 
Brooklin Novo 
Sao Paulo - SP - Brazil 
CEP 04578-000 (Zip Code) 
TEL: (55 11) 21859300 
FAX: (55 11) 21859322 
URL: www.dlinkbrasil.com.br 
South Africa 
Einstein Park II 
Block B 
102-106 Witch-Hazel Avenue 
Highveld Technopark 
Centurion 
Gauteng 
Republic of South Africa 
TEL: 27-12-665-2165 
FAX: 27-12-665-2186 
URL: www.d-link.co.za 
Russia  
Grafsky per., 14, floor 6 
Moscow  
129626 Russia 
TEL: 7-495-744-0099 
FAX: 7-495-744-0099 #350 
URL: www.dlink.ru 
China 
No.202,C1 Building, Huitong Office Park,  
No. 71, Jianguo Road, Chaoyang District, Beijing  
100025, China. 
TEL +86-10-58635800 
FAX: +86-10-58635799 
URL: www.dlink.com.cn 
Taiwan 
No. 289 , Sinhu 3rd Rd., Neihu District ,  
Taipei City 114 ,Taiwan 
TEL: 886-2-6600-0123 
FAX: 886-2-6600-1188 
URL: www.dlinktw.com.tw 
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Registration Card  
All Countries and Regions Excluding USA 

Print, type or use block letters. 
Your name: Mr./Ms _____________________________________________________________________________ 
Organization: ________________________________________________ Dept. ____________________________ 
Your title at organization: ________________________________________________________________________ 
Telephone: _______________________________________ Fax:________________________________________ 
Organization's full address: ______________________________________________________________________ 
____________________________________________________________________________________________ 
Country: _____________________________________________________________________________________ 
Date of purchase (Month/Day/Year): _______________________________________________________________ 

Product Model Product Serial 
No. 

* Product installed in type of 

computer (e.g., Compaq 486) 

* Product installed in 

computer serial No. 

    

    

    

    

    

(* Applies to adapters only) 

Product was purchased from: 

Reseller's name: ______________________________________________________________________________ 
Telephone: _______________________________________ Fax:________________________________________ 
Reseller's full address: _________________________________________________________________________ 
_________________________________________________________________________ 
_________________________________________________________________________ 

Answers to the following questions help us to support your product: 
1. Where and how will the product primarily be used? 

Home Office Travel Company Business Home Business Personal Use 

2. How many employees work at installation site? 
1 employee 2-9 10-49 50-99 100-499 500-999 1000 or more 

3. What network protocol(s) does your organization use ? 
XNS/IPX TCP/IP DECnet Others_____________________________ 

4. What network operating system(s) does your organization use ? 
D-Link LANsmart Novell NetWare NetWare Lite SCO Unix/Xenix PC NFS 3Com 3+Open 
Banyan Vines DECnet Pathwork Windows NT Windows NTAS Windows '95 
Others__________________________________________ 

5. What network management program does your organization use ? 
D-View HP OpenView/Windows HP OpenView/Unix SunNet Manager Novell NMS 
NetView 6000 Others________________________________________ 

6. What network medium/media does your organization use ? 
Fiber-optics Thick coax Ethernet Thin coax Ethernet 10BASE-T UTP/STP 
100BASE-TX 100BASE-T4 100VGAnyLAN Others_________________ 

7. What applications are used on your network? 
Desktop publishing Spreadsheet Word processing CAD/CAM 
Database management Accounting Others_____________________ 

8. What category best describes your company? 
Aerospace Engineering Education Finance Hospital Legal Insurance/Real Estate Manufacturing 
Retail/Chainstore/Wholesale Government Transportation/Utilities/Communication VAR 
System house/company Other________________________________ 

9. Would you recommend your D-Link product to a friend? 
Yes No Don't know yet 

10.Your comments on this product? 
_______________________________________________________________________________________  
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